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Introduction 

 

What is WTP? 

 
The Wolverine Trading Platform (WTP) is a highly sophisticated, yet user-friendly 

electronic trading platform for professional traders.  It provides direct market access to all 

major exchanges, ECNs and liquidity sources for U.S. equities, options and electronically-

traded futures.  WTP is exceedingly flexible, allowing traders to easily customize both 

market data and their workspace.  In addition, WTP provides a combination of advanced 

functionality not found in other trading platforms.  WTP provides powerful tools like Fan Out, 

which lets traders simultaneously take liquidity from multiple exchanges and ECNs.  It also 

provides a Basket Trader and a Managed Order Console, that equips traders with 

powerful logic-based trading tools.  The Managed Order Console includes features like 

Spread Trader which automates the trading of long/short stock spreads or hedged option 

spreads, and Time Slicer which facilitates a “worked” stock order over a period of time. 

WTP was designed by traders for traders, and as a result, flexibility, ease of use and speed 

are its hallmarks.  The system is intuitive, using a series of ubiquitous and recognizable 

icons that guide traders through commands and choices.  Traders can design and save their 

own personalized workspace, with as much or as little complexity as required. 

 

What can WTP do? 

 

In terms of functionality, WTP provides a trader with tools to perform the following tasks: 

 

• Route and execute stock, option and futures orders 

• Order Management 

• Daily Position Management 

• Track quotes 

• View a variety of graphs and news 

• Automate complex orders such as baskets, spreads and other managed orders 

 

 

The definitions for all WTP applets are here. 

 

The icons found throughout WTP are defined here. 

 



Introduction  Connections, Passwords, Splash Screen 

2 © 2014 Wolverine Execution Services, LLC 

Connections, Passwords, Splash Screen 

  

Connect to WTP 

 

When launching WTP, the Connection window appears. If a connection to WTP had 

occurred previously, the Trade Server, Firm, User, and Password fields will be populated 

with content. If this connection is being made for the first time, content will need to be 

entered manually. Select Connect to log in to WTP. 

  

 

  

  

Change Password 

  

 

In order to change the login password a connection to WTP must exist. When a password is 

changed, a follow-up security question is issued, completing the process. 
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1. Select the Connection button  in the WTP toolbar to open the Connection window. 

 

 

2. Press the Change... button. A Disconnect to Change Password confirmation displays. 

To change a password it is required to disconnect from WTP. Select Yes to disconnect from 

WTP. 

 

 
 

3. The Change Password dialog window launches. Enter the current password and new 

password. Re-key the new password in the Confirm New Password field. Select Connect 

& Change. 
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Note: A password must consist of the following: 

 

 Minimum of eight characters 

 At least one alphabet character (a-z) 

 At least one numeric (1-9), punctuation, or special character 

 

4. When a new password has been entered successfully, the Security Question window 

will launch. Enter the correct answer in the blank field and select OK. The login will 

commence and the new password will be in force. 

  

 
  

Note about the Security Question Window: If, during a normal login, a security 

question and answer had not been previously defined, the Security Question window will 

launch. Select a security question from the drop-down list and enter an answer to the 

question. The selected question will appear in Step #4 above when issuing a password 

change. 

 

 

I Forgot My Password 

  

If a WTP login password cannot be remembered selecting the "I forgot my password..." 

button in the Connection window causes a temporary password to be generated and sent to 

the user's email address.  
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Also, this informational message launches: 

  

 
  

 

  

Configure Network 

 

Values associated with network configuration are set in the Network Configuration window. 

Select Configure Network... on the Connection window to launch the Network 

Configuration window. 

  

Note: It is recommended that network configuration values not be changed without first 

contacting WEX Support. 
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The WTP Toolbar 

  

When WTP launches, the main toolbar and, optionally, the Splash Screen are displayed. All 

of the major functions and applets in WTP are launched from the WTP toolbar. A customized 

collection of WTP applets (known as a workspace) can be created and saved. A workspace 

can also be defined as a system default and will appear whenever WTP is launched. 

  

  

 
  
The WTP Toolbar 

  

  

Every major function is controlled by a separate applet each in a separate window.  For 

example, order tickets are separate from quoting tools; and order management is separate 

from position management. The tools work together in a seamless way to provide a trader 

with the ultimate in flexibility and customization options. Each tool is represented by an 

intuitive icon: the tools can be launched by selecting the type of tool (Trade, Manage, 

Analyze, or Explore) or by pressing the WTP button and selecting the applet from the applet 

list. 

  

A trader can arrange the windows in any manner that best fits his needs. The layout of 

windows can be saved by pressing the Workspace Management button. Workspaces can be 

saved with unique names. A saved workspace might contain only those tools used for the 

type of trading that is done. For example, if a user predominantly works with Options 

trading tools, those applets dealing with Option (e.g., Option Quote Cube, Order Ticket in 

Option mode), can be saved as a workspace. When WTP is started, a previously-saved 

workspace can be launched by default. 

  

The tools are linked in a logical fashion that facilitates trading and the management of 

orders and positions. New order tickets can be generated by clicking cells in the Quote Grid, 

or in any of the order and position management tools. In addition, the quoting, 

order/position management and trading applets have a track mode that causes the applet 

to automatically monitor whatever symbol the trader is currently interacting with. Another 

feature, Connections, allows two or more applets to be connected to each other. 

      

Each trader can control the granularity of the orders and position he views. WTP allows the 

trader to view orders and positions by individual account or by “portfolio.”  A portfolio can 

be both macro (i.e., a group of traders) or micro (an individual trader). To create a new 

portfolio, please contact your sales rep or call the WTP help line at (888) 313-0664.   

  

The Message Center and Status Center displays notification/status information. Double-click 

any item to view detailed information about a message or status. 
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Update WTP 

  

 
  

 
  

  

When a new WTP release is available, an update notification icon will be displayed in the 

WTP toolbar (and in the Session menu as "Update Available"). 

  

Select the icon and a confirmation window will display. Press Continue to update WTP to 

the latest release. 

  

  

Hide the WTP Toolbar Status Information 

  

 
  

The status bar on the WTP toolbar displays the status of servers and quotes along with 

notifications and messages. By default, the status bar displays when WTP is launched. 
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To hide the status bar, select Hide Status Bar from the Workspace Management menu. 

  

To show a hidden status bar, select Show Status Bar. 

  

  

The Splash Screen 

  

 
  

When WTP launches, the splash screen appears. 

  

The contents of the splash screen: 

 

 Tip of the Week—A short informational message that changes on a weekly basis. 

Note that the tip may be describing functionality that doesn't apply to every user's 

trading situation (i.e., tips on trading options may not be useful to equity traders, 

and vice versa). 

 A link to www.tradewex.com (the WEX website). 

 What's new?—A link to the current WTP Release Notes (also selectable from the 

Help menu in the WTP Toolbar). 

 More Tips—A link to another tip page. At the bottom of the page is a link to another 

tip. 

 Close—Click on "close" to close the splash screen. 

  

Only Show Me New Tips—When checked, the Splash Screen launches only when a new tip 

has been added (approximately once a week). 

  

If unchecked, the Splash Screen will launch upon logging in to WTP regardless if a new tip 

has been added. 

  

A closed splash screen can be relaunched by selecting Splash Screen from the Help menu 

in the WTP Toolbar. 
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WTP Applets 

 

Allocator 

The Allocator allows for the redistribution of positions across various accounts. When 

positions are redistributed, their average price can be manipulated (within certain 

limitations) and commission rates can be set. 

 

 

 

Launch Allocator 

The Allocator Window 

Issue an Allocation 

Multiple Allocations from a Single Side 

Multiple Allocations from Multiple Sides 

Allocate to Side Types 

Create/Change Cmta Values from the Report Trades Grid 

Show Order Summary 

Show Options Columns 

Templates 

Export Grid Data 

 

 

 

Launch Allocator 

Click on the Allocator icon  in the WTP toolbar (under Manage). 
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Alternate Method: 

 

From the WTP menu, select Allocator. 

 

 

The Allocator Window 

 

Allocator can display Cmta accounts or Omni accounts (see note below). Each account type 

is defined by WEX during WTP installation. 

  

The drop-down list contains the following selections: 

  

 <All> (displays both Cmta and Omni accounts) 

 Cmta 

 Omni   

 Report Trade 

  

Select the account type and the account name to view the account positions from which 

allocations can be made. 

   

Note: Cmta, Omni, or Report Trade mode is accessible only if the Global Configuration 

option Exclude Report Trades from Allocation is checked. If unchecked, no selection is 

possible and Allocator defaults to <All> display. 

    

The Allocator window is divided into three sections when <All>, Cmta, or Omni is 

selected: 

 

 List of Accounts (left grid)—The accounts to which an allocation can be made to 

or from. 

  

 Positions Grid (top)—The buys and sells based on the selected account. 

  

 Orders Grid (bottom)—The product/account/side information of the selected 

position. Allocations made will also be listed. 

  

The Allocator window is divided into two sections when <Report Trade> is selected: 

 

 List of Accounts (left grid)—The accounts to which an allocation can be made to 

or from. 

 Order Grid—The Order grid shows all Option Report Trades, regardless of Cmtas. 

 

Issue an Allocation 

 

An allocation is accomplished when selected position(s) of one or more accounts are defined 

to be allocated to one or more accounts. 

  

Step 1: In the example below, a position is selected. Account = AccountA1, Symbol = 

AAPL, Executed Quantity = 100 
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Step 2: Right click (or double-click) on the position row for the position that is to be 

allocated and select Add Allocation (or select Action-->Add Allocation ). 

  

The Add Allocation window displays: 

  

 
  

The Allocate From portion of the window displays the position data selected. 

  

Step 3:  In the Allocate To section of the Add Allocation window, select an account from 

the drop-down list in the Account column. Once selected, the quantity, and price will 

display.  

  

If a commission is to be attached to the allocated account, check the Commission box and 

select either Per Share or Flat Fee. If the commission value is empty, zero, or greater 

than $0.05, an Allocation warning message will be issued. Allocations can be successfully 

completed despite the warning messages. Click Yes on the warning message to allow the 

allocation to complete. When Commission is unchecked, the Commission column will not be 

displayed, resulting in the same interpretation as an empty commission value.  

  

In the example, the AAPL position will be allocated to the AccountA2 account with a 

commission of $0.02: 
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Note 1: If an entire position is being allocated the average price cannot be modified. 

  

Note 2: If allocating from a position in which all orders are identical (in this example 

Long), you may select the side type of <Auto>. The Allocate-To account's side type will 

automatically match that of the Allocate-From account. 

  

If the Allocate-From account has various positions, then the <Auto> side type will be 

unavailable for selection. 

  

  

Step 4: Click OK to allow the allocation to commence, or Cancel to exit without an 

allocation. 

  

Once the allocation has transpired, the account that received the allocation will be updated. 

  

In the example below, the account (AccountA2) now shows its position as having the 

allocated Symbol (AAPL), and the Order section of the Allocator gird notes that an Allocate 

In transaction has occurred: 

  

 
  

The column labeled Type in the Orders grid shows that this order was Allocate In 

confirming a successful allocation took place. 

 

 

Multiple Allocations From A Single Side 

 

In the example above, one account's position was allocated to one account. 
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A single position can be allocated to multiple accounts. Note: The quantity sum from all 

accounts cannot exceed the quantity of the Allocate From position. 

 

 

Multiple Allocations from Multiple Sides 

 

Multiple sides can be selected for allocation to one or more accounts. 

 

In the example below, three sides for three symbols have been selected for allocation: 

 

 
 

The Add Allocation window looks similar to the single allocation, except that percentages 

must be defined in order for the allocation to commence. 

 

In this example, 20%, 60% and 10% were defined as allocation percentages to three 

accounts. 

 

 
 

Note: The Pct. Quanity cannot exceed a total of 100%, though it can be less. Any 

allocation totaling less than 100% leaves the remaining percentage in the originating 

account. 

 

 

Allocate to Side Types 

 

 
 

Side types will be provided based on whether the orders being allocated are Options or 

Non-Options. If allocating Options and Non-Options together side types cannot be 

selected. 

 

Create/Change Cmta Values from the Report Trades Grid 
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Although Report Trades cannot be allocated per se, a Report Trade can have a Cmta value 

added or changed. Double-click on a specific order (or right-click on the order and select 

Add Allocation). When selected, the Report Trade Allocation window launches. The Cmta 

value can be edited in this window: 

  

 
  

 

 

Show Order Summary 

 

 
  

The Order Summary window in Allocator displays: 

1. Quantity total 

2. Quantity traded 

3. Remaining quantity 

4. Total net traded 

5. Average price 

6. Total cost 

7. Total value 
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8. Total Cash 

 

Launch the Order Summary window: 

1. Highlight one or more orders in the Orders portion of the Allocator window.  

2. Right-click and select Show Order Summary. 

Alternate Method: 

  

From the Action menu, select Show Order Summary. 

   

  

The Order Summary window is also available in the Order Grid and is accessible by right-

clicking on selected orders or via the Action menu. 

  

Show Order Detail 

 

1. Select an order in the Orders portion of Allocator 

2. Right-click and select Show Order Detail. 

 

Alternate Method: 

  

 From the Action menu, select Show Order Detail. 

  

See the Order Grid page for more details on the Show Order Detail feature. 

 

 

Show Options Columns 

 

Columns relating to Options including Underlier, Root, Strike, and Expiration Date can 

be added to Allocator. 

 

(Note: If it's preferred to always display the Options columns, the Allocator can be saved as 

a template. When the template is retrieved, the Options columns will be visible.) 

 

 

Templates 

 

See Templates to learn about saving, retrieving, and overriding templates. 

 

 

Export Grid Data 

 

See Export Grid Data for more information on how data can be exported to files, the 

clipboard, or a spreadsheet program. 
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Basket Trader/Crossing Basket/Spread Basket/Stage Basket 

 

Basket Trader allows users to send batches of equity, option, and/or future products 

together in a single basket order, locking in true markets. Each row in the Basket Trader 

grid is a separate order which can be configured. Multiple baskets can be loaded, allowing a 

user to toggle between them. Multiple asset classes can be loaded into the same basket, 

allowing for the launch of options, futures, and equity orders in the same wave. Basket 

Trader waves can be viewed in the Wave Grid. 

 

The Crossing Basket is a similar applet to Basket Trader but it used for crossing orders. 

The Spread Basket is called when Spread Viewer sends it spread orders. 

 

 

 
Launch Basket Trader 

Baskets 

Multi-Basket Mode 

Folders 

Load Baskets 

General Configuration 

Issue a Basket Trade 

Examples of Basket Trades 

Clean Up Mode 

Override Order Parameters 

 

Read Only Mode 

Advanced Mode 

Status Bar 

Export Grid Data 

Import Basket 

Cancel Orders 

Crossing Basket 

Spread Basket Trader 

Stage Basket Trader 

 

Launch Basket Trader 

 

Click Trade on the WTP toolbar and select Basket Trader. 

 

Alternate Method: 

 

From the WTP menu select Basket Trader. 
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Baskets 

 

A basket is a collection of symbols (i.e., securities), each symbol having its own trading 

parameters. In the image above, the displayed basket is identified as "December 08." Below 

it is another basket "January 09." Any number of baskets can be created. Additionally, 

folders can be created that hold baskets. This allows for complete customization of basket 

tree. 

 

Create a basket: 

  

Right-click anywhere in the Basket Trader grid. Select File Commands --> New Basket 

 

Alternate Methods: 

 

 Click on the New Basket icon  

 

 From the WTP toolbar click Basket Trader. Select File --> New Basket 

  

 If the display is in Multi-Basket Mode, right-click where other baskets are listed and 

select New File 

 

The name of each new basket, by default, is New Basket. 

 

Rename a basket: 

 

1. Right-click on a basket name that is to be changed. 

  

2. Select Rename 

  

3. Type in the new name of the basket and hit enter. 

 

Remove a basket: 

 

1. Select a basket by clicking on it. 

  

2. Press the delete key 

 

Alternate Method: 

 

Right-click and select Remove 

  

3. A confirmation window will appear. Select Yes to remove the basket, No or Cancel 

to prevent the basket from being removed. 

 

Save a basket: 

 

1. Select a basket by clicking on it. 

  

2. Select the Save Basket icon . 
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3. A Save Basket window will appear. Select a desired folder for the basket. The file 

name will default to the basket's name. Select Save. 

 

The basket is saved with a .bbk extension. 

 

Note: The option Save Basket As... works in the same manner as steps #3 and #4. 

 

Alternate Method for Step 2: 

 

1. Right-click anywhere in the Basket Trader grid. 

  

2. Select File Commands --> Save Basket 

 

 

Open an existing basket: 

 

1. Right-click anywhere in the Basket Trader grid. 

 

Alternate Method: 

 

Right-click anywhere in the list of baskets (in multi-basket mode). 

  

2. Select File Commands --> Open Basket 

 

Alternate Methods: 

Click on the Open Basket icon  

 

Right-click in the list of baskets and select Open File... 

  

3. Choose the saved basket by maneuvering to the directory where it's stored. 

  

4. Double-click on the basket name to open it. 

 

Multi-Basket Mode 

 

When Basket Trader is in Multi-Basket Mode it means that all created baskets (and 

folders) will be visible on the left pane of the Basket Trader window. 

 

If Multi-Basket Mode is turned off, only the current basket will be loaded into Basket 

Trader and the left pane will not be visible. 

 

Select the Basket Tree icon  to toggle on/off the display of all baskets. 

 

Alternate Method: 

 

From the Config menu select Show Basket Tree. 

 

Folders 
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Folders can be created in Basket Trader. Similar to folders created on your computer, these 

folders can store baskets, allowing for the creation of a directory tree. Folders are optional 

in Basket Trader. 

 

Create a folder 

 

1. With Basket Trader in multi-basket mode, right-click anywhere in the list of 

baskets (not on the grid itself). 

  

2. Select New Folder. A folder with the name "New Folder" will appear. 

  

3. Rename the folder as desired. Right-click on the folder and choose rename. 

  

Delete a folder 

1. Click on a folder name to delete. 

  

2. Press the delete key OR right-click and select Remove. 

  

3. A confirmation window will appear. Press Yes to delete the folder. Press No or 

Cancel if the folder is not to be deleted. 

 

Note: Any baskets residing in a folder will be deleted when the folder is deleted. 

 

Move Baskets into a Folder 

 

Existing baskets can be placed into a folder.  

 

1. Click on a basket to highlight it. 

  

2. While the mouse is pressed move the basket to the appropriate folder and release 

the mouse button. 

 

Load Baskets 

  

Once a basket has been created, it needs to be filled. The two most important (and 

required) items to place in a basket are: 

 

 Securities—Products that are to be bought and sold, identified by their symbol 

  

 Weight—The number of shares or contracts that are to be purchased or sold 

 

Add Security Names to the Basket Trader Grid 

 

In the Symbol column, security names are listed. To add a symbol name: 

 

1. Click the mouse button in the Symbol column on a row where a name is to be 

added. 

  

2. From the drop-down list, select a security name. 

 

Once a symbol has been added to the Basket Trader grid, other columns (such as Weight) 

will fill in with default values. 
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Configure Trading Parameters 

 

Once a symbol has been added to the Basket Trader grid, trading parameters should be 

configured. The most important of these, is weight, portfolio, route, and min trd qty. 

With these values in place, issuing a trade with the basket's securities can commence. 

 

To configure other columns in the Basket Trader Grid: 

 

1. Click on a row to highlight it. 

  

2. Move the mouse to the column whose value is to be defined. 

  

3. Enter the desired value (note that some columns have drop-down lists, others have 

up/down arrows). 

 

General Configuration 

 

 
 

Before issuing buys or sells in Basket Trader, it is helpful to set up other configurations such 

as maximum basket quantity, basket details, and other values. 

 

To configure Basket Trader: 

 

1. Right-click anywhere in the Basket Trader Grid and select Configuration 

 

Alternate Method: 

 

From the WTP toolbar, click on the Basket Trader column and select Config --> 

Configuration 
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2. The configuration window will display. Edit the fields, and check or uncheck features 

as necessary: 

  

 Maximum Basket Qty—This value refers to the maximum quantity that can 

be sent in any single order. 

  

 Maximum Total Shares—The maximum trade quantity that can be sent at 

one time. 

  

 Maximum Total Cash—Basket Trader will compare your trade parameters 

with the value entered in this field. If the total trade amount exceeds this 

value, Basket Trader will not allow the trade to go through. 

  

 Round Lots Only—Check this box and select Round if trading in round lots 

(i.e., 100, 200, 300, etc.) is desired.  

 

Truncate—Check the box and select Truncate if Basket Trader is to reduce 

the size of the order and keep the size as a round lot. 

  

 Multi-Basket Mode—Check this box to view all created baskets. They will be 

visible on the left side of Basket Trader. If unchecked, only the current basket 

will be displayed. Multi-basket mode is convenient for traders as different 

baskets can be selected with just a mouse click. 

  

 Show Basket Detail—If checked, the Basket Trader grid is displayed. If 

unchecked, only the Override and Basket Trade tables will be visible. 

 

Alternate Methods: 

Select the Basket Detail icon  

 

Right-click on Basket Trader and select Show Basket Details 

  

 Show Options Columns in Grid—The following columns are added to the 

Basket Trader grid if this option is selected: 

 

Option (Call/Put), Underlier, Root, Strike, Exp. Date 

  

 Enable Advanced Mode—If this box is checked, the Override Advanced 

Order Parameters fields (such as start/stop times and book only/sweep 

selections). 

  

 Enable Basket Quantity Spinner—The up/down arrows (spinners) will be 

enabled if this box is checked. 

  

 Show Quick Quantity Controls—If checked, quantity buttons (1, 5, 10, 25, 

50 and Clear Qty) are visible on Basket Trader (below the Basket Trade area). 

These buttons allow for one-touch quantities as opposed to manually entering 

the desired values. 

  

 Don't Allow Limit or Peg Orders that will fill immediately—If this box is 

checked any limit order or peg order that can be filled immediately won't be. 
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If unchecked, limit and peg orders that can fill immediately, will be filled. 

 

 Allow Market price type—Check this box if you want the Market sell type 

as an available Override Order Parameter option. If unchecked, the Market 

sell type will be unavailable for selection. 

 

 

Columns and Formatting 

 

See Global Configuration for instructions on setting up columns and formatting. 

 

Conditions 

 

The Conditions window is similar in function to Row Color Conditions window. Click here to 

learn how to configure the Conditions window.  

 

Issue a Basket Trade 

 

Before trading can begin in Basket Trader, it is assumed that: 

 

 At least one symbol has been defined, along with its weight, portfolio, route, and 

minimum trade quantity 

 

Issue a basic trade in Basket Trader: 

 

1. Check the box next to each symbol in the basket that is to be bought or sold. 

  

2. In the Basket Trade portion of the Basket Trader window, select Trade Mode and 

define a quantity amount. 

  

3. Press BUY or SELL to initiate the trade. 

  

4. A confirmation window will appear. Press OK to send the basket trade or Cancel to 

exit without sending the basket. 

  

Crossing Route Orders 

 

Crossing Route orders are handled with Crossing Basket. 

 

 

Examples of Basket Trades 

 

Here are a couple examples of basket trades, including an error condition that traders might 

encounter, with an easy fix: 
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EXAMPLE ONE— —A SINGLE SYMBOL BASKET TRADE: 

 

 
   

In this example, one symbol (ORCL) has been checked (i.e., selected). The symbol has 

these parameters: 

 

 The number of share to trades is 100 (the weight) 

  

 The minimum trade quantity is 300 

  

 In the Basket Trade section of the window, the quantity has been defined as 3.  

 

To achieve a successful basket trade, this basic formula must be followed for any 

symbol: 

   

(Quantity x Weight) ≥ The Minimum Trade Quantity 

 

Because the quantity (3 baskets) multiplied by the weight (100) = 300 (the minimum trade 

quantity) a basket trade can be filled. A confirmation window appears after pressing Buy: 

 

 
 

A sell order brings up this confirmation window: 
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EXAMPLE TWO— —THREE SUCCESSFUL AND ONE REJECTED  BASKET TRADE: 

 

 
 

In this example, 4 symbols have been selected, but only 3 will be traded. The symbol DIS 

will not trade because the quantity (3) x weight (5) is less than the min trd qty of 25. 

The column Trd Qty will reflect the number of shares to be traded. 

 

The confirmation window will mention only the basket orders that can trade: 
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If a basket order cannot be filled this message will appear: 

 

 
 

 

Clean Up Mode 

 

In the Basket Trade section of the Basket Trader window are two options: Trade Mode or 

Clean Up Mode. 

 

Clean up mode is a method to revert to a specified position (as specified in the Position 

box). 

 

 
 

In the above example, 3 symbols have been selected, the Basket Trade portion of the 

window is in Clean Up Mode, and with a position of 5. 

 

The confirmation window describes the transaction: 
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Override Order Parameters 

 

Certain trade parameters can be overwritten. Items such as Minimum Trade Quantity and 

Portfolio can have values assigned that overwrite an individual symbol's configuration. 

Once symbols are selected and values are placed in the Override Order Parameters 

section of Basket Trader, the override parameters are in force. When an override is enabled, 

its corresponding column is removed from the grid. 

 

 
 

Override Definitions and Examples 

 

Column 

Name 

Definition Content Example 

Min Trd 

Qty 

The minimum number of shares per order Any integer 

Buy Px 

Type 

The price type of the security when buying Market, Limit, Peg Bid, 

Peg Ask, Peg Mid, Peg 
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Last, Bid, Ask, Mid, Last 

Buy 

Px/Inc 

Specified if Buy Px Type requires either a 

price (like "Limit") or increment (like "Mid") 

Any integer (can be zero) 

Buy 

Side 

The side type for buy orders BUY, BYO, BYC (note: can 

be blank) 

Sell Px 

Type 

The price type of the security when selling Market, Limit, Peg Bid, 

Peg Ask, Peg Mid, Peg 

Last, Bid, Ask, Mid, Last 

Sell 

Px/Inc 

Specified if Sell Px Type required a price 

(like "Limit" or increment (like "Mid") 

Any integer (can be zero) 

Sell Side The side type for sell orders SEL, SSH, SSE, SLO, and 

SLC 

Portfolio The portfolio of the security The portfolio name (can 

be blank) 

Route The routing destination for the security The route (can be blank) 

TIF Time In Force instruction DAY, FOK, IOC, OPG 

CP Capacity instruction Should be set to "A" 

unless doing Index Arb, or 

Program Trading 

 

 

Read Only Mode 

 

The Basket Trader grid can be viewed in read-only mode. Symbols cannot be selected while 

in read-only mode. 

 

To set Basket Trader in read-only mode: 

 

1. Right-click anywhere in the Basket Trader grid. 

  

2. Select File Commands --> Read Only Mode 

 

Alternate Method: 

 

From the WTP toolbar, select File --> Read Only Mode 

 

Advanced Mode 

 

 
 

Additional configurations can be selected for the basket while in Advanced Mode: 

 

 Show—The value entered in this field represents the total desired quantity that 

should be available on an Order book. 

  

 Disc (Discretionary)—The discretionary value in which an order can be filled.  
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 % Vol (Volume)—Volume percentage, used for VWAP orders. Values from 0 to 100. 

  

 Agg (Aggression)—Used for algo routes. Values from 0 to 10, reflecting how much 

a user wishes to "push" the market in an aggressive fashion. 

  

 Start/Stop Times—Start and/or Stop times for Basket Trader to send basket orders 

can be defined. If both are unchecked, Basket Trader will endeavor to send basket 

orders immediately and stop at the end of the trading day. 

  

 Give-up—A transaction between three brokers where one broker hands off a trade 

to a second broker, who then buy the stock from a third. The third broker exercises 

the trade, while the first broker gives up the name of the second broker, even 

though the trade is executed between the first and third broker.  

 

Example: Broker A receives a buy order, but is too busy to handle it. Broker B is 

asked to help fill the order and buys the stock from Broker C. The transaction is 

recorded between Brokers B and C. Broker A, in effect, gives up the name of Broker 

B. The trade, however, is executed between Broker A and Broker C. 

 

Select a Give-up value from the drop-down list. 

  

 CMTA (Clearing Member Trade Agreement)—An agreement where an investor 

trades with a number of different brokers, later consolidating the trades through a 

single broker for clearing. 

  

 Account Type—If designating an account type other than the <default> is required 

for the basket order, select one from the following: 

 

Broker Dealer 

Customer 

Firm 

Market Maker 

Professional Customer 

  

 Note—Enter a free-form note in this field. 

 

The location of the Note field depends on which Basket Trader is being worked: 

 

For the Standard Basket Trader and Spread Basket Trader the Note field is in the 

Override Advanced Order Parameters section. 

For the Crossing Basket Trader and Staged Basket Trader the Note field in the 

Override Order Parameters section. 

  
 IOC Routes—Immediate Or Cancel routes can be selected for basket orders. IOC 

routes are configured under the Routes tab in Global Configuration.  

 

The IOC Detail window will display if checked (see image above). 

 

Once a basket buy/sell order is executed, the IOC Tracker window will display: 
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Each order can be selectively stopped or continued. Exiting the IOC Tracker while 
there are active orders will cause all active orders to be stopped.—Immediate Or 

Cancel routes can be selected for basket orders. IOC routes are configured under the 

Routes tab in Global Configuration.  

 

The IOC Detail window will display if checked (see image above). 

 

Once a basket buy/sell order is executed, the IOC Tracker window will display: 
 

 

 

Each order can be selectively stopped or continued. Exiting the IOC Tracker while 

there are active orders will cause all active orders to be stopped. 

  

 AON—All Or None. If checked, all items in the basket will be sent with the 

understanding that all orders need to be filled. If, for whatever reason, all orders 

cannot be filled, all will be canceled. 

 

If unchecked, each symbol individually can be selected for all-or-none processing. 

The AON column must be visible in the basket detail portion of the Basket Trader 

window to individually select a symbol. 

  

 Sweep—A sweep order instructs an exchange to only route an order to fast 

exchanges. 

  

 Book Only—A book only order instructs an exchange to not route an order. Either 

the order will fill an order currently on the exchange's book, or it will remain unfilled. 

 

Set Basket Trader in Advanced Mode: 

 

1. Right-click anywhere in the Basket Trader grid. 

 

2. Select Enable Advanced Mode. 

 

Alternate Method: 

 

From the WTP toolbar, click on the Basket Trader Column, and select Config --> 

Enable Advanced Mode. 
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Status Bar 

 

The status bar in the Basket Trader window displays the applet's status (i.e., "Ready") and 

the time of day. The status bar can be toggled on and off. The default status is ON. 

 

To turn the Status Bar on or off: 

 

1. Click on the Basket Trader column on the WTP toolbar. 

  

2. Select Config --> Status Bar 

 

Repeat this action to turn the feature off (if it's on), or on (if it's off). 

 

 

Export Grid Data 

 

The data contained in Basket Trader can be exported: 

 

 As a file 

  

 To the clipboard 

  

 To a Microsoft Excel spreadsheet 

  

To learn the specifics of exporting grid data, click here. 

 

 

Import Basket 

 

Grid data from an ASCII text file or Microsoft Excel spreadsheet can be imported into Basket 

Trader. Both comma-separated files (.csv) and text files (.txt) can be imported. 

  

 
  

In the image above, an ASCII text file has been created with fields delimited by a comma. 

The stock symbols, weight, and buy and sell price are listed. 

 

1. From the File menu select Import Basket. 

 

Alternate Method: 
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Right-click in the Basket Trader grid and select File Commands-->Import Basket. 

  

2. By default the Files of type will be set to Comma Separated Files (*.csv). You 

can also select Text Files (.txt). 

  

3. Open the file containing the grid data that is to be imported. The Import From File 

window will launch with the imported data displayed: 

 

 
  

4. Assign column names to each column in the Import window by clicking on the 

column head and select the appropriate column descriptor: 

 

 



WTP Applets  Basket Trader/Crossing Basket/Spread Basket/Stage Basket 

32 © 2014 Wolverine Execution Services, LLC 

 

  

5. Click Import to bring the data into Basket Trader. The name of the basket will 

reflect the name of the imported data file. 

 

Note: Due to market fluctuation, values such as bid/ask will undoubtedly change 

once they are imported. 

  

Additional "Import Basket" Details 

  

Start Import At Line—The number in this field refers to the line number in imported file. 

When the file is imported, the first line displayed in Basket Trader will be the line selected 

here. If the imported data file contains column headings of its own, then the "Start Import 

at Line" value should be adjusted to where the headings will not be imported. 

  

In the example above, Line 1 is selected. When the file is imported, Line 1 will be the first 

line displayed. 

  

Import Type—Basket is the only available selection. 

  

Import to—Two choices, either New or Existing Rows 

  

New—A basket will be created that contains all the selected rows of the import 

file. 

 

Existing Rows—Not available for Basket Trader. 

   
Delimiters—This checked box refers to the field delimiters in the import file. A different 

delimiter can be selected, but better results will occur with the delimiter used in the import 

file (i.e., a tab-delimited file will produce better results when tab is selected). 

  

Templates—Once the columns have been assigned names, they can be saved for later use. 

Press Save Import Template to save and name your template. 

  

When importing a file with the same import type, press Load Import Template and select 

the appropriate template for your import type. 

 

 

Cancel Orders 

 

Orders that have been executed, but not filled, can be canceled.  

 

To cancel ALL orders: 

 

1. Right-click anywhere in the Basket Trader grid. 

  

2. Select Cancel All Orders 

 

Alternate Method: 

 

From the WTP toolbar, go to the Basket Trader column and select Action --> 

Cancel All Orders 
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To cancel Matching orders: 

 

1. Right-click anywhere in the Basket Trader grid. 

  

2. Select Cancel Matching Orders --> and one of the following: 

 

Cancel All For Symbol... 

 

To Route... 

 

In Account ... 

 

In Portfolio 

 

OR 

 

From the WTP toolbar, go to the Basket Trader column and select Action --> 

Cancel Matching Orders for the same options. 

 

Crossing Basket 

 

Crossing Basket works in a similar fashion as Basket Trader but is used when creating 

crossing orders. Also, the Crossing Basket does not offer an advanced mode due to the fact 

that advanced mode parameters are displayed by default. 

 

Launch Crossing Basket 

 

Click Trade on the WTP toolbar and select Crossing Basket Trader. 

 

Alternate Method: 

 

From the WTP menu select Crossing Basket. 

 

Issue a Basket Trade with a Crossing Route: 

 

When a crossing order is executed, the Crossing Tracker applet opens allowing for the 

management of all crossing orders. 

 

 The route <Crossing> must be selected. The Crossing Route is based on the 

Option Quote Source Routes defined in Global Configuration. 

  

 Crossing Route(s) must be enabled (see the Crossing Route Detail section of Basket 

Trader above).  

 

Crossing Basket Configuration 

 

The Crossing Basket configuration screen is similar to the Basket Trader with a few 

exclusions: 
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See General Configuration for detailed descriptions each field. 

 

 

Spread Basket Trader 
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The Spread Basket Trader is a standalone applet used to send multiple spread orders in a 

single basket.  

 

Launch Spread Basket Trader 

 

From the WTP menu select Spread Basket Trader. 

 

Alternate Method: 

 

From the WTP toolbar select Trade-->Spread Basket Trader. 

 

In the images above, three spread orders are defined in Spread Viewer and sent to the 

Spread Basket Trader 

 

 

Stage Basket Trader 

 

Operating in the same fashion as the standard Basket Trader, orders sent via the Stage 

Basket Trader are different because they represent an intention to trade waves of single 

orders. 

 

New orders for a particular security can be attached to the same security in the basket, 

reducing the staged order's amount. Viewable in the Order Grid, Stage Basket Trader orders 

can be changed or released. 

 

Launch Stage Basket Trader 

 

From the WTP menu select Stage Basket Trader. 

 

Alternate Method: 

 

From the WTP toolbar select Trade-->Stage Basket Trader. 

 

Learn more about staged orders here.
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Corporate Action Viewer 

View corporate action for the past week including Corporate Events, Delisted Symbols, 

Dividends, IPOs, Splits, and Symbol Changes. 

  

 
  
Corporate Action Viewer Requirement Show/Hide the Status Bar 

Launch Corporate Action Viewer Send Corporate Action Viewer Content to other WTP 

Applets 

Configure Corporate Action Viewer Templates 

Tabs Export Grid Data 

Sorting Data Within Columns Copy, Copy This Cell 

Search for Symbols Printing 

Display Entities  

 

 

Corporate Action Viewer Requirement 

  

An Activ Quote Connection is required in order for Corporate Action Viewer to search 

symbols. 

  

  

Launch Corporate Action Viewer 

  

From the WTP menu select Corporate Action Viewer. 
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Alternate Method: 

  

From the WTP toolbar select Analyze-->Corporate Action Viewer. 

  

  

Configure Corporate Action Viewer 

  

  

 
  

To launch the Configuration window: 

  

Press the configuration icon . 

  

Alternate Methods: 

 

 Right-click anywhere in the grid and select Configuration. 

  

 From the Config menu select Configuration. 

  

Add/Remove Columns 

  

Learn how to set up columns and define formatting here. 

  

  

Miscellaneous Tab 
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Check the Sort Equities to Top box to display equity entities at the top of the Corporate 

Action Viewer grid. If unchecked, entities will be listed in alphabetical/numerical order. 

  

  

Tabs 

  

In the system default template for Corporate Action Viewer are six tabs: 

 Split (stock split data) 

 Dividend (securities issuing dividends) 

 IPO (securities issuing initial public offerings) 

 Delist (securities delisted) 

 Corporate Event (security price adjustments) 

 Symbol Change (old and new symbol names) 

Note about adding tabs: The tabs that can be added to Corporate Action Viewer are, by 

default, named the same as those found in the system default template. For example, the 

IPO tab already exists, but another IPO tab can be added. A trader could be interested in 

equity IPOs and Mutual Fund IPOs. Creating a second IPO tab (where one displays only 

equities, and the other displays only mutual funds) solves this problem. To avoid any 

confusion over the contents of a tab, each can be renamed (e.g., Equity IPO, Mutual Fund 

IPO). 

  

Learn more about using tabs here. 

   

Sorting Data Within Columns 

  

As with all WTP grids, data within columns can have their alphabetical/numerical order 

changed by double-clicking on a column's head. 

  

  

Search for Symbols 
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Search results are displayed in the Search Results tab. In this example, the search results 

for AE are displayed. 

 

Double-clicking on a row displayed in Search Results will automatically open the symbol 

under the appropriate tab. 

 

For example, double-clicking on the symbol CAEUF opens the specific Corporate Action 

page that contains the search result (as seen below) 

 

 

Enter a search term in the Search field and press Enter. This will search the Symbol field* 

of all corporate actions for matching symbols. The results will be displayed in the Search 

Results tab. 
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*For Symbol Change events, both the old symbol and the new symbol fields will be 

searched. 

  

Double-click on any row displayed in Search Results and Corporate Action Viewer switches 

to the specific corporate action page that contains the search result. In the first image 

above, the symbol CAEUF was listed in Search Results. Double-clicking on it opens the 

specific corporate action relating to that symbol. In the second image, the Symbol Change 

tab is automatically selected, reflecting the fact that the corporate action for symbol CAEUF 

was a symbol change. 

  

If you are seeking an exact match to the content in the Search field, check Exact Matches 

Only. 

  

Search Command Limitations 

 

1. Wildcard characters (* +, etc.) should not be used as part of a search and can result 

in Corporate Action Viewer finding no matches.  

2. The results of a search can only be found under the Search Results tab. They will 

not be reflected in the other tabs of Corporate Action Viewer. 

3. An exact search finds only those symbols that match exactly, in order, with no extra 

characters. In the image above, the search for "ab" finds all symbols that contain, in 

order, the letters "a" and "b". An exact match would yield nothing. 

   

Display Entities 

  

The entities that are to be displayed in the Entity column can be filtered. Click on the 

Entity Type column head and select the entities to be displayed from the drop-down list. 

  

  

Show/Hide the Status Bar 

  

In the Config menu, select Status Bar to display the current time and any system 

messages at the bottom of the Symbol Browser window. 

  

  

Send Corporate Action Viewer Content to Other WTP Applets 

  

  

Symbols in Corporate Action Viewer can be sent to other WTP applets via the Send to 

command. 

  

From the Action column select Send to-->. Select the applet to send the Symbol. 

  

Alternate Method: 

  

Right-click anywhere in the Corporate Action Viewer grid and select Send to-->.  

  

Learn more about the Send to feature here. 

  

  

Templates 
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Corporate Action Viewer configurations can be saved as templates. 

  

Learn about templates here. 

  

  

Export Grid Data 

  

  

Data in Corporate Action Viewer can be exported to a file, clipboard, or Excel spreadsheet. 

  

Learn about exporting grid data here. 

  

  

Copy, Copy This Cell 

  

  

The Copy command copies all selected rows. The Copy This Cell command copies a 

selected cell. 

  

To Copy: 

 

1. Select one or more rows. 

  

2. From the Action column select Copy. 

 

Alternate Methods: 

3.  

 Right-click on the highlighted rows and select Copy. 

  

 Press Ctrl +c after highlighting the row(s) 

 

Note: The copy command copies the selected data and their row numbers and column 

heads. 

  

  

To Copy a Cell: 

1. Click on the cell to be copied. 

  

2. From the Action menu, select Copy This Cell. 

 

Alternate Methods: 

 

1. Right-click on the cell to be copied, and select Copy This Cell. 

  

2. Click on the cell to be copied and enter Shift + Ctrl +c. 

  

  

  

Printing 

  

  

The data in Corporate Action Viewer can be printed. 
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Learn about the printing feature here. 
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Crossing Ticket 

Send matching customer and broker orders together straight to the exchange with the 

standalone Crossing Ticket. The Crossing Ticket can be used to send Spread or Outright 

Facilitation, Solicitation, and Customer Match Crossing Orders. Once all the variables of the 

order is in place, the Crossing Ticket displays the order's marketability. 

 

For Crossing Spread Orders, use the Crossing Ticket in Spread Builder. 

 

 

 
Open the Crossing Ticket 

Create a Crossing Spread Order 

Order Eligibility Display 

Configure Crossing Ticket 

Crossing Route Details 

Crossing Tracker 

The Equity Crossing Ticket 

Quotes Dialog Window 

Outright Order Ticket 

 

 

Open the Crossing Ticket 

 

From the WTP toolbar click Trade and select Crossing Ticket. 

 

Alternate Method: 

  

From the WTP menu, select Crossing Ticket. 
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Note: Crossing Ticket can also be launched from the Option Quote Cube. 

 

 

Create a Crossing Spread Order 

 

 

1. Contra Side Types 

 

Contra Side types are opposite those of the Order side (i.e., if the order is a BUY, the Contra 

is a SELL). 

 

2. Crossing Type 

 

Select one crossing type: 

 

 Facilitation (A member or member organization executes a crossing order with an 

order from a public customer). 

  

 Solicitation (An order solicited by a member firm to trade with another order. A 

customer's order is matched with a solicited counter bid or offer). 

  

 Customer Match (An unsolicited crossing type). 

 

3. Facilitation Percentage   

 
The Facilitation % is a minimum guarantee of the percentage a broker will take when 

facilitating a crossing order. 

 

Example: A crossing order is sent with a 40% facilitation. The customer's side gets filled 

100% and the broker gets 40% minimum of the fill. If there are no takers, the broker might 

end up filling more than 40%, but the minimum guarantee remains the same. 

 

Limitations: 

 

 Facilitation % does not apply for customer-to-customer crosses (where the 

guarantee is 100%). 

  

 The maximum facilitation percentage is 40. That is the limit that most exchanges will 

support. 

  

 If the route does not support the feature, Facilitation % will be greyed out. 

 

A 0% facilitation is valid and is indicative of a crossing order where the broker has little 

interest in participation.  

   
4. Account Type 

 

Select an account type from the drop-down list in the Crossing Ticket. Available account 

types are: 

 Broker Dealer 
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 Customer 

  

 Firm 

  

 Market Maker 

 

5. Define Give-up, CMTA  

 

 Give-up—A transaction between three brokers where one broker hands off a trade 

to a second broker, who then buy the stock from a third. The third broker exercises 

the trade, while the first broker gives up the name of the second broker, even 

though the trade is executed between the first and third broker.  

 

Example: Broker A receives a buy order, but is too busy to handle it. Broker B is 

asked to help fill the order and buys the stock from Broker C. The transaction is 

recorded between Brokers B and C. Broker A, in effect, gives up the name of Broker 

B. The trade, however, is executed between Broker A and Broker C. 

 

Select a Give-up value from the drop-down list. 

  

 CMTA (Clearing Member Trade Agreement)—An agreement where an investor 

trades with a number of different brokers, later consolidating the trades through a 

single broker for clearing. 

  

Note: Values for Give-up and CMTA are defined by an administrator. 

   
6. Note Field 

 

Check the Note box to add a free-form note that will accompany the order. 

 

Order Eligibility Display 

 

This Crossing Order Ticket displays the viability of an order in one of three colors (next to 

the Execute button): 

 

 Green—The order is Eligible (Bid < Price < Ask) 

  

 Yellow—The order is Possible (Price = Bid or Price = Ask) 

  

 Red—The order is Ineligible (Price < Bid or Price > Ask) 

 

Configure Crossing Ticket 

 



WTP Applets  Crossing Ticket 

46 © 2014 Wolverine Execution Services, LLC 

 
 

Portfolios—Check each desired portfolio name or select <All Portfolios> that will be 

available on the Crossing Ticket. 

 

Side Types—Select side types (or <All Sides>) from the drop-down list.  

 

Check the box Show Separate Side Btns to see the selected sides: 

 

  

Default Sides                          Show All Sides 

 

Snap Side Types to Defaults on Security Change— The selected Buy and Sell side types 

will be considered default values whenever a new symbol is chosen. 

Check the box to activate this feature. The default side types will be seen when a new 

symbol is selected. 

 

Option Quote Filters—Select/disable one or more Option quote sources by pressing the 

quote source name. 

 

Lock Selection—A checked selection will have its value saved for all new Crossing Orders. 

 

Note: Lock Selections can also be accomplished by pressing the blue lock 

icon next to one of the four fields. 

 

Track Symbol Selection—The security will automatically change to match the security of 

another applet if checked. Learn about Toggle Symbol Tracking here. 
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Note: The feature can be enabled by pressing the Toggle Symbol Tracking 

icon . 

 

Enable Qty/Px Spinners—If checked, the Qty and Px fields in the Crossing Ticket will 

have spinners (up/down arrows) as an alternate method of data input. 

 

Auto Close on Buy/Sell—The Crossing Ticket will close automatically when a buy or sell 

order has been filled if this option is checked. 

 

Crossing Route Details 

 

 
 

A Crossing Route Detail table displays when selecting the <Crossing> route and 

checking the Crossing Route Detail box. The <Crossing> route is based on the Option 

Quote Source Routes defined in Global Configuration. 

 

In the grid, routes may be selectively enabled/disabled by checking/unchecking a selected 

route. By default, all routes are enabled. 

 

When executing a Crossing Order with the <Crossing> route, the Crossing Tracker 

(below) opens. 

 
Crossing Tracker 

 

 
 

When a crossing order is executed via the <Crossing> route, the Crossing Tracker opens. 

An order is automatically sent to one of the enabled routes when the price of the crossing 

order becomes eligible. If the order fails, Crossing Tracker will try to send it to the next 

available route. 
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Crossing Tracker allows for the management of crossing orders. Although Crossing Tracker 

can be column-customized, there are three default columns: 

 

 Stop (allows for the stopping of a crossing order) 

  

 Symbol (as reported in the Crossing Order Ticket) 

  

 Last Error (a specific route's most recently reported error for an order) 

 

By default, Crossing Tracker will close when all orders have finished or all orders have been 

stopped.  

 

If Crossing Tracker is closed, all active crosses will be stopped (a confirmation window will 

appear as a safeguard). 

 

The Equity Crossing Ticket 

 

 
 
The Equity Crossing Ticket has been designed for equity orders. The interface is similar to 

the Crossing Order Ticket except that option-related fields have been removed. 

 

The Equity Crossing Ticket can be changed to the option mode by pressing the "switch to 

option mode" icon . 

 

Quotes Dialog Window 

 

 

A quotes dialog table that displays quotes from selected exchanges can be selected in the 

Crossing Ticket in Options mode. 

 

To launch the quotes window, press the Show Exchange Quotes Dialog button . 
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The quotes table will display quotes from the security selected in the ticket. Current quote 

prices as well as the marketability of the quotes are shown. Quotes in green are 

marketable, quotes in yellow are possible. 

 

By default all exchanges are selected in the quotes window. To disable an exchange from 

reporting in the quotes window, uncheck the box in the Enable column in the row of the 

exchange. 

 

Outright Order Ticket 

 

Select the Outright Order Ticket icon   to switch the Crossing Ticket to the standard 

Order Ticket. 
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Equity Imbalance Viewer 

Large quantities of buy/sell orders for a security can cause an unusually wide spread 

between bids and offers. Exchanges frequently halt the trading of securities with a 

significant order imbalance until more buyers or sellers appear and an orderly market can 

be re-established. Equity Imbalance Viewer displays the securities that are imbalanced at 

the open or close of the current trading day.  

 

 
 
Launch Equity Imbalance 

Viewer 

View Imbalance Data (Open or 

Close) 

Filter Data in Equity 

Imbalance Viewer 

Cancel an Order 

Cancel All Orders 

Columns and Formatting 

Equity Imbalance Viewer Templates 

Send Equity Imbalance Viewer Data 

Copy Security Name(s) 
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View Buy and/or Sell 

Imbalances 

Select Securities to View 

Create an Order from  Equity 

Imbalance Viewer 

Create an Order Without Equity 
Imbalance Viewer Side Types 

Equity Imbalance 

Viewer Configurations 

Select Exchange(s) 

Automatically Refresh 
Data 

Toggle Symbol Tracking 

 

 

 

Launch Equity Imbalance Viewer 

 

From the WTP Toolbar select Analyze-->Equity Imbalance Viewer.  

 

Alternate Method: 

 

From the WTP menu select Equity Imbalance Viewer. 

 

View Imbalance Data (Open or Close) 

 

Equity Imbalance Viewer allows imbalance data to be viewed at the trading day's opening or 

closing. 

 

From the drop-down menu at the top of the Equity Imbalance Viewer select either Open or 

Close.  

 

The availability of Opening and Closing data varies depending on the exchange.  

 

View Buy and/or Sell Imbalances 

 

Equity Imbalance Viewer can display buy and/or sell imbalances. 

 

From the drop-down menu at the top right portion of Equity Imbalance Viewer select check 

the Buy or Sell box or both. 

 

Select Securities to View 

 

Equity Imbalance Viewer can set to report one, many, or all securities from selected 

exchanges. 

 

Type one or more security names in the security-name field (upper left of Equity Imbalance 

Viewer). Separate security names with a semi-colon. 

 

Select All Securities 

 

From the drop-down menu in the security-name field check the box <All>. 

 

Create an Order from Equity Imbalance Viewer 

 

An order can be created directly from Equity Imbalance Viewer by double-clicking on a row 

with the preferred security. Once selected, an order ticket will open. If there is a buy 
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imbalance on the selected row, the order ticket will default to a sell side type (and a buy 

side type with a sell imbalance). 

 

The price in the order ticket will be set to the Price Near value for the selected security in 

Equity Imbalance Viewer. 

 

Create an Order Without Equity Imbalance Viewer Side Types 

 

In addition to creating an order within Equity Imbalance Viewer, an order can be created 

without Equity Imbalance Viewer's default side types. 

 

1. Highlight a row containing the desired security name by clicking on it once. 

  

2. Type Ctrl+n. 

 

The Order Ticket will open but will the side type will not be the reverse of the imbalance, 

nor will the price be the Price Near value. 

 

Alternate Methods: 

 

Follow step 1, then go to the Action menu and select New Order. 

 

Follow step 1, then right-click in the Equity Imbalance Viewer grid and select New Order. 

 

Filter Data in Equity Imbalance Viewer 

 

The data displayed in Equity Imbalance Viewer can be filtered by the following: 

 

 Paired Shares 

 Unpaired Shares 

 Price Near 

 Price Far 

 Reference Price 

 

Press the filter icon   to open the Filters window. 

 

Learn how to configure and enable this window (similar to setting row color conditions) 

here. 

 

Cancel an Order 

 

To cancel a single order for a selected security, highlight the row containing the security and 

type Ctrl+z. 

 

Alternate Method: 

 

Highlight the row containing the security. From the Action menu select Cancel All For 

Symbol: (symbol name). 

 

Cancel All Orders 

 

All orders regardless of security can be canceled in Equity Imbalance Viewer. 
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Equity Imbalance Viewer Configurations 

 

 
 

Select the exchange(s) that will be used in reporting Equity Imbalance Viewer data and 

configure the columns through the configuration feature. 

 

To open the configure window press the Configure icon . 

 

Alternate Methods: 

 

From the Config menu select Configuration. 

 

Right-click in the Equity Imbalance Viewer grid and select Configuration. 

 

Select Exchange(s) 

 

In the Equity Imbalance Viewer tab of the Configuration window, check the box next to each 

exchange to be used for reporting imbalance data. 

 

Select <All Exchanges> to receive data from all listed exchanges. 

 

Automatically Refresh Data 

 

The default time in which Equity Imbalance Viewer refreshes data is every 3 seconds. 

 

This interval can be changed to as low as 1 second or as large as desired. Enter a value in 

the Automatically Refresh Data field that reflects the interval (in seconds) in which 

Equity Imbalance Viewer refreshes data. 

 

Columns and Formatting 
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In the Columns and Formatting tab of the Configuration window, grid customization is 

defined. 

 

Learn about columns and formatting here.  

 

Equity Imbalance Viewer Templates 

 

Customized settings can be captured in a template. A saved template can be defined as 

default and will be subsequently loaded whenever Equity Imbalance Viewer is launched. 

Saved (i.e., not default) templates can be called anytime when working in Equity Imbalance 

Viewer. 

 

Learn about templates here. 

 

Send Equity Imbalance Viewer Data 

 

A row or multiple rows of Equity Imbalance Viewer data can be sent to the following WTP 

applets: 

 

 Order Grid 

  

 Equity Time and Sales 

  

 Option Time and Sales 

  

 Spread Book 

  

 Spread Builder 

  

 Position Grid 

  

 Managed Orders 

  

 WTP Browser 

 

Highlight one or more rows in Equity Imbalance Viewer. From the Action menu select Send 

to --> (name of applet) 

 

Alternate Method: 

 

Right-click in the Equity Imbalance Viewer grid and select Send to --> (name of applet) 

 

Copy Security Name(s) 

 

One or more security names can be copied from Equity Imbalance Viewer and pasted into 

another program (i.e., Excel, Word, etc.) 

 

Highlight one or more rows and click the Copy icon . 

 

Toggle Symbol Tracking 
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Security names can be inserted automatically into Equity Imbalance Viewer via the Toggle 

Symbol Tracking feature . 

 

Learn about Toggle Symbol Tracking here. 
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Equity Quote Cube 

With the Equity Quote Cube you can view Level I and II data and time-of-sales data for 

equities and futures. You can also: 

 

 Display book depth across multiple color-coded exchanges 

  

 Issue and cancel orders directly 

  

 Selectively hide/show quotes for a particular exchange 

  

 Immediately display Bid/Ask, Volume, Low/High, and VWAP 

  

 View quotes consolidated by price or average liquidity 

  

 View real-time and historical ticks across multiple exchanges  

  

 View your orders interleaved with book depth data 

  

 Configure grid colors and fonts 

  

 Place and cancel orders directly from the grid or from an attached order ticket 
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Launch Equity Quote Cube 

 
The Configuration Window 

 
The Equity Quote Cube Display Grid Colors 

 
Toggle Symbol Tracking Configure the Order Ticket 

 
Quote Detail 

 
Order Ticket in Advanced Mode 

 
Bid and Ask Orders from the Quote Detail 

 
Ticker 
 

Configure the Equity Quote Cube 

 
 

 

 

Launch Equity Quote Cube 

 

From the WTP toolbar select Analyze-->Equity Quote Cube. 

 

Alternate Method: 

 

From the WTP menu, select Equity Quote Cube. 

 

 

The Equity Quote Cube Display 

 

The Equity Quote Cube is divided into quadrants, each of which can customized: 

 

 Security Detail (left, top, can be turned on or off) 

  

 Book Data Grids (center, can be configured) 

  

 Order Ticket (left, bottom, can be turned on or off) 

  

 Ticker (right, can be turned on or off and configured) 

 

Toggle Symbol Tracking 

 

Learn all about Toggle Symbol Tracking here. 

 

 

Quote Detail 

 

The Quote Detail portion of the Equity Quote Cube displays: 

 

 Bid/Ask/Last prices along with the most recent trade, the exchange, and time of 

execution 

  

 Change (price and percentage) 

  

 VWAP (Volume-Weighted Average Price) 

  

 Low/High prices (for the current trading day) 
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 Trade volume (number of shares) 

  

 Open price (start-of-the-day price) 

  

 PCls  (price at closing) 

 

View Quote Detail 

 

To view quote details in the Equity Quote Cube: 

 

Press the Show/Hide Security Detail icon  to show the quote details 

 

Alternate Methods: 

 

 Right-click anywhere in the Equity Quote Cube and select Show Security Detail. 

  

 From the Config menu select Show Security Detail. 

 

Either method toggles the display to show or hide the security details. 

 

 

Bid and Ask Orders from the Quote Detail 

 

Enter an order by clicking on Bid or Ask. The Order Ticket will display with the Bid/Ask 

value filled in. 

 

 

Configure the Equity Quote Cube 

 

Columns, rows, and other data displayed in the Equity Quote Cube can be configured. 

 

 

The Configuration Window 

 

To launch the configuration window: 

 

Select the configuration icon . 

 

Alternate Methods: 

 

 Click the right mouse button in the Equity Quote Cube and select Configuration. 

  

 From the Config menu select Configuration. 

 

 

The Configure Equity Quote Cube Tab 
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Quote Display Mode 

 

Select Show Detailed Quotes to view detailed data about a security (including, but not 

limited to, number of bids, market maker identity, ask/bid values, number of bids/asks). 

 

Select Show Consolidated Quotes to view quotes that are: 

 

 Price Consolidation—All matching prices are grouped together in one entry 

where the #Bids or #Asks columns list the quantity of Bids or Asks. 

 

OR 

  

 Average Liquidity—The available quantity at a given price. 

 

Either Show Detailed Quotes or Show Consolidated Quotes must be selected. Both 

may be selected, but the Show Consolidated Quotes option may only have one type of 

consolidated quote. 

 

Alternate Method: 

You can also choose the quote mode by selecting the Select Grid Mode  icon and 

making your choice from the list of quote modes. 
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Track Selected Symbol 

 

Checking the Track Selected Symbol box causes the symbol in the Equity Quote Cube to be 

tracked in other WTP applets. See Toggle Symbol Tracking for more information. 

 

Show Security Detail 

 

When this box is checked, the security detail will appear in the upper left portion of the 

Equity Quote Cube. 

 

Note: The Show Security Detail option can also be accessed from the Workspace toolbar in 

pinned mode (Equity Quote Cube-->Config-->Show Security Detail) or by clicking the 

Show/Hide Security Detail icon , or by right-clicking in the Equity Quote Cube 

window and selecting Show Security Detail. 

 

Show Live Orders 

 

Selecting this option will display your live orders initiated from the Equity Quote Cube and 

orders sent to the Equity Quote Cube from other WTP applets (for example Order Ticket or 

Basket Trader via the send to--> command).  

 

If Show Live Orders is checked you may also choose the manner in which live orders are 

displayed: 

 

 Show Live Orders at the Top Always places live orders at the top of the book 

data grid, regardless of their bid price. 

  

 Show At Top Of Price will display the live order at the very top of a price 

grouping. 

 

 

Enable Automatic Tab Adding 

  

Equity Quote Cube can add new tabs as they're being typed. Learn more about this feature 

here. 

 

 

Security Mapping 

 

With Security Mappings, one or more securities are defined and placed in the Security In 

column. For each security, a Security Out is defined. When sending a Security In security 

from a WTP applet, the Equity Quote Cube will respond by displaying the Security Out 

security. 

 

In the image above, security AA is mapped to security DELL. If Toggle Symbol Tracking 

is enabled, the Equity Quote Cube will display the DELL security whenever the Option Quote 

Cube selects the AA security.  

 

Note 1: When mapping, a Security Out security may be used multiple times but a 

Security In security may be used only once. 
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Note 2: If toggle symbol tracking is disabled, the Equity Quote Cube will also respond to 

the mapping if the Security In symbol is sent to it via an applet's send to--> command. 

 

Note 3: WTP's Connections feature works with similar functionality. 

 

 

Columns and Formatting 

 

 
 

 

The displayed columns and their attributes are configured on this screen. 

 

Mirrored Layout 

 

Mirrored Layout refers to displaying the same columns in both the ASK and BID grids 

(i.e., one grid mirrors the other so that the first column in the BID grid will be reflected as 

the last column in the ASK).  

 

For example, a column is added/deleted to/from the BID grid. Go into Configure Equity 

Quote Cube, check Mirrored Layout and save. The same column is automatically 

added/deleted to/from the ASK grid. 

 

If a new column is added to the either grid and the new column is not reflected in the other 

grid it is because Mirrored Layout is unchecked. 
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Available Columns 

 

See Field Chooser for information on how to search for, and add, columns to grids. 

 

 

Grid Defaults, Row Color Conditions, Column Header Style 

 

Information on setting grid defaults, row color conditions, and column headers can be found 

here. 

 

 

Tabs in Equity Quote Cube 

  

Tabs can be customized and arranged in alphabetical order. 

  

Learn more about tabs here. 

 

 

 

Grid Colors 

 

 
 

 

A color scheme can be defined to group quotes by price or market maker. Additional 

colors can be configured to identify local orders as well as markets that are either locked or 

crossed. 

 

Set Price Group Colors 
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A price group is a collection of quotes that have the same price. 

 

Edit a group color 

 

1. Double click on a row or click once on a row and press the Edit Color button.  

  

2. Select a color (or define a custom color) and click OK.  

 

Insert a Row 

 

1. Click on any existing color in the Price Group. 

  

2. Press Insert Row. A new row will be placed above the row that was selected. 

  

Delete a Row 

  

When a row is deleted, the color is deleted with it. For example: 

 

Price Group Color #1 is green and Price Group Color #2 is yellow. If Price Group Color #1 is 

deleted, Price Group Color #2 will move into the first position but will remain yellow. 

 

To delete a row: 

 

1. Click on a row to be deleted. 

  

2. Pres Delete Row. 

 

Set Market Maker Colors 

 

Configuring a Market Maker color will result in any quote from that Market Maker being 

displayed in the chosen color. A separate color can be assigned to each Market Maker. 

 

To define Market Maker Colors: 

 

1. Click Add Row. A Market Maker ID window will display. 

  

2. Enter the Market Maker ID in the empty field. Click OK. 

  

3. Select a color swatch or define a custom color. Click OK. 

  

4. Repeat to define the colors for other Market Makers. 

 

Editing colors, adding and deleting rows, are handled in the same manner as the Price 

Group Colors. 

 

 

Moving an Existing Color to a Different Price Group 

 

An existing Price Group color can be moved to a different Price Group. For example: 

 

Price Group Color #2 is yellow, but it is desired to have Price Group #6 in yellow. Using the 

down arrow, the yellow color is moved into Price Group #6. Price Group #2 will take the 

color that was previously defined in Price Group #3. 
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To assign an existing color to a different price group: 

 

1. Click on a row that will have its color assigned to a different price group. 

  

2. Click on the UP or DOWN arrows until the color is placed in the desired Price Group. 

 

Result: The desired Price Group will take on the new color while the row selected in 

Step #1 will take the color from the next adjacent row. 

 

Repeat Colors 

 

If there are more Price Groups or Market Makers than there are configured colors, the colors 

will be repeated. 

 

For example, if 5 Price Groups are defined, but there are 7 displayed in the Equity Quote 

Cube, the grid will color Price Group 6 the color of Price Group 1. Price Group 7 will be 

colored the same as Price Group 2, etc. 

 

 

Set Colors for Live Orders, Locked Markets, and Crossed Markets 

 

Press the Edit Color button on each to define its respective color. 

 

Note: Locked and Crossed Market colors have precedence over the Price Group or Market 

Maker colors. 

 

 

Default Colors 

 

Press Reset to Defaults to reset all colors to their original default values. 

 

 

Display Exchange Quotes 

 

 
 Dynamic Quotes window displays the exchanges on which a selected symbol trades. 

  

  

Equity Quote Cube provides the names of all exchanges on which a selected symbol 

trades.*  
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To view the exchanges on which a selected symbol trades: 

 Select the Select Quote/Book Sources button  

 

Alternate Methods: 

 

 From the Config menu, select Filter Quotes... 

 

 Right-click in the EQC grid and select Filter Quotes... 

  

*The displayed exchanges are those in which the user has market data permissions. These 

are not necessarily inclusive of all exchanges on which the symbol trades. 

 

 

 

Order Ticket General 

 

 
  

  

An Order Ticket can be attached to the Equity Quote Cube. 

  

From the Order Ticket tab in the configuration window, check Show Attached Order 

Ticket. 

 

Alternate Methods: 

 

 From the Equity Quote Cube window, right-click and select Show Order Ticket. 
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 From the Config menu select Show Order Ticket. 

  

 Select the Show/Hide Order Ticket icon . 

 

 

Order Ticket in Advanced Mode 

 

Additional order options such as start/stop times, % volatility, IOC routes, and Stop Limit 

and Stop Market orders are available in the ticket's advanced mode. 

 

Detailed advanced mode information is available here. 

 

 

 

  

Position Display Mode 

  

The position field in the Equity Quote Cube order ticket can be configured to display one of 

five positions: 

 

1. Global Default (Acct) 

  

2. Firm Position 

  

3. Account Position 

  

4. Portfolio Position 

  

5. Day Position Only 

 

The Account Position reports position adjustments, while Portfolio and Day Position Only do 

not. 

  

If the position is unknown or unobtainable, "unknown" will be displayed in the position 

fields. 

  

The Global Default (Port) position references the Default Position Mode that was 

selected in Global Configuration. 

  

  

  

Tracking 

  

The Order Ticket can be configured to track (i.e., match) a value in the Equity Quote Cube 

and automatically place that value in the Order Ticket. 

  

Tracking Options: 

  

Track Price—The ticket will use the price of the currently selected quote. 
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Track Quantity—When a security is clicked in the Equity Quote Cube, the order quantity 

will be placed in the QTY field of the Order Ticket. Select one of two options for quantity 

tracking: 

1. Sweep—The ticket will use the sum of the quantities for all quotes above and 

including the selected quote. This is useful when taking the market to 

"sweep" up the top of the book. 

  

2. Single Quote—The ticket will use the quantity of the selected quote. 

Track Side—If selected, when a quote is clicked in the ASK grid, the Order ticket will track 

its side to BUY. When clicked in the BID grid, it will track its side to SSH. 

  

Join Market—Causes the ticket to select the BUY side for a Bid and the SELL side for an 

Ask. 

  

Track Route by Exch/MM—If checked, the Order Ticket will select a route based on the 

Exchange or Market Maker of the selected quote and the Equity Quote Source mapping in 

Global Configuration. 

  

All other instructions for configuring the Order Ticket can be found here. 

  

Note: Order Tickets launched from the Equity Quote Cube (via the send to-->Order 

Ticket command) also obey the tracking configuration. 

  

  

Side Types 

  

 
  

Show Separate Side Btns—Check this box to display all the selected side types from the 

drop-down list (BYO, BYA, SLO, SLA, etc.) on the Order Ticket. If unchecked, only the Buy 

and SEL buttons (or SSH depending on your configuration) will display. 

  

Show Sides—To display any or all of the available Side Types, choose the Side Type(s) to 

display from the drop-down list. Select <All Sides> box to show all Side Types on the 

Order Ticket. 

  

The Order Ticket in Equity Quote Cube supports the following Side Types: 

 BUY 

 BYC (Buy to close) 

 BYA (Auto buy) 

 SEL (Sell long) 

 SLA (Auto sell) 



WTP Applets  Equity Quote Cube 

68 © 2014 Wolverine Execution Services, LLC 

 SSH (Sell short) 

 SSE (Sell Short Exempt) 

  

Notes on Side Types 

  

BYC—Generally used for options, but can be used for stocks on a per-route basis. Not 

allowed for futures. 

  

BYA—The order will be a BUY if it results in a positive position. The order will be a BYC if it 

results in a zero or negative position. 

      
Note: BYA is enabled for equities only and can only be used if the selected route 

supports equity BYC. 

  

SLA—Equities only, not allowed for futures The auto sell side type automatically chooses 

between SEL and SSH based on the current position. 

  

SSH—Equities only, not allowed for futures. 

  

SSE—A short sale in which the uptick rule doesn't apply to the trade, i.e., the trade can go 

through on a down tick as opposed to a standard short sale in which the order has to be 

done on an uptick. 

  

  

  

Snap Side Types to Defaults On Security Change 

  

When you change a Symbol in the Order Ticket, default sides types will be displayed in the 

Order Ticket if you check this box. Buy Side Types are BUY and BYC. Sell Side Types are 

SEL, SLA, SSH, SSE. 

  

  

  

Controls 

  

Show Qty/Px Spinners—Spinners are the up/down arrows adjacent to the Qty and Px 

fields and are used to adjust the quantity and price without the need to manually key in a 

value: 

 

 
  

Price field with Spinners enabled 

  

  

Show Quick Qty Btns—When selected, buttons reflecting values to be added to the Qty 

field are displayed in the Order Ticket. The values are: 

 

 +100 

 +500 

 +1K 

 +2.5K 

 +5K 
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 +10K 

 

Each button can be combined with other buttons for a desired total (i.e., +100 button  + 

 +500 button = Qty of 600). 

  

 

 

 

Select the Clear Qty button to set the Qty value to zero.   

 
  

Quick Qty Btns 

   

Show Quick Buy/Sell Btns—Check this box to display six quick buy/sell buttons in these 

amounts: 

 SEL 1K 

 SEL 500 

 SEL 100 

 BUY 100 

 BUY 500 

 BUY 1K 

The selected side types are reflected in the quick buy/sell buttons (for example, if the side 

type is SSH, the quick sell buttons will be SSH 1K, SSH 500, and SSH 100) 

  

 
  

Quick Buy/Sell Btns 

  

  

  

Use Separate Buy/Sell Btns 

  

When checked, the default ticket layout of one Buy button, one Sell button, and a third 

button that reflects buy/sell and price will be replaced by two buttons each reflecting the 

price. If applicable (based on routes and permissions), each button allows for the selection 

of a different side type. 

  

 
  

Separate buy/sell buttons showing quantity and price. Side types can be selected from each 

button. 
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Show Cancel Button—The Cancel button allows you to cancel all live orders for the 

security selected in the Equity Quote Cube. Check the Show Cancel Button to display it. 

  

 
  

Cancel all live orders for a security with the Cancel button. 

  

  

Lock Selections 

  

Lock override default settings in the Global Configuration. 

  

Global settings such as routes, portfolios, price types, etc. can be associated with certain 

symbols or security types. When a symbol is entered, the global settings are called in 

automatically. If the defaults are to be overridden (for example QTY is changed to 500 from 

the default of 100), and Lock Selection is enabled, each symbol that's entered in the Order 

Ticket will have a QTY value of 500. 

  

As an alternative to the configuration window, the lock icon  on the Order Ticket can be 

employed to lock selected fields.   

   

Order Ticket - Portfolios 

  



WTP Applets  Equity Quote Cube 

71 © 2014 Wolverine Execution Services, LLC 

 
  

The Portfolio Firms and their respective portfolios that are available for selection in the 

Port field of the Equity Quote Cube Order Ticket are listed here. 

  

In the top portion of this window check the Portfolio Firms that are to have their portfolios 

listed. Check <All Firms> to select all Portfolio Firms. 

  

The portfolios for each Portfolio Firm will be displayed in the bottom portion of the window. 

Check the portfolios that will be available for selection or <All Portfolios> to select them 

all. 

  

Alternate Method for Selecting Portfolio Firms 

  

In the drop-down menu in the Port field, you can also select the Portfolio Firms: 
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Ticker 

 

 
 

The ticker displays historical and real-time prints for a chosen security. Displaying the ticker 

is optional. The columns displayed in the ticker along with the styles (font/color) can be 

customized. 

 

Show/Hide Ticker 

  

Select the Show/Hide Ticker icon   to view the ticker. 

 

Alternate Methods: 

 

 With the right mouse button, click on the Equity Quote Cube and choose Show 

Ticker. 

  

 From the Config menu, select Show Ticker. 

  

 From the configuration screen check under "Ticker" check the Show Ticker box. 

 

The "Show Ticker" is a toggle command. Any of the methods above can be selected to hide 

the ticker. 

 

 

Limit to _ _ _ ticks 

 

The value in the Limit to _ _ _ ticks field refers to the number of visible ticks in the ticker. 
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Allow Historical Ticks 

 

When checked, Allow Historical Ticks gets previous ticks from the day. If unchecked, the 

ticker will show only those ticks from the time the ticker was enabled.  
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Equity Time and Sales 

 

With Equity Time and Sales you can view tick-by-tick details for securities over a defined 

time period. One or more symbols, along with a time span for reporting, are entered. Equity 

Time and Sales will retrieve all sales for the symbols that fall within the defined time period. 

Additionally, any number of filters can be applied to the reporting of sales data. If filters are 

employed, Equity Time and Sales table will report sales data when a filtered condition is 

met. Optionally, a notification can be sent when a symbol matches the filtered parameters. 

 

 

Launch Equity Time and 

Sales 

Basic Operation (without 

filters) 

Set Reporting Times 

Configuration 

Quick Trades 

New Orders 

Toggle Symbol Tracking 

Chart 

Templates 

Export Grid Data 

 

   
 

Launch Equity Time and Sales 
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From the WTP toolbar select Analyze -->Equity Time and Sales. 

 

Alternate Method: 

 

From the WTP menu select Equity Time and Sales. 

 

 

Basic Operation (without filters) 

 

One or more symbols can have their sales data reported in Equity Time and Sales. 

 

Entering symbols: 

 

1. Type the symbol name in the Symbols field. Separate symbol names with the semi-

colon or comma. 

 

Alternate Method: 

 

Select one or more symbols from the drop-down list. Check each box next to the 

symbol name that is to be reported. 

  

2. Press the start button  to begin the retrieval of sales data. Press the stop button 

  to stop receiving sales data. 

 

 

Set Reporting Times 

 

Equity Time and Sales can be configured to report real-time ticks in one of three defined 

time periods: 

 

 Today (all ticks from midnight of the current day) 

 Yesterday (all ticks up until midnight of the previous day) 

 

 Custom (tick data retrieved between the two defined time/date settings). When 

selected, the Time Span window launches: 

 

 
 

Enter the start/stop times (or use the up/down spinner arrows), and select a date 

from the drop-down list. 

 

  

 

Filters 
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With the filter option enabled, Equity Time and Sales displays data that matches defined 

conditions. For example, if it is preferable to view only data from a specific exchange, a 

filter can be defined accordingly. When a filter is in force, the filter will be displayed in the 

Equity Time and Sales window. 

 

Setting Filters 

Press the Set Filter button . The Filters screen opens: 

 

 
 

Similar to Set Row Color Conditions the securities are defined, with its expression and 

condition. In the example above, all securities exclusively from the CBOE are to be 

displayed. Also the security K is to be displayed when its target value is greater than 

$12.00. 

 

Check the Enable box on each row to have the filter act on that row. 

 

Press OK or Apply to have the filter(s) enabled. To exit without saving, press Cancel. 

 

Delete a Filter 

 

Press the DEL button on each row to delete that row's filter. 

 

 

Configuration 

 

The columns available for display in Equity Time and Sales are defined on the configuration 

screens. Also, optional symbol tracking and notifications can be selected. 

 

Access the Configuration Screens 

 

Click the right mouse button on the Equity Time and Sales window and select 

Configuration 

 

Alternate Method: 
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From the Config menu select Configuration 

 

Time and Sales Grid 

 

See Columns and Formatting for instructions on defining columns, their fonts, sizes, and 

row color conditions. 

 

 

Miscellaneous 

 

The Miscellaneous tab has two options: 

 

 Track Symbol (see Toggle Symbol Tracking for description of the feature) 

  

 Send notification when ticks match filter (sends an audible notification based on 

the value set in the Global Configuration window)  

 

Check the box on the desired option and press OK. 

 

 

Quick Trades 

 

A quick trade can be issued directly from Equity Time and Sales. The quick trade feature is a 

Last-type, BUY order for 100 shares of a selected security. 

 

Issue a Quick Trade 

 

There are two methods for issuing a quick trade: 

 

 Click on a symbol name in Equity Time and Sales and press CTRL +b 

  

 Click on a symbol name in Equity Time and Sales. With the right mouse button select 

Quick Trades and click the mouse over the quick trade info. 

 

A Send-Order confirmation window will display. Press OK to initiate a quick trade. 

 

 

New Orders 

 

A new order can be issued from Equity Time and Sales. When selected, the Order Ticket 

displays. 

 

Issue a New Order 

 

There are 3 ways to issue a new order: 

 

 Press Ctrl +n 

  

 Click the right mouse button in Equity Time and Sales and select New Order 

  

 From the WTP toolbar select Time and Sales-->Action-->New Order 
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Cancel an Order 

 

Orders that have not filled can be selectively canceled (for a specific symbol) or globally 

canceled (all open orders). 

 

Selectively Cancel an Order 

 

1. Click the left or right mouse button in Equity Time and Sales on the row containing 

the symbol that is to be canceled. 

  

2. Press Ctrl +z 

 

Alternate Methods: 

 

Click the right mouse button and select Cancel All For Symbol _ _ _ 

 

From the WTP toolbar, select Time and Sales-->Action-->Cancel All For Symbol 

_ _ _ 

 

Cancel All Orders 

 

Click on Equity Time and Sales with the right mouse button. Select Cancel All Orders 

 

Alternate Method: 

 

From the WTP toolbar, select Time and Sales-->Action-->Cancel All Orders 

 

 

Toggle Symbol Tracking 

 

Equity Time and Sales can track a symbol that's been called in another WTP applet. 

 

Enable Toggle Symbol Tracking 

 

With right mouse button click on Equity Time and Sales. Click on Toggle Symbol 

Tracking. 

 

Alternate Method: 

 

Click on Time and Sales from the WTP toolbar and select Config-->Toggle Symbol 

Tracking. 

 

To learn more about the Toggle Symbol Tracking feature click here.  

 

 

Chart 
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A chart quoting the price of a selected security can be displayed. Press the chart icon (next 

to the Getting RealTime Ticks field) to view the chart. 

 

To zoom into the chart press the + key. Move the mouse into the chart area. Each click of 

the mouse will zoom in closer to a specific point in time. Press the — — key to zoom 

outward (per each click) from the current display. 

 

View Options Products 

View tick-by-tick details for all Option products by clicking the Option Mode icon . This 

will change Equity Time and Sales to Option Time and Sales. 

 

 

Templates 

 

The settings on Equity Time and Sales can be saved as a template. For example, if Equity 

Time and Sales has been configured with multiple symbols and filters, these settings could 

be saved. Next time the applet is called, the saved template can be accessed with all the 

configuration settings in place. 

 

Learn more about saving and calling templates here. 

 

Export Grid Data 

 

The data in Equity Time and Sales can be exported to a file, the clipboard, or to Microsoft 

Excel. 

 

Learn how to export grid data here
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Historical Trades Browser 

 
  

Log in screen to the WEX Client Portal 

  

  

The Historical Trades Browser allows access to the WEX Client Portal wherein users with 

appropriate permission can: 

 

 Access WTP-related programs (WTP, WTP Help, Real-time-data, VPN/Cisco 

connectivity) 

 Read WEX Specifications (WOTI & FIX) 

 Access Sentry, the Administration Tool for WTP 

 Retrieve Orders, Executions, and Slippage Reports 

 Add New Accounts 

  

Launch the Historical Trades Browser 

 

From the WTP menu, select Historical Trades Browser 

  

Alternate Method: 

  

From the WTP toolbar, select Explore--> Historical Trades Browser 
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The Welcome Page 

  

 
  

Welcome page for the WEX Client Portal 

  

  

  

Once logged in to the WEX Client Portal, the Welcome page appears. Navigate throughout 

the portal using the top-level menus on the page: 

  

 Access 

 Reports 

 Forms 

 Accounts 

  

In addition, links for learning about Algorithms, the WEX Agency Desk, Floor Access and the 

WEX Trading Platform (WTP) are available on the welcome page. 

  

  

  

Print  

  

Any screen in the Historical Trades Browser can be printed. 

  

Learn the basics of printing here. 
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Instant Messenger 

Instant Messenger allows a user to communicate with other WTP users either privately or 

with a group in a chat (similar to an internet chat room). 

 

 
 

 
Launch Instant Messenger 

Channels 

Chats and the Chat Manager 

Compose and Send an Instant Message 

One-Click Words 

Configure Instant Messenger 

Search Feature 

Templates 

Status Bar 

   

 

Launch Instant Messenger 

 

From the WTP toolbar select Explore-->Instant Messenger. 

 

Alternate Methods: 

 

 From the WTP menu, select Instant Messenger. 

  

 Double-click on New Instant Messages on the WTP toolbar. 

 

Note: This method is useful as Instant Messenger will automatically go to the most 

recent channel that sent a message (see below for Channel descriptions). Also, if 

there are a series of unread messages, each double-click in the WTP toolbar jumps 

to the next unread message. 

 

Channels 

 

A channel can refer to a user or a chat and are divided between: 

 

 Favorites folders 

  

 Chat folders 
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 Firm Folders 

 

Favorites folders are user created. Chat and Firm folders cannot be created or deleted. 

 

Favorites Folders 

 

With Favorites Folders you can: 

 

 Add user channels and chat channels to the same Favorites Folder 

  

 Create/Rename/Delete a Favorites Folder 

  

 Delete nodes from Favorites Folder 

  

 Nest other Favorites Folders 

 

Create a Favorites Folder 

 

Click on the Favorites icon in the Instant Messenger window . Enter the name of the 

folder in the text field. 

 

Alternate Methods: 

 

 From the Action menu select New Favorites Folder 

  

 Right-click in the Channels section of the Instant Messenger window and select 

New Favorites Folder 

 

Chats and the Chat Manager 

 

 
 

A chat is a collection of users that have subscribed to a particular chat group. Messages are 

created only in a user's subscribed chats. 

 

The chat manager is used to create/rename/delete chats as well as subscribe/unsubscribe 

to existing chats. 

 

Launch Chat Manager 
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Click on the Launch Chat Manager icon  

 

Alternate Methods: 

 

 From the Action menu select Add/Remove Chats. 

  

 Right-click in the Channels section of the Instant Messenger window and select 

Add/Remove Chats. 

  

 Open the Chat folder and click Add/Remove... 

 

Subscribe or Unsubscribe to Available Chats 

 

From the Chat Manager window under Available Chats select the chat(s) to subscribe and 

click Subscribe >> 

 

To unsubscribe from a chat that is listed in Subscribed Chats select the chat(s) to 

unsubscribe and click << Unsubscribe 

 

Once a chat has been subscribed to, it will be listed in the Chats folder. 

 

Note: Subscribe or Unsubscribe chats and Join or Leave chats accomplish the same thing. 

 

Create/Rename/Delete a Chat 

 

To create a chat, press the New button in the Chat Manager. The Chat Room Details 

window will open: 

 

 
 

From the drop-down list select the Firm to which the chat will be created.  

 

Enter a name and optional description and click Create. 

 

Note: The selection Private Chat Room is not enabled at this time. 

 

Once a chat has been created, it will be listed in the Chat Manager window. This newly 

created chat can now be subscribed to.  

 

Copy a Subscribed Chat to a Favorites Folder 

 

To copy a chat to your Favorites folder, double-click on its name. 
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Alternate Method: 

 

Click on the chat and move it into the Favorites folder. 

 

Remove a Subscribed Chat From a Favorites Folder 

 

Select the chat and press <delete>. 

 

Alternate Method: 

 

Select the chat. Right-click and select Remove from Favorites. 

 

Join or Leave Chats 

 

You may choose to leave a chat without deleting it. A chat that has been left can be 

rejoined. 

 

Leave a Chat 

 

Select a chat to leave. Right-click and select Leave Chat. The chat's icon will be greyed out. 

 

Join a Chat 

 

Select a grayed out chat. Right-click and select Join Chat. 

 

Compose and Send an Instant Message 

 

1. If a channel has not been chosen, select a channel by clicking on it. Members of the 

group will be listed in the Members section of the Instant Messenger window. 

  

2. Type your message in the Message Input Window. 

 

If desired, use the undo/redo buttons to delete/display one character at a time 

. 

  

3. Press <enter> to send your message which will be displayed in the Message 

Display Window. 

 

Alternate Method: 

 

Press the Send button. 

 

Note: To add space between lines when writing an instant message, hold down the shift 

key while pressing <enter>. 

 

 

One-Click Words 

 

The use of one-click words saves the routine typing of regularly used words, numerals, or 

phrases. The available words/phrases are user definable. When selecting a one-click 

word/phrase, the word/phrase is placed in the Message Input Window. 
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There are five word lists and two Request Prompt lists (used primarily for phrases, though 

a single word can be placed in this list).  

 

The most recently selected word will be seen on the button. 

 

Create One-Click Words 

 

1. Press the up arrow next to any displayed word/phrase. 

  

2. Select <Edit...>. An edit window will display. 

  

3. Enter a word/phrase. 

  

4. Press the Add button. 

 

Alternate Method: 

 

Press <enter>. 

  

5. Press the OK button. 

 

Note: Creating words/phrases does not take effect until the OK button is pressed. 

 

Remove One-Click Words 

 

1. Follow steps 1 and 2 above. 

  

2. Click on the word/phrase to be deleted. 

  

3. Press the Remove button. 

 

Alternate Method: 

 

Press <delete> on your keyboard. 

  

4. Press the OK button. 

 

Note: Removing words/phrases does not take effect until the OK button is pressed. 

 

Change the Word List Order 

 

The list of words/phrases in a word list can be adjusted.  

 

To move a word/phrase up or down in the list in which it appears, select it, then press one 

of four available arrows (top of the list, up one line at a time, bottom of the list, down one 

line at a time).  

 

Display/Hide One-Click Words  

 

Press the Hide Insert Options button to display/hide one-click words .  

 

Configure Instant Messenger 

 



WTP Applets  Instant Messenger 

87 © 2014 Wolverine Execution Services, LLC 

Press the configure icon to open the Configure Instant Messenger window . 

 

Alternate Method: 

 

From the Config menu select Configuration. 

 

 
 

Check the configuration options below to customize the Instant Messenger session: 

 

Flash Window for New Private Messages—The Instant Messenger window will flash 

when receiving a new private message from another user. 

 

Flash Window for New Chat Messages—The window flashes when a new chat message 

is received. 

 

Confirm When Sending to Multiple Recipients—A confirmation message is displayed 

when a message is about to be sent to more than one recipient. 

 

Display Chat Room Membership Notifications—A message is displayed whenever a new 

member enters a chat or when a member exits a chat. 

 

Display Message History—Display a message history between all members of a chosen 

chat. The standard time period of retaining an active history is 7 days.  

 

Display Timestamps—The timestamp of each sent message is displayed in military time 

[xx:xx:xx]. 

 

Display Offline Channels—Online as well as offline channels will be displayed. If 

unchecked, only online chats are displayed. 

 

Global Notifications 

 

Press this button to open the Global Configuration window on the Notifications tab. In this 

window a sound can be selected (IM Received (User)). When a private Instant Message is 

received, the defined sound will play. Other notifications can be set for: 

 

 IM Received (Chat) 

  

 IM Received (News) 
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 IM Received (Idle User) 

 

Note for Idle Waiting User Notification: Once the event has been created, a 

notification will be sent to the recipient of an Instant Message if the recipient has not 

responded to the message after a defined time period. The notification will repeat 

until the recipient responds. 

 

Other Global Settings for Instant Messenger 

 

Under the General tab of Global Configuration are three auto-open options for Instant 

Messenger. Check any or all of the following conditions under which Instant Messenger will 

automatically open: 

 

 Personal Messages 

  

 Chat Messages 

  

 News Messages 

 

Text Size 

 

Select from the drop-down list the size of the text that will be displayed in the Message 

Display window. The options are small, medium, or large. 

 

Search Feature 

 

Contents in the Message Display Window can be searched. 

 

Press the Find Text icon to initiate a search . The Find window will display. 

 

Alternate Methods: 

 

 From the Action menu select Find 

  

 Type Ctrl+f 

 

Options allow for a more granular search. 

 

 Match Case—Acknowledges upper and/or lowercase characters in a search. By 

default, the search function disregards upper and lowercase characters. 

  

 Search Up—Reverses the normal down-the-page search. 

  

 Match Whole Word—A whole word is defined as text that is preceded or followed 

by a word space. 

  

 Search Selection Only—Instant Messenger will search through highlighted text 

only. 

 

The Find window will display a message if either the search cannot find what was input, or 

if there are no more instances of what was previously found. 

 

Templates 
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The overall look, style, and display of Instant Messenger can be saved as a template. The 

template is saved with an .imt extension. Additionally, a desired template can be saved as a 

default, and Instant Messenger can revert to the system default template if desired.  

 

Note: Only Favorite Folders are saved in a template. As mentioned above, Chat and Firm 

folders are neither created or deleted and are not saved in a template. 

 

Learn more about templates here. 

 

Status Bar 

 

The status bar is a row of informative text at the bottom of the Instant Messenger window. 

By default the status bar is displayed. 

 

From the Config menu, click on Status Bar to hide it.
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Most Active Symbols Viewer 

View the most active symbols by cumulative value, cumulative volume, percentage change 

of advancers and decliners. 

  

  

 
  

  

Launch Most Active Symbols Viewer 

  

From the WTP toolbar select Analyze --> Most Active Symbols Viewer. 

  

Alternate Method: 

  

From the WTP menu select Most Active Symbols Viewer. 

  

  

Select the Exchange or Security Type 

  

The System Default Template for the MASV uses the US as its Exchange/Security Type for 

all four tabs. 

  

Select another Exchange/Security type from the drop-down list for each tab as desired. 
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Note: The selected Exchange/Security Type applies only to the currently selected tab. For 

example, a selection of Exchange/Security Type for the Most Active (Volume) would not 

affect the remaining three tabs. 

  

Tip: Selections can be saved as a template, eliminating the need to re-select the 

Exchange/Security Types at each session. 

  

  

Put/Call Options Reporting 

  

If the selected Exchange/Security Type is Options based (for example, US - Put Options or 

NDQ Call Options) additional options-related columns can be added to each tab in the 

MASV. These columns are: 

 Underlier 

 Root 

 Exp. Date 

 Option Side 

 Strike 

  

Add Options Columns 

  

Select the Options Columns icon . 

  

Alternate Method: 

  

From the Config menu select Show Option Columns. 

  

  

Add Other Columns 

  

Quote columns and user defined columns can be added to the MASV grid with the Field 

Chooser. 

  

Learn about the Field Chooser here. 

  

  

Column Sorting 

  

Data displayed in the MASV is already sorted based on the appropriate column for that view 

(i.e., Volume for the "Most Active (Volume)" tab). 

  

Columns cannot be manually sorted in the MASV. 

  

  

Working With Tabs 

  

New tabs in the MASV can be added, renamed, closed, or opened in a new window. 

  

  

Add New Tab 

  

Any of the four tabs present in the system default template of the MASV can be duplicated. 
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Duplicating a tab type is useful when the tab is to be viewed with two or more 

Exchange/Security types. 

  

For example: For the Most Active (Volume), it is desired to view the NYMEX and CME 

Globex. Adding an additional "Most Active (Volume)" tab allows for this. 

  

Right-click anywhere in the tab area and select Add New Tab --> tab name. 

  

Alternate Method: 

  

From the Action menu select Add New Tab --> tab name. 

  

  

Rename Tab 

  

Right-click on a tab to be renamed and select Rename Tab. Enter the tab name in the Tab 

Name window. 

  

Note: Renaming a tab does not change the content of the tab. 

  

  

Close Tab 

  

Right-click on a tab that is to be closed and select Close Tab. 

  

  

Close All But This 

  

Right-click on a tab and select, Close All But This. All tabs will close except for the one 

that is selected. 

  

  

Open in a New Window 

  

Right-click on a tab and select Open in a New Window. A new MASV window will open 

with only the selected tab (and the tab will be removed from the previous window). 

  

Alternate Method: 

  

Click on a tab and drag it to a location on the desktop. The new window will appear where 

the mouse is released. 

 

Create New Orders From the MASV Grid 

  

Double-click on any symbol in any grid in the MASV to launch the Order Ticket. The 

selected symbol will automatically be placed in the Sym field. 

  

Alternate Method: 

  

Select a symbol and click on the New Order icon . 
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Templates 

   

MASV configurations can be saved as templates. 

  

Learn about templates here. 

  

  

Export Grid Data 

   

Data in the MASV can be exported to a file, clipboard, or Excel spreadsheet. 

  

Learn about exporting grid data here. 

  

  

Copy, Copy This Cell 

   

The Copy command copies all selected rows. The Copy This Cell command copies a 

selected cell. 

  

To Copy: 

 

1. Select one or more rows. 

  

2. From the Action column select Copy. 

 

Alternate Methods: 

 Right-click on the highlighted rows and select Copy. 

  

 Press Ctrl +c after highlighting the row(s) 

 

Note: The copy command copies the selected data and their row numbers and column 

heads. 

  

 To Copy a Cell: 

 

1. Click on the cell to be copied. 

  

2. From the Action menu, select Copy This Cell. 

 

Alternate Methods: 

1. Right-click on the cell to be copied, and select Copy This Cell. 

  

2. Click on the cell to be copied and enter Shift + Ctrl +c. 

  

  

Printing 

  

  

The data in the MASV can be printed. 

  

Learn about the printing feature here. 
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News Browser 

 

The News Browser displays a list of historical and real-time news headlines. The headlines 

can be filtered based on symbols and keywords. Any listed headline can be opened (by 

double-clicking) to reveal its full story. 

 

 

 

 
Launch News Browser 

Read and Print a News Story 

Filter Selections in the News Browser 

Configure News Browser 

Global Notifications 

Columns and Formatting 

Start and Stop Reporting 
 

 

Launch News Browser 

 

From the WTP toolbar select Explore-->News Browser. 

 

Alternate Methods: 

 

 From the WTP  menu select News Browser.  

 Double-click an entry in the Headline or Headline Time columns in the Quote Grid. 

 

Read and Print a News Story 
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From the News Browser window, double click on a headline or right-click and select Open 

Story. 

 

Alternate Method: 

Select a headline. Click the Open Story icon . 

 

Select a headline. From the Action menu select Open Story. 

  

Note: ALERTS are headlines without full stories. They are issued for stories early before all 

details are known. 

 

Print a News Story 

 

Press the Print button found at the bottom of the news window. 

 

 

Filter Selections in the News Browser 

 

The headlines displayed in the News Browser can be filtered by symbol and time.  

 

Do Not Filter by Symbols—All news headlines will be listed. 

 

Filter by Symbols in Applets—The symbols requested throughout all WTP applets only will 

be listed. 

 

Filter by Symbols—From a drop-down list, select only those symbols to display news 

items. 

 

Alternate Method: 

 

Type one or more symbols. Insert a comma between symbol names. 

  

Open Symbol List—If Filter by Symbols in List is selected, a Symbol List can be 

opened. A Symbol List is a file with a .sym, .bsk, or .txt extension and contains a list of 

symbols separated by a comma or semi-colon. 

 

Press the Open Symbol List icon    to access a symbol list. 

 

Toggle Symbol Tracking—If activated, a symbol from another WTP applet will display in 

News Browser. See Toggle Symbol Tracking for more details on this feature. 

 

Filter by Keywords—Enter one or more keywords, separated by a comma or semi-colon. 

Select one of the following search filters: 

 

Filter—Headlines featuring the keywords (i.e., "News" will find News and New) are 

displayed. 

 

Highlight—Headlines featuring the keywords are highlighted. 

  

Time Parameters—Select the times in which you want headlines to be reported: 
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 Recent—Headlines from the last hour 

  

 Today—Headlines from midnight of the current day 

  

 Start/End—Manually entered parameters of exact time and date 

 

Configure News Browser 

 

Using the right mouse button and select Configuration. 

 

 
 

Under the General tab you have these options: 

  

 Show Alerts 

 

 Color Alert Text—This will make alert headlines stand out in the grid with 

the color of your choice. Click on the Color Alert Text box, then click on 

color swatch to select a different alert-text color. 

  

 Show Retracted Headlines 

 

 Color Retracted Text—Normally, retracted stories from Reuters are not 

displayed. To view retracted stories, click on the Show Retracted Headlines 

box to use this feature. Select a color to highlight retracted stories. Click on 

the swatch if you wish to use a color other than the default. 

  

 Open Stories Automatically—Each time a new headline is received, it will 

automatically open to reveal its full story if the check box is checked. Note: Using 

this feature will open individual windows as fast as headlines are received. This could 

become unwieldy if you are retrieving headlines about multiple securities. 
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 Color Symbols In Stories—Selecting this feature will highlight the symbol names in 

an opened news story. To define a highlight color other than the default, click on the 

color swatch and a color window will open. 

 

 

Global Notifications 

 

To define a sound that plays when a headline is received and define a log severity 

parameter, click on the Global Notifications button. 

 

Defining the Sound 

 

1. In the event column of the Global Configuration window, click on the row News 

Received. 

  

2. From the drop-down list select a .wav sound file that will play when headlines are 

received. To hear a sample of the notification sound, click the right arrow button 

next to the drop-down list. 

  

3. Make sure the Mute All Sounds box is unchecked. 

 

Defining Log Severity 

 

 Each received headline will be logged with a severity of either None, Low, Medium, 

or High. To change the log severity from the default None, click the word <None> 

and a drop-down list becomes available. Click on Low, Medium or High. 

 

Click either OK to save your changes and exit, Apply to save your changes and keep the 

window open, or Cancel to exit the window without saving your changes.  

 

Columns and Formatting 

 

The look of the News Browser with regard to the column headings, row/column colors, 

fonts, and point sizes can be configured. 

 

To add/remove columns: 

 

1. From the News Browser window click the right mouse button and select 

Configuration. 

  

2. Select the tab Columns and Formatting. 

  

3. Under Grid Layout/Available Columns select any listed field. Press the right 

arrow button to add this new column to the News Browser. To remove an existing 

column head, highlight the heading and click on the left arrow button. Use the 

up/down arrows to move the column heads to a desired layout. 

 

Setting the Grid Default Style 

 

The Grid Default Style defines the font, format and colors to be displayed in the News 

Browser. 
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1. Select Columns and Formatting from the News Browser configuration window. 

  

2. Click Set Grid Default Style. 

  

3. Choose your font, style, size and effects from the Font tab. Select formatting 

parameters (horizontal/vertical alignment) from the Format tab. From this window 

select (or deselect) the Wrap Text and Decimal Places options. 

  

4. Select a Grid Line Style from the drop-down list. Options include solid, dashed, 

and dotted. 

  

5. Press OK to save your selections or Cancel to exit without saving. 

 

Setting Grid Colors 

 

1. Bring up the Configuration window from the News Browser. 

  

2. Select Columns and Formatting from the configuration window. 

  

3. Click Set Grid Default Style. 

  

4. Select the Colors tab. 

  

5. Click on any color swatch that you wish to change. A color definition window will 

appear. If an alternating row colors are preferred, check the Alternating 

Background box, and be sure the alternating color is distinctive from the 

background color. 

  

6. To revert the color scheme to default values, press the Reset to Defaults button. 

  

7. Press OK to save your selections or Cancel to exit without saving. 

  

Setting the Column Header Style 

 

1. Bring up the Configuration window from the News Browser. 

  

2. Select Columns and Formatting from the configuration window. 

  

3. Press the Set Column Header Style button. 

  

4. From the Font tab, select font/size/style/size and effects (Strikeout and Underline). 

The Format tab sets Horizontal and Vertical alignment parameters, along with text 

wrapping option. The Colors option sets column head colors and text colors. 

  

5. Press OK to save your selections or Cancel to exit without saving. 

  

Start and Stop Reporting 

 

Press Go to have the News Browser retrieve headlines and Stop to cease headline retrieval.
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Option Quote Cube 

 

The Option Quote Cube provides full book data for all options of a given underlier. Quote 

data can be provided for all six options exchanges: ISE (Y), CBOE (W), AMEX (A), PHLX (X), 

PCX (P), and BOX (B), and calls attention to exchanges that have more favorable quotes. 

Quotes can be viewed by exchange, selected exchanges or NBBO.  The Option Quote Cube 

allows traders to access Order Tickets to quickly execute trades. Similar to the Equity 

Quote Cube, the Option Quote Cube is “trackable” to Order Tickets. 

 

 

 

 
Launch Option Quote Cube 

Filter Visible Strikes by Expiration 

Display All Expirations for a    

Single Product 

Set The Display of the Option 

Quote Cube 

Security Detail 

The Order Ticket 

Display or Hide the Ticker 

Trader or Vol Trader 

 

Select Level 2 Data Sources 

Show Volatility Chart 

Price Consolidation and Quote 

Detail Tables 

Single Option Mode 

Montage Filters 

Option Builder 

Quick Trades 

Configure Option Quote Cube 

Tabs 

 

Toggle Symbol Tracking 

Send Option Quote Cube Data 

 

 

 

Launch Option Quote Cube 
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In the WTP Toolbar select Analyze --> Option Quote Cube.  

 

Alternate Method: 

 

From the WTP menu select Option Quote Cube. 

 

Filter Visible Strikes By Expiration 

 

 
 

The Option Quote Cube can be setup to display the number of visible strikes by expiration. 

Values are in the following increments— 5,10,15,20,25 and All. 

 

Select a value from the drop-down list (centered between Call and Put). The selected value 

reflects the number of strikes closest to being in the money. If the desired number of 

displayed strikes is not available in the drop-down list, it may be manually entered at the 

top of the drop-down list. 

 

Selecting All will display all strikes. 

 

 

Display all Expirations for a Single Product 
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When a single product is selected in the Option Montage Grid of the Option Quote Cube, 

issuing the View Expirations for Strike command (by right-clicking in the grid) will launch 

a new window in which data for all expiration dates is displayed. Multiple strike prices can 

be selected before or after issuing the command. 

  

If a different security is selected in the Option Quote Cube, it will be reflected in the View 

Expirations for Strike window. 

  

The newly-launched window responds as other WTP grids in which the Order Ticket can be 

launched when selecting a bid or ask value. Also, the grid data can be exported and the 

send to command can be issued. 

  

Note: Only one option side can be shown at a time. If a call and a put are selected in the 

Option Quote Cube, the View Expirations for Strike window will display the most recently 

selected option side. 

 

 

Set the Display of the Option Quote Cube 

 

The Option Quote Cube display can be customized to view security details, ticker and order 

ticket. 
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Security Detail 

 

 
 

Show or Hide Security Detail 

 

There are three methods to show/hide the Security Detail portion of the Option Quote Cube: 

 From the Config menu, select Show Security Detail 

  

 Click the right mouse button in the Option Quote Cube and select Show Security 

Detail 

 Press the Show Security Detail icon  

 

The feature toggles between show and hide. 

 

Initiate an Order from the Security Detail Window 

 

A bid or ask order can be initiated from the Security Detail Window. 

Click on either Bid or Ask or on the quote adjacent to each. The Order Ticket will open. 

 

The Order Ticket 

 

There are a number of ways to display the Order Ticket with the Option Quote Cube: 

 

 From the Config menu select Show Order Ticket 

  

 Press the Show/Hide Order Ticket icon  

  

 Click anywhere in the Option Quote Cube with the right mouse button and select 

Show Order Ticket 

 

Create a New Order with the Order Ticket 

 

The Order Ticket can be accessed to create a new order. There are three methods: 

 

 From the Action menu select Order Ticket. 

  

 Type Ctrl + n. 

  

 Double click a quote in either the montage or detail grids. 

  

Display or Hide the Ticker 

 

The ticker displays relevant option data, time and sales fields, expiry dates, a summary, and 

more. 
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There are 4 ways to display 

or hide the Ticker: 

 Press the Ticker icon 

  

 From the Config 

menu select Show 

Ticker 

 Click the right mouse 

button anywhere on 

the Option Quote 

Cube and select 

Show Ticker 

 From the 

Configuration 

window, select the 

Ticker tab. Check 

the Show Ticker 

box. Click OK. 

Uncheck the box to 

hide the ticker.  

 

Configure the Ticker 

Choose one of the following 

methods to configure the 

ticker. 

 Press the Config 

icon . 

 Select Config --

>Configuration 

 With the right mouse 

button click on the 

Option Quote Cube 

and select 

Configuration. 

 

 

 

 
 

   

Allow historical ticks   

 

Check this box if historical ticks from Reuters is desired. 

 

Note: WTP must be connected to a WORMS Market data server. 

 

Number of ticks  

  

Enter a value in the Limit to ___ ticks window to display the maximum number of ticks to 

be reported. 
   
Filter by selection 
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The ticker will only display ticks of the Option that is selected in either the Call or Put tables. 

The Option name will be displayed next to the checked Filter by selection box. 

 

Configure the Ticker Grid 

 

See Columns and Formatting for information on customizing the look of the ticker grid. 

 

 

Launch Order Ticket, Crossing Ticket, Staged Order Ticket, Spread Agent, or Vol 

Trader 

 

Launch buttons for the Order Ticket,  Crossing Ticket, Staged Order Ticket, Spread 

Agent and Vol Trader are available when a row in the grid has been selected. 

 

The launch buttons are unavailable if: 

 

 A row has not been selected 

  

 More than one row has been selected 

  

 The user does not have permission 

 

When the Crossing Ticket button is selected, it will open and the security name will display 

in the Sec field. 

 

When Spread Trader or Vol Trader is selected, the applet will open along with the Managed 

Order Console if it isn't open already. 

 

Launch Vol Trader from the Montage Grid 

 

Vol Trader can also be launched from the montage grid in the Option Quote Cube. 

 

Select an order row and double-click in either the Bid IVol, Ask IVol, or Mid IVol column. 

Vol Trader and the Managed Order Console will open. 

 

 

Select Level 2 Data Sources 

 

Display the depth of various exchanges with this command. 

 

1. From the Config menu select Configuration 

 

Alternate Method: 

  

Select the Configure this Window icon  

  

 

  

2.  Under Level-2 Exchanges individually select the reporting exchanges or to select all, 

choose <All Exchanges>. 
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Show Volatility Chart 

 

Select the Show Volatility Chart icon   to launch the Volatility Chart Viewer. 

 

Learn more about the Volatility Chart here. 

 

 

 

Price Consolidation and Quote Detail Tables 

 

More detailed views of a call or put order are displayed in the Price Consolidation and 

Quote Detail tables 

 

 
 

Click on any row in the montage grid to display Price Consolidation and Quote Detail 

information. 

 

Column Order 

 

Click on a column head to toggle the display of data in ascending or descending order. 

 

Select Price Consolidation or Average Liquidity 

  

Either Price Consolidation or Average Liquidity can be displayed. 

  

From the Config menu select Consolidated Quote Mode --> Price Consolidation (or 

Average Liquidity). 

  

Alternate Method: 

 

Right-click in the Option Quote Cube window and select Consolidated Quote Mode --> 

Price Consolidation (or Average Liquidity). 

 

 

Single Option Mode 

 

The Option Quote Cube can be configured to display market data about a single option. 

  

To view quote details about an option: 

 

1. Select an option in the call or put portion of the Option Quote Cube by clicking on it. 

  

2. From the Config menu select Open Selected in Single Option Tab. 

 

Alternate Method: 
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Right-click in the Option Quote Cube window and select Open Selected in Single 

Option Tab. 

A new tab will be created and the selected quote displayed: 

 

 
  

Option Quote Cube in Single Option Mode 

  

 

Montage Filters 

  

 
  

The Show Montage Filters window allows for the display of selected contract types and 

expiration types. 

  

Launch Show Montage Filters Window 

  

1. Select the Montage Filters Window Icon . 

  

2. Select Contract Type(s) and Expiration Type(s) 

  

Contract Types: 

 Binary 

 Mini* 

 All Other** 

 

*Mini contracts control 10 shares of stock compared to the standard of 100 shares. 

**All Other contract types include Cash-in-Lieu, and odd lots that are not Mini contracts. 
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Expiration Type 

 Weekly 

 Quarterly 

 All Other* 

 

*All Other refers to non-standard expiration types. 

 

 

 

Option Builder 

 

 
 

The Option Builder displays detailed information about a security, its expiration date and 

strike price, and bid/ask/last prices. 

  

Access the Option Builder 

  

Select a quote to display. 

 

1. Click on the Option Builder icon to bring up the Option Builder   

  

2. Make selections from the drop-down fields (security, expiration, strike, root), and 

select Call or Put. 

  

3. Press OK. The Option Quote Cube will now display the option details in Single 

Option Mode. 

  

 

Quick Trades 

 

A shortcut to issuing an order through the Option Quote Cube can be accomplished through 

a Quick Trade. A Quick Trade can be made from the Option Quote Cube in either montage 

or single option modes. 

 

Make a Quick Trade 

 

1. Click on a row in the Option Quote Cube that corresponds to the trade that is to be 

made. 

  

2. Click the right mouse button and select Quick Trades --> and select the quick trade 

parameters. 
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Alternate Method: 

 

Type Ctrl +b. 

 

Configure Option Quote Cube 

 

To open the Option Quote Cube's configuration window, press the configuration icon . 

 

Alternate Methods: 

 

 From the Config menu select Configuration 

  

 Right-click in the Option Quote Cube and select Configuration 

 

General Configurations 

 

 
  

 

  

Strike Detail Display 

  

  

Show Detailed Quotes 
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In Single Option Mode, check this box to view Delta data in the detail section of the Option 

Quote Cube. 

  

  

Show Consolidated Quotes 

  

Check the Show Consolidated Quotes to display  

  

Select Price Consolidation or Average Liquidity (the price per share at which any given 

quantity is available) 

   

Alternate Methods: 

  

From the Config menu, select Show Detailed Quotes and/or Show Consolidate Quotes 

  

For Consolidated Quotes, select one: Price Consolidation or Average Liquidity. 

  

  

Scroll To ATM 

  

When the price of an underlying security is equal to the strike price, the option is ATM (At 

The Money). 

  

Check this box to have the Option Montage Grid to scroll to the ATM quote. 

  

   

Single Option Mode 

   

When the Option Quote Cube is in Single Option Mode, check Show Advanced Quote 

Detail to view detailed quotes data (last, delta, gamma, etc.). 

  

Note: Show Advanced Quote Detail is only available for selection when viewing a quote 

in Single Option Mode. 

  

  

  

Filters 

  

  

Show Filter Summary 

  

Check this box to display all the filters that are currently in force. 

  

The filter summary is displayed below the Security Detail portion of the Option Quote 

Cube. 

  

  

  

Display all strikes/Display only xxx strikes 

  

See Filter Visible Strikes By Expiration 
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Show Live Orders 

  

Check this box to view Live Orders in the Option Quote Cube. 

  

  

Show At Top Always 

  

Check this box to view Live Orders at the top of the Option Quote Cube. 

  

  

User's Orders Only 

  

When selected, all orders not generated by the current user will be hidden. 

  

  

  

Display Prices in Basis Points 

  

Check this box to have the Option Quote Cube show prices in basis points. 

  

  

  

Track Selected Symbol 

  

Check this box to enable Toggle Symbol Tracking. 

  

  

  

Show Security Detail 

  

Check this box to view Quote and Delta data in the details portion of Option Quote Cube. 

  

Alternate Method: 

  

Press the Show/Hide Security Detail icon  

  

  

  

Enable Automatic Tab Adding 

  

Automatic Tab Adding information can be found here. 

  

  

  

Other Tabs in Configure Option Quote Cube 

  

  

Option Montage Grid, Strike Detail Grid, Consolidated Quotes Grid, Ticker, and Grid 

Colors 

  

Learn how to format columns and grids and define grid colors here. 
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Note: To disable the montage grid from displaying exchange colors, check the Disable 

Colors box (found under the Grid Colors tab). 

  

 

 

Order Ticket General 

 

 
  

An Order Ticket can be attached to the Option Quote Cube. 

  

From the Order Ticket tab in the configuration window, check Show Attached Order 

Ticket. 

 

Alternate Methods: 

 

 From the Option Quote Cube window, right-click and select Show Order Ticket. 

  

 From the Config menu select Show Attached Order Ticket. 

  

 Select the Show/Hide Order Ticket icon . 

  

  

  

  

Order Ticket in Advanced Mode 

  

Additional order options such as start/stop times, % volatility, IOC routes, and Stop Limit 

and Stop Market orders are available in the ticket's advanced mode. 

  

Detailed advanced mode information is available here. 
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Position Display Mode 

  

The position field in the Option Quote Cube order ticket can be configured to display one 

of five positions: 

 

 Global Default (Port) 

  

 Firm Position 

  

 Account Position 

  

 Portfolio Position 

  

 Day Position Only 

 

The Account Position reports position adjustments, while Portfolio and Day Position Only do 

not. 

  

If the position is unknown or unobtainable, "unknown" will be displayed in the position 

fields. 

  

The Global Default (Port) position references the Default Position Mode that was 

selected in Global Configuration. 

  

 

Tracking 

  

The Order Ticket can be configured to track (i.e., match) a value in the Option Quote Cube 

and automatically place that value in the Order Ticket. 

  

Tracking Options: 

  

Track Price—The ticket will use the price of the currently selected quote. 

  

Track Quantity—When a security is clicked in the Option Quote Cube, the order quantity 

will be placed in the QTY field of the Order Ticket. Select one of two options for quantity 

tracking: 

 Sweep—The ticket will use the sum of the quantities for all quotes above and 

including the selected quote. This is useful when taking the market 

to "sweep" up the top of the book. 

  

 Single Quote—The ticket will use the quantity of the selected quote. 

 

Track Side—If selected, when a quote is clicked in the ASK grid, the Order ticket will track 

its side to BYO. When clicked in the BID grid, it will track its side to SLO. 

  

Join Market—Causes the ticket to select the BUY side for a Bid and the SELL side for an 

Ask. 

  

Track Route by Exch/MM—If checked, the Order Ticket will select a route based on the 

Exchange or Market Maker of the selected quote and the Option Quote Source mapping in 

Global Configuration. 
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All other instructions for configuring the Order Ticket can be found here. 

  

Note: Order Tickets launched from the Option Quote Cube (via the send to-->Order 

Ticket command) also obey the tracking configuration. 

  

  

Side Types 

  

 
  

Show Separate Side Btns—Check this box to display all the selected side types from the 

drop-down list (BYO, BYA, SLO, SLA, etc.) on the Order Ticket. If unchecked, only the Buy 

and SEL buttons (or SSH depending on your configuration) will display. 

  

Show Sides—To display any or all of the available Side Types, choose the Side Type(s) to 

display from the drop-down list. Select <All Sides> box to show all Side Types on the 

Order Ticket. 

  

The Order Ticket in Option Quote Cube supports the following Side Types: 

 BYO (Buy option) 

 BYC (Buy to close) 

 BYA (Auto buy) 

 SLO (Sell option) 

 SLA (Auto sell) 

 SLC (Sell to close) 

  

Notes on Option Side Types 

  

BYC—Generally used for options, but can be used for stocks on a per-route basis. Not 

allowed for futures. 

  

BYA—The order will be a BUY if it results in a positive position. The order will be a BYC if it 

results in a zero or negative position. 

       
Note: BYA is enabled for equities only and can only be used if the selected route 

supports equity BYC. 

  

SLA—Equities only, not allowed for futures The auto sell side type automatically chooses 

between SEL and SSH based on the current position. 

  

SLC—Not allowed for futures. 
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Snap Side Types to Defaults On Security Change 

  

When you change a Symbol in the Order Ticket, default sides types will be displayed in the 

Order Ticket if you check this box. Buy Side Types are BUY and BYC. Sell Side Types are 

SEL, SLA, SSH, SSE. 

  

  

  

Button Set (for Single Option Mode) 

  

 
  

Button Set: Standard Ticket Buttons 

  

  

 
  

Button Set: Quick Execute/Cancel Buttons 

  

  

When the Option Quote Cube is in single option mode, one of two button sets can be 

selected: 

 Standard Ticket Buttons 

 Quick Execute/Cancel Buttons 

  

Controls 

  

Show Qty/Px Spinners—Spinners are the up/down arrows adjacent to the Qty and Px 

fields and are used to adjust the quantity and price without the need to manually key in a 

value: 

 

 
  

Price field with Spinners enabled 

  

  

Show Quick Qty Btns 
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Quick Qty Btns 

  

  

Quick Qty buttons reflect the values to be added to the Qty field are displayed in the Order 

Ticket. The values are: 

 

 +1 

 +5 

 +10 

 +25 

 +50 

 +100 

 

Each button can be combined with other buttons for a desired total (i.e., +100 button  + 

 +500 button = Qty of 600). 

  

Select the Clear Qty button to set the Qty value to zero.   

   

Show Quick Buy/Sell Btns—Check this box to display six quick buy/sell buttons in these 

amounts: 

  

 
 

Quick Buy/Sell Btns 

 

 SLO 10 

 SLO 5 

 SLO 1 

 BYO 1 

 BYO 5 

 BYO 10 

 

The selected side types are reflected in the quick buy/sell buttons (for example, if the side 

type is BYC, the quick sell buttons will be BYC 1, BYC 5, and BYC 10) 

   

Use Separate Buy/Sell Btns 

  

When checked, the default ticket layout of one Buy button, one Sell button, and a third 

button that reflects buy/sell and price will be replaced by two buttons each reflecting the 

price. If applicable (based on routes and permissions), each button allows for the selection 

of a different side type. 
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Separate buy/sell buttons showing quantity and price. Side types can be selected from each 

button. 

  

  

  

Show Cancel Button—The Cancel button allows you to cancel all live orders for the 

security selected in the Option Quote Cube. Check the Show Cancel Button to display it. 

  

 
  

Cancel all live orders for a security with the Cancel button. 

  

  

Lock Selections 

  

Lock override default settings in the Global Configuration. 

  

Global settings such as routes, portfolios, price types, etc. can be associated with certain 

symbols or security types. When a symbol is entered, the global settings are called in 

automatically. If the defaults are to be overridden (for example QTY is changed to 500 from 

the default of 100), and Lock Selection is enabled, each symbol that's entered in the Order 

Ticket will have a QTY value of 500. 

  

As an alternative to the configuration window, the lock icon  on the Order Ticket can be 

employed to lock selected fields.   

  

 Order Ticket - Portfolios 
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The Portfolio Firms and their respective portfolios that are available for selection in the 

Port field of the Option Quote Cube Order Ticket are listed here. 

  

In the top portion of this window check the Portfolio Firms that are to have their portfolios 

listed. Check <All Firms> to select all Portfolio Firms. 

  

The portfolios for each Portfolio Firm will be displayed in the bottom portion of the window. 

Check the portfolios that will be available for selection or <All Portfolios> to select them 

all. 

  

Alternate Method for Selecting Portfolio Firms 

  

In the drop-down menu in the Port field, you can also select the Portfolio Firms: 
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Tabs 

 

Tabs in grids information can be found here. 

 

 

Toggle Symbol Tracking 

 

See Toggle Symbol Tracking for details on this feature. 

 

 

Send Option Quote Cube Data 

 

Data in the Option Quote Cube can be sent to other WTP applets. 

 

To send Option Quote Cube Data: 

 

1. Click the right mouse button on the Option Quote Cube. 

  

2. Select Send To-->xxx (where xxx is the name of the applet) 

 

The chosen applet will open displaying its data of the sent symbol. 

 

 

Switch to Equity Quote Cube 

 

Select the Equity Quote Cube icon   to exit the Option Quote cube and open the Equity 

Quote Cube. 

 

Alternate Method: 

  

From the Action menu select Switch to Equity Mode. 
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Option Sector Viewer 

 

The Option Sector Viewer is a powerful utility that provides traders an overall feel for the 

options market and allows them to spot hot sectors or option products. Clicking on a sector 

opens a list of underliers, and a list of underliers can be opened to view their expirations. 

 

 

 
Launch Option Sector Viewer 

Input Modes—Sector and Underlier 

Groupings 

Investigate a Sector 

 

Filter Data 

The BACK Button 

The REFRESH Button 

Configure Option 
Sector Viewer 

Other Tabs in Option Sector Viewer 

Create New Orders From Option Sector 

Viewer 

Cancel Orders 

Export Grid Data 
 

 

 

Launch Option Sector Viewer 

 

From the WTP toolbar select Analyze-->Option Sector Viewer. 

 

Alternate Method: 

  

From the WTP menu select Option Sector Viewer. 

 

 

Input Modes—Sector and Underlier 

 

The Option Sector Viewer can retrieve data based on sectors or underliers. The mode is set 

by selecting one or the other at the top of the Option Sector Viewer. 
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Selecting Sectors 

 

1. Select the Sector radio button. 

  

2. Choose the sector to view from the drop-down list. Select <all sectors> to have all 

sectors displayed. 

 

Note: Sectors can be manually typed, separated by a comma or semicolon. 

  

Selecting Underliers 

 

1. Select the Underlier radio button. 

  

2. Enter one or more symbols. Separate symbol with a semicolon. 

 

Underliers and "Grouped By" Selections 

 

When underliers are entered, the sectors they belong to are listed in the Sectors column. 

 

In the example below, underliers GOOG  SIRI and YHOO are entered. Their sectors, 

INTERNET and MEDIA are automatically placed in the Option Sector Viewer: 

 

 
 

Groupings 

 

By default, the Option Sector Viewer shows a single row for every Sector. The Group By 

checkboxes allow the user to partition the sectors by additional fields. 

 

Sectors—All sectors entered in the Sector input mode field will be listed. 

 

Note: If the Sectors box is unchecked, the Option Sector Viewer will respond 

by listing all of the underliers related to the sectors that were selected in the 

input field. 

 

For example, if sectors Advertising and Airlines are selected and the 

SECTORS box is unchecked, all underling symbols related to both sectors will 

be displayed in the Option Sector Viewer. 

 

Expirations—The expirations for each sector will be displayed. For example, if Expirations 

is selected with the Advertising Sector, expirations for a number of months will be listed 

(i.e., Feb09, Mar09, Apr09, etc.) 

 

Put/Calls—Each selected sector will be divided into Puts and Calls if the Put/Calls box is 

checked. 

 

Strikes—Strike prices are displayed with the Strike option selected.  
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Note: The Sectors box must be unchecked in order to view Strikes. 

 

Roots—The root symbol (generally, the first three letters of an option symbol) is displayed 

if this box is checked. 

 

Note: The Sectors box must be unchecked in order to view Roots. 

 

Investigate a Sector 

 

Any listed sector can be investigating further by double-clicking on it. With each double-click 

new information about the sector is revealed. 

 

From the Option Sector Viewer base page, each double-click displays a deeper level of data. 

At the highest level are the sectors, which are then broken down into underliers, 

expiration dates, put/calls, strike prices, and root identifiers in order. 

  

When clicking on a row with a root identifier, the Option Time and Sales applet opens for 

that option product.  

 

Double-clicking automatically sets the filter to display only the data for the clicked item. 

 

Filter Data 

 

The data displayed in the Option Sector Viewer can be filtered. When the filter is active, only 

defined parameters defined in the filter window will display, if available. 

 

Define Filters 

1. Press the Filter icon  and the Filters window opens. 

  

2. Define which securities should be filtered, the expression that is to be acted upon, 

the conditional (=, <, >, etc.), and the target value. 

 

In the sample below, a Filter has been defined for All Sectors listed in the Input 

field, where the Expiration Date equals Mar09: 
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When a filter has been created, it will be displayed in the Option Sector Viewer page: 

 

 
 

 

Uncheck the Filters box to turn off filtering. 

 

To remove the filter entirely, press the Del button in the Filter definition window, then 

select OK. 

 

The BACK Button 

 

The Option Sector Viewer keeps track of the history of data requests. Pressing the Back 

button reveals the previous data request. With each subsequent pressing of the Back 

button the previous Option Sector Viewer screen will be displayed (much like the 

functionality of the back button in a web browser). 

 

The REFRESH Button 

 

The Option Sector Viewer retrieves new data every time a new command is entered. Data is 

refreshed automatically based on the value entered in the configuration window. 

 

A forced refresh is accomplished by pressing the Refresh button. 

 

Configure Option Sector Viewer 

 

The available columns, their styles, and row color conditions are defined in the configuration 

window for the Option Sector Viewer. 

 

Open the Configuration Window 
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Select the Configuration icon . See Columns and Formatting for detailed descriptions 

on how to customize columns and rows. 

 

Alternate Methods: 

 

 Right-click in the Option Sector Viewer window and select Configuration 

  

 From the Config menu select Configuration 

 

Note About News Columns: A News button that links to the News Browser can be 
configured under Quote Fields for each tab in the Option Sector Viewer. Some sectors will not 
have specific securities associated with them. In those cases, the News button will not be highlighted. 

 

The Miscellaneous Tab 

 

Two values are set under the Miscellaneous tab: Highlight Display Size and Refresh 

Data amount. 

 

The numerical value entered in the Highlight Display Size reflects the number of rows to 

display when selecting Option Sector Viewer tabs Largest Trades, Most Active 

(Contracts), Most Active (Transactions) and Unusual Volume. 

 

If Automatically Refresh Data is checked, the Option Sector Viewer will refresh its data 

as often as the displayed value dictates. The minimum refresh value is 10 seconds. 

  

Note: Refreshing sector data can take a significant amount of processing time. Increasing 

this value can improve WTP performance. 

 

 

Other Tabs in Option Sector Viewer 

 

The Highlight Tabs in Option Sector Viewer are defined on the server by an administrator 

and cannot be created, deleted, or changed by a WTP user. 

 

 

Create New Orders from Option Sector Viewer 

 

New orders can be created from Option Sector Viewer. 

  

1. Right-click any row containing either a sector or underlier name. 

  

2. Select New Order  

 

Alternate Method: 

 

Type  Ctrl +n. 

 

The Order Ticket will display. 

 

    

Cancel Orders 
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All unfilled orders or orders for a particular symbol can be canceled. 

 

1. Right-click on a row with a symbol whose order is to be canceled. 

  

2. Select Cancel All Orders (for all orders to be canceled regardless of the symbol), or 

Cancel All for Symbol xxx (where xxx is the symbol name) 

 

Alternate Method: 

 

Type Ctrl +z. 

 

Export Grid Data 

 

Grid data in Option Sector Viewer can be exported to a file, clipboard, or Microsoft Excel 

spreadsheet. 

 

Click here to learn more about exporting grid data. 
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Option Time and Sales 

 

Option Time and Sale allows you to view tick-by-tick details for all option products for a 

given security over a defined period. Optional views include detailed information about a 

selected product and summary data. 

 

 

 

 
Launch Option Time and Sales 

The Option Time and Sales Window 

Select one or more Underliers 

Select a Reporting Time 

Select a Tick for a Detailed View 

The Summary Grid 

Detail Summary Grid 

Data Filter 

Consolidated Mode 

Split Grid Mode 

Switch to Equity Mode 

Configure Option Time and 

Sales 

Issue or Cancel Orders 

Export Grid Data 

Templates 

Printing 

Condition Codes 

 

 

Launch Option Time and Sales 

 

From the WTP Toolbar select Analyze-->Option Time and Sales. 

 

Alternate Method: 
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From the WTP menu select Option Time and Sales. 

 

 

The Option Time and Sales Window 

 

The Option Time and Sales window can be divided in quadrants, depending on viewing 

preferences. In the image above, the four quadrants are defined as follows: 

 

 Upper Left—Primary Display Define the reporting time, start/stop data retrieval, 

and/or filtering parameters. 

  

 Upper Right—Detailed Grid Displays all the ticks for a currently selected product in 

the primary display grid. 

  

 Bottom Left—Summary Grid Displays the summary for a selected underlier OR 

displays the total data for all underliers. 

  

 Bottom Right—Detailed Summary Grid Displays a summary of the currently 

selected product. 

 

Select one or more Underliers 

 

To enter one or more underliers, the Option Time and Sales window must be stopped. Press 

the red Stop button . The Underliers window will now be available for input. 

 

 

1. Enter one or more stock symbols. Separate each symbol with a comma or semi-

colon. 

  

2. Select a reporting time (see below). 

  

3. Press the green Go button . 

 

The Option Time and Sales window will retrieve relevant underlier data.  

 

Select a Reporting Time 

 

Option Time and Sales can retrieve market data based on selected time parameters. 

 

 Select one of three defined time parameters for options reporting: 

Today (all ticks from midnight of the current day) 

 Yesterday (all ticks up until midnight of the previous day) 

  

 Custom (tick data retrieved between the two defined time/date settings). When 

selected, the Time Span window launches: 
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Enter the start/stop times (or use the up/down spinner arrows), and select a date 

from the drop-down list. 

  

Note: Option Time and Sales must be stopped in order to enter reporting time values.  

 

 

Select a tick for a Detailed View 

 

 
 

Click on any tick in the Primary Display to view detailed information about the underlier. 

The data will be displayed in the Detailed Grid. 

 

If the Detailed Grid is not displayed, it must be activated. See Configure Option Time and 

Sales for instructions on how to display the Detailed Grid. 

 

Note: Although many underliers may be reported, only one underlier at a time can have its 

detailed information displayed in the Detailed Grid.  

 

Filter Details 

 



WTP Applets  Option Time and Sales 

128 © 2014 Wolverine Execution Services, LLC 

Press the filter icon   to open the Detail Filters window where filters are defined. In the 

image above, a filter was defined to display ticks only from the CBOE. 

 

The Detail Filters window is similar to the set row color conditions window.  

 

 

The Summary Grid 

 

 
   
Summary Grid All mode 

 

 

   
Summary Grid Only Selected mode 
 
 

The Summary Grid displays either a summary of all underliers (if more than one underlier 

has been entered in the Underliers field), or a summary of a single underlier (selected in 

the primary display).  

 

Select the preferred summary by pressing the All or Only Selected button. 

 

The Summary Grid can be enabled/disabled, by making the appropriate selection in the 

configuration window. 

 

Detail Summary Grid 

 

 
 

The Detail Summary Grid (bottom right) displays a summary of a selected product. 
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To populate the Detail Summary Grid, click on a underlier tick in the Primary display. 

 

The Detail Summary Grid can be enabled/disabled, by making the appropriate selection in 

the configuration window. 

 

Data Filter 

 

The data displayed in the Primary display can be filtered. When a filter is in force, only data 

that matches the parameters of the filter will be displayed.  

 

For example, if it desired to view the underliers from a specific exchange, a filter can be 

defined to show only the exchange name. 

 

Define a Data Filter 

1. Press the filter icon   The Filters input screen displays: 

 

 
  

2. Define a security, expression, condition, and target value and press OK or Apply. 

 

For more information about defining expressions see Set Row Color Conditions. 

 

When a filter is active, the filter expression and target value will be displayed in the Option 

Time and Sales window. The image below reflects the filter selection of displaying data from 

AMEX exclusively: 

  

 
 

 

Consolidated Mode 

 

The Option Time and Sales window can be configured to display data in consolidated mode 

where each line corresponds to a separate product. 

 

In consolidated mode only the cumulative fields are shown per each tick. 

 

Set Option Time and Sales to Consolidated Mode 

 

Right-click the mouse anywhere in the Option Time and Sales window and select 

Consolidated Mode. 
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Alternate Methods: 

 

 From the Config menu select Consolidated Mode. 

  

 From the configuration window, Miscellaneous tab, check Consolidated Mode. 

 

Disable Consolidated Mode by repeating the same procedure. 

 

Split Grid Mode 

 

The Primary Display can be configured for Split Grid Mode, where calls and puts are on 

separate grids. In the image below Split Grid Mode is enabled: 

 

 
 

Enable Split Grid Mode: 

 

Right-click the mouse anywhere in the Option Time and Sales window and select Split Grid 

Mode. 

 

Alternate Methods: 

 

 From the Config menu select Split Grid Mode. 

  

 From the Configuration window, miscellaneous tab, check Split Call/Put Grids. 

 

Disable Split Grid Mode by repeating the same procedure. 

 

Switch to Equity Mode 

 

Option Time and Sales can be changed to Equity Time and Sales with a simple command. 

 

Click on the Equity Time and Sales icon  or right-click the mouse anywhere in the Option 

Time and Sales window and select Switch to Equity Mode 

 

Configure Option Time and Sales 
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Grid styles, color conditions, header styles and other features can be configured through the 

Configuration window. 

 

View the Configuration Dialogue 

 

Select the configuration icon . 

 

Alternate Methods: 

 

 Right-click the mouse anywhere in the Option Time and Sales window and select 

Configuration 

  

 From the Config menu, Configuration 

 

Configure Grids 

 

The first four tabs in the Configuration window are used for defining grid styles, row color 

conditions, and column header styles for the following: 

 

 Time and Sales Grid 

  

 Call Grid 

  

 Put Grid 

  

 Detail Grid 

 

To learn more about grid setup see Columns and Formatting. 

 

Note: Option Time and Sales must be in Split Grid Mode in order to configure the Call 

Grid and Put Grid configuration screens. 

 

Miscellaneous Configurations 

 

On the Miscellaneous page are a number of Option Time and Sales functions. Check the 

box to select/deselect a specific function. 

 

Track Symbol—If checked, the underlier in Option Time and Sales will match that of 

another WTP applet. Learn more about tracking symbols here. 

 

Send notification when ticks match filter— An audible signal (set up in Global 

Configuration) will sound when data in Option Time and Sales matches a defined filter. 

 

Only one notification per product— If checked, the audible notification will sound 

only once per each underlier that matches a defined filter. 

 

Show Summary Grid—Check/uncheck to show/hide the Summary Grid 

 

Show Detail Grid—Check/uncheck to show/hide the Detail Grid 

 

Consolidated Mode—Check/uncheck to have the Primary Grid in/out of consolidated mode 
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Split Call/Put Grids—Check/uncheck to display/not display the Primary Display in 

separate grids for puts and calls. 

 

 

Issue/Cancel Orders from Option Time and Sales 

 

A new order can be initiated from Option Time and Sales. The Order Ticket will appear.  

 

Open (unfilled) orders can also be canceled, either collectively, or individually by symbol 

 

Issue an order 

   
Right-click in the Option Time and Sales window and select Order Ticket. 

 

Alternate Methods: 

 

 From the Action menu select Order Ticket 

  

 Type Ctrl +n 

 

Cancel all open orders 

 

Right-click in the Option Time and Sales window and select Cancel All Orders 

 

Alternate Method: 

 

From the Action menu select Cancel All Orders 

 

Cancel all open orders for a specific symbol 

 

Right-click in the Option Time and Sales window and select Cancel All For Symbol: xxx 

(where xxx is the symbol name) 

 

Alternate Methods: 

 

 From the Action menu Cancel All For Symbol: xxx 

  

 Type Ctrl +z 

 

Export Grid Data 

 

Grid data in Option Time and Sales can be exported to a file, clipboard, or Microsoft Excel 

spreadsheet. 

 

Learn more about exporting grid data here. 

 

Templates 

 

Templates for Option Time and Sales can be opened, saved, or saved as a default. If all the 

characteristics of the Option Time and Sales display are desirable, saving the display as a 

template saves all previously defined parameters.  

 

Option Time and Sales templates are saved with a .tas extension.  
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Learn more about templates and how they're used in WTP here. 

 

Printing 

 

The data in Option Time and Sales can be printed. 

 

Learn about the printing feature here. 
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Condition Codes 

 

 
Value 

 
Description 

REGULAR 
Indicates that the transaction was a regular sale and was made without stated 

conditions.  

CANC 
Transaction previously reported (other than as the last or opening report for the 

particular option contract) is now to be canceled.  

OSEQ 
Transaction is being reported late and is out of sequence; i.e., later transactions 

have been reported for the particular option contract.  

CNCL 
Transaction is the last reported for the particular option contract and is now 

canceled.  

LATE 
Transaction is being reported late, but is in the correct sequence; i.e., no later 

transactions have been reported for the particular option contract.  

CNCO 

Transaction was the first one (opening) reported this day for the particular option 

contract. Although later transactions have been reported, this transaction is now 

to be cancelled.  

OPEN 
Transaction is a late report of the opening trade and is out of sequence; i.e., 

other transactions have been reported for the particular option contract.  

CNOL 
Transaction was the only one reported this day for the particular option contract 

and is now to be canceled.  

OPNL 
Transaction is a late report of the opening trade, but is in the correct sequence; 

i.e., no other transactions have been reported for the particular option contract.  

AUTO 
Transaction was executed electronically. Prefix appears solely for information; 

process as a regular transaction.  

REOP 

Transaction is a reopening of an option contract in which trading has been 

previously halted. Prefix appears solely for information; process as a regular 

transaction.  

AJST 

Transaction is an option contract for which the terms have been adjusted to 

reflect a stock dividend, stock split, or similar event. Prefix appears solely for 

information; process as a regular transaction.  

SPRD 

Transaction represents a trade in two options in the same class (a buy and a sell 

in the same class). Prefix appears solely for information; process as a regular 

transaction.  

STDL 

Transaction represents a trade in two options in the same class (a buy and a sell 

in a put and a call). Prefix appears solely for information; process as a regular 

transaction.  

STPD 

Transaction is the execution of a sale at a price agreed upon by the floor 

personnel involved, where a condition of the trade is that it reported following a 

non-stopped trade of the same series at the same price.  

CSTP Cancel stopped transaction.  

BWRT 

Transaction represents the option portion of an order involving a single option 

leg (buy or sell of a call or put) and stock. Prefix appears solely for information: 

process as a regular transaction.  

CMBO 

Transaction represents the buying of a call and the selling of a put for the same 

underlying stock or index. Prefix appears solely for information; process as a 

regular transaction.  
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SPIM 

Transaction was the execution of an order which was “stopped” at a price that 

did not constitute a Trade-Through on another market at the time of the stop. 

Process like a normal transaction except don’t update “last”.  

ISOI 
Transaction was the execution of an order identified as an Intermarket Sweep 

Order. Process like normal transaction.  

BNMT 

Transaction reflects the execution of a “benchmark trade”. A “Benchmark Trade” 

is a trade resulting from the matching of “Benchmark Orders”. A “Benchmark 

Order” is an order for which the price is not based, directly or indirectly, on the 

quote price of the option at the time of the order’s execution and for which the 

material terms were not reasonably determinable at the time a commitment to 

trade the order was made. Process like a normal transaction except don’t update 

“last”.  

XMPT 
Transaction is Trade Through Exempt. The transaction should be treated like a 

regular sale.  
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Order Grid 

The Order Grid allows you to manage live orders and view details on all open, executed, and 

canceled orders. Once an order is sent from an Order Ticket (or any order-sending applet 

including Basket Trader, Managed Orders, or Allocator among others) it can be 

manipulated, have its status checked, and provide other information. 

  

 

 
Launch Order Grid 

Grid Modes 

Executions and Orders 

Show Order Detail 

The Order ID Field 

Track Symbol Selection 

Order Administration 

Show Order Summary 

 

Search Order Grid 

Cancel Orders 

Change Selected Orders 

Options Columns 

Increment Prices on Live Orders 

Report Trade and the Report Trade 

Ticket 

Force Live Orders to Bottom 

 

Move to Portfolio 

Order Grid Configuration 

Filter Data in Order Grid 

Columns 

Export Order Grid and Global 

Notifications 

Create a New Order 

Create a Staged Order 

 

Launch Order Grid 

 

From the WTP Toolbar select Manage--> Order Grid. 

 

Alternate Method: 

 

From the WTP menu select Order Grid. 

 

Grid Modes 

 

The Order Grid is displayed in one of three modes: 

 

 Order—one row in the grid for each order 

  

 Execution—one row for each execution 

  

 Event—one row for each event and can be filtered by event type 
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See Order Grid Configuration for details on setting the Grid Mode. 

 

 

Executions and Orders 

 

On the left side of the Order Grid are two configurable tabs: Executions and Orders. 

(Learn more about adding and customizing tabs here.) 

 

Executions—Pressing this tab reveals all filled orders. 

 

Note: Filled or rejected orders can not be canceled from the Executions grid 

  

Orders—Information about orders. The columns displayed in the grid are fully selectable. 

 

 

Show Order Detail 

 

To bring up the Order Detail screen: 

 

Select the Show Order Detail icon . 

 

Alternate Method: 

 

Double-click on any row in the Order Grid to bring up the Order Detail screen: 

 

 
 

The Order Detail screen presents read-only information related to selected order in the 

Order Grid. The Summary field describes the order parameters. 

 

The Order ID Field 

 

To view the order detail of another order without closing the window, enter its number in 

the Order ID field. 
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Track Symbol Selection   

 

When Toggle Symbol Tracking  is enabled the Order detail screen will change its symbol to 

match the symbol featured in another WTP applet. 

 

Learn about toggle symbol tracking here. 

 

 

Order Administration 

 

Press the Show Admin >> button to reveal additional options. 

 

Note: Only WEX Technical support can issue Order Administration functions. 

 

 Manual Execution—This command is used if an order was filled and the executing 

broker called with a price adjustment or if an order was not filled and the execution 

broker instructs the Operations desk to fill it. 

  

 Move to Portfolio—When selected, a window opens with a drop-down list of all 

available portfolios to which orders can be moved. Select a portfolio and click Move 

To Portfolio. Click OK in the confirmation window. 

 

Check the Show Portfolios for other Firms box to have the portfolios of other 

firms available in the drop-down list. 

  

 Manually Kill Order—This option kills an unfilled order. 

  

 Bust Selected Execution—If a trade was executed in error, or if a price adjustment 

was made, the order can be eliminated entirely from WTP. As a follow-up to a busted 

order, in most cases the order would be manually executed so a client would see the 

corrected price and not a duplicate of the previous order. 

  

 Show Account Info—When selected, Account Type, Description, and other 

account information is displayed in a read-only window. 

 

 

Show Order Summary 
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View summary totals of a group of orders by multi-selecting several orders (select the first 

order, then <ctrl> click on the next order, etc.) and then selecting the "Show Order 

Summary" icon from the Order Grid menu or right-clicking on the Order Grid and choosing 

"Show Order Summary." An Order Summary window will display the aggregate quantity 

traded, average price, total dollar value traded of the selected orders. 

  

Total Cash is defined as the sum of the executed values with respect to Buy and Sell. The 

formula for computing Total Cash is as follows: 

 

Total Cash = Price  x  Quantity  x  {-1 if BUY, +1 if SELL}  x  Lot Size 

  

   

For spread orders, the Net Traded field reports on the executed quantity of each leg of the 

spread. 

  

In the Order Summary window below, a two-leg spread where one side is BYO and the other 

is SLO with the same ratio, the order yields a net traded value of zero: 
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The value displayed in the Net Traded field is dependent on the order type and is calculated 

as follows: 

  

Order Type Net Traded 

Calculation 

Outright Equities/Options Order Quantity 

Spread with 2 option legs, 

same ratio, opposite sides 
0 

Spread with 2 option legs, 

different ratio, opposite 

sides 

Quantity of spread  x 

 difference of the ratios 

Spread with 2 option legs, 

opposite sides 

Quantity of spread  x 

 sum of the ratios 

Spread with 1 equity and 1 

option leg 

Quantity of spread  x 

 difference of the 

 ratios 

  

View Average Leg Price Across Multiple Spreads with Show Order Summary 

  

 
  

Three filled spreads selected in Order Grid. 
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Order Summary for all selected orders. 

  

  

 
  

Drop-down list allows for the selection of individual legs. 

  

 
  

The selected leg appears in 3 orders. The average price per leg is displayed. 

  

  

The average leg price across multiple spreads can be viewed in the Order Summary window. 

  

1. Select multiple orders and press the Order Summary button . 

2. From the Displaying drop-down list, select a specific leg. The summary will include 

the average price per leg. 

  

By default, the Order Summary will display <All Symbols> when selected. 

  

  

Search Order Grid 
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 Select the search button to launch the Search Order Grid window: 

  

  

 
  

Enter search parameters and press Search. 
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Search Results tab opens and displays found items. 

  

  

The search command allows for the searching of various parameters for all items listed in 

the grid. 

  

Launch the Search Auto Grid by selecting the search button or by entering ctrl + f. 

  

A few things to note about the search feature: 

 

 Only a single item in each search field is allowed. 

 The reset button clears all fields in the Search Order Grid window. 

 Select meta data can be searched without the need for any corroborating fields (i.e., 

a search for strike price or expiration can be accomplished without entering a symbol 

or security). 

 

 

  

Cancel Orders 

 

 
 

Orders in the Order Grid that have not filled can be canceled. While an order is displayed in 

the Order Grid press the Cancel button to cancel the order. 

 

Cancel All Orders 

 

All unfilled orders can be canceled. In the Order Grid click the right mouse button and select 

Cancel All Orders. All orders in the grid will be canceled. 

 

Cancel Selected Orders 

 

Selected unfilled orders can be canceled. To select a single order click on the order in the 

grid. To select multiple orders press the Ctrl key for each order selection. 
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Press the Cancel Select Orders icon . 

 

Alternate Methods: 

 

 Press Ctrl +x  

 

 Select Cxl Selected Orders from the context menu (by clicking the right mouse 

button) 

 

Cancel Matching Orders 

 

Unfilled orders with similar attributes (i.e.,  same symbol, same portfolio) can be canceled. 

 

To cancel matching orders: 

 

1. Click the right mouse button anywhere in the Order Grid and select Cancel 

Matching Orders. 

  

2. Select the type of matching order to cancel: 

Cancel all for symbol (symbol name) 

 

Of Side (example: BUY) 

  

To Route  

 

In Account 

 

In Portfolio 

 

From User 

 

In Wave 

  

 

Cancel Staged Orders 

 

Canceling a staged order is a two-step procedure. The column Stage: Kill will have to be 
added to the Order Grid and it is found in the Order Grid configurationColumns and 

FormattingStaged Order Fields. Alternate methods for adding the Stage:Kill column 

are found here.  
 

1. Press the Cancel button is on the row with the Staged Order. The Stage: Kill button 

will appear in the Stage: Kill column. 

  

2. Press the Stage: Kill button. A confirmation window will have to be acknowledged 

before the staged order is finally canceled. 

 

Note: The Stage: Kill button appears whenever a staged order is in a pending canceled 

state, and both Cancel and Work Staged Order permissions exist in the portfolio. 

Learn more about Staged Orders here. 
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Change Selected Orders 

 

 
 

There are a number of methods for changing a live, unfilled, order: 

  

1. Via the Change button. The Change button to the Order Grid as a column. Use the field 

chooser to add the Change button to the Order Grid. When Change is selected, the 

Change Order Window (above) launches. 

  

2. Select one or more unfilled orders, then right-click and choose Change Selected 

Orders--> (list of proposed changes). To launch the Change Order Window, select Other. 

  

3. Same as #2, but instead of right-clicking, go the Action menu and choose Change 

Selected Orders--> (list of proposed changes). To launch the Change Order Window, 

select Other. 

  

  

Save changes by selecting the Change button in the Change Order Window. 

  

  

Three States of the Check box 

  

The check boxes for Show, Discr, and Peg Lmt in the Change Order window can be in one 

of three states: 

  

 Checked—The value will be applied to the change order 

 Unchecked—The value will be cleared (i.e., unset) 

 Indeterminate—The check box displays with a centered black square indicating that 

value should be ignored (no changes made) 

 
 
 

Options Columns 
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Options columns featuring Underlier, Root, Strike Price, Expiration Date, and Option Side 

can be displayed in the Order Grid. 

  

To display options columns: 

  

 Select the Options Columns button  

 

Alternate Methods: 

 Right-click in the grid and select Show Options Columns 

 In the Configure Order Grid screen, check the box Show Options Columns 
 
 

 

Increment Prices on Live Orders 

 

The current price of a live order can be increased or decreased in Order Grid via the "+" or 

"-" buttons or "Fade In" and "Fade Away".  

 

The columns to add +/- and Fade In/Fade Away are found under Order Fields in either the 

configuration window of Order Grid or by right-clicking on any column head and selecting 

Insert Column-->Order Fields-->. 

 

The Fade In/Fade Away buttons work in a similar fashion to the +/- buttons with a couple 

of exceptions: 

 

 Fade In/Fade Away can be used for multiple live orders. 

  

 With "+" the buy/sell prices move higher. With "-" the buy/sell prices move lower.  

 

The actions of Fade In/Fade Away are described below: 

 

 

COMMAND LIVE ORDER 

(BUY) 

LIVE ORDER 

(SELL) 

RESULT 

Fade In 

Increases price 1 

increment at a 

time 

Decreases price 1 

increment at a 

time 

The buy price 

moves higher, 

the sell price 

moves lower 

(everything 

becomes more 

marketable). 

Fade Away 

Decreases price 1 

increment at a 

time 

Increases price 1 

increment at a 

time 

The buy price 

moves lower, 

the sell price 

moves higher 

(everything 

becomes less 

marketable). 

 

Note: The price increment is normally $0.01 but can be any value when defined in Global 

Configuration. 
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Report Trade and the Report Trade Ticket 

 

 
 

The Report Trade command opens a special Order Ticket that is configured to send 

external orders. An external order is recognized by WORMS as trading activity performed 

outside of the system. An external order is never sent to an exchange (though it affects a 

position), but it is recorded in the WORMS system. External Orders are used commonly 

when a trader performs an execution on the trading floor and returns to WTP to report the 

execution to the system. 

 

To learn about the standard WTP Order Ticket click here. 

 

Launch Report Trade Ticket 

 

Press the Report Trade Ticket icon  in the Order Grid . 

 

Alternate Methods: 

 

 From the Action column select Report Trade Ticket 

  

 Right-click in the Order Grid and select Report Trade Ticket 

  

 Add the Report Trade column to the Order Grid (via Order Grid 

Configuration/Columns and Formatting/Launch Button Fields). 

 

This method places a Report Trade button on each line of the Order Grid, allowing for 

a one-touch selection to launch the Report Trade Ticket. 

 

Configure Report Trade Ticket 
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The Report Trade Ticket has its own configuration page. To open it, click the configuration 

icon  on the Report Trade Ticket. 

 

Option to Always Use Flat Fee Commission 

 

The configuration window is similar to the standard WTP Order Ticket with one exception, 

the default option to Always Use Flat Fee Commission. The Report Trade Ticket defines 

whether a per-share or flat fee commission is paid. If the Always Use Flat Fee Commission 

is checked, the per-share option will be not be available in the Report Trade Ticket. 

 

Customize Ordering of Portfolios 

  

See Customize Ordering in the Order Ticket to learn how to place portfolios into a 

preferable order 

 

 

Force Live Orders to Bottom 

 

This function displays all live (unfilled) orders at the bottom of the Order Grid. 

 

Select the Force Live Orders to Bottom icon . 

 

Alternate Method: 

 

With the right mouse button, click anywhere in the Order Grid and select Force Live 

Orders to Bottom. 

 

Move to Portfolio 

 

Filled orders in the Order Grid can be moved to a different portfolio. The original order's 

state will be changed to Replaced and a new matching order will be placed in the selected 

portfolio. A replaced order does not affect positions. 
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To move an order to a different portfolio: 

 

1. Select an order in the Order Grid 

  

2. Click the right mouse button and select Move To Portfolio 

  

3. Press the Move To Portfolio button 

  

4. Click OK in the confirmation window and the order will be placed in the selected 

portfolio 

 

Order Grid Configuration 

 

 

 
  

Filter By 

 

The data displayed in Order Grid is filtered by one of two selectable methods: 

 

 Intersect—Order Grid will display all orders that match the Security Name, Security 

Type, User, Side, etc., i.e., orders that match all of the selected filters. 

  

 Union—Order Grid will display all orders that match the Security Name or Security 

Type, or User, or Side, etc., i.e., orders that match any of the selected filters. 

 

Display Items in Order Grid 
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Each drop-down list allows you to configure the items that will be displayed in the Order 

Grid. Click the down arrow on an item and check/uncheck the content listed in each filter. 

  

Press the Set Additional Filters button to bring up the Conditions window. This window 

works in the same manner as the Set Row Color Conditions window. 

  

Select either Portfolio, Account, or Firm to be displayed (only one can be selected). 

  

The Grid Mode selections allow you to display Orders, Executions, or Events. If Order is 

selected, you will not be able to select the Event Sec Type filter. You must select 

Execution in order to select an Event Sec Type. With the Events selection you can 

choose one or more events to display. To view all events, select <All Events>. Check 

Show Options Columns to add options-related columns in the Order Grid. 

  

Check the appropriate boxes next to the Order State Filters to view an order's various 

states. To selectively display certain order states, check the State(s) box and check the 

desired state boxes from the drop-down list. To display all states, check the <All States> 

box. 

  

Check Include Position Adjustments to display changes in position in the Order Grid. 

  

Check Force Live Orders to Bottom to have the Order Grid move live (unfilled) orders to 

the bottom row(s) of the grid. 

  

The Global Notifications button opens up the Global Configuration window in the 

Notifications tab.  

  

 

Filter Staged Orders 

 

Staged Orders represent a user's intent to trade a given number of 

shares/contracts/spreads over the course of a day. New orders placed during the day for 

the staged symbol count towards reducing the number of shares/contracts/spreads to be 

traded. Each new order is considered a child of the original staged order in WTP. 

 

Order Grid can display all or specific stages of a staged order, 

 

Select <All Stages> to view all stages of staged orders. Alternately, select the stages to be 

viewed from the drop-down list. 

 

Show Staged Orders 

 

Staged orders can be displayed exclusively, with other orders, or not at all in the Order 

Grid. 

 

To view staged orders exclusively, check the Staged Orders box. 

 

To view staged and other orders, check the Staged Orders box until it is grayed out with 

the check mark showing (see image above). 

 

Leave the Staged Orders box unchecked if staged orders are not to be displayed. 
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Learn how to create a Staged Order here. 

 

Columns and Formatting 

 

For general information on Columns and Formatting, grid styles, colors, and more click 

here. 

 

Columns for Staged Orders 

 

The available columns in Order Grid specific to Staged Orders: 

 

Stage: Detail When selected, the details of a staged order are displayed in a separate 

Order Grid. All orders relating to the Staged Order are displayed.   

 

 

Stage: Release When selected, an Order Ticket launches. The Quantity field will 

automatically 

be populated with the quantity necessary to fill the staged order. However, this 

quantity can be manually adjusted to a lower value. When the order fills, the quantity 

that was defined will be deducted from the remaining quantity of the Staged Order. 

 

Stage: Accept By default, a Staged Order is in a "Live" status when it is created. 

If it is desirable, a Staged Order can have its status defined as "Pending". When 

in the pending state, the Staged Order is, in effect, "in limbo", so that no shares 

can be released. (See Release Notes 13.3.20.0 to learn how to create a Staged Order 

with a status of "Pending".) A Staged Order in the pending status can be changed 

to the live status with the Stage: Accept command. The column Stage: Accept must 

be placed in the Order Grid. On the row with the pending Staged Order, select Stage: 

Accept. The pending status will be changed to "live."  

 

Stage: Reject This command is the opposite of Stage:Accept. A Staged Order in the 

"pending" state can be rejected. Select the Stage: Reject button in the row with 

the pending Staged Order and select OK in the confirmation window. Note that a Staged 

Order with a "live" status cannot be rejected.  

 

Stage: Cancel Children Orders to release a Staged Order are considered "child" orders 

of the original order. These child orders can be canceled as long as they have not 

been filled. Add the Stage: Cancel Children column the Order Grid. Select the Stage: 

Cancel Children button on the row with the live child order then click OK in the 

confirmation window to cancel the order. 

  

The TICKET Column 

 

The Ticket column places a Ticket button on all rows of Order Grid. When selected, an Order 

Ticket launches. 

 

When used in conjunction with a Staged Order, the button also opens an Order Ticket. 

Orders placed will reduce the staged order amount. 

 

 

Format Option Symbols in the Symbol Column 
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If the column called Symbol is added as an available column in the Order Grid, that column 

can be configured to customize the format of an Option's order. 

 

 
 

1. Open the configuration window. Click the Columns and Formatting tab. 

2. If the column called Symbol has not been added as a visible column, do so before 

continuing. 

3. Press Set Column Style. The window will open (above). 

4. Select one of the listed formats and press OK. A custom format can also be 

defined. Select Custom: and enter the format in the Custom Format field. 

 

Filter Data in Order Grid Columns 

 

 
 

A number of columns in Order Grid can be configured to filter its displayed data.  

 

Through drop-down lists (as in the Symbol column above), selections are made as to which 

data shall appear in the column. 

 

The columns in which data can be filtered are: 

 

 Application (i.e., which WTP applet was used in creating the order) 
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 Option components (Root, Option Side, Underlier, Strike, Expiration, Security Type) 

  

 Route 

  

 Status 

  

 Symbol 

 

 

Export Order Grid Data and Global Notifications 

 

Click here for exporting grid data directions and here for global configuration directions. 

 

 

Allocate Report Trade 

 

Filled orders that have been reported with the Report Trade Ticket can have their 

quantities and other related values allocated as desired. 

  

In the example below, a filled 100-share option order was reported. Selecting Allocate 

Report Trade launches the Report Trade Allocations window. In the first line, a quantity 

of 20 shares is defined with associated side type, price, CMTA value, and commission price. 

The second line (80) refers to the quantity available for allocation after the first line has 

been input. 
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After reporting a trade (with the Report Trade Ticket), select Allocate Report Trade to define 

allocations. 

  

  

 
  

Two allocations have been created from the original quantity of 100 shares (20 and 80 

respectively). Note that different side types, CMTA, and Commission values have been 

defined. 
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Confirmation window summarizes the report trade allocation. 

  

  

Allocate Report Trade 

1. Select a filled order from the Order Grid. 

2. From the Action menu select Report Trade. The Report Trade Ticket launches. 

 

Alternate Method: 

 

Right-click on row containing the filled order and select Report Trade. 

3. Once the report trade has filled, a new row will be added to the Order Grid. Select 

this row. 

4. From the Action menu select Allocate Report Trade. The Report Trade 

Allocation window launches. 

 

Alternate Method: 

 

Right-click on the row containing the reported trade and select Allocate Report 

Trade. 

5. The first row in the Report Trade Allocation window will contain, as a minimum, the 

order quantity, side type and price. The CMTA and Commission values will also be 

displayed if they were part of the order. 

 

Each field in this window is editable. If a commission is to be added, check the 

Commission box and select Per Share or Flat Fee. Enter the Commission value in 

the Commission field. If a CMTA identifier is required, it can be manually entered as 

well. 

 

If the order Quantity is to be split into two or more allocations, select the Quantity 

field and define the first quantity either by entering the value directly, or with the 

up/down spinner arrows. Press Add Allocation to add a new row to this table. For 

example: 
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Quantity field selected showing initial quantity of 100.  

 

 

 
  

Initial quantity manually reduced to 80. When Add Allocation is selected, a new row 

is added.  

The remaining quantity is automatically calculated (in this case 20).  If desired, this 

value (20)or the top value (80) can be adjusted and a third row will be added to the 

table. 

6. When satisfied with the allocations, select the Allocate button. A confirmation 

window will launch containing details of the allocations. Select OK to complete the 

report trade allocation process. 

 

Note 1: If there is difference in price from one allocation to another, WTP will flag the 

discrepancy. The allocation can still commence despite the price difference. 

  

Note 2: Multiple reported trades can be allocated in a single Report Trade Allocation window 

if the symbol, side type, route, and portfolio are identical for each order. For staged orders, 

the staged order parent ID must be identical for each order. 
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Note 3: Although a specific side type can be changed (for example, BYO to BYC), the side 

(Buy/Sell) cannot. 

  

Note 4: The entire quantity of the reported trade must be accounted for in the sum of the 

allocations, otherwise the allocation cannot be completed. For example, a 100-share order 

cannot be allocated unless the total of all allocations equals 100. 

 

 

Create a New Order 

 

1. Select a row in the Order Grid corresponding to the symbol that is to be bought/sold. 

  

2. Click the right mouse button and select Order Ticket. 

 

Alternate Methods: 

 

 Press the New Order icon  

  

 Type Ctrl +n. 

 

The Order Ticket will appear. 

 

Create a Staged Order 

 

Right-click in the Order Grid and select New Staged Order. 

 

Alternate Method: 

 

From the Action menu select New Staged Order. 

 

A New Staged Order Ticket will appear.
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Order Tickets 

 

The standard Order Ticket provides traders with a platform to specify, send and execute 

orders. The tickets let the trader easily and quickly choose: symbol/ticker; quantity; price; 

trade type (e.g., market, limit, market on close, etc.); time in force (day order, fill or kill, 

immediate or cancel); and portfolio/account.  An Order Ticket will allow a trader to choose 

whether he wants to buy or sell, and can be tracked (linked) to the Equity Quote Cube. 

The Report Trade Ticket, Adjust Position Ticket, and the Staged Order Ticket are 

order tickets with specifically defined roles. 

 

 

 

 
Launch the Order Ticket 
 
Issue an Order with the Order Ticket 
(Equity Mode) 

 
Issue an Order with the Order Ticket 

(Options Mode) 

 
Shortcuts to Manual Inputting Bid, 
Ask, Mkt Amounts 

 
Configure the Order Ticket 
 
Toggle Between Equities and Options 

 

Position Data 

 
Templates 

 
Quotes Dialog  
 
Tool Tips 

 
Advanced Mode 

 
Stop Limit and Stop Market 
Orders in Advanced Mode 
 
Toggle Symbol Tracking 
 

 

 

The Report Trade Ticket 

 
The Report Trade Spread Ticket 

 

The Report Trade Crossing 

Ticket 

 
The Adjust Position Ticket 

 
The Staged Order Ticket 

 
The Smart Ticket 

 
Flex Ticket 

 

 

 

 

Launch the Order Ticket 

   

From the WTP Toolbar select Trade-->Order Ticket. 

 

Alternate Method: 
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From the WTP menu select Order Ticket. 

     
Issue an Order with the Order Ticket (Equity Mode)  
   
The following fields must be filled before the Order Ticket can issue an order: 

 

SYM— From the drop-down list select a symbol 

 

QTY— Either the quantity of securities to buy/sell or select a round-number in one-

hundred share increments with the up/down arrows. 

 

RTE— From the pull-down menu select a previously-defined route for the order 

 

PORT—From the pull-down menu select a portfolio (previously defined in the Configure 

Order Ticket window). 

 

TIF (Time in Force)—Select one of the following from the pull-down menu: 

CLS (Close) An order is executed as close as possible to the closing price of a 

security. All or any part of the order that cannot be executed at the closing price 

is canceled. 

 

DAY A Day order is canceled if it does not execute by the close of the trading 

day. 

 

FOK (Fill or Kill) If the entire FOK order does not execute as soon as it 

becomes available, the entire order is canceled. 

 

GTC (Good Till Canceled) An order to buy or sell that remains in effect until it 

is either executed or canceled; sometimes called an "open order". 

 

GTX (Good Till Crossing) An order to buy or sell that is canceled prior to the 

market entering an auction, or crossing phase.  

 

IOC (Immediate or Cancel) Any portion of the order that is not filled as soon 

as it becomes available in the market is canceled. 

 

OPN (Open) An order is executed as close as possible to the opening price of 

the security. Any part of the order that cannot be executed at the opening price 

is canceled. 

 

TYPE—Select an order type from the pull-down menu: 

 

Ask—places a limit order at the current best ask price 

Bid—places a limit order at the current best bid price 

Last—places a limit order at the current last price 

Limit—places an order at a specified price 

Market—places an order at the current market price 

Mid—places a limit order at the midpoint between the current best ask and best 

bid prices 

Peg Ask 

Peg Bid          Peg orders maintain the price of the order at the requested 

relative price point (not available from all exchanges) 

Peg Last 
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Peg Mid 

 

Px—Price is an increment for relative price types. For all orders except Market orders, 

enter the value in dollars/cents or any combination. The up/down spinners move in one-

cent increments. 

 

Issue an Order with the Order Ticket (Options Mode) 

 

The Order Ticket Options Mode has additional fields that need to be addressed before an 

order can commence: 

 

Sec—Equivalent to SYM in the Order Ticket Equity mode 

 

Exp—Enter an expiration date for the Option (either manually or by using the up/down 

arrows) 

 

Strk—Enter a strike price (either manually or by using the up/down arrows) 

 

Call/Put—Select one 

 

 

Shortcuts to Manual Inputting Bid, Ask, Mkt Amounts 

 

 
 

Click on Bid, Ask, or Last and their respective values will be entered in the Order Ticket Px 

field. 

 

Click MKT and the Px field will be greyed out as the value is dependent on the current 

market price of the security.  

 

 

Configure the Order Ticket 

 

Press the Configure Order Ticket icon  to bring up the configuration window. 

 

Alternate Method: 

  

Right-click in the blank area to the left of the Order Ticket buttons and select 

Configuration.  

   

(Note: There are a few different set of options when accessing the Order Ticket in Option 

mode.) 
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Order Ticket Mode 

 

Select the default mode when the Order Ticket opens, either Equity or Options.  

Check the Advanced box if it is preferable to open the Order Ticket in advanced mode. 

 

Position Display Mode 

  

The position field in the Order Ticket (and  Option Quote Cube and Equity Quote Cube 

order tickets) can be configured to display one of five positions: 

 

1. Global Default (Acct) 

  

2. Firm Position 

  

3. Account Position 

  

4. Portfolio Position 

  

5. Day Position Only 

 

The Account Position reports position adjustments, while Portfolio and Day Position Only do 

not. 
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If the position is unknown or unobtainable, "unknown" will be displayed in the position 

fields. 

  

The Global Default (Acct) position references the Default Position Mode that was 

selected in Global Configuration. 

 

Option Quote Filters 

  

When the Order Ticket is in Option mode, you may select the options exchange(s) to which 

quotes are received. Each Option Quote Filter selection is a toggle button. A recessed button 

indicates that a particular exchange has been selected. A raised button indicates that the 

exchange has not been selected. 

  

Select Fan Out Routes 

  

An order can be distributed across multiple routes (fan out routes). To setup these routes, 

click Select FanOut Routes. 

  

Under Route Configuration, a security, the type of security, and the route are listed. In 

the Route column click on any cell. A drop-down list becomes available and a selection can 

be made. Choose <Fan Out>, and all subsequent orders with this particular security will be 

sent out across multiple routes. 

  

For configuration of Fan Out Routes, see the Route section of the Global Configuration page 

here. 

 

 

Side Types 

 

Show Separate Side Btns—Check this box to display all the selected side types from the 

drop-down list (BYO, BYA, SLO, SLA, etc.) on the Order Ticket. 

  

Show Sides—To display any or all of the available Side Types, choose the Side Type(s) to 

display from the drop-down list. Select <All Sides> box to show all Side Types on the 

Order Ticket.  

 

The Order Ticket supports the following Side Types: 

  

Order Ticket (Equity Mode) Order Ticket (Options Mode) 

BYC (Buy to close) BYC (Buy to close) 

BYA (Auto buy) BYO (Buy to open) 

SEL (Sell long) BYA (Auto buy) 

SLA (Auto sell) SLA (Auto sell) 

SSH (Sell short) SLC (Sell to close) 

SSE (Sell Short Exempt) SLO (Sell to open) 

 

Notes on Side Types 

 

BYC—Generally used for options, but can be used for stocks on a per-route basis. Not 

allowed for futures. 
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BYA—The order will be a BUY if it results in a positive position. The order will be a BYC if it 

results in a zero or negative position. 

   
Note: BYA is enabled for equities only and can only be used if the selected route 

supports equity BYC. 

 

SEL—Equities only, not allowed for futures 

 

SLA—Equities only, not allowed for futures The auto sell side type automatically chooses 

between SEL and SSH based on the current position.  

 

SSH—Equities only, not allowed for futures 

 

SSE—A short sale in which the uptick rule doesn’t apply to the trade, i.e., the trade can go 

through on a down tick as opposed to a standard short sale in which the order has to be 

done on an uptick. 

 

Side Relative Price Types in Order Tickets 

 

An option set in Global Configuration allows side relative prices types in Order Tickets. 

These side relative prices types are: 

 

BASB—Buys the Ask or Sells the Bid. Select BUY and the Order Ticket will send at the ASK 

price. Select SELL and the Order Ticket will send at the Bid price. 

 

BBSA—Same as BASB, except here we Buy at the Ask and Sell at the Bid. Sends limit 

orders at a price determined whether buying or selling a security. 

 

Peg BASB—A Peg version of BASB, implemented at the exchange.  (Note: not available 

from all exchanges).  

 

Peg BBSA—A Peg version of BBSA, implemented at the exchange.  (Note: not available 

from all exchanges).  

 

Snap Side Types to Defaults On Security Change (Equity Mode) 

 

When you change a Symbol in the Order Ticket, default sides types will be displayed in the 

Order Ticket if you check this box. Buy Side Types are BUY and BYC. Sell Side Types are 

SEL SLA SSH. 

 

Snap Side Types to Defaults On Security Change (Option Mode) 

 

When you change a Symbol in the Order Ticket in Option mode, default sides types will be 

displayed in the Order Ticket if you check this box. Buy Side Types are BYC and BYO. Sell 

Side Types are SLC and SLO. 

 

Controls 

  

Show Qty/Px Spinners—If checked, the QTY and Px fields in the Order Ticket will have 

up/down arrows to increase/decrease the value in their respective fields. If unchecked, 

values in each field will have to be manually input. 

  

Show Quick QTY Btns and Show Quick Buy/Sell Btns 
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The Quick QTY Buttons increase the quantity amount in the QTY field with one touch. 

  

The Quick Buy/Sell buttons allow one-touch ordering. In Equity Mode, Buy orders of 100, 

500, or 1,000 shares can be purchased. Sel Orders of 100, 500, and 1,000 share are acted 

upon with one touch. 

  

In Option mode, the Quick QTY Buttons work in the same manner, though the side types 

are different: 

 

 

 
 

 

Use Separate Buy/Sell Btns 

 

 
 

Check Separate Buy/Sell Btns to display both buy and sell buttons in the Order Ticket. 

 

 

Lock Selections 

 

Locks override default settings in the Global Configuration. Global settings such as routes, 

portfolios, price types, etc. can be associated with certain symbols or security types. When 

a symbol is entered, the global settings are called in automatically. If the defaults are to be 

overridden (for example QTY is changed to 500 from the default of 100), and Lock 

Selection is enabled, each symbol that's entered in the Order Ticket will have a QTY value 

of 500. 

 

As an alternative to the configuration window, the lock icon  on the Order Ticket can be 

employed to lock selected fields. 

 

Miscellaneous 

  

Track Symbol Selection—The Order Ticket will change its symbol to match the symbol 

featured in another WTP applet if Trace Symbol Selection is activated. 
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Auto Close on Execute—The Order Ticket will close upon a successful buy or sell order if 

this option is checked. The Order Ticket "auto close" button will be displayed in red if the 

feature is checked. 

  

If it is preferable to enable the auto close button for all Order Tickets, check Auto Close on 

Execute and save the Order Ticket as a default. 

  

  

Portfolio Firms 

  

The firm(s) to which you have access are listed here. Selectively choose which firm(s) are 

made available for selection, or check <All Firms> to have all listed firms available for 

selection. 

  

  

Select a Portfolio 

  

From the list of available portfolios check the name(s) that will be available when you make 

a selection in the Port field in the Order Ticket. 

  

  

Customize Ordering 

  

The Order Ticket can have the listing of portfolios customized into a preferable order. The 

configuration governs the display order in the Order Ticket's portfolio box. 

  

A single or multiple portfolios can be re-ordered at once. 

  

Note: The default ordering of portfolios is alphabetical. 

  

To customize the list of portfolios: 

1. On the Configure Order Ticket window, check Customize Ordering. 

2. Select one or more portfolios you wish to move 

3. Use one of four ordering buttons to move your selected portfolio(s): 

 

 Move the portfolio(s) to the top of the list 

 

 Move the portfolio(s) one position up 

 

 Move the portfolio(s) one position down 

 

 Move the portfolio(s) to the bottom of the list 

4. Click OK to apply your changes.  

 

 

 

Toggle Between Equity and Option Mode 

 

Press the Equity/Option toggle button  to switch from Equity Mode to Option Mode. 
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While in Option Mode, controls including Root, Expiration Date, Strike Price, Call/Put 

selections, and Option control filters. 

 

The current underlying Bid, Ask, and Last values for the selected security are displayed by 

default. 

To return to Equity Mode, click on the Equity/Option toggle button . 

 

 

Position Data 

 

Basic position data is displayed in the Order Ticket— Total Position, Buy/Sell average price, 

and P&L  

 

Templates 

 

Values in the Order Ticket (symbol name, quantity, etc.) can be saved. When the Order 

Ticket is opened, all fields will be populated with the saved values. 

 

Save Order Ticket Template 

 

1. Click the right mouse on the Order Ticket 

  

2. Select Save as Default Template 

 

Learn more about Templates here. 

 

 

Quotes Dialog 
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A quotes dialog table that displays quotes from selected exchanges can be selected in 

Equity or Options mode. 

To launch the quotes window, press the Show Exchange Quotes Dialog button . 

The quotes table will display quotes from the security selected in the ticket. Current quote 

prices as well as the marketability of the quotes are shown. Quotes in green are 

marketable, quotes in yellow are possible. 

 

By default all exchanges are selected in the quotes window. To disable an exchange from 

reporting in the quotes window, uncheck the box in the Enable column in the row of the 

exchange. 

 

 

Tool Tips 

 

 
  

  

 
  

  

  

Trading status tool tips for a selected security are displayed in the Order Ticket, Option 

Quote Cube, and Equity Quote Cube. 

  

View a tool tip by positioning the mouse pointer in the symbol (or security name) field.  

  

For Equity tickets, one of the following tool tips will display: 

  

 Trading Status: Normal 

 Trading Status: Short Sale Restricted 

 Trading Status: Halted 
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 Trading Status: Volatility Pause (i.e., LULD Pause) 

 Stale Data: (unreliable data at the moment) 

  

For Option tickets, one of the following tool tips will display: 

  

 Underlier Trading Status: Normal 

 Underlier Trading Status: Short Sale Restricted 

 Underlier Trading Status: Halted 

 Underlier Trading Status: Volatility Pause (i.e., LULD Pause) 

 Stale Data: (unreliable data at the moment) 

 

 

 

Advanced Mode 

 

 
 

Order Ticket Advanced Mode 

 

Press the Advanced Mode icon to place the Order Ticket in advanced mode. 

 

Advanced Mode defines order controls such as Show Quantity, Stop Types, Discretion, 

Book Only, Sweep, and the ability to add Notes to the Order Ticket. 

 

Shw (Show)—The value entered in this field represents the total desired quantity that 

should be available on an Order book. This number cannot be higher than the QTY amount. 

The default value is equal to QTY. 
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Pg Lmt (Peg Limit)— If an order's price type is Peg Ask, Peg Bid, Peg Last, or Peg Mid, 

it will follow the market and remove the need for the order to be constantly updated. A Peg 

Limit can be set that prevents an order from being executed above or below a specified 

price level. 

 

Disc—The discretionary value by which an order can be filled. For example, if a bid or ask 

price is 95.00 with a discretionary value of $.02, the bid or ask can go as high as $95.02 

and still be filled. 

 

IOC Routes—Also known as Dark Pool Routes, IOC Routes are defined in Global 

Configuration. When IOC Routes is selected, the routes will appear at the bottom of the 

order ticket. An IOC order will be sent to each IOC route, one at a time, attempting to fill 

some or all of the order before the remaining unfilled quantity is sent to the Order Ticket's 

normal route. 

 

IOC routes can be selectively enabled/disabled by checking/unchecking the box near the 

IOC's route name. 

 

Fanout Routes—A Fanout Details grid is displayed in an order ticket if fanout routes are 

selected. The Fanout details grid can be displayed or hid by checking the Fanout Detail 

box. 

 

Individual fanout routes can be enabled/disabled by checking/unchecking the Enable box 

for each route. 

 

Book Only—A limit order to buy or sell is executed in whole or in part. The portion not 

executed is posted in the Book without routing any portion of the order to another market 

center. When checking Book Only an exchange is ordered to not route an order out. Either 

the order will fill something currently on the exchange's book or it will remain on the 

exchange's book. 

  

Sweep—When Sweep is checked, an exchange is instructed to route an order only to fast 

exchanges.  

 

AON (All Or None)—When checked, either an entire order gets filled, or none of it does. 

Partially filling an order is not considered.  

 

Start/Stop—These parameters define the time in which trading can begin and end. (Note: 

Not supported in all exchanges.) 

 

Solicited—An order initiated by a broker after speaking with a client. In a more advanced 

situation (such as a crossing order), a client calls the broker who, in turn, calls other firms 

looking to take an interest in the other side of the trade. If a seller is found for the client's 

buy order, this side of the order is considered solicited because the broker solicited the 

other side of the trade. 

 

Unsolicited—An order initiated by the client requesting the broker to buy or sell. 

 

Covered (Order Ticket in Options mode)—Options bought/sold when the buyer/seller is 

holding an equivalent position in the underlier. A transaction is considered "covered" when 

the buyer/seller can, when necessary, deliver stock from the sale of currently held options. 
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Uncovered (Order Ticket in Options mode)—Options bought/sold when the buyer/seller has 

no offsetting position in the underlier. 

 

Loc ID—Short for Locate ID, this field is used as part of SEC Regulation SHO for short 

sales. This regulation includes a new uniform requirement for broker-dealers to locate 

securities available for borrowing prior to effecting a short sale. Both numbers and letters 

can be used in a Locate ID, but there is a 16-character limit. 

 

Note—If checked, a note will be attached to the ticket. Type in the note in the empty text 

field. 

 

 

Stop Limit and Stop Market Orders in Advanced Mode 

 

 
 

Stop Market Orders are similar to market orders, in that they are orders to buy or sell a 

contract at the best available price, but they are only processed if the market reaches a 

specific price. Stop Limit Orders are a combination of stop orders and limit orders. Like 

Stop Market Orders, they are only processed if the market reaches a specific price, but they 

are then processed as limit orders, so they will only get filled at the chosen price or a better 

price if there is one available. 

 

The order types Stop Lmt and Stop Mkt are available only when the Order Ticket is in 

advanced mode. 

 

 

Toggle Symbol Tracking 

 

The Order Ticket auto-populates with the symbol that has been selected in another WTP 

applet. Learn more about Toggle Symbol Tracking here. 

 

The Report Trade Ticket 

 

The Report Trade Ticket looks similar to the standard Order Ticket, but is used in 

reporting external orders. It is launched from the Order Grid. 

 

Learn about the Report Trade Ticket here. 



WTP Applets  Order Tickets 

171 © 2014 Wolverine Execution Services, LLC 

 

 

The Report Trade Spread Ticket 

 

 
  

This ticket can be launched from the following: 

  

 The Spread Ticket (by selecting the Report Trade Spread Ticket button ) 

 The WTP drop-down menu. Select Report Trade Spread Ticket 

 The WTP Toolbar: Manage-->Report Trade Spread Ticket 

  

Its function is the same as the Report Trade Ticket, but is used in reporting spread-based 

orders. 

 

The Report Trade Crossing Ticket 
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Report Trade Crossing Ticket in Equity and Option mode 

 

The Report Trade Crossing Ticket allows for the reporting of external crossing equity or 

option trades, similar to the Report Trade Ticket. 

The ticket can be launched as follows: 

 From the WTP drop-down menu, select Report Trade Crossing Ticket 

 From the WTP Toolbar: Manage-->Report Trade Crossing Ticket 
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The Adjust Position Ticket 

 

The Adjust Position Ticket is a permissions-based ticket allowing for changes in a 

position. It is launched from the Position Grid.  

 

Learn about the Adjust Position Ticket here. 

 

 

The Staged Order Ticket 

 

 
 

A staged order is, in essence, a queued order representing an intention to trade shares, 

contracts, or spreads by the end of the trading day. New orders for the same symbol can be 

attached to the staged order resulting in a reduction of the staged order's amount. For 

example, a BUY order for 100 shares is staged. Later during the day, a new BUY order of 20 

shares for the same symbol is filled. The Order Grid will report that 80 shares remain to be 

purchased in the staged order. 

 

Staged orders are entered with a Staged Order Ticket (above).  Similar to the standard 

Order Ticket, a Staged Order Ticket can be setup for equity or option orders. 

 

A Staged Order Ticket can be used for spread orders and is found in Spread Builder. 

 

 

Launch the Staged Order Ticket from the Standard Order Ticket 

 

Select the Staged Order Ticket icon to switch the standard Order Ticket to the Staged 

Order Ticket. 

 

 

Launch the Staged Order Ticket from the WTP Toolbar 

 

From the WTP toolbar, select Trade-->Staged Ticket. 

 

Alternate Method: 

 

From the Launch menu select Staged Ticket. 

 

 

Configure Staged Order Ticket 

 

The Staged Order ticket is configured in the same manner as the standard Order Ticket. 

Portfolios as well as portfolio firms can be selected. 
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The Smart Ticket 

 

 
 
The "Send To" menu 
 

 

Selected grid data from a WTP app (i.e., Option Quote Cube, Equity Imbalance Viewer, or 

Quote Grid to name a few) can be sent to a number of different tickets and apps via the 

send to--> feature. The send to--> command is found in the Action column of most apps, 

or by right-clicking in an app's grid. 

 

The send to--> option Smart Ticket opens a ticket specific to the data it receives. The 

ticket could be a regular Order Ticket, Spread Ticket, Crossing Ticket, or Staged Ticket. 

 

For example, selecting a single row in Option Quote Cube and sending it to the Smart Ticket 

opens a standard Order Ticket in Option mode. If multiple rows are selected in Option Quote 

cube and sent to the Smart Ticket, a Spread Ticket will open. The selected rows become the 

legs of the Spread Ticket. 

 

Once grid data is sent to the Smart Ticket, all other ticket selections will be unavailable in 

the send to--> menu. Conversely, if an order is sent to a non-smart ticket, the Smart 

Ticket will be unavailable in the send to--> menu. 

 

You can, however, change a created Smart Ticket from the resultant ticket's menu bar. For 

example, if a Smart Ticket creates an Order Ticket in option mode, the ticket can be 
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changed to a Staged Ticket or Crossing Ticket, but cannot be changed to an equity Order 

Ticket. 

 

 

 

 

Flex Ticket 

 

 
  

Flex Ticket (System Default Template) 

  

  

FLexible EXchange (FLEX) options are customized equity or index option contracts that 

provide investors with the ability to customize key contract terms including strike prices, 

exercise styles and expiration dates of up to ten years from the trade date; with the 

transparency, administrative ease and clearing guarantees of standard listed options. 

  

The Flex Ticket allows traders the ability to customize key terms (i.e., exercise price, 

expiration date) for equity or index option contracts. 

  

  

Launch Flex Ticket 

From the WTP Toolbar select Trade-->Flex Ticket. 

  

Alternate Method: 

From the WTP menu select Flex Ticket. 

  

  

Configure Flex Ticket 

  

Select the Config button  to open the configuration window. 

  

Alternate Method: 

  

From the Config menu select Configuration 
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In the Flex Ticket tab: 

  

Clear On Execute—All legs of a flex ticket order will be removed once an order has been 

executed. 

  

Enable Side Type Row Coloring—Check this box to display the Buy side in one color and 

the Sell side in another. The colors for Buy and Sell are configured in Global Configuration, 

in the theme window.  

  

  

  

The Status Bar 

  

Status Bar—When selected, the current time is displayed on the bottom-right corner of the 

Flex Ticket. 

  

  

Flex Type Field 

  

The Flex Type defines whether the leg of a FLEX order is traded American or European. The 

AM/PM designation refers to the time of the settlement. 

  

Also, in the Root field, a number is now added to the front of the root symbol. For Index 

options: 

  

1 = American exercise, AM settlement 

2 = European exercise, AM settlement 

3 = American exercise, PM settlement 

4 = European exercise, PM settlement 

  

All Equity options are PM settled. Their numbers refer to the following: 

  

1 = American exercise 

2 = European exercise 

  

The balance of a Flex option's symbol matches that of other standard options symbols 

(underlying, expiration date, option type (call/put) and strike price). 

  

  

Spread Book Exchange for Flex Orders 

  

CFLEX spread book exchange permission is required for FLEX orders. 
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Position Grid 

Position Grid allows you to view accumulated positions by portfolio, account, or firm. 

 

 

 

 
Launch Position Grid 

 
Configure Position Grid 

 
Configure Position Grid to 

Display Underlier Quote Data 

 
Adjust Position 

Show Alert Columns 

 
Cancel Position Orders, Cancel All Orders, 
Cancel Matching Orders 

 
Launch Order Grid 

 
Tabs 

Templates 

 
Export Grid Data 

 
Copy, Copy Cell 

 
Printing 

 
 

Launch Position Grid 

 

From the WTP toolbar select Manage-->Position Grid. 

 

Alternate Method: 

 

From the WTP menu select Position Grid. 

 

Configure Position Grid 
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Open The Configure Window 

 

Open the Configure window by clicking on the configuration icon  

 

Alternate Methods: 

 

 From the Config menu select Configuration 

  

 Right-click the mouse anywhere in the grid and select Configuration 

 

Position Mode 

 

The Position Grid can be configured to report on each type of position collection.  

 

When a Position Mode is selected, additional options are available to customize the 

reporting: 

 

 Portfolio—check the desired portfolio(s), or <All Portfolios>  

  

 Account—check the desired account(s), or <All Accounts> 

  

 Firm—check the desired firm(s), or <All Firms>  

  

 Wave—check the desired wave(s), or <All Waves> 

 

Filter By 

 

The data displayed in Position Grid is filtered by one of two selectable methods: 



WTP Applets  Position Grid 

179 © 2014 Wolverine Execution Services, LLC 

 Intersect—Position Grid will display all orders that match the Security Name, 

Security Type, User, Side, etc., i.e.,  orders that match all of the selected filters. 

  

 Union—Position Grid will display all orders that match the Security Name or Security 

Type, or User, or Side, etc., i.e., orders that match any of the selected filters. 

 

Security and Sec Type 

 

From the drop-down lists select one or more securities and security types. 

 

Select <All Securities> and <All Types> to quickly choose all securities and types. 

 

Show Display Options 

 

Check the box next to the following view options in Position Grid: 

 

 Options Columns—Strike, expiration date, and other options-related columns 

  

 Only Open Positions—Stocks or equities that are owned 

  

 Only Executed Positions—Executed position data 

  

 Aggregate Positions—Adds rows to display the cumulative position of a 

portfolio/account/firm/ or wave. Three asterisks (***) will be displayed in the 

Symbol column for each portfolio. 

  

 Position Summaries—Grouped either by Entity (i.e., account names) or Symbol 

 

Group By Entity—In the Portfolio column, a button for each portfolio will be listed. 

The PNL column will display the total profit/loss for each portfolio. 

 

Group By Symbol—In the Symbol column, a button for each symbol will be listed. 

The PNL column will displays the profit/loss for each symbol. 

 

Group Color—Either position summary rows can be displayed in any desired color. 

Press the rectangular color box to open a color window. Select an existing color or 

define a custom color. 

 

Columns and Formatting 

 

Learn how to set up columns and define formatting here. 

 

Configure Position Grid to Display Underlier Quote Data 
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Ask column displaying Option quotes 

 
 
Ask column displaying underlier quote data 

 
The Position Grid can be configured to display underlier quote data (bid/ask/last/vol) instead 

of, or in conjunction with, Option data. 

 

There are two different methods for displaying underlier values: 

 

Method 1: Set Column Style for the Quote column 

 

1. Right-click on the header of the column and select Set Column Style. 

  

2. Check the box Use Alternate Display. 

 

In the image below, the "Ask" column is configured to display underlier data. 

 

 
 

3. Press OK to close the style window. 

 



WTP Applets  Position Grid 

181 © 2014 Wolverine Execution Services, LLC 

Method 2: Create a User Defined "Numeric Expression" Column 

 

With this method, a user defined column is created and an expression is entered that will 

display the underlier quote data. 

 

The benefit of this method is that an underlier data column can exist in the same grid as the 

Option data. 

 

1. Open the configuration window from the Position Grid 

  

2. Select the Columns and Formatting tab. 

  

3. Select User Defined Fields. 

  

4. Double-click on <Numeric Expression> to add it to the visible columns (or select 

<Numeric Expression> and press the right arrow). 

  

5. In the Visible Columns section, double-click on <Numeric Expression> (or select 

<Numeric Expression> and press Set Column Style). The <Numeric 

Expression> style window will open. 

  

6. Enter a display title and expression. The title should reflect the type of quote data to 

be displayed. 

 

The expression is entered in the following format: 

 

[Alt: name of quote data column] 

 

In the example below the Ask quote data column is defined in the expression. 
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7. Press OK to close the column style window and add the new column to the Position 

Grid. 

 

 

Adjust Position 

 

An adjustment can be made to any position via a special Order Ticket. 

 

Note: Position adjustments can be executed by those with the proper client permission. 

 

To adjust a position: 

 

Press the Adjust Position icon  

 

Alternate Methods: 

 From the Action menu, select Adjust Position. 

  

 Right-click in the Position Grid and select Adjust Position. 

 

Note: If a row in the Position Grid is highlighted prior to selecting Adjust Position, its 

symbol will automatically be placed in the Adjust Position Ticket. 

 

Show Alert Columns 

 

An ALERT column can be added to the Position Grid. When activated, the Alert column will 

display the button Alert next to each symbol in the grid. 

 

Press the Alert Columns icon  to display the Alert button and the Enable check box. 

 

Alternate Methods: 

 

 From the Config menu, select Show Alert Columns. 

  

 Right-click in the Position Grid and select Show Alert Columns. 

 

Alert Button Colors 

 

The Alert button will change colors reflecting the status of the button's underlying settings. 

The display colors of the Alert button are: 

 green—The Alert button is active 

  

 yellow—The Alert button is inactive 

  

 red—The criteria for the Alert button has been met 

  

The Enable check box column (next to the Alert button) turns the Alert for the its row on 

and off. 

  

See Set Row Color Conditions for instructions in using the configuration window. 

 

Cancel Position Orders, Cancel All Orders, Cancel Matching Orders 
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Live orders can be canceled in Position Grid, either selectively or completely. 

 

Cancel Position Orders 

 

1. Highlight the row containing the position to be canceled by clicking on it. 

  

2. Press the Cancel Position Order icon . 

 

Alternate Methods: 

 

 Right-click on the row containing the position to be canceled and select Cxl 

Selected Position Orders. 

  

 From the Action menu select Cxl Selected Position Orders. 

 

Cancel All Orders 

Press the Cancel All Orders icon . 

 

Alternate Methods: 

 

 Right-click anywhere in the grid area and select Cancel All Orders. 

  

 From the Action menu select Cancel All Orders. 

 

Cancel Matching Orders 

 

All orders for a specific symbol, or all orders in an account or portfolio can be canceled. 

 

1. Right-click on a row whose order is to be deleted. 

  

2. Select Cancel Matching Orders --> and one of the following: 

 

 Cancel All For Symbol ___ 

  

 In Account ___ 

  

 In Portfolio ___ 

 

Alternate Method: 

 

Click on the row whose order is to be deleted. 

 

From the Action column select Cancel Matching Orders continue with step #2 

above. 

 

Launch Order Grid 

 

The Order Grid is launched whenever a row in the Position Grid is double-clicked. The 

Order Grid opens with the selected position. 

 

Alternate Methods: 
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 Select a row in the Position Grid and click on the Order Grid icon . 

  

 Right-click on a row in the Position Grid and select Send To --> Order Grid. 

  

 Select a row in the Position Grid and from the Action menu select Send To --> 

Order Grid. 

  

Tabs 

 

Learn how to create, edit, and position tabs here. 

 

Templates 

 

Position Grid configurations can be saved as templates. 

 

Learn about templates here. 

 

Export Grid Data 

 

Data in the Position Grid can be exported to a file, clipboard, or Excel spreadsheet. 

 

Learn about exporting grid data here. 

 

Copy, Copy Cell 

 

The Copy command copies all the symbol names in the Position Grid. The Copy This Cell 

command copies a selected cell. 

 

To Copy: 

 

1. Select one or more rows. 

  

2. From the Action column select Copy. 

 

Alternate Methods: 

 

 Right-click on the highlighted rows and select Copy. 

  

 Press Ctrl +c after highlighting the row(s) 

  

 Press the copy icon   after highlighting the row(s) 

 

To Copy a Cell: 

 

1. Click on the cell to be copied. 

  

2. From the Action menu, select Copy This Cell. 

 

Alternate Methods: 

 

 Right-click on the cell to be copied, and select Copy This Cell. 
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 Click on the cell to be copied and type Ctrl +c. 

  

Printing 

 

Learn the basics of printing a WTP applet here.
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Quote Grid 

The Quote Grid allows you to view real-time streaming quotes for equities, options, and 

futures. 

 

 

 
Requirements 
 
Launch the Quote Grid 

 
Configure the Quote Grid 

 
Available Columns 

 
Fit all Columns to Window 

 
Set Grid Default Style 

 
Set Row Color Conditions 

 
Grid Line Style 

Highlight Period 

 
Symbol Lists 

 
Show Select View 

 
Show Alert Columns 

 
Arrange Columns 

 
Left, Right, Center Format 

 
Sort Column Data 

 
Column Totals 

Export Grid Data  
 
Send Quote Grid Data to Other    
WTP Applets 

 
Place an Order from the Quote 
Grid 

 
Cancel Orders from the Quote 
Grid 

 
Show Options Columns 

 
Lock the Quote Grid 

 
Print Grid Data 
 

 

 

Requirements 

 

A valid market data login is required along with default quote services. For more information 

about setting up Quote Services click here. 

 

 

Launch the Quote Grid 

 

From the WTP toolbar, select Analyze-->Quote Grid. 

 

Alternate Method: 
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From the WTP menu select Quote Grid. 

 

 

Configure the Quote Grid 

 

To launch the Configuration window 

 

Press the configuration icon . 

 

Alternate Methods: 

 

 Click the right mouse button anywhere in the grid and select Configuration. 

  

 From the Config menu select Configuration. 

  

 

Available Columns 

 

In the Available Columns portion of the Configure Quote Grid window are the list of 

available columns that can be placed in the Quote Grid. 

 

Add available columns to the Quote Grid: 

 

1. Click on the + character next to Quote Fields, Quote Grid Fields, or User 

Defined Fields to reveal the available columns under each heading. 

  

2. Double click on a field name to place it on the Quote Grid or click once on a field 

name and click the right arrow. 

 

The field name will be placed in the Visible Columns portion of the Configuration widow 

(and in the Quote Grid if selections are saved). 

 

Remove columns from the Quote Grid: 

 

1. Select any column name in the Visible Columns portion of the Configuration 

window. 

  

2. Click the left arrow to remove the column name.   

   
Fit All Columns to Window 

 

If the Fit All Columns to Window box is checked, the columns will be equally spaced to 

the width of the Quote Grid window.  

 

  

Set Grid Default Style 

 

See Columns and Formatting for information on setting up grids. 

 

 

Set Row Color Conditions 

 

Click here for instructions on setting Row Color Conditions. 
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Multiple Conditions 

 

You may have multiple conditions for the same symbol. 

 

For example, a row color condition can be set for the same expression as one that has 

been previously defined yet display a different color for a condition or target value that 

differs from the first configuration. 

 

Also, the same security can have different expressions. 

 

Select ALL Securities for Row Color Conditions 

 

To select all securities for a row color condition, click your mouse in the Security field. 

Press the down arrow and choose <ALL>. 

 

Alert Priority 

 

1. Choose a priority (Low, Medium, High, Off) for the alert. 

  

2. Click on the Global Configuration icon  to select a sound (in the form of a .wav 

file). The Global Configuration window will display. The Notifications tab will be 

selected. 

  

3. Select the row corresponding to the Alert Condition defined in Step #1. 

  

4. From the drop-down list, select a .wav sound that will play when the row condition 

has been met. To select a .wav file not in the drop-down list, click Browse and 

select a file from your system. 

  

5. Click OK to accept your selections and close the window, or Apply to accept your 

selections and keep the window open, or Cancel to close the window without saving 

your selections. 

  

Note:  Log Severity reporting can also be defined from this window. See the Global 

Configuration Help page for more information on Log Severity reporting.   

  

 

Grid Line Style 

 

Select one of four grid line styles for the Quote Grid: 

 Solid 

 Dashed 

 Dotted 

 None (no grid lines) 

 

Highlight Period 

 

When a cell is updated, it gets highlighted and eventually fades from the highlight color to 

the background color. Highlight Period specifies the length of time until the fade out 

completes. 
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Symbol Lists 

 

A Symbol List is the user-defined list of symbols that are being viewed in a Quote Grid. For 

example: A Symbol List called DOW might contained only those symbols related to DOW 

industrials.  

 

Display the symbols in a Symbol List in the Quote Grid 

 

Click on a Symbol List name. Symbol Lists are displayed on the left side of the Quote Grid. 

Only one Symbol List at a time can be seen in the Quote Grid. 

 

Create and Save a Symbol List 

 

1. Click the File menu. Select New Symbol List. By default this list is called "New 

Symbol List." 

 

Alternate method: 

 

Click the right mouse button anywhere in the Quote Grid. Select File Commands --

> New Symbol List.  

  

2. In the Symbol column of the Quote Grid, either type in a symbol or select one from 

the drop-down list. 

  

3. Continue adding symbols as required. 

  

4. To save the Symbol list as a file on your computer, click the File menu and select 

Save Symbol List. Choose a name for the Symbol List and the appropriate directory 

to store it.  

 

Alternate methods: 

Select the Save Symbol List icon . 

 

Click the right mouse button anywhere in the Quote Grid. Select File Commands --

> Save Symbol List.  

 

Remove a Symbol List 

 

Click on the Symbol List name with right mouse button and choose Remove. 

 

Load a Saved Symbol List 

 

In the Quote Grid select File Commands --> Open Symbol List. Double-click on a Symbol 

List file (designated with a .bsm extension).  

 

 

Show Select View 

 

You can display your Symbol Lists with Show Select View option. The Quote Grid's default 

view displays the Symbol Lists. 
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To display (or remove) Symbol Lists, click the right mouse button on the Quote Grid. Select 

Show Select View.  

 

 

Show Alert Columns  

 

An ALERT column can be added to the Quote Grid. When activated, the Alert column will 

display the button Alert next to each symbol on the Quote Grid. 

 

The Alert button will change colors that reflect the status of the button's underlying settings. 

The display colors of the Alert button are: 

  

 green—The Alert button is active 

  

 yellow—The Alert button is inactive 

  

 red—The criteria for the Alert button has been met 

  

The Enable check box column (next to the Alert button) turns the Alert for the its row on 

and off. 

  

See Set Row Color Conditions for instructions in using the configuration window. Unique 

in the configuration widow for Alert Columns is the Aggregate check box, that causes an 

alert to be raised only when all conditions are satisfied. If unchecked, an alert is raised 

when any condition is satisfied. 

 

 

Arrange Columns 

 

Columns in the Quote Grid can be arranged in any desired order. 

 

To rearrange columns in the Quote Grid: 

 

1. Click on the column head of the column that is to be moved.  

  

2. With the left mouse button depressed, move the mouse left or right and position the 

column accordingly. 

 

Left, Right, Center Format 

 

To view a column's data in either flush left, right, or center: 

 

1. Click on a column head with the right mouse button. 

  

2. Choose Left Justify, Right Justify or Center Justify. 

 

The data in the column will be formatted to match the selection. 

 

Sort Column Data 

 

The data in any column can be sorted either ascending or descending. Additionally, a real 

time sort can be configured. 
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Sort data ascending or descending: 

 

1. Double click on the column head of the column to be sorted OR click on the column 

head with the right mouse button. 

  

2. Double click on the column again to reverse the view (either ascending or 

descending), OR with the right mouse button, select either Sort Ascending or Sort 

Descending or Real Time Sorting. 

 

Real Time Sorting can be detrimental to performance when large or rapidly updating 

data sets are in use. 

 

Column Totals 

 

Similar to a spreadsheet program, the data in a column can be acted upon to display the 

total of all symbols, the average value of all symbols, or the median value. 

 

View Column Totals 

 

1. Select a column by clicking on its column header. 

  

2. With the right mouse button, select Show Total (the sum of column data), Show 

Average (the average value of column data), or Show Median (the middle-most 

value of the column data) 

 

The result of Step #2 will be displayed on the Quote Grid below the selected column. 

  

Export Grid Data 

 

The data contained in the Quote Grid can be exported: 

 

 As a file 

  

 To the clipboard 

  

 To a Microsoft Excel spreadsheet 

 

Export Grid Data: 

 

1. Anywhere in the body of the Quote Grid click the right mouse button. 

  

2. Select Export Grid Data. 

  

3. Select a destination for the exported data. 

 

Export to File—Enter a path and filename for the exported file. 

 

Copy to Clipboard—Select this and the data will be available in clipboard. 

 

Export to Microsoft Excel—Select this and Excel will open and the Quote Grid data 

will be loaded. 
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4. Select the data to export: 

 

Selected Range vs. Entire Grid—Selected Range refers to an area highlighted by 

the mouse. Entire Grid refers to all rows and columns of the Quote Grid. 

 

Include Column Titles—Check this box if the grid's Column Titles should be 

exported. 

 

Include Row Numbers—Row numbers will be a part of the exported file if this 

option is checked. 

  

5. An option to Strip Commas from Numeric Fields and a Field Delimiter selection 

becomes available if Export to File or Copy to Clipboard has been selected, . 

 

To remove the commas from fields with numbers, check this box. 

 

Select either Comma, Space, or Tab to identify the delimiter that will be used 

between fields. 

  

6. Click OK. 

 

 

Send Quote Grid data to Other WTP Applets 

 

The data in the Quote Grid can be sent to these WTP applets: 

 

Order Grid, Equity Quote Cube, Option Quote Cube, Equity Time and Sales, Option 

Time and Sales, Managed Orders, Position Grid, and News Browser. 

 

Send the data in the Quote Grid 

 

1. With the right mouse button, click on a row in the Quote Grid corresponding to the 

symbol you wish to send. 

  

2. Select Send to --> and the name of the applet. 

 

The selected applet will open. 

 

 

Place an Order from the Quote Grid 

 

To bring up the Order Ticket and place an order, click your mouse on a row of the symbol 

you wish to trade. Then: 

 Double click anywhere on the row containing the symbol. 

 

Alternate Methods: 

  

 Type Ctrl +n. 

  

 Right-click the mouse button and select New Order.  

 

Cancel Orders from the Quote Grid 
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Orders can be selectively or collectively canceled from the Quote Grid. 

 

Selectively cancel an Order from the Quote Grid: 

 

1. Click on the row that has an open order. 

  

2. Type Ctrl +z or click the right mouse button and select Cxl Orders for Symbol: 

(symbol name). 

  

Cancel all orders from the Quote Grid 

 

1. Click the right mouse button anywhere in the Quote Grid. 

  

2. Select Cancel All Orders.  

 

Show Options Columns 

 

Columns specific to Options trading can be displayed in the Quote Grid. 

 

Show Options Columns: 

Select the Options Columns icon . 

 

Alternate Methods: 

 

Right-click in the Quote Grid and select Show Options Columns.  

 

From the Config menu select Show Options Columns. 

  

 

Lock the Quote Grid 

 

The Quote Grid can be placed in read-only (locked) mode. This prevents accidental input to 

the Grid. 

 

Lock the Quote Grid 

 

1. Click the right mouse button anywhere in the Quote Grid. 

  

2. Select File Commands --> Read Only Mode. 

 

Print Grid Data 

 

1. To print the Quote Grid click on the grid with the right mouse button.  

  

2. Select File Commands-->Print.
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Spread Book 

Spread Book displays Spread Orders from various exchanges. Viewable information includes 

the Type of Spread, on which exchange the order is found, its Price, Quantity, and Delta, 

and more.  

 

Spread Book is both a standalone applet and an optional pane in Spread Builder. 

 

 

 
Launch Spread Book 

Select One or More Symbols 

The Spread Book Window 

Show or Hide the Security Detail Window 

Create Multi-leg Spread Orders 

Filter Grid 

Spread Types 

Configure Spread Book 

 

Templates 

Export Grid Data 

Printing 
 

 

Launch Spread Book 

 

From the WTP toolbar, select Analyze-->Spread Book. 

 

Alternate Method: 

 

From the WTP menu select Spread Book. 

 

Select One or More Symbols 

 

From the drop-down list select one or more symbols to be displayed in Spread Book. 
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The Spread Book Window 

 

The Spread Book window is divided into three sections: 

 

 SECURITY DETAIL (top)—Bid, Ask, Last, Chg, and VWAP values. 

  

 BOOK GRID (middle)—Summary section for multiple securities. The available 

columns are configurable. 

  

 DETAIL GRID (bottom)—Detailed display of option/underlier data for each leg of a 

selected Spread Order. 

 

Show or Hide the Security Detail Window 

   

Press the Security Detail Icon   to show/hide the Security Detail window.  

 

Alternate Methods: 

 

 From the Config menu select Configuration. Check the Show Security Detail box 

to display the Security Detail. 

  

 Press the Configuration icon . Check the Show Security Detail box to display the 

Security Detail. 

 

Create Multi-leg Spread Orders 

 

Double-click on the row containing the desired Spread Order. This will launch a Spread 

Builder ticket with the legs populated.  

 

The default operation for a double click is a "Take." To "Join" the market, use the Join 

button. 

 

Learn more about the ticket and creating orders in Spread Builder here. 

 

 

Filter Grid 

 

Data displayed in the Book grid can be filtered based on defined criteria. 

 

Click on the filter icon  to open the filter configuration window. From this window define 

one or more expressions with a condition and target value. Once set, the filters are enabled 

by checking the Filters check box on Spread Book. 

 

To the right of the filter icon is the Filter Spread Book on Built Spread icon . Select 

this filter to view unfilled spreads that you created. 

 

Learn about setting expressions here.   

 

 

Spread Types 
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Different spread types are available in Spread Book and are listed in the Type column of the 

Book Grid: 

 

 

Spread 

Type 

 

Definition 

Box 

A dual option position involving a bull and bear spread with identical expiry 

dates. This investment strategy provides for minimal risk. Additionally, it can 

lead to an arbitrage position as an investor attempts to lock in a small return 

at expiry. 

Butterfly 

A strategy combining a bull and bear spread. It uses three strike prices. The 

lower two strike prices are used in the bull spread, and the higher strike 

price in the bear spread. Both puts and calls can be used. 

Buy-

Write 

A strategy that consists of writing call options on an underlying position to 

generate income from option premiums. Because the options position is 

covered by the underlying position, the downside risk of writing the option is 

minimized. 

Calendar 

An options or futures spread established by simultaneously entering a long 

and short position on the same underlying asset but with different delivery 

months. Sometimes referred to as an interdelivery, intramarket, time or 

horizontal spread.  

Condor 

Similar to a butterfly spread, a condor is an options strategy that also has a 

bear and a bull spread, except that the strike prices on the short call and 

short put are different. 

Diagonal 

A strategy established by simultaneously entering into a long and short 

position in two options of the same type (two call options or two put options) 

but with different strike prices and expiration dates.  

Iron 

Butterfly 

A strategy that is created with four options at three consecutively higher 

strike prices. The two options located at the middle strike create a long or 

short straddle (one call and one put with the same strike price and expiration 

date) depending on whether the options are being bought or sold. The 

"wings" (options at the higher and lower strike prices) of the strategy are 

created by the purchase or sale of a strangle (one call and one put at 

different strike prices but the same expiration date). This strategy differs 

from the butterfly spread because it uses both calls and puts, as opposed to 

all calls or all puts. 

Iron 

Condor 

An advanced options strategy that involves buying and holding four different 

options with different strike prices. The iron condor is constructed by 

holding a long and short position in two different strangle strategies. A 

strangle is created by buying or selling a call option and a put option with 

different strike prices, but the same expiration date. The potential for profit 

or loss is limited in this strategy because an offsetting strangle is positioned 

around the two options that make up the strangle at the middle strike prices. 

Married 

Put 

A strategy whereby an investor, holding a long position in stock, purchases a 

put on the same stock to protect against a depreciation in the stock's price. 

Risk 

Reversal 

A hedge strategy that consists of selling a call and buying a put option. This 

strategy protects against unfavorable, downward price movements but limits 

the profits that can be made from favorable upward price movements. 

Straddle 
A strategy with which the investor holds a position in both a call and put with 

the same strike price and expiration date. 
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Strangle 

An options strategy where the investor holds a position in both a call and put 

with different strike prices but with the same maturity and underlying asset. 

This option strategy is profitable only if there are large movements in the 

price of the underlying asset. 

Swap 
The difference between the negotiated and fixed rate of a swap. The spread 

is determined by characteristics of market supply and creditor worthiness.  

Synthetic 

Put 

An investment strategy of short selling a security and entering a long 

position on its call.  

Vertical 

A trading strategy with which a trader makes a simultaneous purchase and 

sale of two options of the same type that have the same expiration dates but 

different strike prices. 

 

 

Configure Spread Book 

 

Press the Configuration icon   to open the Spread Book configuration window. 

 

Alternate Methods: 

 

 From the Config menu select Configuration. 

  

 Right-click anywhere on the Spread Book window and select Configuration. 

 

Spread Book Options 

 

 Show Orders w/Negative Edge—By default, orders with negative edge (i.e., the 

difference between Price and Theoretical) will not be displayed. Check this box to 

view orders with negative edge. 

  

 Show Live Orders—If selected, unfilled (i.e., live) orders are displayed in the Book 

grid. 

  

 Show At Top Always—Working in conjunction with Show Live Orders, if checked, 

the live orders are listed at the top of the Book grid. 

  

 Show Security Detail—If selected, the Security Detail portion of the Spread Book 

window will display. 

  

 Spread Book Exchanges—Check the appropriate box(es) corresponding to the 

exchanges whose book data is to be viewed. For all exchanges, check <All 

Exchanges>. 

 

Book Grid and Detail Grid Options 

 

Column settings and styles are defined in Book Grid and Detail Grid options. 

 

Learn about Columns and Formatting here. 

 

Templates 

 

A Spread Book template is a file with a .spt extension. A configured Spread Book page can 

be saved as a template or default template. 
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Learn about templates here. 

 

Export Grid Data 

 

The data in Spread Book can be exported to a file, clipboard, or Microsoft Excel spreadsheet 

program. 

 

Learn about exporting grid data here. 

 

Printing 

 

The Spread Book window can be printed.  

 

Learn printing details here. 
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Spread Builder 

Spread Builder allows the creation, viewing, and trading of multi-leg Spread Orders. 

Each leg of a spread order is an Option or Equity and defined by a Symbol, Side Type, 

and Ratio. The Spread Order can be created in the Spread Builder Grid and executed 

via the Spread Ticket. 

 

 
 

 
Launch Spread Builder 

Execute a Basic Spread Builder Order 

Display all Expirations 

for a Single Product 

Staged Order Ticket 

Spread BookConfigure Spread 
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The Montage Grid 

The Builder Grid 

Spread Ticket 

Crossing Ticket 

 

Builder 

Templates 

Export Grid Data 

 

 

 

 

 

 

Launch Spread Builder 

 

From the WTP toolbar select Trade-->Spread Builder. 

 

Alternate Method: 

 

From the WTP menu, select Spread Builder. 

 

 

Execute a Basic Spread Builder Order 

 

To execute a Spread Builder order requires the selection of two or more option orders from 

the Option Montage. The selected option orders can consist of all calls, all puts, or a 

combination thereof. 

 

Select two or more spread orders by double-clicking on their rows. 

 

 
 

Each selected spread order is placed in the Legs section of Spread Builder: 

 

 
 

The Spread Builder order ticket adjusts the price based on the spreads in the Legs 

window: 



WTP Applets  Spread Builder 

201 © 2014 Wolverine Execution Services, LLC 

 

 
 

Press Execute to start the order. 

 

 

The Montage Grid 

 

The Montage Grid contains the same Option data for a security as the Option Quote Cube. 

The difference between the two is when an order is selected in the Montage Grid, it is placed 

in the Builder Grid. In the Option Quote Cube, a selected order brings up the Order Ticket. 

 

Display the Montage Grid 

To toggle the display of the Montage Grid, press the Show Montage Grid Icon . 

 

Alternate Methods: 

 

 Right-click anywhere in Spread Builder and select Toggle Option Montage. 

  

 From the Config menu select Toggle Option Montage. 

  

 Select the configuration icon  (from either the Spread Builder toolbar or by right-

clicking anywhere in Spread Builder). In the Spread Builder tab, check Show Option 

Montage Grid to display the Montage Grid. 

 

The Builder Grid 

 

The Builder Grid displays the details for each leg of the current Spread Order including the 

Symbol, Side Type, and Ratio.  Market Values for each product such as Bid, Ask, and Delta 

are also viewable. 

 

Edit in the Builder Grid 

 

Leg Components can be manually edited after inserting a leg.  These include the Symbol, 

Side Type, and Ratio. Additional legs can also be added or removed. 

 

Add Leg 

 

Press Add Leg and a blank leg row is added in the Builder Grid.  

 

Reverse 

 

Press the Reverse button to reverse the side types of the legs (i.e., SLO becomes BYO and 

vice versa). Greeks will adjust accordingly when selecting Reverse. 

 

Clear 
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Press the Clear Legs button to remove all legs from the Builder Grid. 

 

Delete a Leg 

 

Press the Del button on the row featuring the leg to be removed, or press the keyboard 

delete key. 

 

Accurate Hedge 

 

The Accurate Hedge button inserts an Equity leg (or modifies one that already exists) to 

bring the total Delta for the order to 0.  If the Delta is positive then a Sell Equity Leg will be 

inserted.  Conversely, a Buy Leg will be added for negative deltas.  Equity legs are added in 

lots of 100, so the Equity will only be added if the offending Delta is more than 50 (or less 

than -50). 

 

Note: If the legs are close to zero already, selecting Accurate Hedge will have no effect. 

 

Example 1: 3 Legs, all BYO side types before Accurate Hedge: 

 

 
 

After selecting Accurate Hedge, a new leg with a SSH side type is added and the delta is 

rounded down as close to zero (or negative delta) as possible: 

 

 
 

Example 2: 2 Legs, mixed side types. Accurate Hedge command adds an SSH side type with 

a negative delta: 

 

 
 

 

Quotes 
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Pressing the Quotes icon   opens a window containing a grid populated by the prices of 

the spread across various exchanges. 

 

A green row indicates the current order is marketable. A yellow colored row indicates the 

order is possibly marketable. Uncolored rows are not marketable. 

 

Each column in the grid can be sorted. Double-click on a column head to sort. 

 

Press the Quotes icon again to close the grid. 

 

 

Display all Expirations for a Single Product 

  

When a single product is selected in the Option Montage Grid of the Spread Builder, issuing 

the View Expirations for Strike command (by right-clicking in the grid) will launch a new 

window in which data for all expiration dates is displayed. Multiple strike prices can be 

selected before or after issuing the command. 

  

If a different security is selected in Spread Builder, it will be reflected in the View 

Expirations for Strike window. 

  

The newly-launched window responds as other WTP grids in which the Order Ticket can be 

launched when selecting a bid or ask value. Also, the grid data can be exported and the 

send to command can be issued. 

  

Note: Only one option side can be shown at a time. If a call and a put are selected in 

Spread Builder, the View Expirations for Strike window will display the most recently 

selected option side. 

 

 

Spread Ticket 
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Spread Ticket 

 

 

 
Spread Ticket Advanced Mode 

 

 

Spread Builder orders are sent from the Spread Ticket. Similar to the Order Ticket, the 

Spread Ticket allows the user to define the order's Quantity, Price, Price Type, Route, and 

Portfolio as well as various other parameters. The Execute button is colored to reflect 

whether the order is a Credit, Debit, or neutral (gray). Colors for Credit and Debit can be 

modified in the Theme tab of the Global Configuration. 

 

The slider scale is activated for Limit orders and moves in conjunction with the price (Px) 

field. Increments along the scale show the Join price, Mid Price and Take price of a spread. 

 

 The current floating value is displayed on the slider. 

  

 The slider can be moved in three ways:  1. Grabbing and sliding the scale, 2. Clicking 

anywhere on the scale, 3. Adjusting the value in the price (Px) field. 

  

 The price field will display the same value as the slider except when the price 

exceeds the join or take values. 

 

A warning message that the spread may execute immediately will be displayed when 

executing an order where the price exceeds the take value. 

 

Lock Selections 

 

Press the lock icon next to the Qty, Route, Portfolio, or Price Type fields to lock their 

values. 

 

Advanced Mode 

 

Press the advanced mode icon   to place the Spread Ticket in advanced mode. 

 

Alternate Method: 
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 Open the configuration window and click on the Spread Ticket tab. Check the 

Advanced box under Spread Ticket Mode. 

 

In Advanced Mode are five additional fields: 

 

 IOC Rtes—IOC Routes are also known as Dark Pool Routes and are configured in 

Global Configuration under the Routes tab. When IOC Rtes is activated in the 

Ticket, an IOC order will be sent to each of the IOC routes one at a time in an 

attempt to fill the order. 

 

 Note—Check the Note box and leave a text note in the adjacent field. 

  

 Give-up—A transaction between three brokers where one broker hands off a trade 

to a second broker, who then buy the stock from a third. The third broker exercises 

the trade, while the first broker gives up the name of the second broker, even 

though the trade is executed between the first and third broker.  

 

Example: Broker A receives a buy order, but is too busy to handle it. Broker B is 

asked to help fill the order and buys the stock from Broker C. The transaction is 

recorded between Brokers B and C. Broker A, in effect, gives up the name of Broker 

B. The trade, however, is executed between Broker A and Broker C. 

 

Select a Give-up value from the drop-down list. 

  

 CMTA (Clearing Member Trade Agreement)—An agreement where an investor 

trades with a number of different brokers, later consolidating the trades through a 

single broker for clearing. 

  

 Acct Type (Account Type)—Select from Broker Dealer, Customer, Firm, Market 

Maker, or Professional Customer. 

 

Note: Values for Give-up and CMTA are defined by an administrator. 

   

 

Report Trade Ticket 

 

  

 The Report Trade Ticket  is used in reporting external orders.  

  

Launch the Report Trade Ticket 
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Press the Report Trade Ticket icon to display the Report Trade Ticket . 

  

Alternate Methods: 

 

 From the Config menu select Show Report Trade Ticket. 

  

 Right-click in Spread Builder and select Show Report Trade Ticket. 

 

 

 

 

Crossing Ticket 

 

 
 

 

 
 

Crossing spread orders can be achieved with the Crossing Ticket.  Side types are selected 

before issuing a crossing spread. Spread Builder determines if a crossing spread is 

marketable or non-marketable based on a number of factors. 

 

Display the Crossing Ticket 

 

Press the Crossing Ticket icon . 

 

Alternate Methods: 

 

 Right-click in any Spread Builder grid and select Toggle Crossing Ticket. 

 From the Config menu select Toggle Crossing Ticket. 

 

Follow the same procedure to stop displaying the Crossing Ticket. 

 

Create a Crossing Spread Order 

 

1. Broker Side Types 

 

When the Crossing Ticket is active a new column Broker Side Type is added to the Builder 

Grid. The available broker side types are opposite those of the selected legs. 
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If the sides of the selected legs are BUY, the available broker side types will be SELL, and 

vice versa. 

 

2. Crossing Type 

 

Select one crossing type: 

 

 Facilitation—A member or member organization executes a crossing order with an 

order from a public customer. 

  

 Solicitation—An order solicited by a member firm to trade with another order. A 

customer's order is matched with a solicited counter bid or offer. 

  

 Customer Match—An unsolicited crossing type. 

 

3. Facilitation Percentage  

  

The value in this field refers to the percentage that goes to a Broker. If a facilitation order is 

sent, the defined percentage is taken by the Broker and the balance goes to the exchange. 

   

4. Account Type 

 

Select an account type from the drop-down list in the Crossing Ticket. Available account 

types are: 

 

 Broker Dealer 

  

 Customer 

  

 Firm 

  

 Market Maker 

 

Credit/Debit Buttons 

 

There are two sides to a Spread Order. Consequently, there are two sets of Credit/Debit 

buttons that respond to selections on either side (if Order side is a Credit, the Contra side 

will snap to debit and vice versa). 

 

Eligible, Possible, and Ineligible Status Lights 

 

The Crossing Ticket displays the viability of an order in one of three colors (next to the 

Execute button): 

 

 Green—The order is Eligible (Bid < Price < Ask) 

  

 Yellow—The order is Possible (Price = Bid or Price = Ask) 

  

 Red—The order is Ineligible (Price < Bid or Price > Ask) 

 

Staged Order Ticket 
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A staged order in Spread Builder is, in essence, a queued order representing an intention 

to trade spreads by the end of the trading day. A staged order can be viewed and filled in 

the Order Grid. 

 

Launch the Staged Order Ticket 

 

Press the Staged Order Ticket icon to display the Staged Order Ticket . 

 

Alternate Methods: 

 

 From the Config menu select Show Staged Ticket. 

  

 Right-click in Spread Builder and select Show Staged Ticket. 

 

 

Spread Book 

 

 
 

 



WTP Applets  Spread Builder 

209 © 2014 Wolverine Execution Services, LLC 

Spread Book displays Spread Orders from various exchanges. Viewable information 

includes the Type of Spread, on which exchange the order is found, its Price, Quantity, and 

Delta, and more. 

 

Spread Book is both a standalone applet and an optional pane in Spread Builder. 

 

 

Display Spread Book 

 

Press the Spread Book icon . 

 

Alternate Methods: 

 

 Right-click in any Spread Builder grid and select Toggle Spread Book. 

  

 From the Config menu select Toggle Spread Book.  

 

Follow the same procedure to stop displaying the Spread Book. 

 

Select a Spread Order from the Spread Book 

 

 A single click on any row in Spread Brook displays it in the Detail Grid at the bottom 

of the book. 

  

 A double-click performs a Take on the order. 

 

The Builder Grid will be populated with the Spread Order (with its side types and 

price reversed for the take). 

 

Join a Spread 

 

Press the Join button on an order row to join the market (to Buy at the bid price and Sell at 

the ask price). 

 

Configure Spread Builder 
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Press the Configuration icon to bring up the configuration window .  

 

Alternate Methods: 

 

 Right-click in any Spread Builder grid and select Configuration. 

  

 From the Config menu select Configuration. 

 

Spread Builder Configuration 

 

The following Spread Builder options are activated by checking their adjacent box: 

  

Show Security Detail—Displays the security detail. 

  

Track Selected Symbol—See Toggle Symbol Tracking. 

 

Show Spread Book—Displays Spread Book (see Spread Book on this page for details). 

Show Orders with Edge < 0—By default, orders with negative edge (i.e., the 

difference between Price and Theoretical) will not be displayed. Check this box to 

view orders with negative edge (edge < 0). 

 

Enable Book Filter—Filters the Spread Book to only show Spreads containing all Symbols 

currently displayed in the Builder Grid. 

 

Show Live Orders—Unfilled, active orders will display.  

Show At Top Always—Used in conjunction with Show Live Orders, this option 

places live orders at the top of the Montage Grid. 

 

Show Option Montage Grid—Display the Montage Grid. 
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Show Non-Standard Expirations—Non-standard option expirations are displayed. 

 

Show Unusual Strikes—Odd lots and other non-standard strikes are displayed with this 

option. 

  

Display all strikes/Display Only—Select one. For Display only, enter a number to 

coincide.  

 

Display Prices In Basis Points— Check this box to have Spread Builder show prices in the 

grid in basis points. 

 

Enable Side Type Row Coloring—Check this box to display the Buy side in one color and 

the Sell side in another. The colors for Buy and Sell are configured in Global Configuration, 

under the Theme tab. 

 

For other Configuration screens, click here to learn how to setup up grids, columns and row 

color conditions. 

 

Templates 

 

Click here to learn about creating, editing, and using templates. 

 

Export Grid Data 

 

Click here to learn about exporting grid data. 
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Spread Viewer 

 

Multiple spreads can be defined and tracked in Spread Viewer. Each spread is displayed in 

toggled, collapsible, rows where either the spread summary or the names and legs are 

viewable. Each spread can be sent to other WTP applets, most notably Spread Builder 

where a spread can be executed. 

 

 

 
Launch Spread Viewer 

Add a Spread 

Add New Leg to a Spread 

Toggle the View of a Spread 

Accurate/Delta Hedge 

Delete Leg(s) 

Delete Spread(s) 

Quote Dialog 

Launch Order Ticket or Spread 

Ticket From Spread Viewer 

 

 

Send a Leg to the Order Ticket 

Configure Spread Viewer 

Create a Connection between 

Spread Viewer and Other Applets 

Templates 

 

Launch Spread Viewer 

 

From the WTP toolbar, select Analyze-->Spread Viewer. 

 

Alternate Method: 

 

From the WTP menu, select Spread Viewer. 

 

 

Add a Spread 

 

Press the Add New Spread button to add a spread to the Spread Viewer. Two new lines 

(labeled <Leg 1> and <Leg 2>) will automatically be added as follows: 
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Leg parameters are defined on each line of the Spread Viewer grid. 

  

Click on <Leg 1> to define a symbol from the drop-down list. Once a symbol is selected, 

select a side type, an Option command (Put or Call), a strike price, and root symbol. 

  

Once the data has been added, the top row summarizes the symbol, expiration date, option, 

and strike price: 

  

 
  

Continue by defining the parameters of <Leg 2>. 

 

 

Add New Leg to a Spread 

 

Press the Add Leg button to add a leg to the defined spread. 

  

Alternate Method: 

  

Press Insert on the keyboard. 

  

A new row will open below the previous leg with a number that follows the previous leg 

number. Enter leg data (symbol, exp. date, strike, option, root). The top-most row 

summarizes the spread: 
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Additional legs can be appended to the existing spread by following the same procedure. 

  

  

Toggle the View of the Spread 

  

Toggle the top-most row in the Symbol column of a defined spread to reveal or hide the 

spread summary: 

  

 
     
Spread Viewer hiding spread data 

 

 

Accurate/Delta Hedge 

  

 
  

Delta Hedge can be selected instead of Accurate Hedge in a single option leg configuration. 

  

The Accurate Hedge button inserts an Equity leg (or modifies one that already exists) to 

bring the total Delta for the order to zero.  If the Delta is positive then a Sell Equity Leg will 

be inserted.  Conversely, a Buy Leg will be added for negative deltas.  Equity legs are added 

in lots of 100, so the Equity will only be added if the offending Delta is more than 50 (or less 

than -50). 

  

In a single option leg configuration, Delta Hedge can be selected instead of Accurate 

Hedge by pressing the up arrow next to the button. When Delta Hedge is in force, the stock 

leg ratio is changed to 100 (or -100). 
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Note: If the legs are close to zero already, selecting Accurate Hedge will have no effect. 

 

 

Delete Leg(s) 

 

One or more legs can be delete in a single pass. 

 

Delete a single leg: 

 

Click on the leg to be deleted. Press the delete key or the Delete Leg(s) button.  

 

Delete multiple legs: 

 

Hold down the Ctrl key and click on each leg to be deleted. Press the delete key or the 

Delete Leg(s) button. 

 

Delete Spread(s) 

 

One or more spreads can be delete in a single pass. 

 

Delete a single spread: 

 

Click on the row containing the spread. Press the delete key or the Delete Spread(s) 

button. 

 

Delete multiple spreads: 

 

Hold down the Ctrl key and click on each spread to be deleted. Press the delete key or the 

Delete Spread(s) button. 
 

Quote Dialog 

 

 

 

A quotes dialog table that displays quotes from selected exchanges can be viewed by pressing the Quote 
Dialog button. 
 
The quotes table will display quotes from the security selected in the ticket. Current quote prices as well 
as the marketability of the quotes are shown. Quotes in green are marketable, quotes in yellow are 
possible. 
 
By default all exchanges are selected in the quotes window. To disable an exchange from reporting in the 
quotes window, uncheck the box in the Enable column in the row of the exchange. 
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Launch Order Ticket or Spread Ticket from Spread Viewer 

 

Launch Order Ticket from Spread Viewer 

  

Spreads in Spread Viewer can be sent to the Order Ticket where it can be executed. 

  

In the row containing the spread, double-click on the Bid or Ask fields. Order Ticket will 

launch for that leg only. 

  

  

Launch Spread Ticket from Spread Viewer 

  

To launch the Spread Ticket from Spread Viewer, double-click on the spread summary row 

in the Bid, Ask, or Mid fields. 

 

 

Configure Spread Viewer 
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Press the config icon  to open the configuration window. 

  

Alternate Method: 

  

From the Config menu select Configuration. 

  

The available columns in the grid layout are configured in Spread Viewer. 
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Learn more about customizing columns here. 

  

Miscellaneous Tab 

  

Enable Side Type Row Coloring—Check this box to display the Buy side in one color and 

the Sell side in another. The colors for Buy and Sell are configured in Global Configuration, 

under the Theme tab. 

 

Learn more about customizing columns here. 

 

Create a Connection between Spread Viewer and Other Applets 

 

In addition to sending orders to Spread Builder, a connection between Spread Viewer and 

other WTP applets can be created with the Send To--> command. 

 

From the Action column select Send To--> and select the applet. 

 

Learn more about establishing connections here. 

 

Templates 

 

The Spread Viewer grid can be saved as a template or default template. 

 

The File menu contains the template save and call commands. 

 

Learn more about templates here.
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Symbol Browser 

Search for securities by name or symbol in Symbol Browser. Symbols in the grid can be 

sent to populate other WTP applets. Also, customization allows for the addition of quote 

fields.   

  

  

 
  

  

Symbol Browser Requirement 

  

An Activ Quote Connection is required in order for Symbol Browser to search for names 

and symbols. 

  

  

Launch Symbol Browser 

  

From the WTP menu select Symbol Browser. 

  

Alternate Method: 

  

From the WTP toolbar select Explore-->Symbol Browser. 

  

  

Search for Names or Symbols 

  

1. In the Search field, select either Names or Symbols from the drop-down list. 
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2. In the For field enter either the stock Name (e.g., Oracle) or symbol (e.g., Orcl). 

3. Hit enter or press the Search button. 

 

Note: If the columns "Symbol" and "Name" are present in Symbol Browser, both symbols 

and names will be displayed in the grid after a successful search. 

  

  

Search Tips 

 

 Names—Symbol Browser will search for security names if only a portion of the name 

is entered in the For field. A minimum of three letters/numerals is required to initiate 

a search. 

 

For example, a search for gen yields General Electric, General Dynamics, Genco, 

etc. 

 Symbols—Symbol Browser will search for symbol names with a minimum of a single 

character. The limitation of using a single character in a symbol search is that 

Symbol Browser will only display the symbols that exactly match the search criteria. 

 

For example, if searching for the letter A, Symbol Browser returns the symbols that 

exactly match (e.g., Agilent Tech whose symbol is "A" and related symbols "A.EA, 

A.EL, A.OB, but not AAPL). 

 Exact Search—Search criteria enclosed in double quotes returns all names 

containing the enclosed word(s). 

 

For example, a Names search for "Equity" yields Energy Equity Corp., Allegiance 

Equity Corp., Mainstreet Equity Corp., etc. 

  

  

Configure Symbol Browser 
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To launch the Configuration window: 

  

Press the configuration icon . 

  

Alternate Methods: 

 

 Right-click anywhere in the grid and select Configuration. 

  

 From the Config menu select Configuration. 

  

Add/Remove Columns 

  

Learn how to set up columns and define formatting here. 

  

  

Miscellaneous Tab 

  

Check the Sort Equities to Top box to display equity entities at the top of the Symbol 

Browser grid. If unchecked, entities will be listed in alphabetical/numerical order. 

  

  

Sorting Data Within Columns 

  

As with all WTP grids, data within columns can have their alphabetical/numerical order 

changed by double-clicking on a column's head. 
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Place Orders from Symbol Browser with Quote Fields 

   

 
  

Ask column added to Symbol Browser 

  

Adding quote fields (ask, bid, last, etc.) to Symbol Browser offers easy method for creating 

orders directly from the app. 

  

In the image above, real-time quotes are displayed by adding the Ask column. Double-click 

on a quote to open the Order Ticket. The stock symbol and quote will automatically 

populate the Order Ticket. 

  

   

  

Display Entities 

  

The entities that are to be displayed in the Entity column can be filtered. Click on the 

Entity column head and select the entities to be displayed from the drop-down list. 

  

  

Show/Hide the Status Bar 
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In the Config menu, select Status Bar to display the current time and any system 

messages at the bottom of the Symbol Browser window. 

  

  

Send Symbol Browser Content to Other WTP Applets 

  

Symbols in Symbol Browser can be sent to other WTP applets via the Send to command. 

  

From the Action column select Send to-->. Select the applet to send the Symbol. 

  

Alternate Method: 

  

Right-click anywhere in the Symbol Browser grid and select Send to-->.  

  

Learn more about the Send to feature here. 

  

  

Templates 

  

Symbol Browser configurations can be saved as templates. 

  

Learn about templates here. 

  

  

Export Grid Data 

  

Data in the Symbol Browser can be exported to a file, clipboard, or Excel spreadsheet. 

  

Learn about exporting grid data here. 

  

  

Copy, Copy This Cell 

  

The Copy command copies all selected rows. The Copy This Cell command copies a 

selected cell. 

  

To Copy: 

 

1. Select one or more rows. 

  

2. From the Action column select Copy. 

 

Alternate Methods: 

 

 Right-click on the highlighted rows and select Copy. 

  

 Press Ctrl +c after highlighting the row(s) 

 

Note: The copy command copies the selected data and their row numbers and column 

heads. 

  

  

To Copy a Cell: 
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1. Click on the cell to be copied. 

  

2. From the Action menu, select Copy This Cell. 

 

Alternate Methods: 

 

 Right-click on the cell to be copied, and select Copy This Cell. 

  

 Click on the cell to be copied and enter Shift + Ctrl +c. 

  

Printing 

  

The data in Symbol Browser can be printed. 

  

Learn about the printing feature here. 
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Tick Chart Viewer 

Tick Chart Viewer displays charting data for stocks. Various chart types can be configured 

including HLOC (high/low/open/close), Candle Stick, Closing, Median, and Typical prices, 

and Weighted closing. 

 

Configuration consists of beginning and end dates. Real-time charting can be configured as 

well as the time period for reporting trades. Tick Chart Viewer's optional bar graph can be 

setup to display data in increments from one minute to one day.  

 

New orders can be placed and canceled and other WTP applets can be opened via the 

Action menu. 

 

 

 
Launch Chart Viewer 

Select Reporting Days 

Select the Bar Size 

Refresh Button 

Zoom Feature 

Configure Tick Chart Viewer 

Select the Chart Type 

Log Scale 

Chart Type Colors 

Show VWAP 

 

Show Volume Bars 

Show Local Orders 

Show Legend 

Moving Average 

Price Band 

Auto Refresh 

Only Show Trades From... 

Technical Indicators 

Reading Chart and Volume Data 

Save Settings in a Template 

 

Save Chart as an Image File 

Open Other WTP Applets from  

Tick Chart Viewer 

Create and Cancel Orders from 

Tick Chart Viewer 

Launch Equity Time and Sales 

from Tick Chart Viewer 

Toggle Symbol Tracking 

Status Bar 
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Launch Chart Viewer 

 

From the WTP Toolbar, select Analyze then Chart Viewer. 

 

Alternate Method: 

 

From the WTP menu select Chart Viewer. 

 

Select Reporting Days 

 

Select the charting date range in Tick Chart Viewer by one of two methods: 

 

 From the drop-down list of preset dates  

 Manually entering the date range 

 

Press the radio button next to the drop-down list select one of the following: 

 

 Today 

 Week 

 Month 

 3 Month 

 Year 

 YTD (year to date) 

 

To manually enter the from/to dates, press the radio button next to From and type in the 

date range or select the dates from the drop-down list. 

 

Select the Bar Size 

 

The horizontal axis in Tick Chart Viewer reflects incrementally the selection made in the Bar 

Size drop-down list. Select one of the following: 

 

 1 Minute 

 5 Minutes 

 10 Minutes 

 1 Hour 

 6 Hours 

 1 Day 

 

Refresh Button 

 

Press the Refresh Button as often as desired to repaint Tick Chart Viewer data. 

 

Hint: It might be beneficial to lower the Bar Size reporting times to avoid continued use of 

the Refresh button. 

 

Zoom Feature 

 

The zoom function is located on the lower left corner of Tick Chart Viewer. To zoom in on 

the chart, press the + key. A zoom tool in the shape of a magnifying glass will appear in 

the chart. Repeated pressing of the tool brings up a higher level of magnification. When 

zooming in on a chart, horizontal scrolling is enabled. 
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Pressing the — zoom key results in the "zoom out" tool being displayed in Tick Chart 

Viewer. Repeated pressing of this tool causes the chart to reverse its previous zoom level, 

eventually resulting in the original non-zoom display 

 

Configure Tick Chart Viewer 

 

 
 

A number of display options are configured through Tick Chart Viewer's configuration 

window including the chart type, color display, moving average and price band types. 

 

Open the Configuration Window 

 

Press the configuration icon . 

 

Alternate Method: 

 

From the Config menu select Configuration. 

 

Select the Chart Type 

 

Different data is displayed depending on the selected chart. 

 

From the drop-down list select the desired chart type: 

 

 HLOC (High Low Open Close)—default (see the image at the top of this section). 

 

Charted data displayed: 
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Opening, High, Low, and Closing Prices 

Local Buy Orders (optional) 

Local Sell Orders (optional) 

  

 Candle Stick——Charting that displays the following: 

 

 
 

  

  Candle Stick chart  

 

 

 

Charted data displayed: Same as HLOC 

  

 Closing Price—a single line plotted for the closing price of a selected bar size. 

 

Charted data displayed: 

 

Closing Price 

Local Buy Orders (optional) 

Local Sell Orders (optional) 

  

 Median Price—a single line plotted for the median (i.e., mid-point) price of a 

selected bar size. 

 

Charted data displayed: 

 

Median Price 

Local Buy Orders (optional) 
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Local Sell Orders (optional) 

 

  

 Typical Price—a single line plotted for the typical price (i.e., average price) of a 

selected bar size. 

 

Charted data displayed: 

 

Typical Price 

Local Buy Orders (optional) 

Local Sell Orders (optional) 

  

 Weighted Close—a single line plotted for the weighted close of a selected bar size.  

 

The weighted close is calculated as: (High + Low + Close  x  2) / 4 

 

Charted data displayed: 

 

Weighted Close Price 

Local Buy Orders (optional) 

Local Sell Orders (optional) 

 

Log Scale 

 

The default display for Tick Chart Viewer is via the linear scale axis. 

 

Check the Log Scale box to have Tick Chart Viewer display charting data using the 

logarithmic scale axis. 

 

The Log Scale applies only to the price axis. 

 

Chart Type Colors 

 

The line colors displayed in the chart types can be configured. 

 

For the HLOC and Candle Stick Chart types: 

 

Click on either the Uptick Color box (green by default) or Downtick Color box  (red by 

default) to open a color window where a basic color can be selected or a custom color can 

be defined. 

 

For Closing Price, Median Price, Typical Price, and Weighted Close Chart types: 

 

Click on the Line Color box to open the color window where a basic line color can be 

selected or a custom color defined. 

 

Show VWAP 

 

Click the Show VWAP (Volume Weighted Average Price) box to display its charted data. 

 

VWAP Color 
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Click the VWAP Color button to open a color window where a basic VWAP line color can be 

selected or a custom color defined. 

 

Rolling VWAP 

 

A non-rolling VWAP is the default VWAP setting and generally follows the graph data in 

whatever chart type has been selected. 

 

A rolling VWAP is calculated as a weighted average of all VWAPs. 

 

Show Volume Bars 

 

Volume Bars display volume data for a selected stock based on the number of shares traded 

and encompasses the selected date range. The Volume Bars are placed at the bottom of 

Tick Chart Viewer. 

 

By default, the Show Volume Bars box is checked. To not display Volume Bars, uncheck 

this box. 

 

Height of Volume Bars 

 

By default the height of the Volume Bars is 20% (or one-fifth) the size of Tick Chart Viewer. 

 

To increase the size of the Volume Bars key in a percentage value (or select a value from 

the spinner arrows). As a general rule, limit the size of the Volume Bars to 50% of Tick 

Chart Viewer to allow the Volume Bars and Chart Viewer data to be equally visible. 

 

Show Local Orders 

 

Show Local Orders refers to executed orders only. 

 

Check the Show Local Orders box to display Local Sell Orders and Local Buy Orders in 

Tick Chart Viewer. 

 

Show Legend 

 

By default, the legend in Tick Chart Viewer is displayed. Un-check the Show Legend box to 

hide the legend. 

 

Moving Average 

 

Moving averages display an overall trend direction and are normally calculated using a 

stock's closing price. Moving averages can also be determined with median, typical, or 

weighted close prices.  

 

Select a Moving Average Type 

 

From the drop-down list in the Moving Average field, select a moving average type: 

 

 Simple—The average stock price over a certain period of time 

  

 Exponential—Similar to a Simple Moving Average. an exponentially weighted 

moving average gives more credence to a most recent time period (i.e., what trades 
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are doing now). 

  

 Triangular—The triangular moving average gives more weight to the middle values 

of moving average data rather than early or late values. 

  

 Weighted—The weighted moving average is the weighted average of the last 

number of a defined time period. 

 

Select a Moving Average Time Period 

 

Key in a value (or use the up/down spinners) that represent the value of the selected Bar 

Size in which the Moving Average is calculated. For example, if the Bar Size is set for one 

day and the Moving Average period is set for 20, then 20 days are plotted. 

 

Define a Moving Average Line Color 

 

Press the Line Color button to open the color window where a basic color or custom color 

can be defined for the moving average line. 

 

Price Band 

 

One of three price bands (price range which stocks are priced) can be charted in Tick Chart 

Viewer. 

 

Select one of the following price bands from the drop-down list: 

 

 Bollinger Bands—Provide a relative analysis in which graph lines are plotted by two 

standard deviations above and below a moving average. 

A market which approaches an upper band is usually thought of as being overbought 

while a market approaching the lower band is thought of as oversold. 

  

 Donchian Channel—Similar to Bollinger Bands, Donchian Channel performs a 

calculation using only the recent high and low prices (rather than standard 

deviations). 

  

 Envelope—Band envelope consists of moving averages calculated from the 

underlying price that is shifted up and down by a fixed percentage. These averages 

can be simple, exponential, or weighted. 

 

Select a Price Band Time Period 

 

Key in a value (or use the up/down spinners) that represent the number of days in which 

the price band is calculated. 

 

Define a Price Band Line Color 

 

Press the Line Color button to open the color window where a basic color or custom color 

can be defined for the price band line. 

 

Auto Refresh 

 

Check the Automatically Refresh Every box and enter a value (in seconds) to have Tick 

Chart Viewer refresh the chart. 
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If unchecked, Tick Chart Viewer will only refresh when the Refresh button (above the 

chart) is pressed. 

 

The minimum refresh interval is 10 seconds. 

 

Only Show Trades From... 

 

Tick Chart Viewer will show trades only from a specifically defined time period. 

 

Manually key in the start/stop times or use the up/down spinner arrows. 

 

Technical Indicators 

 

There are a number of technical indicators from which to choose. These indicators are 

charted in its own graph below Tick Chart Viewer. Depending on the selected indicator, up 

to three colors are defined. As with all colors in Tick Chart Viewer, they can be customized. 

 

With each indicator are a number of customized fields that are defined. The fields that can 

be edited (those with up/down spinner arrows) are dependent on the selected technical 

indicator: 

 

 Size—The height of the indicator chart in pixels. 

  

 Period (1, 2, 3)—The period to compute the indicator. 

  

 Range—Defined by the chart type. 

  

 Color (1, 2, 3)—The color(s) used to represent a specific indicator line. Each color 

can be customized. 

 

Select an indicator from the drop-down list in the Indicator field.  

 

More than one technical indicator can be simultaneously defined. Each defined technical 

indicator is stacked in its own chart. 

 

 Accumulation/Distribution—Determined by the changes in price and volume. As 

the indicator grows it refers the buying of a security. If it drops it indicates the 

selling of a security. 

  

 Aroon—Used for defining trends. An Up indicator and a Down indicator are 

displayed. 

  

 Aroon Oscillator—The trend stop and start of a sideways trend and is calculated as 

the difference between Aroon Up and Aroon Down. 

  

 Average Directional Index—Determines a price trend (positive, negative, 

average). 

  

 Average True Range—An indicator showing the volatility of the market. 
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 Bollinger Band Width—Represents the expanding and contracting of the bands 

based on market volatility. 

  

 Commodity Channel Index—The deviation of the commodity price from its 

average statistical price (defined with an indicator line, above and below thresholds). 

  

 Chaikin Money Flow—Based on the observation that buying support is normally 

signaled by increased volume and frequent closes in the top half of the daily range. 

Selling pressure is seen by increased volume and frequent closes in the lower half of 

the daily range. 

  

 Chaikin Oscillator—The difference of the moving averages of the 

Accumulation/Distribution indicator. 

  

 Chaikin Volatility—A determination of the volatility of financial data using the 

percentage of change in a moving average of the high vs. low price over a given 

time. 

 

Period 1: The period to smooth the range. 

Period 2: The period to compute the rate of change of the smoothed range. 

  

 Close Location Value—A measure to determine where the price of a stock closes 

relative to the day's high and low. CLV ranges between +1 and -1 where +1 means 

the close is equal to the high and a value of -1 means the close is equal to the day's 

low. 

  

 Detrend Price Oscillator—Used to isolate short-term cycles comparing the closing 

price to a prior moving average. 

  

 Donchian Channel Width—A moving average plotting the highest high and lowest 

low for a set period. 

  

 Ease Of Movement—Highlights the relationship between volume and price changes 

used primarily for assessing the strength of a trend. 

  

 Fast Stochastic—Used to track momentum, two lines are used: %K compares the 

latest closing price to the recent trade range, and %D is a signal line calculated by 

smoothing %K. 

 

Period 1: The period to compute the %K line. 

Period 2: The period to compute the %D line. 

  

 MACD—Moving Average Convergence Divergence. MACD measures the distance 

between two moving average lines and used to trade trends. 

 

Period 1: The first moving average period to compute the indicator. 

Period 2: The second moving average period to compute the indicator. 

Period 3: The moving average period of the signal line. 

  

 Mass Index—Used in the detection of trend turns based on changes in the 

bandwidth between the maximum and minimal price. If the bandwidth expands, the 

Mass Index increases. If it narrows, the Mass Index decreases. 
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 Money Flow Index—An indicator which shows the rate at which money is invested 

into a security and then withdrawn from it. 

 

Range: The distance between the middle line and the upper and lower threshold 

lines. 

  

 Momentum—A measurement of the amount that a security's price has changed 

over a given time span. It is calculated as a ratio of today's price to the price of 

several periods ago. 

  

 Moving Standard Deviation—A measure of market volatility (though it makes no 

prediction of market direction). 

  

 Negative Volume Index—An index that focuses on the days where the volume has 

significantly decreased from the previous day's trading. 

  

 On Balance Volume—An indicator that adds a period's volume when the close is up 

and subtracts the period's volume when the close is down. The concept is that 

volume precedes price. 

  

 Performance—The performance indicator of a selected security. 

  

 Percentage Price Oscillator—A technical momentum indicator showing the 

relationship between two moving averages based on price. 

 

Period 1: The first moving average period to compute the indicator. 

Period 2: The second moving average period to compute the indicator. 

Period 3: The moving average period of the signal line. 

  

 Positive Volume Index—An index that focuses on days where the volume has 

significantly increased from the previous day's trading. 

  

 Percentage Volume Oscillator—A technical momentum indicator showing the 

relationship between two moving averages based on volume. 

 

Period 1: The first moving average period to compute the indicator. 

Period 2: The second moving average period to compute the indicator. 

Period 3: The moving average period of the signal line. 

  

 Price Volume Trend—A technical indicator used to determine the balance between 

a stock's demand and supply depending upon its upward and downward movement. 

  

 Rate of Change—The speed at which a variable changes over a specific time period. 

The rate of change is represented by the slope of the line. 

  

 Relative Strength Index—A technical momentum indicator that compares the 

magnitude of recent gains to recent losses in an attempt to determine overbought 

and oversold conditions of an asset. 

 

Range: The distance between the middle line and the upper and lower threshold 

lines. 
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 Slow Stochastic—An indicator that compares two lines (%K and %D) to predict 

the possibility of an uptrend or a downtrend. The %K value is based on a 3-period 

moving average of the %K fast stochastics value. The %D value is based on a 3-

period moving average of the %K slow stochastics value. 

 

Period 1: The period to compute the %K line. 

Period 2: The period to compute the %D line. 

  

 Stochastic RSI—An indicator that ranges between zero and one and is deemed to 

be oversold when the value drops below 0.20 meaning the RSI (Relative Strength 

Index) value is trading at the lower end of its predefined range.  It also indicates 

that the short-term direction of a security is near to a correction. A reading above 

0.80 is indicative that the RSI is reaching an extreme level and could signal a 

pullback of a security. 

 

Range: The distance between the middle line and the upper and lower threshold 

lines. 

  

 TRIX—Used in determining of overbought or oversold market conditions. A positive 

value indicates and overbought market. A negative value indicates an oversold 

market. 

  

 Ultimate Oscillator—Combines a stock's price action during three different time 

frames. Values range from 0 to 100 with 50 as the center line. An oversold stock 

exists below 30 and an overbought stock extends from 70 to 100. 

 

Period 1: The first moving average period to compute the indicator. 

Period 2: The second moving average period to compute the indicator. 

Period 3: The third moving average period to compute the indicator. 

Range: The distance between the middle line and the upper and lower threshold 

lines. 

  

 Volume Indicator—Displays in the same manner as the volume indicator in Tick 

Chart Viewer. 

  

 William %R—A momentum indicator that displays the relationship of the close 

relative to the high/low range over a defined period of time (usually 14 days). 

 

Range: The distance between the middle line and the upper and lower threshold 

lines. 

 

Reading Chart and Volume Data 

 

The value of each plotted point along a Chart Viewer's x/y axis is viewed by positioning the 

mouse over the graph's line. 

 

Local orders are displayed in the chart. They are designated by a square in one of various 

colors depending on their status. The legend at the top of Tick Chart Viewer defines the 

various states of an order. 

 

Changed  orders are marked with a circle. For non-limit orders that have been changed, 

the order's average price is displayed. 
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Canceled orders that have been partially filled are marked with an X. Canceled orders 

with a zero filled quantity will not be displayed.  

 

For volume data, position the mouse over each bar in the graph for a detailed readout. 

 

 

Save Settings in a Template 

 

Configuration settings for Tick Chart Viewer can be saved in a template. The file will have a 

.hloct extension. 

 

Also, a desired chart can be saved as a default. Template commands are found in the File 

menu. 

 

Read more about templates here. 

 

 

Save Chart as an Image File 

 

 
  

  

The Save Chart As feature allows you to save a chart as an image file in one of the 

following formats: 

 

 bmp 

 png 

 jpg 

 gif 

 

Save a Chart as an Image File: 

  

From the File column in Chart Viewer, select Save Chart As... 

  

Alternate Method: 

 

Right-click anywhere on the chart itself. Select File Commands-->Save Chart As... 
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When the Save As window opens, select a file name, file type, and destination for the chart 

image. 

 

 

 

Open Other WTP Applets from Tick Chart Viewer 

 

Other WTP applets such as the Option Quote Cube via the send to command in the Action 

menu in Tick Chart Viewer.  

 

The only thing that is actually sent to these applets is the security name currently displayed 

in Tick Chart Viewer. 

 

Create and Cancel Orders from Tick Chart Viewer 

 

Press Ctrl+n to open the Order Ticket. 

 

Alternate Method: 

 

From the Action menu select New Order. 

 

Press Ctrl+z to cancel all orders for a specific symbol. 

 

Alternate Method: 

 

From the Action menu select Cancel All for Symbol xxx. 

 

Cancel All Orders 

 

From the Action menu select Cancel All Orders. 

 

Launch Equity Time and Sales from Tick Chart Viewer 

 

Double-click anywhere in Tick Chart Viewer will launch Equity Time and Sales. 

 

Toggle Symbol Tracking 

 

The Toggle Symbol Tracking function is available in Tick Chart Viewer. 

 

When enabled the symbol in Tick Chart Viewer will change depending on the symbol 

selected in other WTP applets. 

 

Learn about Toggle Symbol Tracking here. 

 

Status Bar 

 

The status bar displays the current time and ready status of Tick Chart Viewer. 

 

From the Config menu select Status Bar to enable/disable it. 
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Volatility Chart Viewer 

With the Volatility Chart Viewer the volatility of a security can be displayed in a graph with a 

number of display options. A maximum of three years of charting data is available. The 

volatility is displayed as a percentage (both implied and historical) over a defined time 

period. The selected time along with closing prices and other measurable data can be 

incorporated in the graph. Additionally, the graph data can be saved as a text file or image 

file. 
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Launch Volatility 

Chart Viewer 

Select Charting 

Dates on the X Axis 

Send Symbols to 

Other WTP Apps with 

the "Send To" 

feature 

Templates 

Launch Volatility 

Chart Viewer from 

Option Quote Cube, 

Spread Trader, 

Equity Time and 

Sales, and Vol Trader 

Zoom into the 

Volatility Chart 

Viewer 

Save Chart Image Export Grid Data 

Display Selections 

Overlay Other 

Symbols in the 

Volatility Chart 

Viewer 

Copy Data to 

Clipboard 
Printing 

Median and Average 

Quotes 
Tabs 

Toggle Symbol 

Tracking 
Status Bar 

  

 

Launch Volatility Chart Viewer 

  

  

From the WTP menu select Volatility Chart Viewer 

  

Alternate Method: 

  

From the WTP toolbar select Analyze --> Volatility Chart Viewer 

  

   

Launch Volatility Chart Viewer from Option Quote Cube, Spread Trader, Equity 

Time and Sales, and Vol Trader  

  

In Option Quote Cube, Spread Trader, Equity Time and Sales, and Vol Trader, press 

the volatility chart icon . 

  

  

  

Display Selections 

  

The historic volatility of a security can be measured in the following increments: 

 

1. 10 day 

2. 30 day 

3. 50 day 

4. 100 day 

5. 200 day 

6. IVOL (Implied volume) 

7. 100 Day IVOL Avg 

8. 200 Day IVOL Avg 

 

Also, the security's close price can also be displayed. In the following example, a security is 

followed over 100 days along the closing price for that time period: 
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Other time periods can be seen within the same chart. Here, 100 and 200 days volatility, 

the close price, and the minimum/maximum prices are charted: 
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Median and Average Quotes 

  

The median and average quotes for selected time periods along the median/average closing 

prices are seen in the Volatility Chart Viewer: 

 

 
  

  

  

Select Charting Dates on the X Axis 

  

In the Show Last drop-down list a selection is made to define the time period of the graph. 

Options are: 

1. 7 days 

2. 30 days 

3. 3 months 

4. 6 months 

5. 1 year 

6. 2 years 

7. 3 years 

  

Zoom into the Volatility Chart Viewer 

  

Two dates on the X-axis be selected and zoomed in, allowing a more detailed view of the 

symbol's activity. 

  

To zoom into the Volatility Char Viewer: 

 

1. Press the plus sign (+) next to Zoom. 

  

2. Click anywhere in the Volatility chart to zoom into the chart. Successive clicks zoom 

further into the chart. 

 

To zoom out of the Volatility Chart Viewer: 

 

1. Press the minus button ( - ) next to Zoom 

  

2. Click anywhere in the Volatility Chart Viewer to zoom out of the chart. Successive 

clicks zoom further out. 

 

Select Two Time Periods for a Zoom 

  

Two points on the Volatility Chart Viewer can be selected and zoomed in for a more detailed 

display. 

  

To select two points: 

 

1. Press the plus sign (+) next to Zoom. 
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2. In the Volatility chart press and hold the left mouse button at the first point that is 

to be zoomed. 

  

3. Drag the mouse to the second point that is to be zoomed. 

  

4. Release the mouse button. 

 

The display in the Volatility Chart Viewer will be zoomed in. 

  

In the example below two points are selected and the resultant zoom is displayed: 
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To return to normal display, select the Zoom minus key and click on the Volatility chart. 

  

  

Overlay Other Symbols in the Volatility Chart Viewer 

  

Two symbols can be placed in the Volatility Chart Viewer for comparison purposes. 

  

To select an additional symbol to add to an existing one: 

 

1. Check the Overlay box. 

  

2. From the drop-down list select a symbol to display in the Volatility Chart Viewer. 

  

Tabs 

  

When a new security is selected via the drop-down list it is added as a tab in Volatility Chart 

Viewer. 

 

Learn about tabs here. 

  

  

Send Symbols to Other WTP Apps with the "Send To" feature 

  

The send to feature allows for a symbol displayed in the Volatility Chart Viewer to be sent 

to another WTP app (for example, the Order Ticket). The sent symbol will populate the 

symbol field in the receiving app. 

 

Learn about the send to feature here. 

  

  

Save Chart Image 
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The chart displayed in the Volatility Chart Viewer can be saved as an image file  in various 

formats (.png, .jpg, .bmp, or .gif). 

 

1. Select the Save Chart Image icon . 

2. The Save As window will launch. 

3. Enter a file name and image type and select Save. 

  

 

Copy Data to Clipboard 

  

Volatility Chart Viewer data (in numerical form) can be copied to the clipboard. The copied 

data can be pasted into a spreadsheet or word processing program. 

  

Press the Copy Data to Clipboard button, found at the bottom-right portion of the 

Volatility Chart Viewer window. 

  

  

Toggle Symbol Tracking 

  

The Volatility Chart Viewer auto-populates with the symbol that has been selected in 

another WTP applet. Learn more about Toggle Symbol Tracking here. 

  

   

Templates 

  

Volatility Chart Viewer configurations can be saved as templates. 

  

Learn about templates here. 

  

  

Export Grid Data 

  

Data in the Volatility Chart Viewer can be exported to a file, clipboard, or Excel spreadsheet. 

  

Learn about exporting grid data here. 

  

  

Printing 

  

The data in the Volatility Chart Viewer can be printed. 

  

Learn about the printing feature here. 

  

  

Status Bar 

  

The status bar (at the bottom of the Volatility Chart Viewer window) displays the current 

time. 

  

From the Config menu select Status Bar to enable/disable it. 
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Wave Grid 

WTP groups orders (i.e., waves) are related to each other by their applets. The Wave Grid 

displays information about a day's waves in a grid, one row for each wave. Columns, users, 

and wave reporting can be totally customized. Waves can be changed and reversed (a sell 

for each buy and a buy for each sell), non-market orders can be changed to Market orders, 

and order and position details can be viewed in supporting applications Position Grid and 

Order Grid. 

 

 

 
Launch the Wave Grid 

Configure the Wave Grid 

Change Waves 

Cancel Orders 

Reverse Selected Waves 

Order Details and Position Details 

Fade Columns 

Export Grid Data 

 

 

Launch the Wave Grid 

 

From the WTP toolbar, select Manage --> Wave Grid. 

 

Alternate Method: 

 

From the WTP menu, select Wave Grid. 

 

 

Configure The Wave Grid 

 

The columns displayed in the Wave Grid can be customized. Also, data in the Wave Grid can 

be filtered, showing only the type of data required. 

 

To configure the Wave Grid: 

 

1. With the right mouse button, click anywhere in the Wave Grid and select 

Configuration. 

 

Alternate Methods: 

 

From the WTP toolbar, click Wave Grid --> Config --> Configuration. 
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Click the Configuration icon . 

  

2. The General tab in the Configure Wave Grid window will display. This page defines 

which waves, users, and sources to display. 

 

Select from the following options: 

 

Filter by Logic—select from Intersect or Union  

 

Intersect—The Wave Grid will display all orders that match the Security Name, 

Security Type, User, Side, etc., i.e.,  orders that match all  of the selected filters. 

 

Union—The Wave Grid will display all orders that match the Security Name or 

Security Type, or User, or Side, etc., i.e., orders that match any of the selected 

filters. 

 

There are three fields that can be defined: Wave Name, User, Source. From the 

drop-down lists next to each field, select the items to display. These selections define 

what the Wave Grid will report, and can be as specific as desired. 

  

3. The Columns And Formatting screen is where columns, grid defaults, column 

headers, and row color conditions are defined.  

 

Learn columns and formatting here. 

 

Change Waves 

 

Unfilled wave orders listed in the Wave Grid can be changed to other Price Types. 

  

To change a Wave: 

 

1. Select one or more rows in the Wave Grid. (Hint: to select more than one row, hold 

down the Ctrl key while clicking on rows.) 

  

2. Click the right mouse button in the Wave Grid and select Change Selected Waves 

 

Alternate Method: 

 

From the WTP toolbar click on Wave Grid and select Action --> Change Selected 

Waves 

  

3. Select from the following 

 

MKT 

 

Last Price 

 

Buy Bid/Sell Ask 

 

Buy Ask/Sell Bid 
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4. A confirmation window will display if the change can be accomplished. Select OK to 

change the order or Cancel to exit without making changes. 

 

NOTE: The column Change to MKT can be added to the Wave Grid. If a wave order 

can be changed to MKT, a "Change to MKT" button will appear in the row of the 

order. The result will be the same as selecting MKT in step #3. 

 

 

Cancel Orders 

 

All unfilled orders, or specific matching orders, can be canceled. 

 

To Cancel All Orders: 

 

1. Click the right mouse button in the Wave Grid.  

 

Alternate Method: 

 

From the WTP toolbar, click on the Wave Grid menu and select Action  

  

2. Select Cancel All Orders 

  

3. If orders can be canceled, a confirmation window will display. Click OK to cancel all 

orders, or Cancel to exit the screen without canceling orders. 

 

If there is a warning associated with the confirmation window, check the 

confirmation box before proceeding. 

  

To Cancel Matching Orders: 

 

1. Select one or more orders in the Wave Grid. 

  

2. Click the right mouse button in the Wave Grid.  

 

Alternate Method: 

 

From the WTP toolbar, click on the Wave Grid menu and select Action  

  

3. Select Cancel Matching Orders 

  

4. Select the type of matching order that is to be canceled. 

  

5. If the matching orders can be canceled, a confirmation window will display. Click OK 

to cancel all the matching orders, or Cancel to exit the screen without canceling 

matching orders. 

 

If there is a warning associated with the confirmation window, check the 

confirmation box before proceeding. 

  

Reverse Selected Waves 

 

This feature "neutralizes" a wave position, by executing an equivalent sell if the order was a 

buy, or an equivalent buy if the order was a sell. 
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To Reverse Select Waves: 

 

1. Select one or more waves in the Wave Grid. 

  

2. With the right mouse button click on the Wave Grid and select Reverse Selected 

Waves. 

 

Alternate Method: 

 

Click Wave Grid from the WTP toolbar and select Reverse Selected Waves. 

  

3. Click OK to reverse the selected waves, or Cancel to exit without making changes. 

 

Order Details and Position Details 

 

View specifics about a wave order, and see details about your position. 

 

To View Order Details: 

 

1. Double-click on a row in the Wave Grid to view details of the order. 

 

Alternate Methods: 

 

Click the right mouse button on a row in the Wave Grid and select View Order 

Detail 

 

Click the Launch Order Grid icon . 

  

2. The Order Grid will display. 

 

To View Position Details: 

 

1. Click the right mouse button on a row in the Wave Grid and select View Position 

Detail 

 

Alternate Methods: 

 

From the WTP toolbar, click on Wave Grid and select Action --> View Position 

Detail 

 

Click the Launch Wave Position Grid icon . 

  

2. The Position Grid will display. 

 

 

Fade Columns 
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A tool for expressing aggression in pricing for live wave orders is handled through Fade 

columns. 

 

These columns Fade in 1 and Fade Away 1 move an order either closer or farther from 

market price. These two columns are added under Columns and Formatting-->Wave 

Fields. 

 

If a wave order is sent and it is unfilled, the Fade Away buttons will appear. With each 

pressing of a Fade button: 

 

Fade in 1 (Toward Market Price): 

Price will increase by one increment for BUY orders. 

Price will decrease by one increment for SELL orders. 

 

Fade Away 1 (Away From Market Price): 

Price will decrease by one increment for BUY orders. 

Price will increase by one increment for SELL orders. 

 

Note that the plus ( + ) and minus ( - ) buttons accomplish the same thing with regard to 

increasing/decreasing an order's price, but the Fade Away buttons should be considered as 

tools for moving toward or away from the current market price. 

 

 

Export Grid Data 

 

Data in the Wave Grid can be exported to a file, the clipboard, or an Excel spreadsheet. 

 

To learn about the export feature, click here. 
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WTP Browser 

 

View web-based market data, stock charts, news, and other pages with the WTP Browser. 

 

 

 
Launch WTP Browser 

Content Available in WTP Browser 

Open a Web Page 

WTP Browser Templates 

Toggle Snap to Size 

Symbol Tracking 

Status Bar 

Printing 
 

Launch WTP Browser 

 

On the WTP Toolbar select Explore-->WTP Browser. 

 

Alternate Method: 

 

From the WTP menu, select WTP Browser. 

 

Content Available in WTP Browser 

 

Web-based content is divided between five tabs: 
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1. Markets 

General market information from CNN Money, MarketWatch, Yahoo!, Nasdaq, NYSE 

Arca 

  

2. Charts 

Stock charts from suppliers such as Yahoo! Finance, MSN Money, Google Finance, 

TradingMarkets 

  

3. News 

The latest market news from Yahoo! Finance, MSN Money, BigCharts, MarketWatch 

  

4. Research 

Stock research from Yahoo! Finance, MSN Money, MarketWatch 

  

5. Resources 

Miscellaneous financial links, splits and dividend data, and a system clock (non web-

based) 

 

Open a Web Page 

 

In addition to the pre-defined links under each tab (above), any web page (assuming 

permission) can be called from the WTP Browser. 

 

To open a web page: 

 

From the File menu select Open Page. 

 

Alternate Method: 

 

Enter Ctrl +o. 

 

A dialog window will appear: 

 

 
 

Enter a web site's URL, or click Browse and select a page to view. Click OK. 

 

The web page will open in the WTP Browser window. 

 

 

WTP Browser Templates 

 

Frequently viewed web pages can be stored as one or more WTP Browser templates. When 

a template is opened, the web page is automatically called. 
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A default template can also be saved. This template is called each time WTP Browser 

starts. 

 

Save a Template 

 

1. Navigate to a WTP Browser tab or page within a tab. 

  

2. From the File menu select Save Template As... 

  

3. Enter a template name and save the template in the directory of choice. The WTP 

Browser template name has a .qet extension. 

 

Save a Template as a Default 

 

1. Navigate to a WTP Browser tab or page within a tab. 

  

2. From the File menu select Save As Default Template. 

 

The next time WTP Browser starts, the default template will open. 

 

Revert to the System Default Template 

 

To change the default template to the system default, select Revert To System Default 

Template from the File menu. 

 

Open a Template 

 

To open a saved template, go to the File menu and select Recent Templates --->. Choose 

a template name from the list. 

 

Toggle Snap to Size 

 

If the dimensions of the default WTP Browser window have been increased or decreased, 

the window can be reset to its default size by pressing the toggle snap to size icon . 

 

Alternate Method: 

 

From the Config menu select Toggle Snap to Size. 

 

Symbol Tracking 

 

A symbol entered in a WTP applet (for example, Order Ticket) can be tracked and 

automatically entered in one of the symbol/news pages in WTP Browser if the Symbol 

Tracking feature is selected. 

 

For example: 

 

If the Order Ticket is showing the symbol IBM, the symbol field in WTP Browser will display 

IBM. Enter a different symbol in the Order Ticket and WTP Browser will respond by matching 

the new symbol. 

 

To enable symbol tracking click on its icon: . 
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Learn more about toggle symbol tracking here. 

 

Status Bar 

 

The status bar provides the current time and status of the WTP Browser. 

 

By default the status bar is enabled. To disable the status bar, go to the Config menu and 

select Status Bar. Repeat the procedure to re-enable the status bar. 

 

Printing 

 

Any page displayed in WTP Browser can be printed. 

 

Printing instructions can be found here.
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Managed Orders 

Managed Order Configurations 

 

For the Managed Order applets, (Market Maker, Spread Agent, Spread Trader, Time Slicer, 

and Vol Trader), there are similar configuration forms. Those functions that span across all 

Managed Orders are included here. Discrepancies among individual applets have been 

noted. 

 

On This Page: 

 

Safeguards 

 

Conditions 

 

Other Actions 

 

Activity Log 

 

 

 

Safeguards 

 

Each Managed Order type allows for the setting of safeguards. If enabled, Managed Order 

safeguards protect a trader's position by stopping or otherwise preventing an order from 

completing if a defined set of circumstances are achieved. 

  

  

 
Spread Trader 

  

  

 
Spread Agent 
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Time Slicer 

  

  

 
Vol Trader 

  

  

 
Hedge Agent 

  

  

  

Spread Trader Specifics: 

 Restart W/O Confirmation After Trade Server Reconnect—If a managed order 

was running and a disconnect occurred within the trading day, WTP will restart the 

managed order without a confirmation. 

 

If this safeguard is not activated, WTP will ask if it should restart managed orders 

following a server reconnect. 

  

 Stall if Market Data Lags Exceeds _ _ _ Seconds—If checked, Spread Trader will 

stall if the market data feed is delayed by the number of defined seconds. 

  

 Alert When Working for More Than _ _ _ (mm:ss) Without an Execution 

('Managed Order—Alert' notification req'd)—When Spread Trader is working the 

spread (i.e., an initial order is outstanding), an alert can be given when a specific 

length of time has passed without executing the spread. If the spread is not 

achievable or an execution occurs, the 'alert' timer automatically resets. 
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To define the alert notification, press the Global Notifications button. Learn how to 

setup global notifications here. 

  

 Stop At Time—A specific time and time zone is defined that reflects the time when 

Spread Trader should stop. If not activated, Spread Trader will run until the target 

quantities are traded, even if the spread is not achieved. 

  

 Trade Only After Both Symbols Are Open—If this safeguard is checked, Spread 

Trader will prevent any order from being sent until both symbols are open. 

  

 Auto-Resume After Market Data Outage—If checked, Spread Trader will continue 

its attempt to achieve the defined spread automatically after a data outage condition 

occurs. If unchecked, Spread Trader will require manual intervention in order to 

resume. 

  

 Stop Loss At—Once a loss is encountered that is greater than the entered value, 

Spread Trader will replace the hedge order. A stock hedge order will be sent with the 

market price type, but the spread will not be achieved. 

  

 Ignore Market Quantities—When creating an initial order, Spread Trader considers 

a number of values including the adjusted available hedge quantity. When Ignore 

Market Quantities is selected, Spread Trader will ignore the available hedge 

quantity when determining initial order quantity. 

  

Spread Agent Specifics 

  

Same safeguards as Spread Trader with these exceptions: 

 Stop loss with BASB limit orders—The Stop loss safeguard has been expanded 

to include BASB (Buys the Ask or Sells the Bid) limit orders. Once a loss is 

encountered that is greater than the entered value, Spread Agent cancels the 

offending hedge order and replaces it at the BASB price when this safeguard is 

enabled. 

 Force hedge with BASB limit orders—Hedging for BASB orders is accomplished 

with this Spread Agent safeguard. When checked, a BASB order will attempt to 

hedge at the market price. When disabled, Spread Agent will hedge at a price that 

will achieve the spread as long as the market has not moved beyond the configured 

Stop Loss value. 

 

Note: This safeguard is enabled by default. 

  

Time Slicer Specifics: 

 Price Boundary Check +/- _ _ _ From the Last Price—When checked, Time 

Slicer will stop the managed order if it's more than the configured amount away from 

the last price. 

 Maximum Open Orders—Time Slicer will stop filling the managed orders if orders 

haven't been filled, AND an order that's about to be placed would exceed the 

Maximum Open Orders value. 

  

  

Vol Trader Specifics: 
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 When Abnormal Vol Conditions Exist (Abort or Stall for 10 Sec)—When an 

abnormal condition is encountered, Vol Trader will either Abort or Stall for 10 

seconds depending on the selection. If "Stall for 10 Sec" has been selected and a 

stall is in effect when a second abnormal condition is encountered, a new 10-second 

stall will begin. Example: Vol Trader is in a stalled state for 4 seconds when it 

encounters another abnormal condition. The total time of the stalled state will be 

increased to 14 seconds (4 seconds + 10 seconds for the second abnormal 

condition). 

  

 Stall on Start Until Market Data Valid—Vol Trader will run only when valid market 

data is received. This allows for trading before the market is open. Without valid 

market data, Vol Trader will remain in a stalled state. 

 Option Px Limit—Vol Trader will not trade if its desired option price is greater than 

the value in the Option Px Limit field. 

 Place option only after quote update—If checked, option orders will be placed 

only when the market has changed (e.g., if buying the option, its Ask Price or Ask 

Size changes) since the previous option execution. This is recommended so that the 

Vol Trader doesn't place option orders until the effect of its previous executions on 

the market have been reflected in its quotes.  

 Stop loss with BASB limit orders—The Stop loss safeguard has been expanded 

to include BASB (Buys the Ask or Sells the Bid) limit orders. Once a loss is 

encountered that is greater than the entered value, Vol Trader cancels the offending 

hedge order and replaces it at the BASB price when this safeguard is enabled. 

  

Hedge Agent Specifics: 

 

 Allow Hedging of—From the drop-down list, select the managed order(s) to which 

Hedge Agent will attempt to hedge. Also, Hedge Agent can attempt to hedge outright 

orders. To allow Hedge Agent to hedge all managed order applets and outright 

orders, select <All Types>.   

 Abort Hedge if Symbol Stalled for more than _ _ _ seconds—The portfolio 

hedge will cease if a symbol stalls for a period longer than defined. 

Alert if any symbol stalls—Check this box to have WTP send an alert if any symbol should 

encounter a stall, regardless of the length of the stall. In order for an alert to launch, a 

notification must first be set in Global Configuration under the Notifications tab.  

 

 

 

Conditions 
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Managed Orders can be configured to trade only when a defined set of circumstances are 

met. 

 

Define Conditions: 

 

1. Select a symbol from the drop-down list. 

  

2. Select an expression. 

 

The column Current Value will populate with the amount that reflects the selected 

expression. 

  

3. Select a Condition from the drop-down list, for example greater than (>), less than 

(<), etc. 

  

4. Enter a Target Value. When the target value meets the defined condition, the 

Managed Order will proceed. 

 

Check the box in the first column to activate the Only Trade When expression. Un-check 

the box to disable a defined condition. 

 

Press the Del button to delete a specific condition. 

  

Other Actions 

 

 
 

 

Set Ownership 
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Managed Orders allow for the current user to take ownership of another user's spread trade. 

 

1. Open a managed order owned by someone else. See the Managed Order Console 

for a list of existing managed orders and their owners.  

  

2. Press Other Actions. 

  

3. Select Set Ownership. 

  

4. The current user will be selected. Assign ownership to another user by selecting 

Other User and enter the user's name in the blank field. Press OK. 

 

Note: There is no confirmation dialog box when selecting Set Ownership. Once selected, 

the change of ownership is immediate.  

 

Rename 

 

Managed Order applets assign a name to each order similar to this format: 

 

Side 1 Symbol    Side 2 Symbol    Applet Name  (example: CSCO DELL Spread 

Trader). 

 

Other applets will include its expiration date and strike price in its name: IBM IBM 0910 P 

70 Vol Trader where 0910 is the expiration date and P70 is the strike price. 

 

The name can be customized in the status field by selecting Other Actions-->Rename  

 

Note 1:  A renamed managed order will have its new name displayed in the Managed 

Order Console. 

 

Note 2:  Renaming an applet to a blank string will reinstate its default name. 

 

Save As Default 

 

The settings defined in a Managed Order applet can be saved as a default for newly created 

managed orders. 

 

1. Enter all necessary values that will be saved as default in the Managed Order applet. 

  

2. Press Other Actions. 

  

3. Select Save as Default. 
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Clear Default 

 

Clear Default causes all future Managed Orders to be created with only system default 

parameters. 

 

Press Other Actions and select Clear Default. A confirmation dialog box will display. 

 

 

Activity Log 

 

 
 

The Activity Log is accessed by clicking the tab at the top of a Managed Order window. The 

log displays status messages created by the current managed order along with a timestamp 

for each activity. 

 

The activities may be displayed in one of three colors: 

 

 Grey—low priority 

  

 Blue—medium priority 

  

 Red—high priority 

 

 

 



Managed Orders  The Managed Order Console 

261 © 2014 Wolverine Execution Services, LLC 

  

The Managed Order Console 

 

The Managed Order Console is a grid that displays the real-time status of managed 

orders (Hedge Agent, Spread Trader, Market Maker, Time Slicer, Vol Trader). Each 

row in the grid corresponds to a single managed order and is color-coded to represent the 

current state of the order (i.e., ready, started, marketable). Additionally, Start/Stop and 

Alert buttons can be displayed in the console allowing control of each managed order. 

 

 

 
Configure Managed Order Console 

Create a New Managed Order 

Clone a Managed Order 

Start Managed Orders 

Stop Managed Orders 

Stop All Managed Orders 

Delete Managed Orders 

 

Alert Columns 

Grid Row Colors 

Reverse Spread Trader 

Read Only Mode 

Launch Order Grid 

Launch Position Grid 

Export Grid Data 

 

 

Import a Managed Order 

Set a Different Firm 

View Level 2 Data 

 

 

Configure Managed Order Console 
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Owners and creators of managed orders, managed order types and their state(s) are 

configured in the Managed Order Console. 

 

Access the Configuration Window: 

 

From the Config menu select Configuration. 

 

Alternate Methods: 

 

 Right-click the mouse anywhere in the Managed Order Console window and select 

Configuration. 

  

 Click on the toolbar's Configuration icon . 

 

Set General Parameters 

 

From the drop-down lists, select the filters that determine the data to be displayed in the 

Managed Order Console. 
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Owner—Select <Current User> to view all of your orders exclusively. Select <All 

Owners> to view orders from all users that you have permission to view. 

 

Otherwise, select one or more user names from the list. 

 

Type—Select one or more managed order types to display. Select <All Types> to display 

Market Maker, Spread Trader, Time Slicer, and Vol Trader orders. 

 

State—Select one or more managed order states to display. Select <All States> to display 

Aborted, Finished, Stalled, Started, or Stopped states. 

 

Creator—Select one or more creators to view their managed orders, or select <All 

Creators> to view orders for all listed users. 

  

Note: The creator of a managed order isn't necessarily the owner.  

 

Set Additional Filters—In addition to the filters already described, filters specific to 

managed orders such as Orders, PNL, and Status Messages can be defined along with a 

condition (<, >, =, etc.) and target value. Additional filters are defined in a manner similar 

to Row Color Conditions. 

 

 

Global Managed Order Settings 

 

Prevent Spread Trader and Spread Agent from placing crossed orders within a firm 

 

Spread Trader and Spread Agent will be prevented from filling a crossed order (i.e., an 

order to buy and sell the same stock, usually for the purpose of making a quotation) if this 

option is checked. 

 

 

Abort on executions that are _ _ _ increments outside the expected market 

  

When selected, a managed order will abort if the execution price is X increments outside the 

expected price (the market bid or ask price that WTP had at the time the order was sent). 

  

Note: Contact WEX Support to have this feature enabled. 

 

 

Vol % Increment 

 

The value entered will be reflected in the Vol % field of Vol Trader where each pressing of 

the spinner arrow will move in the defined increments. 

 

For example, a Vol % Increment of .20 is seen in the Vol % field of Vol Trader as .20, .40, 

.60, etc. 

 

Market Maker Widths X 

  

The width percentages are used exclusively with the Market Maker managed order. 

(Note: Access to Market Maker is by permission only. Contact WEX Support for more 

information.) 
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Width is added to the Market Maker's theoretical market. This feature multiplies the widths 

of all owned Market Makers. If market conditions become unfavorable, a trader may 

increase the width multiplier to 200% or 300% to instantly become less aggressive across 

the board. By globally increasing or decreasing their Market Maker widths, traders have 

broad control over their risk. 

  

Select one of the percentage buttons (50%, 100%, 150%, 200%, 400%) or enter any 

percentage value in the Market Maker Widths X field. 

 

 

Market Maker Lean Adj 

  

The value entered here (in basis points (bps)) moves the lean of all market makers owned 

by a user. 

  

The lean adjustment is calculated as follows: 

 

Market Maker  Lean Adjustment  x  (1/10000)  x  Derived Reference Price = 

Additional Lean Amount 

  

The total lean is the sum of the current lean + the added lean amount. 

  

Example: 

 

1. Market Maker Lean Adjustment = 100 bps 

  

2. Current lean value= 1.00 

  

3. Derived Reference Price = 13.38 

  

100  x  (1/10000)  x  13.38 =  0.13 (the additional lean amount) 

  

1.00 (the current lean value) + 0.13 = 1.13 (Market Maker's total lean) 

   

Select a Market Maker Lean Adjustment bps value from one of the pre-defined buttons 

(-200, -100, 100, 200) or enter a value. Selecting "0" means no additional lean amount will 

be added to the current lean. 

 

 

Automatic Stop 

 

Managed orders can be stopped on a per-order basis. If enabled, a selection is made to 

determine which managed orders are to be stopped. If the Managed Order Console is 

closed, automatic stop will not commence. 

 

Automatically Stop Managed Orders At—Enter a time of day either manually or with the 

up/down (spinner) arrows when managed orders are to be stopped. If this is checked, one 

of the following conditions must be selected: 

 

Stop Those Visible in This Managed Order Console—All managed orders listed in the 

Managed Order Console will be stopped at the defined time. 
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Stop All Those I Own—Only the managed orders owned by you will be stopped at the 

defined time. 

 

Stop All Those I Have Permission to See—Managed orders that can be seen in the 

Managed Order Console may or may not be owned by you. Select this option to stop the 

managed orders that you have permission to view. 

 

Global Notifications 

 

A notification (sound and/or text) can be sent if a defined managed order condition exists. 

 

See Global Configuration for instructions on defining an event's notification. 

 

Columns and Formatting 

 

See Columns and Formatting for instructions on setting grids, color conditions, header 

styles, and more. 

 

 

Create a New Managed Order 

 

There are a number of methods for creating one of six managed orders: 

 

From the Action menu select New Managed Order--->Managed Order Type 

 

Alternate Methods: 

 

 Right-click anywhere in the Managed Order Console and select New Managed 

Order--->Managed Order Type 

  

 Click on the toolbar's New Managed Order icon   and select a managed order. 

Select a firm name (if more than one is available) from the drop-down list. 

  

 Type one of the following keyboard shortcuts: 

 

Managed Order  

 

Keyboard Shortcut 

 

Market Maker Ctrl+M 

 

Spread Trader Ctrl+P 

 

Time Slicer Ctrl+T 

 

Vol Trader 

 

Ctrl+O 

Choose Type and Firm* Ctrl+N 

   
*The option Choose Type and Firm brings up a window where a managed order and 

firm name are chosen. 

 

Note: Pressing the New Managed Order icon also opens the Choose Type and 

Firm window. 



Managed Orders  The Managed Order Console 

266 © 2014 Wolverine Execution Services, LLC 

 

 

Clone a Managed Order 

 

Any managed order can be cloned (i.e., copied). When an order is selected for cloning, its 

name will be appended with the word "copy." A cloned managed order does not necessarily 

need the same parameters of the original in order to execute.  

 

1. Select a managed order in the Managed Order Console by clicking on it. 

  

2. Right-click in the grid and select Clone Managed Order. 

 

Alternate Method: 

 

 From the Action menu, select Clone Managed Order. 

 

The cloned managed order will display and can be edited before starting. 

 

 

Start Managed Orders 

 

Managed orders can be started in their configuration window (by pressing the Start button) 

or in the Managed Order Console. 

 

Start Orders from the Managed Order Console 

 

Press the Start button on each row containing the managed order. (Note: Be sure the 

Start column is displayed in the Managed Order Console. If it isn't, it will have to be added. 

See Columns and Formatting for more details.) 

 

Alternate Methods: 

 

 Select one or more rows in the Managed Order Console and click the Start Selected 

Managed Orders icon  . 

  

 Select one or more rows in the Managed Order Console and right-click the mouse. 

Select Start Selected Managed Orders. 

  

 Select one or more rows in the Managed Order Console and select Start Selected 

Managed Orders from the Action menu. 

 

In all cases, a dialog window will ask for confirmation before starting an order. 

 

 

Stop Managed Orders 

 

Managed orders that have started can be stopped in their own window (by pressing the 

Stop button) or in the Managed Order Console.  

 

Stop Selected Managed Orders 
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Press the Stop button on each row containing the managed order. (Note: Be sure the Stop 

column is displayed in the Managed Order Console.) 

 

Alternate Methods: 

 

 Select one or more rows in the Managed Order Console and click the Stop Selected 

Managed Orders icon . 

  

 Select one or more rows in the Managed Order Console and right-click the mouse. 

Select Stop Selected Managed Orders. 

  

 Select one or more rows in the Managed Order Console and select Stop Selected 

Managed Orders from the Action menu. 

 

In all cases, a dialog window will ask for confirmation before stopping any order. 

 

 

Stop All Managed Orders 

 

The following managed orders can be stopped with the Stop All Managed Orders 

command: 

 

 Orders visible in the Managed Order Console 

  

 Orders owned by the user 

  

 Orders the user has permission to see 

 

Press the Stop All Managed Orders icon . 

 

Alternate Methods 

 

 Right click in the Managed Order Console grid and select Stop All Managed Orders. 

  

 From the Action menu, select Stop All Managed Orders. This window will display: 

 

             

 

Make a selection and click OK. A window will display asking for confirmation before stopping 

any managed order. 

 

 

Delete Managed Orders 
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Managed orders can be deleted from the Managed Order Console. In all cases, a dialog 

window will ask for confirmation before deleting any order. 

 

Delete One or More Managed Orders 

 

Highlight one or more rows in the Managed Order Console and press the delete managed 

order icon . 

 

Alternate Methods: 

 

 Press the delete key. 

  

 Right-click anywhere in the Managed Order Console and choose Delete Selected 

Managed Orders. 

  

 Click the Action menu and select Delete Selected Managed Orders. 

 

  

Alert Columns 

 

A defined set of circumstances can be configured for a particular managed order. When 

market conditions match the defined circumstances, an audible or visual alert is given. 

 

The Alert column and its associated Enable column are optionally displayed. If a box is 

checked in the enabled column, the corresponding alert will become active and will be 

triggered once the specified alert conditions are met. 

 

Enable the Alert Columns 

 

Press the Alert Columns icon . 

 

Alternate Method: 

 

 Right-click anywhere in the Managed Order Console and select Show Alert 

Columns. 

 

Two columns (Enable, Alert) will be added to the Managed Order Console. 

 

Set Alert Conditions 

 

1. Press the Alert button. A configuration window similar in look and functionality to 

the Row Color Conditions window will display. 

  

2. Define one or more expressions, an Alert Priority value, and check to specify 

whether the Aggregate value should be considered. 

  

3. Select OK to accept your changes and close the window or Apply to save your edits 

and keep the window open. 

 

The Alert button is displayed in one of three colors: 

 

 

 



Managed Orders  The Managed Order Console 

269 © 2014 Wolverine Execution Services, LLC 

The Alert has been enabled, but has no match to the defined 

condition has been made. 

 

 

 

The Alert has been disabled (the Enable box has been 

unchecked). Check the Enable box to re-enable the Alert. 

 

 

 

The defined condition has been met. 

 

 

Disable the Alert Columns 

 

Follow the same procedure used to enable the Alert columns. 

 

Grid Row Colors 

 

The color of each row in the Managed Order Console indicates the state of the managed 

order: 

 

 

Color 

 

State of the Managed 

Order 

 Aborted 

 Finished 

 Marketable 

 Not Owned 

 Ready 

 Stalled 

 Started 

 Stopped 

 

Note: The row colors cannot be configured.   
   
 

Reverse Spread Trader 

 

Using Reverse Spread Trader, you can create a new Spread Trader that is used to reverse 

the positions of a selected Spread Trader. The side types of the original Spread Trader are 

reversed in the new Spread Trader. The Targets of the new Spread Trader are determined 

by which type of reverse Spread Trader was created, as such:  

 

 Reverse Filled Quantities sets the new Targets to the traded quantities of the original 

Spread Trader.  

  

 Reverse Entire Spread sets the new Targets to be the same as the original Targets. 

 

1. Right-click on a row containing the spread trade that is to be reversed. 

  

2. Choose Reverse Spread Trader-->Reverse Filled Quantities. 
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Alternate Method: 

 

 Choose Reverse Spread Trader-->Reverse Entire Spread 

 

If Reverse Filled Quantities or Reverse Entire Spread is selected, the new Spread 

Trader configuration window will open allowing for additional changes before the managed 

order is applied. 

 

  

Read Only Mode 

 

When the Managed Order Console is in read only mode, managed orders cannot be edited 

through the grid controls. 

 

Put Managed Order Console in Read Only Mode 

 

Press the read only mode icon  

 

Alternate Methods: 

 

 Right-click anywhere in the Managed Order Console and select Read Only Mode. 

  

 From the Config menu, select Read Only Mode. 

 

Launch Order Grid 

 

Managed orders that have been started and have generated a Wave ID displays the order 

details in the Order Grid. 

 

1. Select one or more managed orders in the Managed Order Console. 

  

2. Click the Order Grid icon . 

 

Alternate Methods: 

 

 Right-click on the managed order and select View Order Detail. 

  

 From the Action menu, select View Order Detail.  

 

Launch Position Grid 

 

Managed orders that have been started and have generated a Wave ID displays the position 

details in the Position Grid. 

 

1. Select one or more managed orders in the Managed Order Console. 

  

2. Click the Position Grid icon . 

 

Alternate Methods: 
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 Right-click anywhere in the Managed Order Console and select View Position 

Detail. 

  

 From the Action menu, select View Position Detail.  

 

Export Grid Data 

 

Orders in the Managed Order Console can be exported to a file, the clipboard, or to 

Microsoft Excel.  

 

Click here for detailed information on exporting grid data. 

 

 

Import a Managed Order 

 

Any delimited tabular data or previously exported managed order can be imported to the 

Managed Order Console. 

Select the Import Managed Order icon . 

 

Alternate Methods: 

 

 From the Action menu, select Import Managed Orders 

 

 Right-click in the Managed Order Console and select Import Managed Orders 

  

 Type Ctrl +i. 

 

Double-click on a file name to import, or click once and press Open. 

 

An Import From File window displays: 
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Before the file import can proceed, the following values must be defined: 

 

Start Import At Line—The number in this field refers to the line number in imported file. 

When the file is imported, the first line displayed in the Managed Order Console will be the 

line selected here.  

 

In the example above, Line 1 is selected. When the file is imported, Line 1 will be the first 

line displayed. Since this line is really nothing but headers, a better choice would be to 

Start Import at Line 2.  

 

Import Type—The managed order type that is being imported. Mixed managed orders 

cannot be imported in a single pass.  

 

Import to—Two choices, either New or Existing Rows 

 

New—A new managed order will be created from each row in the import file. 

 

Existing Rows—Managed orders owned by you in the Managed Order Console 

will be modified with the new data contained in the imported file. 

 

Assign Columns—At least one column must be assigned a name in order for the import 

feature to commence.  To assign a name to a column, click on <Unassigned>. A list of 

names will display. Click on the name that will be assigned to the column.  

 

Delimiters—This checked box refers to the field delimiters in the import file. A different 

delimiter can be selected, but better results will occur with the delimiter used in the import 

file (i.e., a tab-delimited file will produce better results when tab is selected). 
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Templates—Once the columns have been assigned names, they can be saved for later use. 

Press Save Import Template to save and name your template. 

 

When importing a file with the same import type, press Load Import Template and select 

the appropriate template for your import type. 

 

Press Import to import the file into the Managed Order Console. 

 

Tips for Importing Managed Orders 

 

Create a Managed Order import template. 

   
For example, when importing Spread Trader managed orders, the Import From File 

dialog window should have a column name for each field in the imported file. 

 

 
 

Note 1: The data in the column Managed Order ID is generated automatically.  

   
Note 2: Press Save Import Template and save your work. Load the Import Template on 

subsequent imports to eliminate the need to manually assign column names. 

 

 

 

Import Managed Orders into Existing Rows 

When importing to existing rows, new managed orders are not created. The values specified 

in an import file are simply modified on existing managed orders. For this to happen:  

 the import file must have a column of Managed Order IDs, each pulled from the 

Managed Order Console and corresponding to the data value of that import row 
 the Managed Order ID import field must be assigned to the correct column of the 

imported file 
 Existing Rows must be checked in the import dialog window.  

Note: Some values cannot be modified while importing to existing rows. Side types, 

symbols, portfolios, and a few others are specifically prohibited from changing if a managed 

order has already been started during the current day.  
 

 
Set a Different Firm  
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When a relationship is established between a WTP applet and a managed order (via the 

send to feature), or when a managed order is launched, the user's current firm is selected 

by default. "Set Firm" allows a user to choose a different firm for the managed order. 

 

To set a different firm for a managed order, press the Other Actions button and select Set 

Firm. A Set Firm window appears. Select Other Firm and make a selection from the drop-

down list. 

 

 
 

Once a managed order has been configured and the "apply" button has been pressed, the 

Set Firm option is no longer available even if the order has not started. Set Firm is also 

not available if the managed order is stopped and re-edited. 

 

 

View Level 2 Data 
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The menu option View Level 2 Data, when activated, will cause the Equity Quote Cube 

and/or Option Quote Cube (depending on the managed order) to launch when a managed 

order is selected. If View Level 2 Data is turned off while the quote cubes are displayed, the 

quote cubes will close. 

 

To activate View Level 2 Data, select it from the Action menu or right-click anywhere in the 

Managed Order Console grid and select View Level 2 Data.  
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Hedge Agent 

Hedge Agent delta hedges an entire portfolio of managed orders at market price, BASB (buy 

ask/sell bid), or BBSA (buy bid/sell ask). The hedging occurs on executions as they arrive 

and only for those orders sent by the user running the managed order. 

  

The hedge trade is placed in a destination portfolio using the selected route at the correct 

price. No hedging occurs until the accumulated hedge quantity is equal to, or greater than, 

the defined minimum delta. 

  

 
  

  

  

Launch Hedge Agent 

  

With the Managed Order Console selected: 

  

Ctrl + Shift + H 

  

Alternate Method: 

  

Right-click in the Managed Order Grid and select New Managed Order --> Hedge Agent 

  

  

  

Configure Hedge Agent 
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The basic configuration of Hedge Agent consists of selecting the portfolio containing the 

orders to be hedged and the destination portfolio for the hedged orders. Additionally, the 

route, minimum order size, price type, and optional incremental value are defined. 

  

  

Portfolio To Hedge 

  

From the drop-down list of portfolio names, select the portfolio in which orders will be delta 

hedged. 

  

  

Destination Portfolio 

  

Select the destination portfolio in which hedged orders will be placed, from the drop-down 

list of portfolio names. Select <Default> to use the global default portfolio for the hedged 

orders. 

  

Note: The destination portfolio can be the same as the one selected in the Portfolio To 

Hedge. 

  

  

Route 

  

Select a route that Hedge Agent will use to delta hedge orders. Select <Default> to use 

the system default route (as defined in Global Configuration). 

  

  

Min(imum) Delta 

  

Hedge Agent will not delta hedge a portfolio below the value entered in the Min(imum) Delta 

field. 

  

Enter the minimum delta value or select a value using the up/down spinner arrows.  

  

 

Price Type 

  

Hedge Agent supports the Market, BASB, and BBSA price types. 

 

To have BASB & BBSA price types available for selection, the option “Allow side relative 

price types in order tickets (BBSA, BASB, Peg BBSA, Peg BASB)” must be checked on 

the Orders page of Global Configuration. 

  

  

Inc(rement) 

  

When the price type is BASB or BBSA, it can be modified by a specified increment. 

  

Enter an increment value or select one from the up/down spinner arrows. 
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Root Hedge Overrides 

  

 
  

The Root Hedge Overrides table allows a user to hedge incoming options of the root and 

hedge symbol. It "overrides" the default behavior of WTP to hedge with the underlier. 

  

In the Root column, type a symbol name or select one from the drop-down list. 

  

In the Hedge Symbol column, enter the symbol to hedge with (either from the drop-down 

list or by typing directly in the column). 

  

Delete a root hedge override by selecting the Del button in the appropriate row. 

  

  

  

Advanced Parameters 

  

 
  

Symbols in the Portfolio To Hedge may be subject to short-sale and restricted rules.  

  

In the Advanced Parameter grid of Hedge Agent, such symbols can be selected and 

confirmed for short sales. Each row in the Advanced Parameters grid can be defined for a 

different symbol. 

  

Select a symbol from the drop-down list. 

  

Confirm Short Sale—Normally, WTP issues a confirmation message when a short-sale 

condition exists. Checking the Confirm Short Sale box means that a short-sale with the 

selected symbol is "pre-approved", and no confirmation message will be issued. 

  

When Confirm Short Sale is unchecked, a confirmation message will launch when Hedge 

Agent tries to work a short sale. 
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Confirm Rule—Similar in function to Confirm Short Sale, checking the Confirm Rule box 

indicates that a warning about a particular security (for example, the security is restricted) 

will not be generated because the security has been "pre-approved". 

  

When Confirm Rule is unchecked and a rule needs to be confirmed, the symbol will stall. 

  

  

Key in the Locate ID and/or Override Reason as necessary. 

  

  

Round Lots Only 

  

Check this box if trading shares only in round lots (i.e., 100, 200, 300, etc.) is desired. 

  

  

  

Safeguards 

  

Safeguards are common throughout all Managed Orders. Click here to learn about them. 

  

  

  

Symbol Status 

  

If Hedge Agent is unable to trade a particular symbol, a stall occurs. Hedge Agent will, 

however, continue to hedge the remaining symbols despite the stall.  

  

There are a number of issues that could cause a symbol stall. Here are just a few: 

 

 No market data 

 Stale market data 

 Short sale 

 Route issues: Invalid, route, route unavailable, can't trade on route, price type not 

allowed on route, etc. 

 Trading halted 

 Hard-to-borrow confirmation required 

 Invalid delta (not between -1 and 1) 

  

If a symbol stall occurs, Hedge Agent will report it in the Symbol Status table. Select 

Symbol Status to view the table. 

  

  

  

Other Actions 

  

See the Other Actions description in the Managed Order Configurations page for details on 

this feature. 
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The Activity Log 

  

See the description in the Managed Order Configurations page for details on the Activity 

Log. 

  

  

   

Bypass Hedge Agent in Other Managed Orders 

  

Bypass Hedge Agent is a safeguard in each Managed Order with the exceptions of Market 

Maker and Vol Trader. 

  

When Bypass Hedge Agent is selected, orders placed in the Portfolio To Hedge will be 

ignored by all running Hedge Agents. 
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Spread Agent 

Spread Agent trades two securities based on the difference of their ratio-adjusted prices 

(or Spread). The difference between Spread Agent and Spread Trader is that Spread 

Agent can trade a single spread and reverse spreads simultaneously. The reverse spread is 

achieved by trading the same two securities as the initial spread but with opposing side 

types (for example BUY/SSH vs. SSH/BUY). 

 

 
 

 

Launch Spread Agent 

 

Bid, Ask, Achieved, and Set 

as Spread 

 

Quantity, Value, Spread 

Value, Credit and Debit 

 

State of Spread Agent 

 

Configuration Parameters 

Reverse Spread 

 

Disable the Initial 

Spread and Work Only 

The Reverse Spread 

 

Currency 

 

Estimated Complete 

Values and Clean Up 

Positions 

 

 

Advanced Parameters 

 

Slip Adjustment 

 

Conditions 

  

Safeguards 

  

Other Actions 

  

Status Messages 

  

  

  

Launch Spread Agent 

  

With the Managed Order Console selected, enter Ctrl + Shift + s. 

  

Alternate Methods: 

 

From the Action menu in the Managed Order Console, select New Managed Order --

>Spread Agent. 
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Right-click in the Managed Order Console grid and select New Managed Order -->Spread 

Agent. 

  

  

Quantity, Value,  Spread Value, Credit and Debit 

  

 
  

1. Quantity (Qty) or Value—This input is a convenient way to specify the Max 

Position for each security in the corresponding spread. Whenever a Max Position 

configuration needs to be updated, it is computed from this input as follows: 

 

Quantity—This will be multiplied by the corresponding Ratio at the time of the 

computation. 

 

Value—This will be divided by the market price of the corresponding security at the 

time of the computation. 

 

Note: The amount in the Max Position field will be rounded to the nearest hundred if 

Round Lots Only is checked. 

2. Spread—The difference of the ratio-adjusted prices of two securities. It must be 

greater than or equal to zero. The value placed in the field works in conjunction with 

the Credit/Debit buttons (below). 

  

3. Credit/Debit—If a spread value is to be collected it is a Credit. If a spread value is 

to be paid, it is a Debit. 

 

A credit occurs when the security with the lower ratio-adjusted price is bought, and 

the security with the higher ratio-adjusted price is sold. 

 

A debit occurs when the security with the higher ratio-adjusted price is bought, and 

the security the lower ratio-adjusted price is sold. 

 

Select either Credit or Debit when setting up a spread. 

  

Bid, Ask, Achieved, and Set as Spread 

  

 
  

The value displayed in the Bid field is the computed spread of the two securities if they 

were bought at the bid and sold at the ask prices of the current market. 

  

The value displayed in the Ask field is the computer spread of the two securities if they 

were bought at the ask and sold at the bid prices of the current market. 

  

The value displayed in the Achieved field is the spread achieved from the average executed 

prices of the securities.  

  

Note: The Bid, Ask, and Achieved values may fluctuate as the market moves.   
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Set as Spread—You can select the Bid or Ask value to be the spread amount. Right-click 

on either the Bid or Ask field and select Set as Spread. The spread will instantly change to 

match the selected Bid or Ask value. 

  

  

State of Spread Agent 

  

 
  

State of the spread. The bottom value in green (20.110) reflects that the corresponding 

security's initial order is marketable. 

  

  

The values displayed in the State portion of Spread Agent reflect: 

 

 The Calculated price. This is the price that the Spread Agent needs to place the 

corresponding security's initial order at in order to achieve its spread. This is all 

inclusive of the spread configuration, current market prices, and slip adjustments. 

 The side(s) being worked first. In the image above, the bottom security is able to 

place initial orders so its calculated price is shown. The top row shows dashes 

because only the bottom security is configured to be worked first. See advanced 

parameters for instructions on how to define the side that is to be worked first. 

 

The side that is being worked will be displayed in one of three colors, depending on 

market conditions: 

 

Green  The order is marketable. 

 

Yellow  The order is placeable, but not marketable. 

 

Red  The order is not placeable because it is too far outside the market. 

 Bid & Asked Values based on the current market quotes. 

 

Bid is the current market's Bid price and below it is the current executed quantity of 

the security. 

 

Ask is the current market's Ask price and below it is the current executed quantity of 

the security. 

 Achieved is the average price and quantity that have been executed by Spread 

Agent.  

  

Configuration Parameters 
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1. Sides, Side Types, and Symbols—Generally, each spread will have one security 

with a buy side type and another with a sell side type. However, two like side types 

may also be chosen (i.e., BUY and BUY). 

 

In the Symbol field, either manually type in a symbol name or select one from the 

drop-down list. 

 

 

Set Spread Agent for Options 

 

 
 

Spread Agent can be set to send initial and hedge orders as Options. 

 

a. Press the Build Option icon  (located next to the Symbol field). The Option 

Builder window (above) will appear. 

 

b. Enter the necessary data in each field (security, expiration date, strike price, call 

or put, and root). 

 

c. Select OK to accept the values or Cancel to exit without savings. 

 

d. Repeat for the other side, if desired. 

 

  

2. Ratio—The ratio values are applied to their corresponding security's prices whenever 

calculating a Spread value. This allows for the normalization of the price of each 

security so that it will have an appropriately weighted effect on the resulting Spread 

value. When the Symbol input is modified, these values are snapped to the ratio of 

the current market prices. 

  

3. Max Position—The maximum position (in shares) that the Spread Agent may have 

open for the corresponding security and side. If the Reverse spread is enabled, the 

Spread Agent will trade both sides of a security without exceeding the position 

specified for each side. If the Reverse spread is disabled, the Spread Agent will finish 

once each security's position is achieved. Pressing the lock icon  will prevent this 
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value from being snapped as a result of other configurations (Qty, Ratio, Symbol, 

etc.) being modified. 

 

TIP FOR SETTING MAX POSITION: It is common to have a Locate ID for a Short 

Sale (SSH) of a certain amount of a security. In that case, it may be beneficial to 

limit the position on the sell side more than on the buy side. 

  

4. Ref. Price—The reference price influences the value of the desired spread. If this 

value is modified, the spread will change accordingly. 

  

Reverse Spread 

  

 
  

Initial Spread 

  

  

 
  

Reverse spread uses side types that oppose those in the initial spread 

  

  

A second (or Reverse) spread is achieved by trading the same two securities with the 

same ratios as the first spread. However, the reverse spread must use side types that 

oppose the side types used by the first spread. In the images above, the initial spread uses 

the BUY side type for the first security, while the Reverse spread uses the SSH side type for 

that same security. 

  

Check the Reverse box to reveal the reverse spread parameters. The configuration 

parameters are set up in the same manner as the regular spread. If Reverse is not 

checked, Spread Agent will only work a single spread and will not display the reverse spread 

parameters. 

  

Note Regarding Reverse Spread and Hedge Orders: When using a reverse spread, the 

Spread Agent may close out a position instead of hedging it. If an initial order fills before an 

opposing hedge order of the same security, the hedge order will be canceled. If there are 

multiple live hedge orders, the hedge order with the worst price will be canceled. 
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Disable the Initial Spread and Work Only the Reverse Spread 

  

 
  

When it's preferable to work only the Reverse spread, the Initial spread can be disabled. 

  

The Initial check box can be unchecked while the Spread Agent is running. The order 

change will be reflected in the Managed Order Console in the Summary column: 

  

 
  

The Managed Order Console lists the Spread Agent with both Initial and Reverse spreads. 

  

  

 
  

The Managed Order Console displays only the Reverse Spread when the Initial Spread is 

disabled. 

  

  

Note: At any time while the Spread Agent is running, the initial spread can be worked again 

by checking the Initial check box. 
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Currency 

  

  

  

By default, Spread Agent trades in U.S. dollars, but different currencies may be selected. 

  

Choose a different currency: 

 

1. Check the Use Currencies box. 

  

2. From the drop-down list, select a currency for each side. 

 

The conversion rate will be computed automatically. 

 

To view historic volatility data for a security, press the show/hide chart button  (next to 

the symbol name).  

  

 

Clean Up Positions, Progress, Position, Estimated Cash 

  

  

  

 
  

  

Selecting the Clean Up Positions button causes Spread Agent to only send orders that will 

close out a position. Once a position of zero is reached, the Spread Agent status is 

"finished". If the Clean Up Positions button is in the "up" position Spread Agent will respond 

as before by working the defined spread. 

  

  

The Estimated Complete Values indicate the percentage of completion of the spread 

order (and reverse order if applicable). The top value refers to the first security in the 

spread, the second number refers to the second security. 

  

  

% Cmpl shows the security's executed quantity as a percentage of the security's Max 

Position. Note: This value is not applicable when working two spreads. 

  

  

Position refers to the accumulated position by firm, account, or portfolio. The default 

position mode is set in Global Configuration. 
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The Estimated Cash fields indicate the profit/loss currently estimated as each spread is 

being worked. The Total Est Cash is the estimated profit/loss from the entire spread order. 

These cash values are the PNL that the Spread Agent would realize if its positions were 

closed at current market prices. 

  

  

  

  

Advanced Parameters 

  

  

 
  

Press the Advanced button in Edit mode to reveal additional configuration options for 

Spread Agent. Minimum/maximum order size, round lot selections, and additional cash 

amounts to add to a spread order are configurable here. 

  

  

Min Ord Size 

  

The minimum order size is considered firm in that an initial order will be placed at the 

minimum amount if market prices allow it even if the market quantities do not. 

  

Define the minimum order size in shares for a security by entering the value directly or by 

using the up/down arrows. The value for bottom symbol changes as the top symbol is 

edited. Only one symbol can be edited for Min Ord Size and the other will be snapped based 

on the ratio of their Max Positions. In cases where the first symbol is an equity and the 

second symbol is an option, both can be edited. 

  

Note: The minimum order size cannot be larger than the Max Ord Size. 

  

  

Max Ord Size 

  

The maximum order size specifies the largest quantity that may be placed for any single 

order of its corresponding security. Also, it specifies the quantity that may be executed 

above the achieved quantity of the opposite security (after adjusting for the ratio of the 

quantities that are remaining before the Max Positions will be reached). 

  

Define the maximum order size in shares for a security by entering the value directly or by 

using the up/down arrows. The value for bottom symbol changes as the top symbol is 
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edited. Only one symbol can be edited for Max Ord Size and the other will be snapped based 

on the ratio of their Max Positions. In cases where the first symbol is an equity and the 

second symbol is an option (or vice versa), both can be edited. 

  

Note: The maximum order size cannot be smaller than the Min Ord Size. 

  

  

Round Lots Only 

  

Round Lots Only will cause the Spread Agent to try and place order quantities that are 

rounded to a multiple of 100. The one exception is that partial fills of orders may force the 

Spread Agent to break this rule and place a non-round lot to prevent a state where it cannot 

trade. When Round Lots Only is checked, the Order Sizes and Max Positions must be 

configured to multiples of 100.  

  

Note: A Min Ord Side will be rounded down to the closest multiple of 100 (i.e., 175 shares 

will round down to 100), while a Max Ord Size will be rounded up. 

  

  

Cash 

  

This value refers to the amount of cash added to a trade. 

 

For example, in a merger situation, for each share of AGE stock, WB is offering .9844 shares 

of its stock plus $35.80 in cash. 

 

The current price of AGE is $82.36 and WB is $48.82. The offer value per share is $83.86 

(.9844 x 48.82) + 35.80 = $83.86 

$83.86 - $82.36 = $1.50 credit. 

  

Note: The values entered in the Cash field affect the spread value. As a single cash value 

increases, the spread is increased to account for the additional amount. If a single cash 

value exists, increasing the opposite cash value reduces the spread value as one cash 

value works against the other. 

  

  

Max Inc Outside Mkt 

  

The Max Inc Outside Mkt refers to the threshold outside of the current market that the 

Spread Agent will place initial orders. The state of the order reflects the Max Inc Outside 

Mkt value. Specifically, if the state is yellow it indicates the order can be placed, even if it 

isn't marketable. This is used in conjunction with the Work Mode. 

  

Note: Increasing the Max Inc Outside Mkt is likely to cause the Spread Agent to generate 

more order flow, so it should be used with caution. 

  

  

Route and Portfolio 

  

Both Route and Portfolio must be selected from their drop-down lists before Spread Agent 

can initiate a spread order. 

  

Note: Both routes and portfolios can have their values locked by pressing the lock icon. 
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Learn how to set up default routes and portfolios here. 

  

  

Locate ID 

  

The Locate ID field is used in conjunction with SEC regulation SHO which requires a locate 

identifier for short sales in all equity securities. Usually, a locate ID number is entered prior 

to effecting the short sale. Enter the locate ID in for either symbol in Spread Agent.  

  

  

Work Mode 

  

 
  

Work modes, coupled with Max Inc Outside Mkt, determine at what levels the Spread 

Agent will place orders (relative to current market prices and quantities). These 

configurations have a direct effect on the amount of order flow generated by the Spread 

Agent. 

  

Spread Agent is set to run in one of three modes: 

 

1. Work Bid or Offer—An initial order will be placed at the buy bid/sell ask price when 

the calculated price of the security is as good as, or better than, the current 

marketable price (less the Max Inc Outside Mkt adjustment). 

 

Eye—The Eye feature enables the Work Bid or Offer mode to place an IOC 

(Immediate or Cancel) option order to buy at the ask or sell at the bid to try and 

capture marketable liquidity before falling back to its default behavior. To use this 

feature, Spread Agent must be in Work Bid or Offer mode and the configured option 

route must support a Time In Force of IOC. Since the order will only be routed to the 

exchange designated in the Rte (Route) field, it is highly recommended to use this 

feature with a WEX smart router such as Xenon for orders to capture liquidity more 

broadly. 

  

2. Work Aggressively—An initial order will be placed at the calculated price of the 

security when that price is as good as, or better than, the current marketable price 

(less the Max Inc Outside Mkt adjustment). 

  

3. Market Taker—An initial order will be placed at the current marketable price when 

the calculated price of a security is as good as, or better than, the current 

marketable price (less the Max Inc Outside Mkt adjustment). The quantity of the 

initial order will be at most the amount currently available in the market. 

 

Work Side First 

  

Spread Agent can be instructed to work either or sell side first for a spread or reverse 

spread. If enabled, the selected side will send out orders based on the achievability of the 

spread. 

  

The side not selected will place orders only when they are needed to hedge. 
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1. Check the Work Side First box to enable the feature. 

  

2. Select the side to work first from the drop-down list. 

 

For reverse spreads check the Reverse Work Side First box and make a selection from 

the drop-down list. 

  

Note 1: When Work Side First is unchecked, Spread Agent will place initial orders for both 

securities simultaneously (assuming the spread is achievable on both sides of the market). 

When one or both initial orders fill, they will be hedged with the opposing security in the 

same way as when working only one side. 

 

Note 2: If trading an option and a stock, Spread Agent will force the option side first. 

  

  

Slip Adjustment 

  

 
  

Slip Adjustment 

  

 
  

Calculated Slip Components 

  

A Slip occurs in Spread Agent when it attempts to achieve a spread, yet fills a portion of the 

order at a worse than configured price. Spread Agent will attempt to rectify this situation by 

adding a calculated amount that's spread over the entire order (known as the Slip 

Adjustment), with the result of a completed order at the desired price. 

  

The following conditions could cause a slip adjustment to occur (note this is not a 

comprehensive list): 

 

 An initial order is filled, but the opposite security's market has moved before the 

hedge order was placed.  
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 Round Lots Only has been selected and a partial fill of an initial order occurs that 

cannot be hedged immediately due to the round-lots demand. 

 Stopping before the Spread Agent is fully hedged, and then restarting after the 

market has moved. 

 A Stop Loss has been hit. The amount of the slip incurred will be directly 

proportional to the amount of loss. 

 

The values displayed in the Calculated window are price adjustments that will be applied to 

the expected hedge security's price during initial order price calculations. The effect of the 

slip adjustment is reflected in the State Calculated prices. In the Slip Adjustment image 

(above), when calculating the price of an initial order for the sell side, the Spread Agent 

must assume a hedge price that is 0.618 worse than the current market price in order to 

achieve its spread. 

  

Pressing the Calculated button opens the Calculated Slip Components window. This 

read-only window displays the components that caused the calculation. 

 Expected—The average of how much the hedge order of the security has missed its 

expected price during the runtime of this Spread Agent. This will reset once orders 

from previous trading have been cleared from the system. 

 

TIP: A lower Max Ord Size relative to the Max Position can improve the accuracy 

of the expected slip since the average will smooth out over a larger order history. 

 

 Realized—The amount that the price of a hedge order needs to be adjusted in order 

to make up the incurred slip by the time the Spread Agent reaches its max position. 

This will reset once orders from previous trading have been cleared from the system. 

 

For example: If the Spread Agent has missed the desired spread so far, incurring a 

$100 deviation from the total desired value, the realized slip adjustment would be 

$100 divided by the quantity remaining until the Max Position is achieved. 

  

Override Spread Agent's Slip Adjustment 

  

You can override the dynamic values that Spread Agent has calculated for achieving a 

spread with custom defined values. In edit mode, check the Override box and either 

manually enter a value or use the up/down arrows to define a value. Once the order has 

started again, the override value can be adjusted without the need for entering the edit 

mode. 

  

Caution is advised when using the override. The Spread Agent's dynamic Slip 

Adjustments will be ignored when the override is enabled. This introduces risk 

that the desired Spread may not be achieved when the occurring slip is larger 

than the configured adjustment. There is also risk that the Spread Agent will be 

less aggressive if the occurring slip is less than the configured adjustment, 

causing market opportunities to be missed. 

  

  

  

Conditions 
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Learn how to configure conditions here. 

  

  

Safeguards 

  

Safeguards are common throughout all Managed Orders. Click here to learn about them. 

  

  

Other Actions 

  

Other Actions are also common throughout all Managed Orders. Click here to learn about 

them. 

  

  

Status Messages 

  

A number of status messages can be displayed in Spread Agent. Some are reactive to the 

safeguards in place (i.e., "past automatic shutoff time") while others report an error or 

status of the spread order. Here are just a few of the more common status messages: 

 Finished—Spread Agent is finished when both sides have executed quantity greater 

than or equal to each specified Target. The Spread Agent should never execute 

quantity greater than a side's Target, but Spread Agent checks for this case 
regardless. 

 Aborted—Spread Agent will additionally abort when any of the following occurs: 

 No unhedged initial order prices exist when a hedge order needs to be placed 

 An order cannot be initialized 

 An order reject is received 

 Stalled—Spread Agent will also stall when any of the following occurs: 

 Either side's route becomes unavailable 

 Required option quote sources are missing from the global configuration 

 Any required market data record is missing data 

 Any enabled trading Condition is not true 

 The current and reverse spreads are crossed 
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Spread Trader 

Spread Trader allows for the trading of two products with the anticipation that an increase 

in one product will effect an increase in the other (or a decrease in one effect a decrease in 

the other). The two products are defined by their price ratios, target quantities and the 

spread value. Once market conditions are suitable for achieving the spread, Spread Trader 

places an order for the product that is easiest to fill. Once that order has been filled, an 

order for the opposing product is sent at a price that will achieve the spread. If market 

conditions make it impossible to complete the spread with the initial order price, the open 

initial order will be canceled. 

 

 

 
Launch Spread Trader 

Configure a Basic Spread 

The Current Market 

Volatility Chart 

Currency 

Traded Status 

Advanced Parameters 

Conditions 

Safeguards 

Spread Ticket 

Trading Options 

Activity Log 

Start and Stop Spread Trader 

Other Actions 

 

 

 

Launch Spread Trader 

 

From the Managed Order Console type Ctrl + Shift + d. 

 

Alternate Methods: 

 

From the Action menu in the Managed Order Console, select New Managed Order --

>Spread Trader 
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Right-click in the Managed Order Console grid and select New Managed Order -->Spread 

Trader 

 

Note: Spread Trader can also be launched via the Spread Trader button in the Option 

Quote Cube. 

 

 

Configure a Basic Spread 

 

There are a number of values in Spread Trader that must be filled in order to execute a 

spread. 

 

Note: Each Spread Trader side can have only one initial order open at any point in time. 

 

 Quantity or $ Value—Enter one of the following: 

 

Quantity—The number of shares. The value entered is multiplied by the Ratio value 

and its sum is reflected in the Target field. 

 

Note: The amount in the Target field will be rounded up or down to the nearest 

hundred if Round Lots Only is checked. 

 

$ Value—Estimated cash for each side will equal the $ Value. This value is used 

when a trader wishes to create (or remove) a certain cash position on either side. 

  

 Spread—The price a trader desired to pay (debit) or receive (credit) when trading 

the two sides of the Spread Trader.  

  

 Credit/Debit—The buttons Credit and Debit refer to the concepts of "widening" 

and "narrowing." If Credit is selected, it's anticipated that the long symbol price 

(i.e., the long symbol you're selling) will increase, thereby "widening" the difference 

between two symbols. Selecting Debit indicates a desire to see the spread price 

"narrow" to zero then open up (or "widen") to make money. 

 

If Credit is selected, it is with the anticipation that a payout will be made in at least 

the defined value. If Debit is selected, the charge when trading a pair will be at most 

the defined value. 

  

 Sides and Symbols—Generally, a BUY side and a SELL side are selected as 

parameters for the spread, but two like sides (i.e., BUY and BUY) may also be 

chosen. 

 

Select a side from the following: 

 

BUY (Buy long) 

BYC (Buy to close) 

SEL (Sell long) 

SLA (Auto sell) 

SSH (Sell short) 

 

In the Symbol field, either manually type in a symbol name or select one from the 

drop-down list. 
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 Cash—This value refers to the amount of cash added to a trade. 

 

For example, in a merger situation, for each share of AGE stock, WB is offering .9844 

shares of its stock plus $35.80 in cash. 

 

The current price of AGE is $82.36 and WB is $48.82. The offer value per share is 

$83.86 (.9844 x 48.82) + 35.80 = $83.86 

$83.86 - $82.36 = $1.50 credit. 

  

 Ratio—The pricing of orders is based on the Ratio value, defined as the ratio 

between the prices of the symbols. 

  

 Target—The total number of shares (or contracts) to be traded on this side. In 

Quantity mode, each side's target value is defined as Quantity x Ratio. 

 

Note: The target amounts can be locked by pressing the lock icon next to the target 

field. 

  

 Max Order Size—An initial order on this side will not be sent with a quantity larger 

than the maximum order size. 

  

 Ref. Price—The reference price influences the value of the desired spread. If this 

value is modified, the spread will update. 

  

 Estimated Cash and Total Est. Cash—The estimated cash values of everything 

Spread Trader will trade. Buy sides have a negative cash, sell sides have a positive 

cash and is calculated as (estimated side price x side target). 

 

 

The Current Market 

 

 
 

Spread Trader reports the current Bid, Ask, and Last quotes for the selected symbols. 

 

In addition, the spread values for each quote are displayed resulting in either a Credit (C) or 

Debit (D) position. 

 

 

Volatility Chart 

 

Pressing the Volatility Chart button  opens the chart for the defined security.  

 

Learn more about the Volatility Chart here. 

 

 

Currency 
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By default, Spread Trader trades in U.S. dollars, but different currencies may be selected. 

 

Choose a different currency: 

 

1. Check the Use Currencies box. 

  

2. From the drop-down list, select a currency for each side. 

 

The conversion rate will be computed automatically. 

 

Traded Status 

 

 
 

The Traded box reports on the status of the Spread Trader. 

 

 Actual Spread—The spread value that was achieved while trading, specified using 

Credit (C) or Debit (D) notation. 

  

 Shares, Avg. Price, % Cmpl—The number of shares/contracts traded on each side, 

the average price of each side's traded shares/contracts, and the percentage of 

completion toward each side's target (100% indicates Spread Trader has completed 

in its entirety). 

 

Advanced Parameters 

 

 
 

Press the Advanced button to configure minimum order size, route, portfolio, and other 

options. 
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Min Ord Size 

 

The minimum order size is considered firm in that an initial order will be placed at the 

minimum amount if market prices allow it even if the market quantities do not. 

 

Define the minimum order size in shares for each symbol either by entering the value 

directly or by using the up/down arrows.  

  

Note: The minimum order size cannot be larger than the Max Ord Size. 

 

Round Lots Only 

 

If the Round Lots Only box is checked, the Min Ord Size and Max Ord Size will be 

interpreted as multiples of 100. 

 

Note: A Min Ord Side will be rounded down to the closest multiple of 100 (i.e., 175 

shares will round down to 100), while a Max Ord Size will be rounded up. 

 

Route and Portfolio 

 

Both Route and Portfolio must be selected from their drop-down lists before Spread 

Trader can initiate a spread order. 

 

Note: Both routes and portfolios can have their values locked by pressing the lock icon. 

 

Learn how to set up default routes and portfolios here.  

 

Slippage 

 

Slippage refers to the difference between the actual fill price and the available price at the 

time the order was placed. For a buy, it's the difference between the execution price and 

the ask. For a sell, it's the difference between the execution price and the bid at the time 

the order was placed. 

 

The value entered in the Slippage field is considered in the viability of achieving the spread. 

 

Max Increment Outside Market  

 

The Max Increment Outside Market refers to the maximum increment below the current 

bid or above the current ask at which an initial order will be placed. This value is internally 

adjusted by small amounts to prevent rapid cancelation and replacement of orders sitting at 

the edges of the market during small market fluctuations 

 

Note: You can only enter a value for the side being worked first. 

 

Work Mode 

 

Whether or not a price can be sent might require additional work. The different types of 

Work Modes affect where in the market an initial order can be placed.  

 

Spread Trader is set to run in one of three modes: 
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 Work Bid or Offer—The initial order will match the prevailing bid or offer as long as 

this will not violate the desired limit price.  

  

 Work Aggressively—The initial order will be placed at the most aggressive price 

allowable without violating the desired limit. This may, or may not, result in the 

initial order taking liquidity. 

  

 Market Taker—The initial order is only placed when the desired limit is currently 

achievable in the marketplace.  It will only take liquidity.  

 

Work This Side First 

 

Spread Trader can be instructed to work either side first. If enabled, the selected side will 

send out orders based on the achievability of the spread. 

 

The side not selected will place orders only when they are needed to hedge. 

 

1. Check the Work This Side First box to enable the feature. 

  

2. Select the side to work first from the drop-down list. 

 

Note: If trading an option and a stock, Spread Trader will force the option side first. 

 

 

Side 1 Locate Id/Side 2 Locate Id 

 

These fields are used as part of SEC Regulation SHO for short sales. This regulation includes 

a new uniform requirement for broker-dealers to locate securities available for borrowing 

prior to effecting a short sale. Both numbers and letters can be used in each Locate ID, but 

there is a 16-character limit. 

 

 

Conditions 

 

Learn how to configure conditions here. 

  

 

Safeguards 

 

Safeguards are common throughout all Managed Orders. Click here to learn about them. 

 

 

Spread Ticket 

 

Selecting the Spread Ticket button opens the ticket. In order for the Spread Ticket button 
to be active, the securities must be the same and, at least, one of the two has to be an option order. 

 

 

Trading Options 
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Spread Trader can send initial and hedge orders as options.  

 

 

Set Spread Trader for Options 

1. In the Basic Parameters section of Spread Trader, press the Build Option icon  

next to the Symbol name.     

  

2. The Option Builder window (above) will appear. 

  

3. Enter the necessary data in each field (security, expiration date, strike price, call or 

put, and root). 

  

4. Press OK to accept the values or Cancel to exit without savings. 

  

5. Repeat for the other side. 

 

 

Activity Log 

 

Click here to learn about the Activity Log. 

 

 

Start and Stop Spread Trader 

 

 
 

 

When all the edits to Spread Trader are complete, press the Apply button then the Start 

button. 

 

Note: If the Start button is pressed before the Apply button, Spread Trader will open a 

dialog box asking if the editing is finished and should the managed order be started. 

 

The Start button is also displayed in the Managed Order Console. 

 

The Stop button stops an incomplete spread trade. Once stopped, Spread Trader can be 

edited. The Stop button is also visible in the Managed Order Console. Pressing it here or in 

Spread Trader accomplishes the same thing. 
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In the image above, two spread trades are summarized in the Managed Order Console. One 

is waiting to start and one has started and can be stopped. 

 

 

Other Actions 

 

Click here to learn about the Other Actions feature in this, and all Managed Order applets. 

 

 



Managed Orders  Time Slicer 

302 © 2014 Wolverine Execution Services, LLC 

Time Slicer 

Time Slicer spreads trades on a single product over a defined time period. Configuring the 

start and stop times, minimum trade quantity, and interval between "slices" (portions of the 

total order) avoids flooding the market with a large order. Additional controls allow for the 

randomization of Time Slicer intervals and/or quantities. 

 

 
 
Launch Time Slicer 

Configure a Time Slicer Order 

The Summary Section 

Advanced Parameters 

Conditional Trading 

Safeguards 

Order Detail 

Other Actions 
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Launch Time Slicer 

 

From the Managed Order Console type Ctrl + Shift + t. 

 

Alternate Methods: 

 

From the Action menu in the Managed Order Console, select  

New Managed Order -->Time Slicer 

 

Right-click in the Managed Order Console grid and select  

New Managed Order -->Time Slicer 

 

Configure a Time Slicer Order 

 

The following fields must be specified to start a Time Slicer order: 

 

Symbol—Type a symbol or select one from the drop-down list. 

Note: Press the Build Option icon (next to the Symbol field) to configure Time 

Slicer to trade Options. 

 

Side Type—Select a BUY or SELL side type from the drop-down list. 

 

Price Type—Select a price type from the drop-down list. 

 

Inc/Px—Depending on the selected Price Type, either an incremental value or price 

amount is entered in this field.  

 

Press the Bid/Ask/Last buttons to enter the selected amount in the Px field.  

 

Note: When the Price Type is Market, a Px value cannot be entered. If a 

Bid/Ask/Last button is pressed, the Price Type will change to Limit.  

 

Portfolio and Route—Select a portfolio and route from their respective drop-down lists. 

 

Note: Press the lock icon next to the Portfolio and Route fields to save those 

values if the symbol field is changed. The values will not be saved when opening 

a new Time Slicer window. 

 

Qty or $—To have Time Slicer attempt to fill an order based on the number of shares to 

buy or sell, select Qty and enter the number of shares. The Est. $Val field will display the 

value of the shares. 

 

To fill an order based on the total price, select $ and enter a dollar value. The Est. Qty field 

will display the equivalent number of shares based on the dollar value. 

 

Min Slice Qty—Enter a value corresponding to the minimum number of shares (i.e., the 

slice) Time Slicer will attempt to fill. 

 

Note: Optionally, check the Max Slice Qty box and enter a value corresponding 

to the maximum slice size that Time Slicer will place. 
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Slice Show Qty—When enabled, the entered display value is applied to all sliced orders 

sent. The show quantity will be displayed as long as its value is less than or equal to the 

slice's order quantity. 
 

Round Lots Only—Check this box if Time Slicer is to send equity orders in multiples of 

100. 

 

Start Time/Stop Time—Enter the start and stop parameters when Time Slicer can trade. 

 

Note: Check the Start Immediately box to have Time Slicer trade as soon as 

the order has started. 

 

Min Slice Time Interval—This value (expressed in seconds) refers to the minimum time 

interval that Time Slicer will attempt to trade the minimum slice quantity. 

 

 

Complex Orders 

 

 

A spread order originating in Option Quote Cube sent to Time Slicer 

  

Time Slicer has the ability to support spread orders. 

  

The send to feature can be used to send spread parameters from a WTP applet (such as 

Option Quote Cube or Spread Trader).  

  

Spread parameters can be manually entered as well by checking the Complex box and 

filling in values into the Symbol, Side Type, and Ratio edit boxes. 

 

 

 

The Summary Section 
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Time Slicer displays an order's status in the Summary section. 

 

Target Qty—Time Slicer sends an order when the Target Quantity is greater than the sum 

of Total Sliced Quantity and the Next Slice (estimated) quantity. 

 

In the image above, 400 (Total Slice Quantity) + 600 (Next Slice estimated) 

= 1000 

 

Time Slicer will send an order when the Target Quantity is greater than 1000. 

 

Note: The behavior of Time Slicer with regard to the Target Quantity is only 

true if Randomize Slice Quantity is not enabled. See advanced 

parameters below for the description of the randomize feature. 

  

% Complete—The percentage of completeness for the entire quantity or dollar amount. 

 

Slice Count—The total number of traded and open orders. 

 

$ Val Exec—The dollar amount refers to the total dollar amount executed by a Time Slicer 

order. It is calculated by multiplying the traded quantity by the traded average price. 

 

Total Sliced Qty—The sum of all traded and open shares. 

 

Traded Qty—The total number of traded shares. 

 

Traded Avg Px—The average price for all trades. 

 

Open Qty—The number of shares still waiting to be traded. 

 

Open Avg Px—The average price of the shares waiting to be traded. 

 

 

Next Slice/Previous Slice 

 

The Next Slice field displays the estimated time and quantity of the next slice. These 

values are determined by Time Slicer based on market conditions. 

 

The Previous Slice displays the time and quantity of the most recent slice. 

 

 

Advanced Parameters 
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Randomize Slice Quantity and Time Interval 

  

Each slice is typically placed using a consistent time interval and quantity. The quantity can 

be varied by a defined percentage.  

  

Similarly, the minimum slice time interval can also be varied by a value in seconds. 

However, the Time Slicer will never violate the Min Slice Time Interval or Min Slice Qty 

values. 

  

Check either box to activate the advanced parameter. For Random Slice Quantity enter a 

percentage value. For Random Slice Time enter a value representing seconds. 

  

Time Zone 

  

From the drop-down menu, select the appropriate time zone. The time zone selected works 

in conjunction with the Start Time and Stop Time basic parameters. 

  

Locate ID 

  

Per SEC regulation SHO, traders are required to locate securities available for borrowing 

prior to effecting a short sale. Consequently, an identifier can be added in the Locate ID 

field.   

  

Both numbers and letters can be used in a Locate ID, but there is a 16-character limit. 

  

 

Time Zone 

 

From the drop-down menu, select the appropriate time zone. The time zone selected works 

in conjunction with the Start Time and Stop Time basic parameters. 

 

Conditional Trading 

 

One or more expressions can be defined that allows trading under specific circumstances. 

Press the Conditions button to open the Conditional Trading window. 

 

Learn more about defining conditions here.  

 

Safeguards 

 

Safeguards can offer an additional layer of protection for the trader with features such as 

limiting the number of open orders, order cancelation, and price boundary checks. 

 

Learn more about safeguards here.  
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Order Detail 

 

Press the Order Detail button to open the Order Grid. 

 

Other Actions 

 

Click here to learn how to rename Time Slicer orders, set ownership, and more.
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Vol Trader 

Vol Trader works by trading an option hedging with its underlying product based on market 

volatility. An option symbol is defined along with side types and percentage of volatility. A 

Vol Trader is marketable when (1) buying options with a volatility percentage greater or 

equal to the ask volatility or (2) selling options with a volatility percentage less than or 

equal to the bid volatility. 

 

 
 
Launch Vol Trader 

Set Up the Option Order 

Set Up The Underlying Stock 

Symbol 

The Current Market 

Greeks 

 

Achieved 

Advanced Setup 

Underlying 

Reverse a Vol Trader Order 

The Volatility Chart 

Conditions 

Safeguards 

Other Actions 

Activity Log 

 

 

Launch Vol Trader 

 

From the Managed Order Console type Ctrl + Shift + o. 

 

Alternate Methods: 

 

From the Action menu in the Managed Order Console, select New Managed Order -->Vol 

Trader 
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Right-click in the Managed Order Console grid and select New Managed Order -->Vol 

Trader 

 

Note: Vol Trader can also be launched via the Vol Trader button in the Option Quote 

Cube. 

 

 

Set Up the Option Order 

 

 
 

In the Option section of the Vol Trader window enter values for each field: 

 

 Und—The underlying security. Select from the drop-down list or type a symbol 

name. 

  

 Expr—The option's expiration date. 

  

 Strk—The strike price. 

  

 Root—The unique option class identifier. 

  

 Call/Put—Select the type of option order. 

  

 Option Side Type—BYO (Buy to open), BYC (Buy to close), SLO (Sell to open), SLC 

(Sell to close). 

  

 Option Quantity—The desired number of option contracts to trade. 

  

 Ref Px—The reference price.  

  

 Vol %—Volatility percentage. This value is based on the option and underlying 

reference prices, though it can be edited once Vol Trader has started. The volatility 

percentage increases or decreases in direct correlation to the reference price. 

 

Set Up the Underlying Stock Symbol 
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Vol Trader automatically assigns the underlying security to match the option symbol. 

Consequently, the Underlying Symbol field cannot be edited. 

 

Option Sides Types and the Underlying Stock Side Types 

 

The side type of the underlying security is determined by two factors: the option type (call 

or put) and the option's side. 

 

Option Type Option Side Type Underlying Symbol Side Type 

Call BYC or BYO SEL, SLA, or SSH 

Call SLC or SLO 

 

BUY or BYC 

 

Put 

 

BYC or BYO 

 

BUY or BYC 

Put 

 

SLC or SLO 

 

SEL, SLA, or SSH 

 

Here, the Ref Px refers is the reference price of the underlying security. 

 

 

The Current Market 

 

 
 

The current market's option and underlying Bid/Ask/Last prices are displayed in the 

Current Market area of Vol Trader. The volatility percentage values are also displayed. 

 

 

Greeks 
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Greeks measure an option's sensitivity to risk components.  

 

Delta measures the rate of change in the option price over the rate of the change in the 

underlying security. 

 

Gamma is the ratio of the change of an option's Delta to a small change in the price of the 

underlying security. 

 

Vega is the measurement of the sensitivity of an option's price to a change in its implied 

volatility. 

 

Note: Greek values are calculated by Wolverine and cannot be edited. 

 

 

Achieved 

 

 
 

The non-editable Achieved section displays the current status of Vol Trader: 

 

 Percentage complete 

  

 PNL (Profit and Loss) amount (profit displayed in green, loss displayed in red.) 

  

 Number of options traded and price 

  

 Number of underlying shares traded and price 

 

Note: The option and underlying prices are the average prices. 

  

 

Advanced Setup 

 

 
 

Option 
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Press the Advanced button to select the following: 

 

 Rte (Route) The route(s) to which option orders will be sent (click here for Option 

Quote Source route information). 

 

Note: If more than one route is selected, Vol Trader with fanout the order as equally 

as possible among all routes. 

  

 Port(folio) The portfolio in which option orders will exist (as defined in Global 

Configuration). 

 

Note: Both Rte and Port selections can be locked from making accidental changes. 

Press the lock button  to invoke this option. 

  

 Show (optional field). For reserve orders this value represents the quantity that 

should be shown to the world. 

 

Note: Field is disabled if the selected route does not support reserve orders. 

  

 Min(imum) Size specifies the minimum order size. 

  

 Max(imum) Size specifies the maximum order size. 

  

 Work Mode 

 

Work Bid or Offer—The initial order will match the prevailing bid or offer as long as 

this will not violate the desired limit price. 

 

Eye—The Eye feature enables the Work Bid or Offer mode to place an IOC 

(Immediate or Cancel) option order to buy at the ask or sell at the bid to try and 

capture marketable liquidity before falling back to its default behavior. To use this 

feature, the Vol Trader must be in Work Bid or Offer mode and the configured option 

route must support a Time In Force of IOC. Since the order will only be routed to the 

exchange designated in the Rte (Route) field, it is highly recommended to use this 

feature with a WEX smart router such as Xenon for orders to capture liquidity more 

broadly. 

 

Work Aggressively—The initial order will be placed at the most aggressive price 

allowable without violating the desired limit. This may, or may not, result in the 

initial order taking liquidity. 

 

Market Taker—The initial order is only placed when the desired limit is currently 

achievable in the marketplace.  It will only take liquidity.  

 

Hedge Parameters 

  

Hedge With: 

 

 Rte (Route) for underlying stock symbol (click here for information on route 

configurations). 

 Port(folio) (as defined in Global Configuration). 
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Note: Both RTE and Port selections can be locked from making accidental changes. 

Press the lock button  to invoke this option. 

  

 Min Size—The minimum order size. 

  

 Round Lots Only—Check this box if it's preferable to trade shares in round lots 

only. 

  

 Force (side type)—To force a hedge trade to be placed with the specified price 

type, select a side type from the drop-down list. 

 

If Calc Price From Option Exec is selected, Vol Trader will determine the 

underlying security's price based on the option's sale price and the defined volatility 

value.   

  

 Inc(remental)—Used with Calc Price and Force. 

 

Note: The increment cannot be adjusted if the price type is Market. 

  

 Disable Hedge Side—If checked, only option side orders will be placed. 

  

 Hedge Delta—Check this box to specify a delta value which, in turn, will be used in 

computing the Est. Qty of an underlying symbol. 

 

The Est. Qty is computed as follows: Hedge Delta x  Qty = Est. Qty 

 

If Hedge Delta is not checked, the market delta will be used when calculating the 

Est. Qty value. 

 

Note: A warning message displays whenever a Hedge Delta value is applied. The 

message states that a defined underlying quantity will not change with the market. 

  

 Locate ID—This field is used as part of SEC Regulation SHO for short sales. This 

regulation includes a new uniform requirement for broker-dealers to locate 

securities available for borrowing prior to effecting a short sale. Both numbers and 

letters can be used in a Locate ID, but there is a 16-character limit. 

 

Reverse a Vol Trader Order 

 

An unfilled Vol Trader order can have its sides reversed. For example a Vol Trader with a 

buy side and an underlying sell side can be switched: 

 

 
   
Original Vol Trader Order 

 
 
Vol Trader Reversed 
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Once a Vol Trader order has been selected to be reversed, the new Vol Trader order will 

display with the word "Reversed" in the title bar. 

 

With the reverse feature, Vol Trader can be configured to reverse those quantities that have 

already been filled, or the entire Vol Trader order. 

 

1. Right-click on a Vol Trader order in the Managed Order Console and select 

Reverse Vol Trader. 

  

2. Select either Reverse Filled Quantities or Reverse Entire Vol Trader. 

 

 
 

A reversed Vol Trader window will open. Make any desired changes and press Start to start 

the reversed order. 

 

 

The Volatility Chart Viewer 
 

 

 

Press the Historic Volatility Chart icon  to launch the chart.  

 

The Historic Volatility Chart graphs volatility data for a security over selected time periods. 

 If the underlying security in Vol Trader changes, the Historic Volatility Chart will change 

accordingly. 

 

To learn more about the Volatility Chart click here. 

 

 

Calculate Vol Trader Percentage from Reference Prices 
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Vol % is 0.00 for imported Vol Trader orders 

 

 

 

 

 
 
Vol % is calculated when Snap Vol is selected 
 

  
 

 

Unless specifically defined in a Vol Trader import file, imported Vol Traders do not have an 

associated Vol % value. This is due to the fact that a Vol % value is dependent on a number 

of factors including a security's reference price, an underlying security's reference price, and 

current market conditions. 

  

Consequently, the Managed Order Console will display the Vol % of imported Vol Traders 

as 0.00 unless one of the following occurs: 

 

 The order is opened for viewing, at which point the Vol % will be calculated. 
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 The Vol Trader button Snap Vol is selected. The Vol % will be calculated and 

displayed without the need for opening the order. 

  

Add the Snap Vol column to the Managed Order Console: 

1. Open the Field Chooser. 

2. Select Vol Trader then Snap Vol. 

 
 

Conditions 

 

 
 

Learn how to define Conditions under which a trade can be made here.  

 

Safeguards 

 

Safeguards are common to all Managed Orders. Learn all about them here. 

 

Other Actions 

 

Actions such as setting ownership and renaming an order are described here.  

 

Activity Log 

 

The Activity Log is common for all Managed Orders. Learn about it here. 
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Basic Concepts 

 

Cancel Orders 

 

Orders that are live but have not filled can be canceled. 

 

Most grid-display applets allow for order cancellation, while others display a button that 

accomplishes the same thing. 

 

Cancel a Live Order for a Single Symbol 

 

1. Click the right mouse button anywhere in a grid-based applet. 

  

2. Select CXL Orders for Symbol  (symbol name) or type CTRL +z. 

 

Cancel All Live Orders 

  

1. Click the right mouse button anywhere in a grid-based applet. 

  

2. Select Cancel All Orders. 

  

Cancel Matching Orders 

 

With some WTP applets, not only can an order be canceled, but categorized orders can be 

canceled as well. 

 

Applets Position Grid, Order Grid, and Wave Grid allow for the cancelation of matching 

orders. 

 

Options when canceling matching orders include: 

 

 Cancel of Side 

  

 Route 

  

 In Account 

  

 In Portfolio 

  

 From User  

 

Follow the same steps as above when canceling matching orders. 

 

Cancel Order and Cancel Matching Orders  from the Order Ticket 

 

Orders can also be canceled from the Order Ticket. Click on the Order Ticket with right 

mouse button and select either Cancel All Orders or Cancel Matching Orders.
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Columns and Formatting 

The grids available in a number of WTP applets (Quote Grid, Option Quote Cube, Spread 

Builder, etc.) are dynamic data reporting tools, completely configurable in both appearance 

and content type. 

  

The rows and columns in a WTP grid can be customized as follows: 

 

1. Display Columns (applet based, consisting of launch button fields, quote fields, alert 

fields, and user-defined fields) 

  

2. Colors (standard and alternating backgrounds, selection colors, highlight colors, text 

colors, market changing colors, PNL colors, buy/sell colors, filled order colors) 

  

3. Fonts (headers/body text, size) 

  

4. Alignment (horizontal/vertical) 

  

5. Format (fractional/numeric/ticks for individual cells) 

  

6. Conditional colors (based on expressions, conditions, and target values) 

  

7. Line Style (none, solid, dashed, dotted) 

  

8. Highlight period of a column (in seconds) 

  

  

On This Page: 

  

Access the 

Configuration Screen 

  

Move Columns  

Set Grid Default 

Style 

  

Delete Columns 

  

Set Column Header 

Style 

  

Add and Delete Rows  

Set Row Color 

Conditions 

  

Issue an Order from a Grid  

Set an Alert Priority 

  

Custom Quote Fields  

Column Data—

Ascending, 

Descending, and 

Absolute Order  

User Defined Fields  

  

Add Columns To Grid 
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Quote Grid, default grid colors 

  

  

 
  
Quote Grid, custom row colors 
  

  

  

Access the Configuration Screen 

  

For most WTP applets, grid customizing begins with the Configuration screen: 
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Click the right mouse button anywhere in the grid of an applet and select Configuration. A 

screen similar to the one above will display. 

  

Set Grid Default Style 
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Font, format, and colors can be defined as default values 

  

To define the default font for a grid: 

 

1. Click Set Grid Default Style 

  

2. The Grid Default Style window will appear and default to the Font tab 

  

3. Choose a font, style, and size. If the strikeout or underline feature is desired, check 

the appropriate box. The preview window will display the font selections. 

  

4. Press OK to accept the selections, or Cancel to exit the screen without saving. 
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For alignment related settings click on the Alignment tab: 

 

 
  

Horizontal and Vertical alignment are selected here. Both alignment settings refer to the 

positioning of content within a grid's cell. 

  

Wrap Text causes text to automatically fit within a cell by causing the copy to break to the 

next line. If unchecked, text will not automatically break to the next line. 

  

Decimal Places refer to the display of the amount of integers following the decimal point 

(example: setting the value to 5 will, if necessary, display up to five numerals after the 

decimal point). 

  

Reset to Defaults sets formatting to WTP's original default values. 

  

To select default Colors, click on the Colors tab: 
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The color selection screen above may not match exactly depending on the WTP applet, but 

there are universal settings applicable to all color selections. 

  

To change colors: 

 

Click on a color that is to be changed. The color window will open: 
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From this window you can: 

  

1. Select any color just by clicking on it 

  

2. Create a custom color either manually (by entering numeric values), or by 

moving the mouse in the color field into an acceptable color is found. 

 

3. When a color is defined, click Add to Custom Colors and the new color will be 

in the Custom colors portion of the window. 

 

4. Click OK to accept your changes or Cancel to exit the color window without 

accepting changes. 

  

Set Column Header Style 

  

The method for changing the Column Header style is identical to that of the Grid default 

style. Fonts, formatting, and colors are selected in the same manner. See Set Grid Default 

Style for directions. 

  

  

Set Row Color Conditions 
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In this example, all securities with an ASK value less than $25.00 will be flagged in this 

color. 

  

In addition to defining overall colors for the grid and headers, defined conditions (such as 

the asking price on a security that has decreased) can be flagged with a specific color. 

  

To set up Row Color Conditions: 

 

1. Select Set Row Color Conditions from the Configuration window. 

  

2. Select a specific security (if available), or select <All>. 

  

3. Click a field in the Expression column and select an expression from the drop-down 

list. Expressions include: Ask, Bid, Previous Close, and Last. 

  

4. Select a condition ( <   <=   =   >   >=   Not =) 

  

5. Enter a target value. 

  

6. Press the Color button 

  

7. Select OK to accept your values or Cancel to exit the Row Color Conditions window. 

 

The rows in the grid will highlighted where the color condition matches the target value. 

  

  

Set an Alert Priority 

  

In addition to setting visually-based color conditions, an audio alert priority can be set up 

to play a sound when defined conditions have been met. 

 

1. In the Row Color Conditions window select an Alert Priority from the drop-down list 

(Low, Medium, High). 

  

2. Press the Notifications Config button   and the Global Configuration screen will 

display. 
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3. In the Event column are listed the three alert conditions. Click once on the row 

containing the priority level selected in Step 1. 

  

4. Select a sound to be played when the conditions on the grid have been met, by 

selecting a .wav file from the drop-down list. 

 

Alternatively, you may browse for a .wav file anywhere on your system by pressing 

the Browse button and select the appropriate .wav file. 

  

5. The selected .wav file can be sampled. Press the play button  to hear the .wav 

file. 

  

Column Data—Ascending, Descending, and Absolute Order 

  

Every column in a grid can have its content displayed in ascending or descending order. 

  

To change the display order of a column: 

 

1. Double-click the mouse on the head of a column who's data display is to change. The 

data will be displayed ascending in value. (If the column contains only text, the 

column will display in alphabetical order). 

  

2. Double-click the mouse to toggle the display (from ascending to descending and vice 

versa). 

 

Absolute Order 

  

In addition to ascending or descending order, all numerical columns can be sorted in 

absolute order. An absolute sort follows this similar pattern: 0, -1 , 1, -2, 2, etc. 

  

To sort a column in absolute order, double-click on the column head three times, OR right-

click in a grid and select Sort Absolute Ascending or Sort Absolute Descending. 

  

  

Add Columns to Grids 

  

  

There are a three methods for adding columns to grids. 

  

Method 1: The Configure Window 
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In a WTP grid app (Quote Grid, Order Grid, etc.) open the configuration window under the 

Columns and Formatting tab. 

  

Select the field type (i.e., Alert Fields, Launch Button Fields, etc. Note that field types are 

different for different grids). Within each field type are the columns available for placement 

in the grid. Double-click the column to be added or select the column to be added and press 

the right arrow button  . The column will be placed below the row selected in the 

Visible Columns portion of the window. Select OK to save your changes. The column will 

then be visible in the grid. 

  

  

Method 2: The Right Mouse Button 
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Right-click on any column head in the grid. Select Insert Column-->The Field Type--

>The Column Name. 

  

The column will be placed immediately to the left of the column that was originally 

selected. 

  

  

Method 3: Field Chooser 

  

 
  

  

With Field Chooser, single or multiple columns can be inserted in all WTP grid apps in a 

manner that is relatively easy. 

  

The benefit of using Field Chooser is that multiple columns can be added in a single pass, 

whereas only a single column at a time could be added via the Insert Column-->Field 

Name-->Column name command. 

  

Launch Field Chooser 

  

In a WTP Grid app, right-click on any column head and select Field Chooser. The Field 

Chooser selection window opens. 

  

Select Columns with Field Chooser 

  

In the top portion of the Field Chooser window (white background) select the field type (for 

example, Alert, Launch Button, etc.) Note that field types are specific to each grid. 

  

Once a field type has been selected, the columns associated with that field type are 

displayed in the bottom portion of Field Chooser (the background color in Field Chooser 

reflects the background color of the grid). 

  



Basic Concepts  Columns and Formatting 

329 © 2014 Wolverine Execution Services, LLC 

To place a single column to the left of the selected column, double-click on a column 

name. 

  

To place a single column anywhere in the grid, single-click a column name and drag 

the column to the desired location in the grid and release. 

  

To select and place multiple columns anywhere in the grid in a single pass, hold 

down the Ctrl key while selecting the columns. Drag the selected columns to the desired 

location in the grid and release. 

  

When a column is placed in a grid it is removed from selection in Field Chooser. When a 

column in a grid is removed, it is available for selection in Field Chooser. 

  

  

Move Columns 

  

To move a single column: 

  

1. Select the column to be moved with a single mouse click on the column head. 

  

2. Press and hold the left-mouse button and move the column left or right. 

  

3. Release the mouse button. 

  

  

To move multiple adjacent columns: 

  

1. Click and hold the left mouse button on the first column to be moved. 

  

2. Moved the mouse left or right to select adjacent rows to be moved. 

  

3. With all the rows selected, click on one and hold the left mouse button. 

  

4. Move the entire group of the columns left or right as desired and release the mouse 

button. 

  

  

An alternate method for selecting multiple columns: 

  

1. Select a single column. 

  

2. Move the mouse to the left-most or right-most column in the group of columns. 

  

3. Hold down the shift key and click the left mouse button. All columns will be highlighted.  

  

  

Delete Columns 

  

1. Right-click on the column head for the column that is to be deleted. 

  

2. Select Remove Column. 
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Multiple columns can also be deleted by this method. See Move Columns (above) for 

directions on selecting multiple columns. 

  

  

  

Add and Delete Rows 

  

To add a row to a grid: 

 

1. Click on a row where the row will be added. 

  

2. Press Insert on the keyboard. 

 

The row will be added above the selected row. 

  

To delete a row in a grid: 

 

1. Select a row that is to be deleted. 

  

2. Press the Delete key. 

 

The row will be deleted. A deleted row cannot be undeleted. 

  

  

Issue an Order from a Grid 

  

Most grids in WTP allow the placing of orders by bringing up the Order Ticket. 

 

1. Double-click the mouse on a row containing a symbol that is to be traded. 

  

2. The Order Ticket will appear. 

  

Custom Quote Fields 

  

A quote field column that can be added to grids is initially identified as <Custom>. The data 

in a custom column is supplied by a selected Reuters Field ID. Once a field ID has been 

defined for a custom column, the column's name automatically changes to match the 

description of the field ID. For example, a Reuters Field ID of 16 = Trade Date. The 

column's header will default to the standard FID Acronym (though, as with all column 

heads, it can be customized). 

  

Step 1: Add a Custom Quote Field 

 

1. Click the configuration icon or right-click on any existing column head. 

  

2. Select Quote Fields 

  

3. Select <Custom>. 

 

A new column <Custom> will be placed in the grid. 

  

Step 2: Set the Column Style 
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1. Right-click on the column header <Custom> in the grid and select Set Column 

Style. The <Custom> Style window opens: 

 

 
  

2. Enter an FID number in the Reuters Field ID field. If the number is an active FID, 

the <Custom> Style window will respond by populating the Default Title, Display 

Title, and Reuters Field ID Name fields: 

 

 
  

3. Click OK to save the defined custom style. The custom quote field column will be 

placed in the grid with its title displayed. 

  

User Defined Fields 

  

User Defined Fields are grid columns also known as Expression Fields (or Calculated 

Fields). Similar to the cells in an Excel spreadsheet, functions can be created for columns 

that yield a text or mathematical result. 

  

Expression Fields 
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There are two types of Expression Fields: 

 

1. Numeric (Used for displaying Expressions that return numerical values. 

Addition/subtraction/multiplication/division functions can be used in numeric 

expressions. ) 

  

2. String (Returns string values) 

 

Define Expression Fields 

 

1. From the applet's configuration screen, select User Defined Fields. 

2. Select either <Numeric Expression> or <String Expression> and press the 

right-arrow key to add it to the grid. 

3. In the grid, right-click on the column head and select Set Column Style. One of the 

following will open, depending on the expression: 

 

 

     

 
 

<String Expression> Style    <Numeric Expression> Style 
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4. Enter a Display Title in the Display Title field. The title entered here will be the 

column head title that is displayed in the grid.  (The Default Title field cannot be 

edited.) 

5. For String Expressions, optionally enter a column width. 

 

For Numeric Expressions, optionally enter a column width, and, if desired, check 

whether the column will Display Column Total and/or Display Column Average. 

6. Enter an Expression. 

7. Click OK. 

  

Data Fields 

  

In addition to the Expression Fields, there are up to 16 Data Fields from which to choose. 

Data Fields are input fields where static information is applied to an Expression. 

  

A Data Field can have its content entered directly in the grid, and have its content 

calculated in an expression (which references the Data Field's values). Data Fields have 

their names defaulted to DataXX (where XX is the Data Field number, 01 to 16). Once a 

specific Data Field is added to a grid, that Data Field is removed from the list of available 

columns. 

  

Define a Data Field 

 

1. From the applet's configuration screen, select User Defined Fields. 

2. Select an available DataXX column and press the right-arrow key to add it to the 

grid. 

3. In the grid, right-click on the column head and select Set Column Style. A Data 

Field Style window will open: 

 

 
4. Enter a Display Title. The title entered here will be the column head title that is 

displayed in the grid. 

5. Click OK. 

  

Numeric Expression Example 

  

In the following Numeric Expression, the goal is to display the Edge value in the grid. The 

expression [Last] - [TV] will yield the Edge value. 
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The Style window contains the display title and expression: 

 

 
  

  

Data Field Example 

  

In this example, a Data Field (Data01) has been created with the name d1: 

  

 
  

The d1 column in the grid shows text manually added: 
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String Expression Example 

  

In this example, a string expression has been built around the manually created d1 

(Data01) column (above). To this column is added the current Ask value for a security: 

  

 
  

The new column, titled Ask + d1 takes the Ask value and adds it to the d1 value and 

displays the sum: 

  

 
  

  

Advanced Functions 
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A variety of Advanced functions (math/string/logic/date + time) can be called in all WTP 

grids. 

  

See available functions on the List of Functions page. 
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Export Grid Data 

 

 
 

Data contained in WTP grid-based applets can be exported to a file, the clipboard, or to a 

Microsoft Excel spreadsheet. 

 

Export Grid Data 

 

1. Anywhere in the body of the WTP applet, click the right mouse button. 

  

2. Select Export Grid Data. 

  

3. Select a destination for the exported data 

 

Export to File—Enter a path and filename for the exported file 

 

Copy to Clipboard—Select this and the data will be available in clipboard 

 

Export to Microsoft Excel—Select this and Excel will open and the grid data will be 

loaded 

  

4. Select the data to export: 

 

Selected Range vs. Entire Grid—Selected Range refers to an area highlighted by 

the mouse. Entire Grid refers to all rows and columns of the grid. 

 

Include Column Titles—Check this box if the grid's Column Titles should be 

exported. 

 

Include Row Numbers—Row numbers will be a part of the exported file if this 

option is checked. 

 

Only Symbols—Stock symbols exclusively will be exported with this option. 

  

5. An option to Strip Commas from Numeric Fields and a Field Delimiter selection 

becomes available if Export to File or Copy to Clipboard has been selected. 

 

To remove the commas from fields with numbers, check this box. 
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Select either Comma, Space, or Tab to identify the delimiter that will be used 

between fields. 

  

6. Click OK. 

 

Note: When selecting OK, an exported file will be created. To save Export Grid Data 

settings without actually creating an exported file, select Save Settings. 

 

 

Quick Export 

  

  

 
  

Quick Export exports grid data (either selected range or entire grid) to a file, clipboard, or 

MS-Excel spreadsheet, based on the settings defined in the Export Grid Data window. 

  

  

Select Quick Export 

 

A quick export can be issued by selecting the Quick Export icon in a grid app's toolbar.  

 

Alternate methods for selecting Quick Export: 

 

 From the Action menu 

 Right-clicking in the grid 

 Ctrl + Shift + E keyboard shortcut 

  

  

Warning Conditions Issued By Quick Export 
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The Quick Export function will issue a warning if either of these conditions exist: 

 

 The Export Grid Data settings have not been configured and saved 

 The exported grid data will overwrite an existing exported file 

  

Tip: It is recommended to save the WTP app containing the Export Grid Data settings as a 

template (either as the default template or a customized template) in order to retain the 

export settings when the app is re-launched. If the app is not saved as a template, the 

Export Grid Data settings will not be saved.
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Icons in WTP 

The following are a list of icons that appear throughout the WTP applet suite. Click 

on the icon's name to see it described in context with a specific applet. 

 

The links to the icon's descriptions are by no means exhaustive as many icons are 

repeated throughout WTP (the Configure icon, for example, appears in almost every 

applet). 

 

ICON Name Found In 

 

Adjust position  Position Grid 

 

Advanced mode  All 

 

Alert Column All Grids/Managed Order Console 

 

Auto close on buy and sell  Order Ticket/Crossing Ticket/Stage Ticket 

 

Basket Detail  Basket Trader 

 

Build Option Option Quote Cube 

 

Cancel All Orders  Order Tickets/Grids 

 

Cancel Selected Order  All Grids 

 

Configure (opens 

configuration window for a 

WTP app) 

All Apps/WTP Toolbar 

 

Connection  WTP Toolbar 

 

Copy (standard Windows 

feature used in 

conjunction with Cut and 

Paste) 

All 

 

Credit  Spread Tickets (displays with Debit icon) 

 

Debit Spread Tickets (displays with Credit icon) 

 

Delete Selected Managed 

Orders  

Managed Order Console, managed orders 

 

Equity Mode (toggle to 

Option mode) 

Option Quote Cube 
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Equity Mode (toggle to 

Option mode) 

Option Time and Sales 

 

Filter Options  Options Time and Sales/Equity Time and 

Sales/Equity Imbalance Viewer/Option Sector 

Viewer/Spread Book/Spread Builder/Flex Ticket 

 

Filter Spread Book on Built 

Spread  

Spread Builder/Spread Book 

 

Force Live Orders to the 

Bottom  

Order Grid 

 

Import Managed Order  Managed Order Console 

 

Launch Chat Manager  Instant Messenger 

 

Launch Order Grid  Position Grid/Wave Grid/Managed Order Console 

 

Launch Wave Position Grid Wave Grid/Managed Order Console 

 

Link to WTP Help Pages All 

 

Lock Icon/Read Only 

Mode/Pin Dialog Open 

Lock Icon = All tickets 

Read Only Mode = All Basket Trader 

apps/Managed Order Console 

Pin Dialog Open = Option Quote Cube when 

selecting the Filters Icon 

 

New Basket  All Basket Trader apps  

 

New Favorites Folder  Instant Messenger 

 

New Managed Order  Managed Order Console 

 

New Order (opens Order 

Ticket) 

Order Grid 

 

Open Basket  All Basket Trader apps 

 

Open Story  News Browser 

 

Open Symbol List  News Browser 

 

Option Mode (toggle to 

Option Time and Sales) 

Equity Time and Sales 

 

Options Column Display Order Grid/Quote Grid/Basket Trader/Crossing 

Basket/Stage Basket 
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Paste (standard Windows 

feature used in 

conjunction with Copy and 

Cut) 

All Basket Trader apps/Quote Grid 

 

Print Managed Order Console/Instant Messenger/News 

Browser/WTP Browser 

 

Report Trade Ticket  Order Grid 

 

Save Basket  All Basket Trader apps 

 

Save Symbol List  Quote Grid 

 

Select Grid Mode  Equity Quote Cube 

 

Select View Basket Trader 

 

Show Basket Detail  All Basket Trader apps 

 

Show Exchange Order 

Quotes  

Order Ticket/Spread Ticket/Crossing Ticket 

 

Show/Hide Volatility Chart 

Viewer  

Option Quote Cube/Equity Time and Sales/Spread 

Trader/Vol Trader 

 

Show/Hide Ticker  Option Quote Cube/Equity Quote Cube 

 

Show Montage Grid  Spread Ticket/Spread Builder/Flex Ticket 

 

Show Order Detail  Order Grid/Allocator 

 

Show Order Summary  Order Grid/Allocator 

 

Show Security Detail  Equity Quote Cube/Option Quote Cube/Flex Ticket 

 

Show Spread Book  Spread Ticket/Spread Builder 

 

Start Selected Managed 

Orders  

Managed Order Console 

 

Stop All Managed Orders  Managed Order Console 

 

Stop Selected Managed 

Orders  

Managed Order Console 

 

Switch to Crossing Ticket  Order Ticket/Spread Ticket/Staged Ticket/Flex 

Ticket/Spread Builder 

 

Switch to Equity Mode  Options Mode in: Order Ticket /Crossing Order 

Ticket /Staged Order Ticket 
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Switch to Options Mode  Equity Mode in: Order Ticket /Crossing Order 

Ticket /Staged Order Ticket 

 

Switch to Outright Ticket  Crossing Order Ticket/Staged Ticket 

 

Switch to Staged 

Ticket/New Staged Order  

Order Ticket/Spread Ticket/Crossing Ticket/Order 

Grid/Spread Builder 

 

Snap to Size (toggle) WTP Browser 

 

Toggle Symbol Tracking  All WTP apps except News Browser/Instant 

Messenger 

 

WTP Update Available WTP Toolbar 

 

Workspace Management  WTP Toolbar 
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Keyboard Shortcuts 

Applet Command Keyboard Shortcut 

ALL APPLETS 

Launch Help File F1 

Define WTP Icon 
Hover over icon and press 

F1 

Close Applet Ctrl + q 

Launch Order Ticket (except 

Managed Order Console) 
Ctrl + n 

      

ALL GRIDS 

New order (launches Order 

Ticket) 
Ctrl + n 

Copy Ctrl + c 

Copy selected cell Ctrl + Shift + c 

Quick Export Ctrl + Shift + e 

Select all Ctrl + a 

Extend selection range 

Up/Down 
Shift + up/down 

Select range Shift + mouse click 

Multi-select (select/deselect) 

rows 
Ctrl + mouse click 

Zoom in/out 
Ctrl + mouse scroll 

up/down 

Scroll view without moving 

current cell 
Ctrl + up/down/left/right 

arrow 

Move to next UI control Tab key 

Select column Ctrl + select column 

      

EDITABLE GRIDS 
(Basket Traders, 

Spread 
Builder/Ticket Grid, 

Spread Viewer) 

Paste Ctrl + v 

Add row Insert 

Delete row Delete 

      

Managed Order 

Console 

Launch Hedge Agent Ctrl + Shift + h 

Launch Spread Agent Ctrl +Shift + s 

Launch Spread Trader Ctrl + Shift + d 

Launch Time Slicer Ctrl + Shift +t 
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Launch Vol Trader Ctrl + Shift + o 

Choose type and firm Ctrl + n 

Import Managed Order Ctrl + i 

Open Selected Managed 

Order 
Enter 

Delete Selected Managed 

Order 
Delete 

      

Equity Quote Cube Launch Crossing Ticket Ctrl + Shift + x 

      

Instant Messenger Search feature Ctrl + f 

      

News Browser Open news story Enter 

      

Option Quote Cube 

Make quick trade Ctrl + b 

View multiple months 
Ctrl + click on each 

individual month's tab 

Launch crossing ticket Ctrl + Shift + x 

      

Order Grid 

Cancel selected orders Ctrl + x 

Open Order Detail dialog for 

selected order 
Enter 

      

Position Grid 
Open Order Grid for selected 

position 
Enter 

      

Wave Grid 
Open Order Grid for selected 

position 
Enter 

      

WTP Browser Open a web page Ctrl + o 

      

Function: Price/Qty 
Spinners 

Spin by 5x the default setting Shift + up/down arrow 
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Option Exchange Codes 

 
Code 

 

 
Exchange 

 
A NYSE AMEX 

B BOX 

C CBOE C2 

H GEMINI 

M MIAX 

P NYSE ARCA 

Q NASDAQ 

T NASDAQ OMX BX 

W CBOE 

X NASDAQ OMX PHLX 

Y ISE 

Z BATS 
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Printing 

The following WTP applets can have their screen image sent to a printer: 

 

 Order Grid 

  

 Position Grid 

  

 Wave Grid 

  

 Managed Order Console 

  

 Allocator 

  

 Quote Grid 

  

 Equity Time and Sales 

  

 Option Time and Sales 

  

 Option Sector Viewer 

  

 News Browser 

  

 Instant Messenger 

  

 Quote Explorer 

 

Print, Print Preview, Print Setup 

 

The print functions operate in the same manner as other Windows-based applications. 

 

Print—A print window opens and all print-related options display 

 

Print Preview—A screen displays what the printed output will look like. Additional options 

are available (Zoom, one page/two page display) 

 

Print Setup—Brings up the same print window as Print without actually issuing the print 

command 
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Tabs in Grids 

 

Each tab in a grid can be renamed, removed, or repositioned. Additionally, a tab's 

identifying label (font/style/size) can be changed. New tabs can also be created. 

 

 

 
 

 

 

Create a New Tab 

 

1. Right-click on a tab to be created. 

  

2. Select Create New Tab. 

  

3. Enter a new tab name in the window and click OK. 

 

Close Tab 

 

1. Right-click on a tab to close. 

  

2. Select Close Tab. 

 

Close All But This 

 

1. Right-click on a tab to remain open while all others will close. 

  

2. Select Close All But This. 

 

Open In a New Window 
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1. Right-click on a tab that will be opened in its own window. 

  

2. Select Open In a New Window. 

 

A new window will open and the tab will be deleted from its original grouping. 

 

Rename Tab 

 

1. Right-click on a tab to be renamed. 

  

2. Select Rename Tab. 

  

3. Enter a new tab name in the window and click OK. 

 

 

Change Font/Style/Size of Tabs 

 

1. Right-click anywhere in the tab area. 

  

2. Select Configuration. 

  

3. Select the variables for the new style in the Tab Style window and click OK. 

 

 

Position Tabs 

 

The tabs can be placed in the top/bottom/left/right areas of the Position Grid. The default 

position is the bottom of the grid. 

 

To Change the Tab Position: 

 

1. Right-click near the row of tabs and select Configuration. A configuration window 

appears. 

  

2. Select the Format tab. 
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3. Choose the desired alignment of the tabs, or select Hide Tabs. 

 

Note: Hiding tabs will cause all grids and templates associated with the inactive tabs 

to be permanently removed from the window. 

  

4. Click OK. 

 

 

Drag Tab to Create a New Window at the Drop Point 

  

 
  

Select a tab and drag it to a preferred desktop location. A new window will display at the 

drop point. 

  

  

  

Tabs in the Equity Quote Cube and Option Quote Cube can be dragged from their 

location onto another area of the desktop, creating a new window at the drop point. 

  

When a tab is dragged to a new location, it will be removed from the remaining tabs of the 

source applet. 

 

Alphabetize Tabs in Equity and Option Quote Cubes 
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Tabs listed in random order 

  

 
  

New option "Keep Tabs Sorted" sorts tabs alphabetically 

  

  

 
  

Tabs sorted alphabetically 
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A feature in Equity Quote Cube and Option Quote Cube allows for the display of tabs in 

alphabetical order. 

  

To place tabs in alphabetical order: 

 

1. Right-click on any tab and select Configuration. 

 

Alternate Method: 

 

From the Config menu select Configure Tabs. 

 

2. In the Configure Tabs window, select the Format tab. 

 

3. Check Keep Tabs Sorted. 

 

Every new tab that is added will be placed in the correct alphabetical order. 

  

Note: Tabs cannot be manually repositioned as long as Keep Tabs Sorted is in effect. To 

manually reposition tabs, uncheck Keep Tabs Sorted. 

 

 

Automatic Tab Adding 

  

 

Automatic Tab Adding Enabled Automatic Tab Adding Disabled 
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Automatic Tab Adding is a optional feature found in the Equity Quote Cube and Option 

Quote Cube. 

  

Automatic Tab adding will create a tab without any additional user interaction. Disabling 

Automatic Tab Adding will require pressing the Enter key after a symbol is entered to add a 

tab. 

  

With Automatic Tab Adding enabled (column 1 above): 

 When a symbol is entered in the symbol field, a new tab is created soon after the 

final character is entered. 

 

For example, if the symbol MSFT is entered slowly, the Quote Cubes would respond 

by creating four new tabs as follows: 

 

M opens a new tab with the symbol M. 

 

S opens a new tab with the symbol MS. 

 

F opens a new tab with the symbol MSF. 

 

T opens a new tab with the symbol MSFT. 

With Automatic Tab Adding disabled (column 2 above): 

 The Quote Cubes will display the symbol name as each letter is entered. 

 

A single tab will be created and updated as additional letters are entered but 

additional tabs will not be created. 

 
To create additional tabs, press Enter after each symbol is entered. 
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In the System Default Template for the Equity/Option Quote Cubes, Automatic Tab Adding 

is disabled. If it's preferred to always allow Automatic Tab Adding, either Quote Cube can be 

saved as a template. 

  

Hide Tabs 

  

If neither of the Automatic Tab Adding options is desired, tabs can be hidden. 
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Templates 

 

The grid data in many WTP applets can be saved as a template and retrieved at a later 

time. Generally, saved templates are used for those applets in which a number of unique 

configurations have been defined and wished to be saved for future retrieval. A default 

template can also be defined. 

 

The suffix for a saved template is dependent upon the applet. For example, a saved 

template has a .aot suffix for the Allocator while Quote Grid's template has a .qgt 

extension. 

 

To access the template commands: 

 

 Right-click on the applet's grid and select File Commands 

  

 Click on the applet name in the WTP toolbar and select File 

 

Open Template—Opens a dialog box in which a previously saved template can be selected. 

(Note: It may be necessary to maneuver through a directory's hierarchy in order to find the 

template.) 

 

Save Template As—Opens a dialog box in which a template is given a name and is placed 

in a chosen directory. 

 

Save as Default Template—The template is saved as a default. A default template is not 

named. 

 

Revert to System Default Template—The default template (above) is overwritten by the 

system default template. If selected a query window will display: 

  

"Reverting to the system default template for (applet name) will    

replace your existing default template with the  system default 

template for the current window. Continue?" 

 

Select Yes to write over the existing default template with the system default template, No 

to prevent the system default template from overriding the default template, Cancel to exit 

without overriding the default template. 
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Toggle Symbol Tracking 

 

Many applets in WTP have a feature called Toggle Symbol Tracking. The idea behind 

Toggle Symbol Tracking is that a symbol can be "tracked" while working on other WTP 

applets without having to manually select the same symbol each time an applet 

 

If enabled, Toggle Symbol Tracking automatically populates the symbol field with the 

symbol from another applet. 

 

 

Enable/disable Toggle Symbol Tracking 

 

Press the Toggle Symbol Tracking icon  in whatever WTP applet is being worked on. The 

symbol in that applet will change to match the symbol selected in other WTP applets. 

 

To disable Toggle Symbol Tracking, press the icon again. 

 

 

For example: 

 

1. In the Option Quote Cube, a default symbol (CSCO) is displayed. Toggle Symbol Tracking 

is then enabled. 

 

 
 

 

 

2. The Order Ticket is opened. The stock symbol IBM is selected in the Order Ticket. 
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3. The symbol window in Option Quote Cube reflects the Order Ticket's symbol (IBM). 

  

 

 
 

If an applet is in tabbed mode, the toggle symbol tracking will create a new tab (as above), 

and will not delete previously created tabs. If an applet is not in tabbed mode, the tracked 

symbol will replace the applet's current symbol. 
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User Permissions Viewer 

 

 
 

 

The User Permission Viewer is a read-only window that displays useful information about 

the logged-in user's permissions with regard to firms, accounts, portfolios, along with 

trading and route permissions. 

 

In those cases where a user's permission is granted to more than one firm, account, and/or 

portfolio, selecting an item in the viewer reveals other related permissions. For example, if a 

user has permissions over a few accounts in a firm, selecting each account will, in turn, 

reveal the portfolio or portfolio security types. 

 

The User Permissions Viewer is launched from the Session column of the WTP toolbar. 

Select View User Permissions. 
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WTP Applet Definitions 

 

Applet Name Function 

Allocator  Redistribute positions across various accounts 

Basket Trader  Send batches of equity, option, and/or future products 

together in a single "basket" order 

Crossing Ticket  Send matching customer and broker orders together straight 

to the exchange 

Equity Imbalance 

Viewer  

View the securities that are imbalanced at the market open or 

market close for the current trading day 

Equity Quote Cube  View Level 1 and Level 2 data and time-of-sales data for 

equities, futures, and send equity orders 

Equity Time and Sales View tick-by-tick details for securities over a defined time 

period 

Instant Messenger  Communicate with other WTP users privately or in a group 

Managed Order Console  Create, manage, and view Managed Orders (specialized 

trading applets) 

News Browser  View real-time and historical news headlines from various 

news providers sources 

Option Quote Cube  View detailed option data for every strike and every expiration 

of a given option product, and send option orders 

Option Time and Sales View tick-by-tick details for all options products for a given 

security over a defined time period 

Option Sector Viewer  View sector-specific data on options, including open interest 

and sentiment 

Order Grid  Manage live orders and view details on all open, executed and 

canceled orders 

Order Ticket  Send equity and option orders, send Staged orders, report 

trades, adjust positions 

Position Grid View accumulated positions by portfolio, account, or firm 

Quote Grid  View real-time streaming quotes for equities, options, and 

futures 

Spread Agent Trade single and reverse spreads simultaneously. 

Spread Book  View open Spread Orders from various exchanges (read only). 

Spread Builder Create, send, and view multi-leg Spread Orders 

Spread Trader  Trade two products with the anticipation that an increase in 

one product will effect an increase in the other (or a decrease 

in one effect a decrease in the other) 

Spread Viewer  Create and view multi-leg Spread Orders 

Symbol Browser Search for securities by name or symbol 

Tick Chart Viewer View charting data for stocks 
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Time Slicer  Evenly distribute trades for a product over a defined time 

period 

Volatility Chart Viewer Display security volatility with a number of display options 

Vol Trader  Trade an option product with its underlying product based on 

market volatility 

Wave Grid  View and manage waves (grouped orders such as Managed 

Orders and Baskets) 

WTP Browser  View market data, stock charts, news, and other pages on the 

web 
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Advanced Concepts 

 

Connections 

 

Connections can be created between two or more WTP applets.  When a connection is 

made, the applet being connected to responds by displaying the same symbol as its parent 

(i.e., the connecting applet). As the parent's symbol changes, so does its child (the applet 

the parent is connected to), if defined as such. Child applets cannot change their symbol 

while the connection is active. At any time, each child applet can be disconnected from its 

parent, or the parent applet can disconnect all its child applets. 

 

In addition to symbols, other information can be transferred from a parent applet to its child 

(such as the Option Quote Cube sending price and side types to the Order Ticket). 

 

A Connections Manager is used to define the circumstances under which a child applet 

responds to a function of its parent and other child applets. 

 

A connection is also a physical link, so when the parent applet is moved around the screen 

its children move along with it. 

 

Connections between applets can be saved in a template. When a saved template is 

launched the parent/child relationship is maintained. 

 

In the image below, Option Quote Cube is the parent applet and a connection has been 

established between three child applets: 

  

 
 

 

Make A Connection 

 

A connection is made from the parent applet to a child applet via the Send to--> command 

(found in the Action menu of WTP applets). 
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1. Select a parent applet. 

  

2. From the Action column in the parent applet go to Send to--> and select a WTP 

applet 

 

Repeat as necessary. 

 

Once a destination applet has been selected, a parent/child relationship will exist. 

 

Note: Connections are not applicable for the following applets: Instant Messenger, 

Managed Order Console, Wave Grid. 

 

 

The Connections Manager 

 

The parent/child connections are seen in the image above. The circumstances under which 

the child applet responds to actions in the parent applet are defined in the Connections 

Manager. 

 

Launch the Connections Manager 

 

From the parent or child, right-click on the applet and select Connections Manager. 

 

Note: In addition to relationships between parent and child applets, relationships can also 

be established between one child applet and another and are also defined in the 

Connections Manager. 

 

List Mode and Grid Mode 

 

The Connections Manager can be displayed in Grid Mode or List Mode. They perform 

identical functions, only the display differs. 

 

This is the Connections Manager in both modes for the Option Quote Cube parent and 3 

child applets: 
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Grid Mode  
 

 
List Mode 
 

The Connections Manager Window 

 

In both modes, the Connections Manager Window is divided into four areas: 

 

Grid Mode: 

 

DEL key. Select this key to delete a specific Parent/Child action. Note: If a row is 

accidentally deleted, exit the Connections Manager by selecting Cancel, then re-launch the 

Connections Manager. The row will have been un-deleted. 
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Source—Any applets that currently act as a source for the destination applet. By default, 

each destination applet will have all possible relationships with the parent applet. The 

parent is denoted by (main) next to its name. 

 

Action—The action refers to the action in the parent that will cause the destination applet 

to respond. There are three actions available: 

 

 Double Click—A child applet will change its symbol to match its parent 

when there is a double-click on a field in the parent applet. 

  

 Selection—A child applet will change its symbol to match its parent 

when an item is selected in the parent applet. 

 

 Broadcast—A child applet will change its symbol to match its parent 

when the parent applet selects a different symbol. 

 

Destination—Select a child applet in the Destination column. In the example above, two 

different actions (Broadcast and Selection) have been made for the three destination 

applets. 

 

While in Grid mode, the Source/Action/Destination columns can be edited. Click on any field 

(including a blank field) and select a source/action/destination from each column's drop-

down list. 

 

Select Done to save any edits. To view connections in List Mode select the List Mode 

button. 

 

List Mode: 

 

The functions in List Mode are identical to those in Grid Mode, only the interface is a bit 

different. 

 

To add an action and destination from a source, select the Source/Action/Destination. If this 

connection is allowable, the Connect button will be available. Press it to create a new 

connection. 

 

Delete a Parent/Child Connection: In the "Connections" portion of the Connections 

Manager, select a row to be deleted and press Disconnect. 

 

Press Done to save any edits to the Connections Manager or Cancel to exit without saving. 

 

Break Connections 

 

The parent applet can only break connections to all its children, while each child applet can 

individually break the relationship to its parent. When a relationship has been broken, the 

parent applet must issue a new Send to--> command to reestablish a relationship. A new 

child applet will launch when issuing a new Send to--> command.  

 

To break a relationship, right-click on the parent or child applet and select Break 

Connections.  

 

As a shortcut, the parent or applet can also be deleted causing the relationship to break. 
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Repositioning Parent and Child Applets 

 

When a parent applet is moved across the screen its child applets move with it. 

 

Any child applet can be repositioned without affecting its parent or other child applets. 

 

Save a Relationship in a Template 

 

A parent/child relationship can be saved as a template. When the template is launched the 

relationship is maintained. 

 

Learn about templates here.
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Global Configuration 

 

Default selections and default features that cover all items in the WTP suite are selected on 

the nine screens that make up Global Configurations. 

 

 

General 

Configuration 

 

Notifications  

Orders 

 

Quote 

Connection  

Portfolios 

 

Quote Data  

Routes  QTY and Price 

Increments 

 

Theme   

 

 

General Configuration 

 

 
 

 

Allow applet connections 

 

A connection can be made between two or more WTP applets via the Send to--> 

command. When a connection is made, the applet being connected to responds by 

displaying the same symbol as its parent (i.e., the connecting applet). As the parent's 

symbol changes, so does its child (the applet the parent is connected to), if defined as such. 

 

Check the Allow Applet Connections box to have this feature enabled when issuing the 

Send to--> command. 
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Note: Connections already established will not be broken if the Allow Applet Connections 

is subsequently unchecked. 

 

Learn the specifics of Connections here. 

 

Allow delete key shortcut to cancel in order tickets 

 

You can cancel an order in an Order Ticket by pressing the Delete key with this option. A 

confirmation window will appear when the box is checked: 

 

 
 

Press Yes to allow the delete key to cancel orders. Press No or Cancel to close the window 

and not allow the delete key to cancel orders. 

 

 

Allow lowercase symbols (hold shift while typing)—Symbols entered in an order ticket 

are in uppercase by default. If this box is checked, symbols can be entered in lowercase. To 

enter lowercase characters press the shift key when typing. 

 

Close quick ticket on buy/sell 

 

An Order Ticket can be accessed directly from a number of WTP applets.  

 

If the Close Quick Ticket on Buy/Sell is checked, an Order Ticket will automatically close 

once a buy or sell order has been issued. 

 

Enable Cancel and Ship 

 

When changing an order, the route for that order can be simultaneously changed. This 

effectively cancels the order and makes a new order on a different exchange.  

 

The following is a sequence of events that can occur if the Enable Cancel and Ship 

feature is active: 

 

1. An order has been submitted. 

  

2. The order is accepted by the exchange and is considered Live. 

  

3. A request to change the order is made. 

  

4. The original order is canceled by the exchange. 

  

5. The gateway sends the replacement order to a different route where the order could 

end up at a different exchange. 

  

6. The replacement order has been accepted. 
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Check Enable Cancel and Ship to activate this option. 

 

Exclude reported trades from allocations 

 

If a stock purchase is done away from WEX and then reported (using the Report Trade 

Ticket), the trade will be excluded from the Allocator if the Exclude reported trades 

from allocations is checked. 

 

Copy/Paste Options 

 

There are three options that can be selected when copying data from any WTP grid and 

pasting the data into another application. 

 

 Include Column Titles—The column head will be included when pasting grid data 

into another program. 

  

 Include Row Numbers—Each row will have its own number. The numbers will be 

visible when pasting grid data into another program. 

  

 Remove Commas—The commas used in numerical strings (i.e., 7,200) will not be 

seen when pasting grid data into another program. 

 

Custom IVol Data 

 

Custom IVol values that are stored in a comma-delimited source file can be imported into 

one of the various WTP grids where Options data is reported (for example, Option Quote 

Cube or Quote Grid). 

  

The comma-delimited source file is imported along with an import file (containing the 

relevant column headings). If no import file exists, it must be created and have its column 

headings defined. 

  

Once imported, a new column Custom IVol is added to the grid. The custom IVol values 

(multiplied by a factor of 100) are added to the Custom IVol column, matching the strike 

price and expiration date that is listed in the source file. 

  

If a change is made to the source file after importing, a confirmation window will display 

asking if the source file is to be reloaded (i.e., re-imported). 

  

A notification can be setup whereby a notification window announces any custom IVol 

import changes (along with a sound, if defined). 

  

Steps to Import Custom IVol Data 

  

1. The source file must be a comma-delimited file with a .csv extension. The file should 

contain: 

 The name of the security 

 The strike price 

 The expiration date (Format = MM/DD/YYYY) 

 The IVol percentage (displayed in decimal format) 
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In the example below, the security is CSCO with an expiration of 3/19/2011. The Strike 

price is $17.00, and the IVol value is 0.3428. 

 

Note: The IVol value in the source file will be multiplied by 100 when it's placed into a WTP 

grid. 

  

 
  

  

2. In the Data File Path field in Global Configuration click Browse and load the .csv file: 

 

 
  

If an Import File exists, enter it in the Import File Path field. If not, leave the field blank. 

  

  

3. Select Create Import File. An Import From File window will display: 
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Because an import file did not exist, the column heads are listed as <Unassigned>. 

  

Assign a column head to each column by clicking on <Unassigned> and select a name that 

reflects the data stored in each column. 

  

When finished it should look like this: 

 

 
  

Note that only the first 20 rows of the source file will be displayed. 

  

Optional: Select Save Import Template to save this template for reuse without having to 

redefine column heads. 
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4. Click Import. 

  

If the WTP grid does not display the column Custom IVol it must be added. 

  

In the grid, the Custom IVol values will populate the Custom IVol column: 

 

 
  

Note that the values in the source .csv file are multiplied by 100 when placed into a grid. 

For example, in the source file the strike price of $17.00 has a Custom IVol value of .3428. 

Multiplied by 100, the value displayed in the grid is 34.2800. 

  

  

Making Changes to the .csv Source File 

  

If a change is made and saved in the .csv source file, a confirmation window will display: 

  

 
  

Click Yes to load the changes into the grid. Click No to not accept the changes into the grid. 

  

A Notification can be defined for Custom IVols: 
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When a change is encountered a notification will be issued: 
 

 
  

  

Enable/Disable Custom Vol Data 

  

 
  

Check the Enable Custom Vol Data if you wish to enable both. When checked, "Enable 

Custom Vol Data" monitors the custom data file path and will notify you if any changes have 

been made (see Making Changes to the .csv Source File above). If the check box is 

disabled, no notifications will be delivered. 

  

If no data file path or import file path exists, be sure to un-check the "Enable Custom Vol 

Data" box. If Enable Custom Vol Data is checked but no data file path or no import file 

path exists, an error message will appear when saving Global Configuration. 

 

On Initial Connection 
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The workspace that will load upon the initial connection to WTP is set here. 

 

The initial connection is defined as the first connection to WTP following a complete exit. 

To log on after a log off (while WTP remains running) is not the same thing as an initial 

connection. 

 

When launching WTP and connecting, WTP will load a workspace based on one of three 

settings: 

 

1. Show Blank Workspace—No workspace will load. 

2. Restore Last State—Load the workspace as it was when WTP was last closed. 

3. Open Specific Workspace—Select the Browse button and choose an existing 

workspace (with a .wtp extension). This workspace will load the next time WTP is 

launched and connected. 

 

 

Orders 

 

 
  

  

Allow Side Relative Prices Types in Order Tickets (BBSA, BASB, Peg BBSA, Peg 

BASB)—If this box is checked, a warning message will appear: 
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Click Yes if side relative price types are to be included in the Order Ticket. Click No or 

Cancel to exit the warning screen without allowing side relative price types. 

  

Side Type Definitions: 

 

BASB—Buy at the Ask, Sell at the Bid, modified by a specified increment 

  

BBSA—Buy at the Bid, Sell at the Ask, modified by a specified increment 

  

Peg BBSA—Peg Buy at the Bid. Peg Orders allows a user to specify a value they want their 

order pegged, and an increment that defines an offset from the value. For example, if a 

price type is Peg Ask with a +.01 increment, the exchange pegs the price of any orders it 

receives to be one cent less than the best ask. 

  

Peg BASB—Peg buy at the Ask, Sell at the Bid 

  

NOTE: Peg orders are not supported by all exchanges. Check with your WORMS 

administrator for the routes that support peg orders. 

  

  

Auto-Split Outright BYA/SLA Orders 

  

If SLA (Auto Sell) is used to sell a security in an amount larger than the currently held 

position, a flat position will be crossed. 

  

Checking "Auto-Split Outright BYA/SLA Orders" assures that two things will occur: 1. If 

the sell order is for an amount equal or larger than the currently held position, the security 

will sell long in an amount that will equal a flat position, and 2. A sell-short order will be 

issued for any remaining shares. 

  

Conversely, a BYA order that's larger than the currently held negative-position results in a 

BYC (Buy to Close) order up to the flat position and a BUY order for any amount thereafter. 

  

Example 1: 

1. Current position on stock XXX is 500 shares. 

  

2. An SLA order is sent to sell 800 shares of XXX. 

  

3. A sell-long order is automatically generated for 500 shares, resulting in a flat 

position AND a sell-short order is automatically generated for the remaining 

quantity of 300 shares. 

 

Example 2: 
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1. Current negative position on stock YYY is -200 shares. 

  

2. A BYA (Auto Buy) is issued for 50 shares of YYY stock. 

  

3. A BYC (Buy to Close) order is automatically generated resulting in a current position 

of -150 shares. 

  

4. Another BYA order is issued to purchase 400 shares of YYY stock. 

  

5. Another BYC order is generated for 150 shares (resulting in a flat position), AND a 

BUY order is generated for 250 shares. 

  

Show confirmation when an order may split 

  

If this option is checked, a confirmation message will display immediately after executing an 

SLA or BYA order that will result in a split order. 

  

  

Clear cancelled orders after _ _ _ minutes 

  

Check this box and enter a number that reflects the period of time (in minutes) in which 

WTP will purge canceled orders. WTP performance will be significantly improved with this 

feature. 

  

If enabled, canceled orders will be removed from the Order Grid once the defined time has 

been achieved. 

  

Note: The default time setting is 10 minutes. 

  

  

Suppress Nonstandard Expiration Warning 

  

When executing an options trade with a non-standard expiration date, a warning message 

will display. 

  

If Suppress Nonstandard Expiration Warning is checked, no warning message will 

display. 

  

  

Configure Quick Trades 
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Twelve different hot key combinations can be defined, allowing for quick trade. 

  

To configure Quick Trades: 

 

1. Press Configure Quick Trades from the Global Configuration Window. 

  

2. Check the box next to the desired hot key combination 

  

3. Select the variables that will be in force when typing the hot key combination (Side, 

Quantity, Type, Increment, Route, and Portfolio). 

  

4. Press OK to save the quick trade configuration(s) or Cancel to exit without saving. 

  

Trade Limit Warning Percentage 

  

 
Sample of some Trade Limit warnings 

 

The percentage value set in the Trade Limit Warning Percentage field indicates the point 

at which a warning message will appear. This value can refer to a number of maximum 

limits including Max Total Share, Max Total Value, Max Position Shares, Max Position 

Value. The message informs you that you are approaching a defined limit. 
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Example of when a warning will occur: You have the permission to trade a maximum of 

5000 shares per day. If you set the Trade Limit Warning Percentage to 80%, a warning 

message will appear once you've traded 4000 shares (80% of 5000 = 4000). 

  

  

Bypass Confirm Dialogs 

  

The Bypass Confirm Dialogs feature suppresses the confirmation dialog window if any of 

the following are checked: 

 

1. Cancels—When an order is canceled 

  

2. Baskets—All basket orders 

  

3. Position—All position changes 

 

Select which orders are to have the confirmation message disabled. 

  

A warning message will be issued when selecting any of the following: 

 

1. For Equity orders and Equity stages enter the number of shares. A dialog window 

will not display for equity orders less than this amount. 

  

2. For Option orders, Option stages, Futures orders and Futures stages enter the 

number of contracts.  A dialog window will not display for contracts less than this 

amount. 

  

Default position mode 

  

This option allows users to select a default entity position. 

  

Primarily, this is used when auto-splitting BYA/SLA orders. When an auto-split is 

encountered, the Default position mode will reference the selected position. 

  

Note: If a user does not have the permission to view a position value, a BYA or SLA order 

will not split. 

 

 

 

Portfolios 
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Portfolio Configuration 

 

Users can define default Portfolios in the Portfolios Grid. These Portfolios will be used 

automatically when defined criteria are met. The criteria are: 

  

Security Name—The name of the Security (AAPL, CSCO, etc.) 

  

Order Category 

 Crossing (Order)—The Order Portfolio on a Crossing Ticket 

 Crossing (Contra)—The Contra Portfolio on a Crossing Ticket 

 Staged—The Portfolio on a Staged Ticket 

 Basic—The Portfolio on any other Ticket, Basket Trader, or Managed Order 

  

Order Complexity 

 Spread—Spread Orders w/multiple Symbols 

 Outright—Orders with a single Symbol 

  

Security Type—The Type of the product being traded (Option, Equity, Future, etc.) 

  

  

For all Portfolio Configuration columns, select <Any> to match any selection available in 

that column.  

  

For instance, when a symbol is entered into an Order Ticket, WTP looks at the defined 

portfolio configurations to find a rule matching the criteria of the ticket (i.e., Does the 

Security, Order Category, Order Complexity, Security type, and the Portfolio match?).  If a 

match is found, the default portfolio defined by the matching row will apply to the current 

ticket.  If a matching row is not found, the portfolio will default to Spaces. 

  

To reset all Portfolio settings to their default values, select Reset User Settings. 

  

To accept changes, select OK or Apply. Select Cancel to exit this screen without saving 

selections. 
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Route-Specific Portfolios 

 

 
 

 

When <From Route> is selected in the Portfolio column of the main Portfolio Configuration 

grid, and a route and portfolio is defined in Route-Specific Portfolios (in the example 

above, the Route is ISE-OPT and the portfolio Test), the Order Ticket will automatically fill 

the Portfolio field with the defined portfolio. 

  

In the example below, the symbol AAPL and the route ISE-OPT are selected. The Port 

field is automatically filled in with the portfolio TEST. 

 

 
 

 

Routes 

 

 
 

The default behavior in the Order Ticket with regard to routes is set up here.  
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Route Configuration—Similar in behavior to the Portfolios tab, an Order Ticket will first 

look here for a rule of a defined security. If it cannot be found, it looks for a listed equity 

rule. If neither are found, it defaults to blank. 

 

Each column under Route Configuration has a drop-down list. Select the Security, Order 

Category (<Any>, Basic, Crossing (Order), Staged), Complexity (<Any>, Outright, 

Spread), Security Type, and Route from the drop-down list. 

 

Equity Quote Source Routes (in priority order)—Market Maker routes are defined here. 

Their purpose is to identify which routes a Fan Out Grid will fill itself with. By defining a 

route for the Market Maker, the Fan Out Grid can determine to which route an order can be 

sent. 

 

IOC Routes are also known as Dark Pool Routes. They are defined in the same manner as 

other routes (via the drop-down list). When IOC Routes is activated in the Order Ticket, an 

IOC order will be sent to each of the IOC routes one at a time in an attempt to fill the order. 

 

Spread IOC Routes are similar to IOC routes and are used in the Spread Ticket and 

Spread Basket Trader.  

 

Portfolio-Specific Routes links a portfolio to a route. If a portfolio/route is defined here 

and the portfolio is selected when creating an order, its associated route will automatically 
be selected. Note: This feature is the reverse of the Portfolios section of Global Configuration 

where a security can be linked to a portfolio via a route when <From Route> is selected. 
 

Hammer Function—"Hammer" is a WEX function that allows traders to sweep the market 

up to a defined limit price and cross the remaining quantity.  

  

Two routes for the hammer sweep and cross are defined (Hammer Sweep and Hammer 

Cross respectively). 

  

A window titled Hammer Order Tracker launches when a crossing order with a 

<hammer> route hasn't immediately filled. If this should occur, the order can be canceled 

by selecting the Cancel button. 

 

In the example below, the route selected in the Crossing Ticket is <Hammer>. The 

Hammer Sweep and Hammer Cross routes will be used. Because the order didn't fill 

immediately, the Hammer Order Tracker launches: 
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Crossing Ticket in which the <Hammer> route is selected. 

 

 

 
The Hammer Order Tracker launches when a crossing order with a <hammer> route 

hasn't immediately filled. 

 

 

Note: Closing the Hammer Order Tracker will cancel all live <Hammer> orders. 

 

 

 

Theme 
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The Theme tab in Global Configuration allows users to gain more control over the look of 

the WTP screens. 

  

  

Select Theme 

  

A theme encompasses many visual elements including the Finish Type, text colors, 

button colors, and control field colors. 

  

Although each color element can be worked on individually, a theme allows you save all 

color configurations as a .wtp-theme file. 

  

Select one of the pre-defined themes from the drop-down list and it will automatically 

display in the Global Configuration window. Select OK or Apply to activate the theme 

throughout WTP. 

  

  

Save a Theme 

  

A new or existing theme can be saved under any desired name. Once all color 

configurations have been made, select Save As...  The saved file will have a .wtp-theme 

extension. 

  

  

Finish Type: 

  

Select from one of the following: 

  

None—No finish type applied to screens and buttons: 
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Smooth: 

  

 
  

  

Glass: 

 

 
  

  

Metal: 
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Use Flat Controls When selected, buttons and tabs will have a flat, flushed look: 

  

 
  

  

  

Use Background Image—A bitmap (.bmp) image can be used as the background for all 

WTP apps. 

  

Press the Browse button to select the .bmp file that will be imported.  

  

In the image below, a blue-colored bitmap photograph was defined as the background 

image: 
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Button Colors can be customized. To change a button color: 

 

1. Press on the button to be changed. The color window will appear: 

 

 

 
 

To define colors other than the basic colors, click Define Custom Colors:   
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2. Select a color either by entering red/green/blue or Hue/Sat(uration)/Lum(inosity) 

values, or by moving the mouse and choosing a desired color. 

  

3. Click OK to save your new color selection or Cancel to exit without saving a custom 

color. 

  

Theme Color 

  

Select Theme Color to change the background color of all WTP windows and configuration 

screens. When selected, the color window will display. As with the button colors (above) you 

can select from pre-defined colors or a custom defined color: 

 

 
  

  

Text Color 

  

Select the color of all text displayed in WTP windows and configuration screens. In the 

image below, the text color was changed to red: 

  

 
  

  

  

Control Color 

  

Select the color of content-input fields, check boxes, and radio buttons with this control. 
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Button Color 

  

Select the color for all buttons in WTP with this control: 

  

 
  

  

  

The Center Display 

  

The center portion of the Theme window reflects the text, control, and button settings: 

  

 
  

  

Report Color 

 

The Report Color button is used to define the background color of the Report Trade 

Ticket. 

 

When Report Color is unchecked, the Report Trade Ticket will display in the system default 

color. 



Advanced Concepts  Global Configuration 

389 © 2014 Wolverine Execution Services, LLC 

 

 

Reset User Settings 

  

Select Reset User Settings to revert to the default WTP color scheme. A confirmation 

window will launch when making this selection. Press Yes to reset the color values. 

  

  

Save Changes 

  

Click OK to accept changes and exit or Apply to accept changes and keep the Global 

Configuration window open. 

  

Click Cancel to exit the window without saving changes. 

 

 

Notifications 

 

 
 

Notifications are sound files played when a defined event occurs. Additionally, a log severity 

can be set that appends event information to a log file. 

 

Events and Sounds 

 

To link an event with a sound: 

 

1. Select an event from the drop-down list in the Event column. 

  

2. Select a corresponding sound from the drop-down list (below the Event column) OR 

select a .wav file from your system by pressing the Browse button. 

  

3. Press the play button  to hear the sound that will play when the event occurs. 

  

Note: If no sounds are preferred, check the Mute All Sounds box. 
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Notify by Security 

 

A notification can be sent based on a defined event of a security. A drop-down list in the 

Security column lists all available securities. 

 

Note: If notification is to be given for a single event with multiple securities, each security 

must be defined individually. 

 

Log Severity 

 

A defined event can be flagged as a log severity of Low, Medium, or High. If an event is 

flagged, the event will be written to a log file. 

 

To link an event with a log severity: 

1. Click on an event from those listed in the window. 

  

2. In the Log Severity column select either Low, Medium, or High from the drop-

down list. 

  

Note:  A sound need not be defined in order to record a log severity event. 

 

The Auto Open Log Window 

 

An Auto Log Window will open if a defined log severity condition has been met. This 

function can also be disabled. 

 

To open or disable a log window: 

 

1. Select either Low, Medium or High corresponding to the log severity event selected 

(above). 

  

2. To disable a log window from opening, select Disable Auto Open. 

 

Flash On Notification 

  

When the WTP toolbar is minimized to the taskbar, the WTP taskbar icon will flash if Flash 

On Notification is checked and the Notifications Window launches. 

  

The flashing of the taskbar icon stops when the Notifications Window is selected. 

  

If it is preferable to not have the taskbar icon flash when a notification is received, do not 

check Flash On Notification. 

  

Note: Auto Open Log Window must be checked in order to access the Flash On Notification 

option. 

 

Log Size 

 

The number of entries in a log can be defined. 

 

1. Enter the amount of the last log entries that will be saved (or press the up/down 

arrows in increments of 100 to define the number). 
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2. To save all log entries, select All log entries for this session. 

 

Show Other User Notifications 

 

Check the box Show Other User Notifications to see all the notifications from other users 

to whom viewing permissions are granted. 

 

When the feature is active and one or more users have been selected, you will receive 

notifications when any of those users receive a notification. 

 

Selecting <all> will show notifications for all users in the drop-down list. The only 

requirement to use Show Other User Notifications is that you must have permission for the 

action that is to be notified (i.e., portfolio permissions are necessary if you wish to be 

notified about submitted or filled orders). 

 

Reset User Settings 

 

Pressing Reset User Settings will bring up a confirmation window. If Yes is selected, all 

settings will revert to their default status. 

 

Accept/Cancel Changes 

 

Click OK to accept changes and exit or Apply to accept changes and keep the Global 

Configuration window open. 

 

Click Cancel to exit the window without saving changes. 
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Quote Connection 

 

 

 
  

  

The Quote Connection screen contains settings related to market data server connections 

and quote services. 

  

  

1. Activ Connection 

  

If market data is to be received via an Activ data feed, select a Primary connection address 

from the drop-down list, or type one in the Primary field. Optionally, a backup connection 

can be defined by checking the Backup box and selecting the backup address (or entering 

an address in the Backup field). 

  

The primary/backup fields are formatted as Host Name: Port. 

  

Enter also a predefined Username and Password. 

  

Note: All fields relating to the Activ connection are normally set up during WTP installation. 

  

  

Use Daemon 

  

When Use Daemon is selected, a Port Number must be entered (e.g., 9003) instead of a 

full address (e.g., 192.168.187.51:9002). After selecting Apply, a message will be 

displayed indicating whether or not a connection has made. If the message is "Not 

connected" it will also display the time (in seconds) in which a reconnection will be 

attempted. 

 

When Use Daemon is selected, both Primary and Backup selections are unavailable for 

editing. 

 

Force Connect 
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If Activ has not been able to make a successful connection, selecting Force Connect will 

display any username or password issues that need to be fixed. 

  

Force Connect can also be used to manually disconnect from, and reconnect to, Activ. 

  

Before selecting the Force Connect button, be sure to save configuration changes by hitting 

Apply. 

  

Note: This feature can be used to forcibly disconnect other WTP instances using the same 

username from Activ. Contact WEX Support to have the feature enabled. 

 

  

Prefer Activ For News 

  

Check this box if it’s preferable to have headlines/news stories delivered via the Activ feed. 

  

If unchecked, headlines/news stories will be delivered via Reuters. 

  

  

  

2. Solace Connection 

  

Similar to the Reuters Sink, Solace is a device used in distributing high-speed real-time 

market data. Both a primary and backup connection are defined along with a username and 

password. A virtual lan network (VLAN) is also defined. 

  

The primary/backup fields are formatted as Host Name: Port. 

  

  

  

3. Solace Custom Data 

  

The Custom Data field is used to publish a user's own data into Solace. The settings are 

used to tell WTP where to find the data. 

Note: All fields related to Solace values are normally set up during WTP installation. 

  

  

  

4. Mkt Data Cache 

  

The Market Data Cache is useful for quickly retrieving large amounts of historical volatility, 

news, and option tick data. 

  

This field contains the name and port (default value: 9010) of the Market Data Cache 

server. 

  

  

Prefer Market Data Cache for strikes 

  

Check this box if it is preferable to use the value in the Mkt Data Cache field for all strike 

quotes. 
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5. Spread Market Data 

  

The Spread Market Data field is a suite of server applications that provide market data for 

complex strategies. Enter the host name in the text field or select one from the drop-down 

list. 

  

Reset User Settings 

  

Select Rest User Settings if default values for Quote Connections is desired. A warning 

message will appear "Are you sure you want to reset these configuration settings?". 

Select Yes to reset the settings. 

 

 

Quote Data 

 

 
 

The Quote Data screen is used to define how WTP requests market data. 

  

  

Quote Configuration 

  

A security name and type (Stock Listed or Equity Option) are defined. Its Quote Service is 

the Reuters service to use for quote data (based on the security and/or type) 

  

In the Security field, a security name is not necessary. To refer to any security, use 

<any>. 

  

Also, wildcard card characters can be used. 

  

  

Wildcards in the Quote Configuration Table 

  

In the Security and Translate As fields, wildcard characters can be entered in place of 

hard-coded characters. 
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The wildcard characters that can be used are: 

 

* (matches one or more characters) 

  

? (matches a single character) 

  

Example 

In the Security field is the value <any>. Translate As field, the 

value entered is *.0 

This rule will cause a request for any symbol (i.e., MSFT), to be 

translated as MSFT.0 in the listed Quote Service. 

  

{1} (refers to the first wildcard character in a string) 

  

{2} (refers to the second wildcard character in a string) 

  

U forces a matched string to uppercase 

  

L forces a matched string to lowercase 

  

  

Example 

In the Security field is the following, using two wildcard characters: *.PR?  (meaning: 

any security with an extension of .PR and one other character) 

In the Translate As field is the following using wildcard characters: {1}_p{2L} 

(meaning: translate the * of the security to read a security name, place an underscore 

character, the letter "p" and one letter in lowercase) 

 

A request for ABN.PRF will translate as: ABN_pf 

 

A request for FCX.PRF will translate as: FCX_pc 

  

  

Equity Book Source Configuration/Option Book Source Configuration 

  

There are some quote sources that are not provided by Reuters. WTP receives this data 

directly from the exchanges. 

  

The Quote Source and Service columns define that relationship. The general rule of 

thumb is that the Quote Source name and Service name are identical (i.e., the Quote 

Source BRUT has a Service name of BRUT). 

  

To select a Quote Source and Service: 

 

Type in a name in the Quote Source and Service fields, or select a Quote Source and 

Service from their respective drop-down lists. 

  

Click OK or Apply to save your selections, or Cancel to exit without saving. 

  

  

Alternate Services 
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The Alternate Services table lists service-related settings. The columns are: 

 

 Primary Service—The service name whose attributes are displayed on the same 

row (cannot edit field) 

  

 Status—The current status of the primary service. Values for the status column 

include: 

 

Not Available—The service is not available from the current Reuters connection 

 

Inactive—The service is not serving data 

 

Not Permissioned—The current logged in user does not have permission to view its 

data 

 

Stale—The server is presenting data, but it is not guaranteed to be current 

 

OK—The service is operating normally 

  

 Backup Service—If the primary service is unavailable, the backup service will be 

used. 

 

To select a backup service, click on the row associated with the primary service, and 

select a backup service from the drop-down list. 

  

Tick Service—If the primary tick service is unavailable, the backup tick service will be 

used. 

 

To select a backup tick service, click on the row associated with the primary service, and 

select a backup tick service from the drop-down list. 

 

 

Trade Defaults 
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Default values such as quantity default, quantity increments, and price increments are 

defined here. 

 

Set default quantities: 

  

1. Select a Security and Type by entering the values manually, or select from the 

drop-down lists. 

  

2. Enter the default quantity. 

  

3. Enter a value in the Show Default column. This value defines the show quantity for 

new orders. If the value is set to <none> the show quantity will match the order 

quantity. 

  

4. Enter a value in the Qty Inc field. The value refers to the increment increase each 

time the Up or Down arrows are selected (in the Order Ticket for example). 

  

5. Enter a value in the Price Inc field. This defines two things: the increment in which 

the Up/Down arrows move, and the number of decimal places that will be displayed. 

  

 

 

 

6. Enter a Price Type manually, or select one using the drop-down list. 

 

The DISPLAY TYPE Column 

 

In the column DISPLAY TYPE select the method for displaying values: 

 

 Decimal—Displays values in decimal form. 

 

Note: The default value <none> displays the same as Decimal. 

  

 Fraction—Displays values in fraction form and works in conjunction with the Price 

Inc column. 

 

When Fraction is selected, choose a denominator value from the Price Inc column: 

10, 16, 20, 32, 64, 100, 128, 256. 

  

 Tick/Half-Tick/Quarter-Tick—Displays values in Tick form. This display type is 

setup per the Fraction type above, where a denominator value is selected in the Price 

Inc column. 

 

 

Example: A value of 0.010 means that prices should increment at one 

cent at a time, and display up to 3 decimal places 
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IOC and Crossing Trackers 

 

 
 

 
 

 

IOC Tracker  

 

The IOC Tracker is launched automatically during a live order whenever IOC (Immediate 

Or Cancel) routes are selected from the Order Ticket (or a WTP applet that has its own 

order ticket such as Basket Trader). Also, the IOC Tracker will launch only for orders that 

have not been filled immediately.  

 

Default columns Continue and Stop allow for manipulating live orders: 

 

 Selecting Continue forces the tracker to employ the next enabled IOC route and can 

been seen in the Last Route and Next Route columns. When the final IOC route 

has been reached, the Next Route column will display <none> indicating that no 

further routes are available. Selecting Continue at this point will result in the order 

being removed from the IOC Tracker. Note that the order will still be live if this 

occurs, and will use the route selected in the order ticket in an attempt to fill the 

order. 

  

 Selecting Stop will cancel an order. If there is more than one order in the IOC 

Tracker, each order can be selectively stopped without affecting the others. 

 

The IOC Tracker will not launch (or will not add an IOC order if already opened) if an IOC 

order is filled immediately.     

 

Crossing Tracker 

 

The Crossing Tracker is launched automatically when a crossing route is selected and a 

unfilled crossing order is executed from the Crossing Ticket. An order that is filled 

immediately will not launch the Crossing Tracker (or will not be added to an opened 

Crossing Tracker). 
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Orders cannot be continued to the next route in the Crossing Tracker as they can in the IOC 

tracker. 

 

Closing the Trackers 

 

Each tracker will close if the Auto Close feature is enabled   and all tracking orders have 

been filled or stopped. 

 

If an attempt is made to close a tracker window while IOC or Crossing orders exist, a 

warning/confirmation message will display stating that all tracking orders will be stopped if 

the window is closed. 

 

Configuration for the IOC and Crossing Trackers 

 

The configuration for both trackers involves the setting of columns and formatting. Both are 

described here.
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List of Functions 

 

The following is a list of all available functions that can be used in the User Defined Fields 

of WTP grids.  

 

MATH FUNCTIONS 

 

STRING FUNCTIONS 

 

LOGIC FUNCTIONS 

 

DATE/TIME FUNCTIONS 

 

 

MATH FUNCTIONS 

 

 

@PI() 

 The value of pi. 

 

@RAND() 

 A uniform random number on the interval (0,1). 

 

@GRAND 

 A 12th-degree binomial approximation to a Gaussian random number with zero mean and 

unit variance. 

 

@ABS(X) 

 The absolute value of X. 

 

@CEIL(X) 

 The smallest integer greater than or equal to X. 

 

@EXP(X) 

 e raised to the X power. 

 

@FACT(N) 

 The value of N. 

 

@FLOOR(X) 

 The largest integer less than or equal to X. 

 

@FRAC(X) 

 The fractional portion of X. 

 

@INT(X) 

 The integer portion of X. 

 

@ROUND(X, n) 

 X rounded to n number of decimal places (0 to 15). 
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@SQRT(X) 

 The positive square root of X. 

 

@MOD(X, Y) 

 The remainder of X/Y. 

 

@MODULUS(X, Y) 

 The modulus of X/Y. 

--------------------------------------------------------------------------------- 

@LNGAMMA(X) 

 The log base e of the gamma function evaluated at X. 

 

@LOG(X) 

 The log base 10 of X. 

 

@LOG10(X) 

 The log base 10 of X. 

 

@LOG2(X) 

 The log base 2 of X. 

 

@LN(X) 

 The natural log (base e) of X. 

--------------------------------------------------------------------------------- 

@AVG(...) 

 The average (arithmetic mean) of its arguments. 

 

@MAX(...) 

 The maximum of its arguments. 

 

@MEDIAN(...) 

 The median (middle value) of the range R1. 

 

@MIN(...) 

 The minimum of its arguments. 

 

@MODE(...) 

 The mode or most frequently occurring value. 

 

@MSQ(...) 

 The mean of the squares of its arguments. 

 

@PRODUCT(X, ...) 

 The product of all the numeric values in the argument list. 

 

@SUM(...) 

 The sum of its arguments. 

--------------------------------------------------------------------------------- 

@GMEAN(...) 

 The geometric mean of its arguments. 

 

@HMEAN(...) 
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 The harmonic mean of its arguments. 

 

@RMS(...) 

 The root of the mean of squares of its arguments. 

 

@SSQ(...) 

 The sum of squares of its arguments. 

 

@SSE(...) 

 The sum squared error of its arguments. It is equivalent to @VAR(...) @COUNT(...). 

 

@STD(...) 

 The population standard deviation (N weighting) of its arguments. 

 

@STDS(...) 

 The sample standard deviation (N-1 weighting) of its arguments. 

 

@VECLEN(...) 

 The square root of the sum of squares of its arguments. 

 

@VAR(...) 

 The sample variance (N weighting) of its arguments. 

 

@VARS(...) 

 The sample variance (N-1 weighting) of its arguments. 

 

@VSUM(...) 

 The visual sum of its arguments, using precision and rounding of formatted cell values. 

--------------------------------------------------------------------------------- 

@F(M, N, F) 

 The integral of Snedecor's F-distribution with M and N degrees of freedom from minus 

infinity to F. 

 

@ERF(L[, U]) 

 Error function integrated between 0 and L; if U specified, between L and U. 

 

@ERFC(L) 

 Complementary error function integrated between L and infinity. 

 

@GAMMA(X) 

 The value of the gamma function evaluated at X. 

 

@SIGMOID(X) 

 The value of the sigmoid function. 

 

@T(N, T) 

 The integral of Student's T-distribution with N degrees of freedom from minus infinity to T. 

 

@POLY(X, ...) 

 The value of an Nth-degree polynomial in X. 

--------------------------------------------------------------------------------- 

@ACOS(X) 

 The arc cosine of X. 
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@ASIN(X) 

 The arc sine of X. 

 

@ATAN(X) 

 The 2-quadrant arc tangent of X. 

 

@ATAN2(X, Y) 

 The 4-quadrant arc tangent of Y/X. 

 

@COS(X)  

 The cosine of X. 

 

@COSH(X) 

 The hyperbolic cosine of X. 

 

@DEGREES(X)  

 Converts the angle expressed in radians to degrees ( ). 

 

@RADIANS(X) 

 Converts the angle expressed in degrees to radians ( ). 

 

@SIN(X) 

 The sine of X. 

 

@SINH(X) 

 The hyperbolic sine of X. 

 

@TAN(X) 

 The tangent of X. 

 

@TANH(X) 

 The hyperbolic tangent of X. 

 

 

STRING FUNCTIONS 

 

Note: Arguments for string functions are placed between quotation marks. 

 

--------------------------------------------------------------------------------- 

@CHAR(N) 

 The character represented by the code N (ASCII): RETURN TYPE - STRING 

 

@CODE(S) 

 The ASCII code for the first character in string S: RETURN TYPE - NUMERIC 

 

@HEXTONUM(S) 

 The numeric value for the hexadecimal interpretation of S. 

 

@NUMTOHEX(X)  

 The hexadecimal representation of the integer portion of X. 

 

@VALUE(S) 



Advanced Concepts  List of Functions 

404 © 2014 Wolverine Execution Services, LLC 

 The numeric value represented by the string S; otherwise 0 if S does not represent a 

number. 

 

@STRING(X, N) 

 The string representing the numeric value of X, to N decimal places. 

--------------------------------------------------------------------------------- 

@LOWER(S) 

 S converted to lower case. 

 

@UPPER(S) 

 The string S converted to upper case. 

 

@TRIM(S) 

 The string formed by removing spaces from the string S. 

 

@PROPER(S) 

 The string S with the first letter of each word capitalized. 

 

@CLEAN(S) 

 The string formed by removing all non-printing characters from the string S. 

--------------------------------------------------------------------------------- 

@LENGTH(S) 

 The number of characters in S. 

 

@STRLEN(...) 

 The total length of all strings in its arguments. 

 

@STRCAT(...) 

 The concatenation of all its arguments. 

 

@LEFT(S, N) 

 The string composed of the left-most N characters of S. 

 

@MID(S, N1, N2) 

 The string of length N2 that starts at position N1 in S. 

 

@RIGHT(S, N) 

 The string composed of the right-most N characters of S. 

 

@REPEAT(S, N) 

 The string S repeated N times. 

 

@REPLACE(S1, N1, N2, S2) 

 The string formed by replacing the N2 characters starting at position N1 in S1 with string 

S2. 

--------------------------------------------------------------------------------- 

@EXACT(S1, S2) 

 Returns true (1) if string S1 exactly matches string S2, otherwise returns 0. 

 

@FIND(S1, S2, N) 

 The index of the first occurrence of S1 in S2. 

 

@REGEX(S1, S2) 
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 Returns true (1) if string S1 exactly matches string S2; otherwise returns false (0). Allows 

"wildcard"' comparisons by interpreting S1 as a regular expression. 

 

 

LOGIC FUNCTIONS 

--------------------------------------------------------------------------------- 

@FALSE() 

The logical value 0. 

 

@TRUE() 

The logical value 1. 

 

@ISNUMBER(X)  

 1 if X is a numeric value; otherwise 0. 

 

@ISSTRING(X) 

 1 if X is a string value; otherwise 0. 

--------------------------------------------------------------------------------- 

@AND(...) 

 0 if any arguments are 0; 1 if all arguments are 1; otherwise -1. 

 

@NAND(...) 

 0 if all arguments are 1; 1 if any arguments are 0; otherwise -1. 

 

@NOR(...) 

 0 if any arguments are 1; 1 if all arguments are 0; otherwise -1. 

 

@NOT(X) 

 0 if X=1; 1 if X=0; otherwise -1. 

 

@OR(...) 

 0 if all arguments are 0; 1 if any arguments are 1; otherwise -1. 

 

@XOR(...) 

 -1 if any of the arguments are not 0 or 1; otherwise 0 if the total number of arguments 

with the value 1 is even; 1 if the total number of arguments with the value 1 is odd. 

 

@IF(X, T, F) 

 The value of T if X evaluates to 1, or F if X evaluates to 0. (equivalent with ternary). 

 

 

DATE/TIME FUNCTIONS 

--------------------------------------------------------------------------------- 

@NOW 

 The date/time value of the current system date and time. 

 

@TODAY 

 The date value of the current system date. 

--------------------------------------------------------------------------------- 

@DATE(Y, M, D) 

 The date value for year Y, month M, and day D. 

 

@DATEVALUE(S) 
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 The corresponding date value for a given string S. 

 

@TIME(H, M, S) 

 The time value for hour H, minute M, and second S. 

 

@TIMEVALUE(S) 

 The corresponding time value for a given string value S. 

--------------------------------------------------------------------------------- 

@YEAR(DT) 

 The year value of date/time value DT. 

 

@MONTH(DT) 

 The number of the month in date/time value DT. 

 

@DAY(DT) 

 The day number in the date/time value DT. 

 

@HOUR(DT) 

 The hour value (0-23) of date/time value DT. 

 

@MINUTE(DT) 

 The minute value (0-59) of date/time value DT. 

 

@SECOND(DT) 

 The seconds value (0-59) of the date/time value DT. 

 

@WEEKDAY(D) 

 The integer representing the day of the week on which the day D falls. 1 is Sunday, 7 is 

Saturday. 

--------------------------------------------------------------------------------- 

@DAYS360(S, E) 

 The number of days between two dates, based on a 30/360 day count system. 

 

@EDATE(S, M) 

 The date/time value representing number of months (M) before or after start date (S). 

 

@EOMONTH(S, M) 

 The date/time value representing the last day of the month M months after S, if M is 

positive, or M months before if M is negative. 

 

@NETWORKDAYS(S, E[, H]) 

 The number of whole working days, starting at S and going to E, excluding weekends and 

holidays. 

 

@WORKDAY(S, D[, H]) 

 The day that is D working days after S, if D is positive, or before S, if D is negative, 

excluding weekends and all holidays specified as dates in range H. 

 

@YEARFRAC(S, E) 

 The portion of the year represented by the number of days between start date (S) and end 

date (E).
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Ticket Editor 

 
 

Customize the fields of WTP order tickets with the Ticket Editor. 

 

With the Ticket Editor you can: 

 

 Add or delete fields 

  

 Rename and resize fields 

  

 Move and align fields 

  

 Save ticket layouts and apply them to any WTP ticket  

 

Using a few simple commands a standard ticket can be transformed into a customized 

ticket: 

 

 
   
System Default Ticket 
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Customized Ticket 

 

 

 

Place an Order Ticket in Edit Mode 

 

Edit an Order Ticket 

 

Edit a Text Field 

 

Field Controls 

 

Add Controls to an Order Ticket 

 

Save a Ticket Layout 

 

Load a Ticket Layout 

 

Edit a Ticket Layout File 

 

Refresh Ticket Layout 

 

Add a Drop-Down List to an Order Ticket 

 

Revert to Default Ticket Layout 

 

Revert to System Default Template 

 

 

 

 

Place an Order Ticket in Edit Mode 

 

An order ticket must first be placed in Edit mode in order for changes to be made. 

 

For the Standard Order Ticket, Crossing Order Ticket, Report Trade Ticket, Adjust 

Position Ticket and Stage Ticket: 

 

Right-click on the ticket and select Edit Ticket Layout. 
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For Order Tickets in Spread Ticket, Spread Builder, Equity Quote Cube, and Option 

Quote Cube: 

 

Click on the ticket then select Edit Ticket Layout from the File menu. 

 

Alternate Method: 

 

Right-click on the ticket and select File Commands-->Edit Ticket Layout. 

 

 

Edit an Order Ticket 

 

When an order ticket is in Edit mode all controls that can be edited are displayed: 

 

 
 

 

 

Edit a Text Field 

 

There are two methods to edit a text field. 

 

Double-click on a text field. An Edit Text window will display: 
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Enter the new text and select Apply. 

 

Alternate Method: 

 

Select a text field. A box will encircle the selected field. In the image below, the Port field 

has been selected for editing: 

 

 
 

Right-click and select Edit... The Edit Text window will appear as above. 

 

 

Field Controls 

 

 

Move a Field 

 

Once a field has been selected it can be moved by dragging it with the mouse or using the 

keyboard's arrow keys. 

 

 

Resize a Field 

 

Every field can resized horizontally. Select a field and grab the left or right handles of the 

field and drag the mouse to the desired size. 

 

Note 1: Icon fields and grid control fields can have their width and height resized. 

 

Note 2: Though icon fields can be resized, the icons themselves cannot be changed. 

 

 

Delete a Field 

 

A field can be deleted using the delete key or by right-clicking on the text field and selecting 

Delete. 

 

Note: Any deleted field can be placed in an Order Ticket again using the Add Control 

feature. 

 

 

Select Multiple Fields 
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Multiple fields can be selected. The fields can then be aligned, moved, or deleted. 

 

Select multiple fields by holding down the ctrl key and click on each field to be manipulated. 

 

 

Align Fields 

 

Multiple selected fields can be aligned left, right, top, or bottom.  

 

1. Select the fields that are to be aligned. 

  

2. Right-click and select Align --> Align left, Align right, Align top, or Align bottom. 

 

In the first image below, four text fields have been selected. 

 

 
 

After selecting Align --> Align Right the fields are right-aligned: 

 

 
 

Note 1: Text field alignment results in the fields being aligned, not the text within those 

fields. If it desirable to align the text, resize each text field so there is no space around the 

text, then issue an alignment left or right command. 

 

Note 2: The align top command aligns the tops of all selected fields. The align bottom 

command aligns the bottoms of all the selected fields. 

 

 

Add Controls to an Order Ticket 

 

Controls (i.e., fields) can be added to order tickets. 

 

In edit mode, right-click anywhere in an order ticket and select Add... The Add Control 

window lists controls by category: 
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Double-click on a control category (or click on the + symbol) to display the controls for the 

category. 

  

The controls that are not currently on the order ticket are listed in boldface. 

 

To add controls to an order ticket: 

 

Double-click on a control 

 

Alternate Methods: 

 

 Select a control and press Add. 

  

 Select a control and drag it to the desired position on the order ticket. 

 

Multiple controls can be selected with the ctrl key and placed in an order ticket. Controls 

will display in a cascading fashion as they are added to an order ticket. 

 

Note 1: Any control that was previously deleted from an order ticket will be listed in 

boldface in the Add Control window and can be re-inserted. 
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Note 2: The list in the Add Controls dialogue contains every control from all tickets, not just 

the controls supported by the current ticket. Some controls are only supported on certain 

tickets. 

 

 

Search for Control Names 

  

 
  

Search results are displayed on a character-by-character basis as each character is 

entered in the search field (see search field above). Also, search results are displayed within 

the control category in which they reside. In the example above, the word "Commission" is 

found under two control categories, "Report Trade" and "Advanced". 

  

  

Save a Ticket Layout 

 

A ticket layout can be saved as a text file (.txt). 

 

Save a ticket layout without exiting Edit mode: 

 

Right-click on the order ticket and select Save Layout As... 

 

The Save Ticket Layout As... window will display: 
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Enter the ticket name and press Browse. A new window will open allowing you to select a 

desired location for the layout file. Once the location has been selected, press Save on the 

Save Ticket Layout As... window. 

 

Note: If a ticket name is not entered before Browse is selected, it can be named when a 

folder/drive is selected. 

  

Alternate Method: 

 

Enter the ticket name and press Save. The ticket layout will be saved in your system's 

default folder/drive.  

 

Apply changes from Edit mode: 

 

1. Right-click on the order ticket and select Exit Edit Mode. The Exit edit mode 

confirmation window displays: 

 

 
  

2. Select one of the following: 

 

Apply and Save—Exit edit mode, apply all layout changes to the current ticket, and 

save the ticket as the default template. 

 

Apply—Exit edit mode, apply all layout changes to the current ticket, but do not 

save it as the default template.  

 

Don't Apply—Exit edit mode, do not save any layout changes and do not modify the 

default template. 

 

Cancel—Return to edit mode without saving any changes. 

 

Note: If Apply was selected, the edited ticket layout can still be saved as the default 

template with the following command: 

 

For the Standard Order Ticket, Crossing Order Ticket, Report Trade Ticket, Adjust 

Position Ticket and Stage Ticket: 

 

Right-click on the ticket and select Save as Default Template. 
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For Order Tickets in Spread Ticket, Spread Builder, Equity Quote Cube, and Option 

Quote Cube: 

 

Click on the ticket then select Save as Default Template from the File menu. 

 

Alternate Method: 

 

Right-click on the ticket and select File Commands-->Save as Default Template. 

  

 

 

Load a Ticket Layout 

 

There are a couple of methods for loading a ticket layout, depending on the ticket being 

edited and whether the ticket is already in edit mode. 

 

Load a Ticket Layout When Not in Edit Ticket Mode: 

 

For the Standard Order Ticket, Crossing Order Ticket, Report Trade Ticket, Adjust 

Position Ticket and Stage Ticket: 

 

Right-click on the ticket and select Load Ticket Layout. 

 

 

For Order Tickets in Spread Ticket, Spread Builder, Equity Quote Cube, and Option 

Quote Cube: 

 

Click on the ticket then select Load Ticket Layout from the File menu. 

 

Alternate Method: 

 

Right-click on the ticket and select File Commands-->Load Ticket Layout... 

 

 

Load a Ticket Layout When in Edit Ticket Mode: 

 

Right-click on an order ticket in edit mode and select Load Layout... The Load Ticket 

Layout... window displays: 

 

 
 

If the path and order ticket name are known they can be entered in the text field. Press 

Load to load the ticket layout. 

 

Otherwise, press the Browse key and select the file from the appropriate folder or drive. 
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Once a ticket layout file is selected, press the Load button. 

 

 

Edit a Ticket Layout File 

 

Although it is recommended to edit a ticket layout using the ticket editor function, the ticket 

layout file can be manually edited in Notepad or other text editing programs. 

 

 
 

Each line in the ticket layout file contains (left to right): 

 Field name 

 X position 

 Y position 

 Width 

 Height 

 Display text (applies to labels, checkboxes, and radio buttons) 

 

 

Refresh Ticket Layout 

 

If a ticket layout was edited in a text editing program (as above), the order ticket will need 

to be refreshed in order to display your changes. 

 

To refresh a ticket layout: 

 

For the Standard Order Ticket, Crossing Order Ticket, Report Trade Ticket, Adjust 

Position Ticket and Stage Ticket: 

 

Right-click on the ticket and select Refresh Ticket Layout. 

 

 

For Order Tickets in Spread Ticket, Spread Builder, Equity Quote Cube, and Option 

Quote Cube: 

 

Click on the ticket then select Refresh Ticket Layout from the File menu. 

 

Alternate Method: 
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Right-click on the ticket and select File Commands-->Refresh Ticket Layout. 

 

Note: The Refresh Ticket Layout command will only refresh the currently loaded layout. 

 

 

 

Add a Drop-Down List to an Order Ticket 

  

 
  

  

Generic string controls can be added to the Order Ticket that result in a drop-down list of 

configurable values. These values are stored in a text file associated with the order ticket. 

  

  

To add generic string controls with configurable values: 

  

1. Add the controls Generic String # Enable and Generic String # Field to the Order 

Ticket: 
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2. Save the Order Ticket to a .txt file by right-clicking on the ticket and selecting Save 

Current Layout As...  

  

3. Open the .txt file and add the values that will appear in the drop-down list. The list of 

values must be proceeded with drop_choices; 

  

Use the semi-colon as a delimiter between selections as seen below: 

  

 
  

4. Load the .txt file into the Order Ticket: 

Launch the Order Ticket. 

 

Right-click on the ticket and select Load Ticket Layout. 

Select the .txt file that was previously saved. 

  

5. The Order Ticket will now feature the drop-down list. 

  

6. The new ticket layout can be saved as the default template. 

  

  

The Order Grid can be configured to display the generic value associated with an order. 

Add the Generic String column using the Field Chooser. 

 

 

Revert to Default Ticket Layout 

 

A customized ticket layout can be reverted to the default version of the ticket. The default 

ticket layout will be effective only until the ticket is closed. When an order ticket is re-

launched, the ticket layout that was previously saved as the default will be loaded. 

 

To revert to the default ticket layout: 

  

For the Standard Order Ticket, Crossing Order Ticket, Report Trade Ticket, Adjust 

Position Ticket and Stage Ticket: 

 

Right-click on the ticket and select Revert to Default Ticket Layout. 

 

 

For Order Tickets in Spread Ticket, Spread Builder, Equity Quote Cube, and Option 

Quote Cube: 

 

Click on the ticket then select Revert to Default Ticket Layout from the File menu. 

 

Alternate Method: 

 



Advanced Concepts  Ticket Editor 

419 © 2014 Wolverine Execution Services, LLC 

Right-click on the ticket and select File Commands-->Revert to Default Ticket Layout. 

 

 

Revert to System Default Template 

 

A ticket layout saved as a default template can be reverted to the system default version of 

the ticket. Once this occurs, the system default ticket will be one that is displayed whenever 

an order ticket is launched. When issuing the Revert to System Default Template 

command, a warning/confirmation message displays: 

 

 
 

  

To revert to the System Default Template: 

 

For the Standard Order Ticket, Crossing Order Ticket, Report Trade Ticket, Adjust 

Position Ticket and Stage Ticket: 

1. Right-click on the ticket and select Revert to System Default Template. 

  

2. Select Yes to revert to the system default template. 

 

For Order Tickets in Spread Ticket, Spread Builder, Equity Quote Cube, and Option 

Quote Cube: 

 

1. Click on the ticket and select Revert to System Default Template from the File 

menu.  

  

2. Select Yes to revert to the system default template. 

 

Alternate Method: 

 

1. Right-click on the ticket and select File Commands-->Revert to System Default 

Template. 

  

2. Select Yes to revert to the system default template. 
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Workspaces 

 

The applets that appear on the desktop when WTP is started is known as the workspace. 

The workspace can be configured and saved as a .wtp file. 

 

 

Reasons To Save A Workspace 

 

Applets that are regularly used can be saved as a workspace. When WTP is opened, a 

previously saved workspace can be opened. 

 

There are a number of reasons to save a workspace: 

 

 Regular trading in Options, Equities, or Futures require those type of applets to be 

displayed. 

  

 Market trends need to be followed with applets such as Quote Grid and Option Sector 

Viewer. 

  

 Spread trading, market making, and other types of managed orders are routinely 

accessed. 

  

 News headlines relating to owned or traded stock symbols are regularly tracked. 

 

Save a Workspace 

 

When a workspace is saved, every applet that is currently displayed will be saved. 

 

To Save a Workspace: 

 

1. Go to the Session column and select Save Workspace. A "Save Workspace" window 

will open.  

  

2. Move to the folder where the workspace will be stored. 

  

3. Enter a filename for the workspace. By default the workspace will be saved with a 

.wtp extension. 

 

Save a Workspace As 

 

An open workspace can be saved as another name. 

 

Follow the same steps as Save a Workspace. If the workspace is saved as an existing one, 

a confirmation window will ask if the workspace is to be overwritten. 

 

Note: A workspace need not be saved as a .wtp file. 
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New Workspace 

 

The New Workspace option will clear the currently loaded workspace, but not before 

querying you whether or not to save the current workspace. 

 

 

Recent Workspaces 

 

Select Recent Workspaces for a list of the saved workspaces. Click on the desired 

workspace to load it.
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WTP FAQ 
 

The questions on this FAQ page reflect those regularly received by technical support. 

 

Feel free to contact WEX technical support with WTP questions or issues not covered here. 

 

 

WTP Applets General Information  

Basket Trader 

Basket Rejected—Is there a setting that 

needs to be changed? 

What’s the easiest way to drop a vector of 

positions into the grid? 

Does execution start immediately? 

What is the format for an option order? 

Can I have Buy and Sell orders in the same 

basket? 

 

 

How do I make my WTP windows have a title 

bar so they can be selected and dragged? 

 

How can I see the trade details from the prior 

day? 

 

What are the bandwidth requirements for a 

Radianz line? 

 

What do the messages mean in the WTP 

Toolbar? 

 

Can the tabs in grids be moved to the bottom 

of the grid or to the side of the grid? 

 

What is window snapping? 

 

Can I have Toggle Symbol Tracking enabled 

between two WTP applets only? 

 

The "Send To" feature seems to open the 

wrong app 

 

When sending out orders via IOC routes, I 

often don't see the IOC tracker. Why is that? 

 

In a grid, how do I remove the decimals in a 

column? 

 

 

 

 

 

 

 

Chart Viewer 

How do I get real time data in the charts? 

What are the various technical indicators 

in charts? 

 

Equity Quote Cube 

How do I lock SLA? 

In the Equity Quote Cube and Option 

Quote Cube tickers, what do the 

identifiers in the EXTRA column refer 

to? 

 

Global Configuration 

How do you add a specific sound for an 

event 

How do I disable a notification? 

 

Managed Orders 

For a Spread Trader, how can I see the 

average spread of my Executed Orders?  

How can I increase vol levels by more than 

one percent at a time  

How do I change the firm when creating a 

new managed order 

mailto:support@tradewex.com
file:///C:/Documents%20and%20Settings/All%20Users/Documents/Documents/Adobe/Adobe%20RoboHelp%207/RoboHTML/Samples/WTP%20v13/advanced%20concepts/ioc%20and%20crossing%20trackers.htm
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What does it mean when, in a spread 

order, I add a value in the he Px (price) 

field and press the “C” button?  

When I execute an order on Spread 

Trader, am I subject to leg risk? 

What does Stop Loss mean in Spread 

Trader? 

How can I prevent stalled message (due to 

lagged market data) in my Vol Trader 

orders? 

How does Vol Trader calculate the 

volatility? 

Why am I seeing market data lag in the 

Managed Order Console? 

 

 

 

 

Option Quote Cube 

Can I see the book depth in the Option 

Quote Cube? 

I've lost my depth of book and cannot see 

the stacked bids and offers 

How do I launch a volatility graph? 

How do I turn off the flashing every time a 

price movement occurs in the montage 

grid? 

How can I view non-standard expirations? 

 

Order Grid 

How do I add/change tabs in the Order 

Grid? 

Is there a better way to view stocks or 

options separately? 

How can I quickly get an average of some 

but not all? 

How do I see the total number of contracts 

traded for the day? 

 

Order Ticket 

How do I enter stop orders? 

Do the position fields in the Order Ticket 

refer to the total position or the amount 

executed during the current day? 

 

Position Grid 

In the Position Grid are columns Position 
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and Position Exec. What is the 

difference? 

 

How do I create a custom column with the 

formula Gamma * (.01/(1/last price)) * 

Last Price? 

 

Quote Grid 

 

How do I set up a color highlight in Quote 

Grid when a new low/high or 52-week 

low/high is reached? 

 

Spread Builder/Spread Book 

Is there a method to place spread orders 

on hold to be executed at a later time? 

Does the bid/ask represent the national 

best bid/offer or by exchange? 

How can I view the complex order book? 

What are negative bid values and negative 

ask values? 

Can a contingency be set in Spread Builder 

so that a spread order is canceled when 

the stock price moves? 

Can a list of names be copied from a 

spread sheet and entered in the Spread 

Book at one time? 

What is the difference between Spread 

Builder and Spread Trader? 

Which Spread Types are available in 

Spread Book? 

What does Stop Loss mean in Spread 

Trader? 

 

Spread Ticket 

When I execute an order on the Spread 

Ticket, am I subject to leg risk? 

 

 
 

Basket Trader 

 

Q: I received a Basket Trader message: "Basket rejected: exceeds maximum total 

cash 100,000.00. No orders have been sent." Is there a setting that needs to be 

changed?  
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A: Open the Configuration window in Basket Trader. Set the Maximum Total Cash field 

to a higher value. 

 

 
 

 

Q: I'm looking to run a few test orders through Basket Trader. What is the easiest way to 

drop a vector of positions into the grid? 

 

A: From the File menu select Open Basket (or right-click in Basket Trader and select File 

Commands-->Open Basket). Import the .bbk file that has been created. 

 

 

Q: Does Basket Trader support Bloomberg symbology? 

 

A: No. 

 

 

Q: Once the basket is loaded, does execution start immediately? 

 

A: No, the order has to be submitted first via the Buy or Sell buttons.  

 

 

Q: What is the format for an option order? 

 

A: Type, Security, Expiration year/month, Strike Price, Option Price, Route, Portfolio): BYO 

1 DELL DELL 1108 C13 @ 2.71 on "route name" in "portfolio name".  

 

 

Q: Can I have Buy and Sell orders in the same basket?  
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A: Yes. If the Basket will be used to "BUY" securities, change the Weight Value of a stock that is to be 

sold to a negative number. 

In the example below two symbols (C and CAT) will be placed in the basket, where CAT is a buy order 

and C is a sell order of 100 shares each. The Weight of symbol C is -100.00 and weight of CAT is 

100.00: 

 

 

 

When Buy is selected, the confirmation window displays the orders: 

 

 

 

Conversely, if the basket will be used to SELL securities, a negative weight value will be considered a 
BUY order. 
 

 

 

Chart Viewer 

 

 

Q: How do I get real time data in the charts? 

 

A: In Chart Viewer, data reporting can be set for increments as small as one minutes. 

Currently, there is no tick-by-tick data reporting. 
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Q: What are the various technical indicators in charts? 

  

A: The technical indicators that can be used in Chart Viewer along with their definitions can 

be found here. 

 

 

Equity Quote Cube 

 

 

Q: In the Equity Quote Cube's Order Ticket, how do I lock SLA (Auto Sell)? 

 

A: Check Snap Side Type to Defaults on Security Change in the Quote Cube Order 

ticket and set up your default side types in Global Configuration. 

 

 
 

 

 

Q: In the Equity Quote Cube and Option Quote Cube tickers, what do the identifiers in the 

EXTRA column refer to? 

 

A:  

 

REGULAR Regular Sale  

 

 

CANC  Cancel Previously Reported Transaction  

 

 

LATE  Transaction is being reported late  
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CNCO Cancel Opening Transaction  

 

 

OPEN Opening Trade. Late Report. Out of Sequence  

 

 

CNOL Cancel Transaction that is the only one reported  

 

 

OPNL Opening Trade. Late report  

 

 

AUTO Regular Sale: Electronic Execution  

 

 

REOP Regular Sale: Reopening  

 

 

AJST Regular Sale: terms adjusted to reflect a stock dividend, split, etc.  

 

 

SPRD Regular Sale: Spread  

 

 

STDL Regular Sale: Straddle  

 

 

STPD Sale at a price agreed upon by the floor personnel involved  

 

 

CSTP Cancel stopped transaction  

 

 

BWRT Regular Sale: option portion of a buy/write  

 

 

CMBO Regular Sale: Buying of a call and selling of a put  

 

 

SPIM Execution of an order which was stopped at a price that did not constitute a Trade-

Through at a time of a stop  

 

 

ISOI Intermarket Sweep Order execution  

 

 

BNMT Benchmark Trade execution  

 

 

XMPT Regular Sale: Trade Through Exempt  
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Global Configuration 

 

Q: How do you add a specific sound for an event (for example: "an order is filled")? 

 

A: In the Global Configuration window, go to the Notifications tab. From the drop-down 

list, select the event to launch a notification. Select the sound to play when the event has 

been accomplished.  

 

 

 
 

Q: How do I disable a notification? 

 

A: Currently there is technically no way to disable a notification without deleting the 

notification. However, by setting the sound to <None>, setting the Log Severity to 

<None> and setting the Action to <None> (or N/A if there is no Action available) the 

notification will effectively be disabled. 

 

 

Managed Orders 

 

Q: For a Spread Trader, how can I see the average spread of my Executed Orders? 

 

A: In the Managed Order Console add the columns Actual Sprd: 
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Q: How can I increase vol levels by more than one percent at a time? 

 

A: In the Configure Managed Order Console window, enter the desired vol increment in 

the Vol % Increment field. 

 

 

Q: How do I change the firm when creating a new managed order? 

 

A: Assuming that there is more than one firm name from which to choose and you have the 

permission to make the change: 

 

1. Right-click on the Managed Order Console. 

2. Select New Managed Order Choose Type and Firm. 

3. Select a different firm from the drop-down list: 

 

 
 

 

Q: What does it mean when, in a spread order, I add a value in the Px (price) field and 

press the "C" button? 

 

A: The "c" stands for credit ("d" for debit). This is how much you wish to receive. If debit 

is selected, this is the amount you wish to be charged (or debited). 

 

 

Q: When I execute an order on Spread Trader, am I subject to leg risk? 

 

A: Spread Trader sends out each leg of the order individually so there is always the 

possibility of leg risk. However, the configuration and safeguards of Spread Trader 

determine the amount of leg risk. 
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Q: What does Stop Loss mean in Spread Trader? 

 

A: The stop loss is the amount of ticks that you would allow your spread to move before 

executing a market order to hedge the legged portion of your spread. 

 

 

Q: How can I prevent stalled messages (due to lagged market data) in my Vol Trader 

orders? 

 

A: In Vol Trader select Safeguards. Check the box and enter a higher value in the Stall if 

Market Data Lag Exceeds field. 

 

 

Q: How does Vol Trader calculate the volatility? 

 

A: Voltrader calculates the volatility dependent on the stock side. If you're buying 

stock, it will use the offer of the stock price. If you're selling stock (as part 

of the vol order) it will use the bid price. 

 

 

Q: Why am I seeing market data lag in the Managed Order Console? 

 

A: For managed orders, it is recommended to set the market data lag value between 3 and 

5 seconds. A lower value can cause the market data lag. 

 

 
 

 

 

Option Quote Cube 

 

Q: Can I see the book depth in the Option Quote Cube? 

 

A: In the Config menu select Show Detailed Quotes. Quote Detail data is displayed at the 

bottom-right of the window: 
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Q: I've lost my depth of book and cannot see the stacked bids and offers. What must be 

configured? 

 

A: In Global Configuration go to the Quote Data tab. Under Option Book Source 

Configuration (Level-2) be sure to add the following: 

 

 

Quote 

Source 

Service 

ISE ISEOPT 

PSE NYSEOPT 

 

 

Q: How do I launch a volatility graph? 

 

A: Once a symbol has been selected, press the Show Volatility Chart icon: 

 

 
 

 

Q: How do I turn off the flashing every time a price movement occurs in the montage grid? 

  

A: Open the Configure Option Quote Cube window and go to the Option Montage Grid 

tab. At the bottom of the window is the Highlight Period field. To disable the flashing of 

price movements in the montage grid, set the value to 0 seconds. 
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Q: How can I view non-standard expirations? 

 

A: The options to Show Non-Standard Expirations and Show Unusual Strikes are 

available by selecting the Show Montage Filters icon (upper right corner) of the Equity 

Quote Cube. When selected, the Filters window displays. Make your selection(s) in this 

window. To close this window, click anywhere in the Equity Quote Cube. To keep this 

window open, select the lock icon. It will remain open as long as the Equity Quote Cube is 

open. 

 

 
 

 

 

Order Grid 
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Q: How do I add/change tabs in the Order Grid? 

 

A: See the Tabs in Grids page for a detailed explanation. 

 

 

Q: I see options and stocks lumped together. Is there a better way to view stocks or options 

separately? 

 

A: You can create tabs and customize the tab to display only the desired data. 

 

1. Right-click on an existing tab and select Create New Tab. 

 

2. Enter a name in the Tab Name window. 

 

3. Open the Configure Order Grid window and select the content to be displayed.  

 

After creating and naming your tabs, open the Order Grid Configuration and configure 

the Order Sec(urity) Type filter as desired. For Event Grids, configure the Event 

Sec(urity) Type.  

 

 

Q: When I have several orders in one name how can I quickly get an average of some but 

not all? 

 

A: Highlight the selected fills of those in which you have an interest. Right click and select 

Show Order Summary: 

 

 
 

 

Q: How do I see the total number of contracts traded for the day? 

 

A: Right-click on the column head for the column Traded and select Show Total. The total 

will be placed below the last row in the Traded column. 

 

 

Order Ticket 

 

 

Q: How do I enter stop orders? 

  

A: In Advanced Mode select the price type to Stop Mkt or Stop Lmt. For Stop Mkt 

orders, enter a stop price in the Stop field. For Stop Lmt orders, enter both the stop price 

and the limit price in the Px field. 
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Q: Do the position fields in the Order Ticket refer to the total position or the amount 

executed during the current day? 

 

A: By default, the position fields display the total portfolio position for the day, which 

includes position loads and adjustments. However, the Order Ticket Configuration has a 

configuration option titled “Day Position Only” which causes the position fields to display 

the position for only the day’s executions. 

 

 

 

Position Grid 

 

Q: In the Position Grid are columns Position and Position Exec. What is the difference? 

 

A: The Position column displays the total position for the day, which includes position loads 

and adjustments. The Position Exec column displays the position of only the current day’s 

executions. 

 

 

Q: How do I create a custom column with the formula Gamma * (.01/(1/last price)) * 

Last Price? 

 

A: First, determine whether you want to use Position Gamma Total or Position Gamma 

Exec. Position Gamma Total is calculated using the total position which includes the day’s 

executions as well as position loads and adjustments. Position Gamma Exec is calculated 

using the executed position which is only the executions for the current day. 

 

Next, insert a Numeric Expression column into the Position Grid. <Numeric 

Expression> is located under User Defined Fields. Set the title of the field to something 

descriptive, like Gamma*Last. 

 

For the expression, enter the following: [Position Gamma 

Total]*[Last]*(.01/(1/[Last])) (Position Gamma Exec and Position Gamma Total are 

interchangeable depending on what you want to see). 

 

If you encounter the Ambiguous Field Dialog choose the Field Type that corresponds to the 

Position you wish to see (Portfolio, Account, or Firm). 
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Save your template as the default. Go to File --> Save as Default Template. 

 

Once the column is in your Position Grid you may revise the fields at any time by right 

clicking over the column --> Set Column Style.  

 

After each change, save your template as the default. Go to File --> Save as Default 

Template. 

 

Additional information on inserting columns into grids can be found here. 

 

 

Quote Grid 

 

Q: How do I set up a color highlight in Quote Grid when a new low/high or 52-week 

low/high is reached? 

 

A: Right-click on any column head in the Quote Grid and select Add Color Condition. Enter 

the following conditions: 
 
 

Highlight a new low/high for a 52-week time period: 

  

 
 
This expression can also be written as: 
[Last] = [Yr Low] = 1 
[Last] = [Yr High] = 1 
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Highlight a new low/high for today: 
 

 
 

Note: Both color conditions defined above can be combined in a single color conditions 

table. 

 

 

Spread Builder/Spread Book 

 

 

Q: In Spread Builder, is there a method to place spread orders on hold to be executed at a 

later time? 

 

A: No. To configure spreads to be executed at a later time, it is best to use Spread 

Viewer. 

 

 

Q: Does the bid/ask represent the national best bid/offer or by exchange? 

 

A: By default, the bid and ask represents the national best bid or offer of all exchanges. To 

view these values by exchange, use the Quote Dialog.  

 

 

Q: How can I view the complex order book? 

 

A: The Spread Book is the complex order book. In Spread Builder and Spread Ticket 

the Spread Book can optionally be shown by selecting the spread book icon .  

 

 

Q: When viewing the spread book inside Spread Builder, I noticed that there were negative 

bid values and negative ask values. How is that possible? 

 

A: Negative numbers imply credits. A bid of -0.30 indicates that the user wants to collect a 

$0.30 credit. If the user wanted to pay the offer, they would only collect a $0.20 credit. 

Using this convention, the spread book displays the $0.30 credit as the bid (since the user 

would be working the bid and it wouldn't execute immediately) and the $0.20 credit as the 

ask (as the user would execute immediately). 

 

 

Q: Can a contingency be set in Spread Builder so that a spread order is canceled when the 

stock price moves? 

 

A: No, there is no such safeguard. 
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Q: Can a list of names be copied from a spread sheet and entered in the Spread Book at 

one time? 

 

A: Yes. This can be done with Spread Viewer and Spread Basket Trader. 

 

 

Q: What is the difference between Spread Builder and Spread Trader? 

 

A: Spread Trader trades two products (two stocks, two options, one option/one stock) 

with the goal that the change in one security affects the other. Spread Builder allows for 

the creation of multi leg spread orders of the same security where a leg can either be 

an Option or an Equity. 

 

 

Q: Which Spread Types are available in Spread Book? 

 

A: The various spread types available for viewing in Spread book are defined here.  

 

 

 

 

Spread Ticket 

 

Q: When I execute an order on the Spread Ticket, am I subject to leg risk? 

 

A: No. When using Spread Ticket, all orders will be sent as a bundle to the exchange. 

Therefore, there will be no leg risk with these trades. 

 

 

 

 

General Information 

 

Q: How do I make my WTP windows have a title bar so they can be selected and dragged? 

 

A: If the title bar is missing, the windows are pinned. To unpin WTP windows press the F12 

key. Alternately, you can select unpin windows from the WTP toolbar/Workspace 

Management. 

 

Even without a title bar, pinned windows can still be selected and dragged. 

 

 

Q: How can I see the trade details from the prior day? 

 

A: Go to www.tradewex.com/reports_v13/Login.aspx. Enter your current trading logon and 

password and fill out all relevant information. 

 

 

Q: What are the bandwidth requirements for a Radianz line? 

 

https://www.tradewex.com/reports_v13/Login.aspx
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A: An average client, watching an option chain, equity level 2 screen, and 100 equity items 

will consume a steady 64Kb per users with bursts (at the open/close or when moving 

between products) of up to 256Kb. 

 

A high-end index client, watching the Russell, QQQQ and SPY options, and the NASDAQ 100 

will consume a steady 100Kb per user, with bursts of 300Kb. Radianz typically carves out 

the line in 1Mb increments (1Mb = 1000Kb). Radianz also typically charges about 

$1000/Mb. Approximately 5 users can be handled over a 1Mb line. A recommendation for 20 

users would be about a 4Mb or 5Mb line. 

 

 

Q: What do the messages mean in the WTP Toolbar? 

 

A: From left to right: 

 

 
 

New Notifications—A notification event that was set in Global Configuration has been 

achieved. Double-click on New Notifications to read the notification. 

 

New Messages—A message from Instant Messenger has been received. Double-click on 

New Messages to view Instant Messenger. 

 

Executing Managed Orders—The number of managed orders currently being worked. 

Double-click on Executing Managed Orders to open the Managed Order Console. 

 

Trader Server: (connected/not connected)—A status message indicated whether or not 

a server connection exists. Double-click on the Trade Server message to open the 

Connection window to see the status. From this window you can disconnect from the trade 

server, or adjust the network configuration.  

 

Quotes—The status of market data feeds are displayed here. If all quotes are 

permissioned, the status will be Quotes: OK. If one or more quotes is not permissioned, the 

quotes indicator will display in red the number of these quotes and the number of quotes 

that are OK. Double-click on Quotes to display the market data status and determine which 

quotes are non-permissioned. 

 

xxxx.x ms—This value reflects the latency (the round-trip ping time) to the order server. If 

green, this indicates a generally fast ping time. If yellow or red, there may be an issue with 

network congestion. 

 

 

Q: Can the tabs in grids be moved to the bottom of the grid or to the side of the grid? 

 

A: Yes. Right-click on any tab and select Configuration. From the Configuration window 

select the Format tab. Select one of the alignment options for the tabs and click OK. 

 

 

Q: What is window snapping? 

 

A: Window snapping causes one window to butt against another window (i.e, "snap" 

together) when both are in close proximity. 
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To enable/disable window snapping, select the option from the Workspace Management 

menu from the WTP toolbar. 

 

 

Q: Can I have Toggle Symbol Tracking enabled between two WTP applets only (Equity 

Quote Cube and Order Ticket, for example) while ignoring other WTP applets? 

 

A: No. You cannot define Toggle Symbol Tracking to work with only selected applets. Once 

enabled, Toggle Symbol Tracking will respond to symbol changes in all WTP applets. 

 

Regarding to two applets only, you can use the Connections feature. With this feature, a 

connection is be made between selected applets and will ignore all unselected WTP applets 

regardless of their symbol changes. 

 

 

Q: Why is it that when I select two or more securities from a grid (Quote Grid, for example) 

and use the send to feature and select Order Ticket, the Spread Ticket opens instead? 

 

A: This is by design. Selecting one security from a grid and employing the send to feature 

will open the applet that is expected (in this case, the Order Ticket). However, when 

selecting more than one security WTP will act as if a spread order is being requested. The 

security that will appear in the Spread Ticket is the one in which the send to feature was 

clicked on, i.e., if three securities are highlighted in a grid, the one selected security when 

issuing the send to command will be the one in the Spread Ticket. 

 

The best use of the send to feature for multiple securities would originate from the Option 

Quote Cube. Selecting multiple options and sending them to the Order Ticket will open the 

Spread Ticket with all the selected options in place.  

 

Also, sending two or more securities from a grid and sending them to the Basket Trader will 

place the securities in the app as expected. 

 

 

Q: When sending out orders via IOC routes, I often don't see the IOC tracker. Why is that? 

 

A: The IOC tracker is not an applet per se. It's designed to appear only when there are 

issues routing an IOC order. If an IOC order is sent and the IOC tracker doesn't open, you 

can assume the order has been sent without any problems. 

 

 
Q: In a grid, how do I remove the decimals in a column? 

 

A: Right click over the specific column and choose Set Column Style. Select the Format 

tab and change the decimal places to 0. 
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Release Notes 

13.4.72.0 

June, 2014 

  

 New Time-In-Force Selection: GTD (Good Till Date) 

 GTC (Good Till Canceled) Now Available for Staged Orders  

 Bust Allocations in Allocator 

 Allocator Change: "Normal" Mode to "All" 

 Print Topic Button Added to Help Tool Bar 

  

  

  

  

New Time-In-Force Selection: GTD (Good Till Date) 

  

 
  

New TIF selection GTD (Good Till Date) with Date and Time controls 

  

  

A new time-in-force selection, GTD, allows a user to define a date when an unfilled order 

will be canceled. Optionally, a time selection can be appended to a selected date. If a time 

selection is not made, the unfilled order will be canceled at midnight of the day after the 

chosen date (for example, a GTD of 6/10/2014 will cancel the order at midnight on 

6/11/2014). 

  

The required GTD Expire Date Field and optional GTD Expire Time Field controls are 

added with the Ticket Editor.  

  

The GTD values can be displayed in the Order Grid. Add the In Force and GTD Expiration 

columns with the Field Chooser. 
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GTC (Good Till Canceled) Now Available for Staged Orders  

  

  

 
  

Staged Order Ticket with TIF of GTC 

  

  

 
Staged Order in Order Grid sent to Basket Trader 

  

  

The time-in-force selection GTC (good till canceled) can now be used for staged orders on 

the Staged Order Ticket. If a staged order is sent from the Order Grid (via the "send to" 

command) to another WTP app, the time-in-force is inherited from the staged order. 

  

If no TIF is defined, the default value "Day" will be used. 

  

Add the TIF control to a Staged Order Ticket using the Ticket Editor.  
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Bust Allocations in Allocator 

  

 
  

An allocated order is selected and issued a Bust command. 

  

  

 
  

Confirmation dialog launches confirming the Bust command  

  

One or more allocated orders can be busted in Allocator. In the image above, 100 shares 

were allocated from AccountA1 to AccountA2. 

  

The 100-share allocation can be busted (note the availability of the Bust button).  

  

1. Select one or more allocations to be busted in the Orders section of the Allocator 

window. 

  

2. Press the "Bust" button. A conformation dialog launches.  

  

3. Select OK to bust the selected allocation(s). 

  

  

Once allocations are busted, they are removed from the grid. 
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Add the Bust button to the Orders grid in Allocator with the Field Chooser. 

  

  

  

Allocator Change: <Normal> Mode to <All> 

  

 
The selection in the Allocator drop-down list formerly identified as <Normal> (displaying 

both Cmta and Omni accounts) has been changed to <All>. 

  

There is no change in function. 

  

  

  

Print Topic Button Added to Help Tool Bar 

  

 
  

A Print Topic button has been added to the Help tool bar. 

  

When viewing a Help page containing hidden text, press the Print Topic button to reveal the 

hidden text and launch the Print dialog window. 

  

Only the Print dialog will launch if Print Topic is selected on a page without hidden text. 
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13.4.71.0 

May, 2014 

 

 

There were no new WTP features in this release.
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13.4.70.0 

May, 2014 

  

 New Help Page "Import Samples" 

 New Buttons Added to WTP Help 

  

  

New Help Page "Import Samples" 

  

A new Help page titled Import Samples displays three different scenarios: 

 

 CSV File imported into Spread Basket Trader 

 CSV File imported into Spread Agent 

 CSV File imported into Vol Trader 

 

Included in this page are the source Excel and Import files. 

  

The Import Samples page is found under Advanced Concepts. 

  

  

  

  

New Buttons Added to WTP Help 

  

  

   

  

Two new buttons have been added to the WTP Help toolbar: 

  

1. Show—Open all hidden drop-down text on the current page. 

 

2. Hide—Hide all content that is currently displayed. 
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13.4.69.0 

April, 2014 

 

 

 Start/Stop Times Now Available in the Staged Order Ticket 

 Progress Bar Added to the Order Grid 

 

 Warn When Canceling an Order Owned by a Managed Order 

  

  

Start/Stop Times Now Available in Staged Order Ticket 

  

 
  

Start time and Stop time controls are now available in the Staged Ticket. The controls are 

found in the Advanced category. 

  

Add the Start/Stop controls using the Ticket Editor function. 
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Progress Bar Added to the Order Grid 

  

  

 
  

  

  

Long delays have been experienced when opening an Order Grid with a large number of 

orders. Individual orders could not be accessed until the grid was completely populated. 

These delays have been eliminated.  

  

The Order Grid now populates in the background and displays a Progress bar as orders fill 

the grid. Orders displayed in the grid can be accessed while the grid populates. 

  

  

  

Warn When Canceling an Order Owned by a Managed Order 

  

  

In Release Notes 13.4.64.0 it was reported that a warning message is issued when 

attempting to cancel or modify a live managed order. 

  

With this release, a warning message will be issued only when attempting to cancel a live 

managed order. No such warning will be issued when attempting to modify a live managed 

order. 
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13.4.68.0 

March, 2014 

 

There are no new WTP features/improvements in this release.
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13.4.67.0 

March, 2014 

  

  

 Spread Viewer "TV" Grid Field Changed to "Mid" 

 New Buttons Added to Help Toolbar 

  

Spread Viewer "TV" Grid Field Changed to "Mid" 

  

  

 
  

  

The grid field formerly known as TV (theoretical value) has been changed to Mid in Spread 

Viewer. The change affects only the grid field name and not its contents. 

  

The system default template for Spread Viewer now contains the Mid column. 
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New Buttons Added to Help Toolbar 

  

 
  

  

Two new buttons have been added to the Help toolbar. 

  

1. Email—Select this button to open your email program. The To: field will be auto-

populated with support@tradewex.com (the technical support address of the WEX help 

desk). 

  

2. Favorites—Select this button to view a list of Help pages that have been saved as 

"favorites". 

  

  

Save, Call, and Delete Favorite pages 

  

  

Save a Help page as a favorite 

  

Click on the gray star at the top of each Help page (release notes excluded) to save that 

page as a favorite. The gray star will change to a gold star: 
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View list of Favorites 

  

In the Help toolbar, select the Favorites button to see a list of pages that have been saved 

as a favorite: 
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Click on the page name to be directed to that page. 

  

Click on the [X] next to the page name to remove the page as a favorite. Clicking on a 

page's gold star will also remove the page from the favorites list. 
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13.4.66.0 

February, 2014 

  

  

 New Search Feature for Order Grid 

 User Permissions Viewer Improved Accessibility 

 Isolate Execution by Side Type in the Order Detail Window 

 Symbol Browser Improvement: Show All Products for a Name When 

Searching the Symbol 

  

  

New Search Feature for Order Grid 

  

 
  

Select the search button to launch the Search Order Grid window: 
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Enter search parameters and press Search. 

  

  

 
  

Search Results tab opens and displays found items. 

  

  

A new search feature has been added to the Order Grid. This feature allows for the 

searching of various parameters for all items listed in the grid. 

  

Initiate a search by selecting the search button or by entering ctrl + f. The Search Auto 

Grid window launches. 

  

A few things to note about the search feature: 

 Only a single item in each search field is allowed. 

 The reset button clears all fields in the Search Order Grid window. 

 Select meta data can be searched without the need for any corroborating fields (i.e., 

a search for strike price or expiration can be accomplished without entering a symbol 

or security). 
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User Permissions Viewer Improved Accessibility 

  

The User Permissions Viewer can now be launched via the following methods: 

 

 From the Session menu: select View User Permissions 

 From the WTP menu: select Trade Limits Viewer 

  

  

  

Isolate Execution by Side Type in the Order Detail Window 

  

Side column (highlighted in gray) can now be added to the Event grid in the Order Detail 

window 

   

A complex order could contain many executions and side types. Previously, when viewing 

details of an order (via the Order Detail window), it was impossible to determine an order's 

side types.  

 

 
  

A new selection of Order Fields can now be added to the Event grid portion of the Order 

Detail window. In the image above, the shaded column Side has been added to the Event 

grid. 

  

Add any Order Field to the Event grid using the Field Chooser. 

  

Note: Columns added to the Event Grid are not saved when the Order Detail window closes. 

  

  

  



Release Notes  13.4.66.0  

   

457 © 2014 Wolverine Execution Services, LLC 

Symbol Browser Improvement: Show All Products for a Name When Searching the 

Symbol 

  

 
Symbol Browser matches the symbol "Goog". Double click on the name in the grid to display 

all products associated with the selected symbol: 

  

  

 
  

  

  

Symbol Browser can now display all related products to a found symbol with a double-

click. 

  

In the first image above, a search for "Goog" was initiated. Symbol Browser finds a match 

with the name Google Inc. 

  

Double-clicking on a name in the grid (in this case "Google Inc"), causes Symbol Browser to 

do the following: 

  

 The Search field changes from Symbols to Names 

 Content in the For field changes to the symbol name previously selected 

 All products related to the symbol are now displayed in the grid 

  

Note: A more granular search can be run by double-clicking on any product row. The 

product name will be placed in the For field. 
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13.4.65.0 

February, 2014 

  

  

 Tool tips Display When Hovering Over Non-Enabled Execute Button 

 Send Crossing Trade Reports with the Report Trade Crossing Ticket 

  

Tool tips Display When Hovering Over Non-Enabled Execute Button  
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Two examples of tool tips that display when the mouse hovers over a non-enabled execute 

button. 

  

  

  

When the execute button is not enabled for WTP applets, hovering over the button will 

display a tool tip that describes what is blocking the execution. 

  

If the cited errors refer to those highlighted in red, the tool tip will read "Errors exist in the 

highlighted areas". Otherwise, the tool tip will describe the error specific to the applet. 

  

  

  

Send Crossing Trade Reports with the Report Trade Crossing Ticket 

  

 
  

Report Trade Crossing Ticket Equity Mode 
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Report Trade Crossing Ticket Option Mode 

  

  

The Report Trade Crossing Ticket allows for the reporting of external crossing equity or 

option trades, similar to the Report Trade Ticket.
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13.4.64.0 

January, 2014 

  

  

 Warning Issued When Modifying an Order Owned by a Managed Order 

  

  

  

When attempting to cancel or modify a live order initiated by a managed order (Time Slicer, 

Spread Agent, etc.), a warning message will launch and it will be necessary to confirm the 

cancelation/modification before proceeding. For example: 

  

  

1. A Time Slicer order is configured to buy 1,100 shares with a minimum slice quantity of 

100 shares: 
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2. Time Slicer issues a buy order. Press the Order Detail button on Time Slicer to launch 

the Order Grid. 

  

 
  

Select the Cancel button on the row with the live order. 

  

  

3. A warning message is issued: 

  

 
  

The order can be canceled by checking the box Confirm this operation despite warnings 

then clicking OK.
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13.4.63.0 

December, 2013 

 

There were no new features in this release.



Release Notes  13.4.62.0  

   

464 © 2014 Wolverine Execution Services, LLC 

 

13.4.62.0 

November, 2013 

  

  

  

 Allocator Enhancements 

 

Ability to view Cmta and Omni accounts  

 

Ability to view Report Trades 

  

Allocator Enhancements 

  

1. Ability to view Cmta and Omni accounts: 

  

 
  

New enhancements in Allocator allows for the display of Cmta accounts or Omni accounts. 

Each account type is defined by WEX during WTP installation. 

  

A new drop-down list featuring Cmta and Omni selections has been added to Allocator. 

Select the account type and the account name to view the account positions from which 

allocations can be made. 
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2. Ability to view Report Trades: 

  

 
  

When Report Trade is selected, Allocator changes its view to an Account Grid and a single 

Order Grid. The Account grid shows the position consisting of Option Report Trades without 

a Cmta. The Order grid shows all Option Report Trades, regardless of Cmtas. 

  

Although Report Trades cannot be allocated per se, a Report Trade can have a Cmta value 

added or changed. Double-click on a specific order (or right-click on the order and select 

Add Allocation). When selected, the Report Trade Allocation window launches. The 

Cmta value can be edited in this window: 

  

 
  

  

  

Note: Cmta, Omni, or Report Trade mode is accessible only if the Global Configuration 

option Exclude Report Trades from Allocation is checked. If unchecked, no selection is 

possible and Allocator defaults to <Normal> display. 
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13.4.61.0 

November, 2013 

  

  

 FIX Notification Can Launch Order Ticket 

 Stale Quotes Will Now Be Indicated in Order Tickets and Quote Cubes 

 Short Sale Warnings Implemented for SLA Orders 

 Commission Summary Added to Order Grid 

 Internal Change Button Allows Commission Changes to Filled Orders 

  

  

  

FIX Notification Can Launch Order Ticket 

  

 
  

A new notification Fix Action has been added as an event in Global Configuration.  

  

Whenever an order is received from a FIX server, the Order Ticket will launch if the action 

to Open Order Ticket is selected. 
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Stale Quotes Will Now Be Indicated in Order Tickets and Quote Cubes 

  

 
 

If a stale quote exists for a particular symbol, the trading status tool tip will read "Stale" 

and the word (Stale) will be displayed next to the security name. 

  

Also, the security box will be colored yellow for securities with a stale quote. 

  

  

State Quote in Quote Grid 

  

A stale quote in the Quote Grid will have a line through the security name. 

  

  

  

  

Short Sale Warnings Implemented for SLA Orders 

  

 
  

 

When it is determined that an auto-sell order (SLA) will trade as a short sale, an affirmation 

message will be issued.  

  

The number of shares identified in the affirmation message (in the example above it is 100) 

reflects the quantity that is going short. This value is calculated by the current position on a 

security minus the amount to be sold via auto-sell. 
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The short-sell affirmation message will launch in the following applets: 

 

 Order Ticket 

 Report Trade Ticket 

 Adjust Position Ticket 

 Crossing Ticket 

 Spread Ticket 

 Crossing Spread Ticket 

 Report Trade Spread Ticket 

 Basket Trader 

 Spread Basket Trader 

 Crossing Basket Trader 

 Spread Agent 

 Spread Trader 

 Time Slicer 

 Vol Trader 

  

  

  

Commission Summary Added to Order Grid 

  

 
  

A new column Commission Summary is available in the Order Grid.  

  

Filled orders that have a commission will display the total value of the commission along 

with the order size and commission amount. 

  

Add the Commission Summary to the Order Grid with the Field Chooser. 
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Internal Change Button Allows Commission Changes to Filled Orders 

  

 
  

The column Internal Change added to the Order Grid. Press the Internal Change button to 

make changes to a filled order. 

  

  

 
  

Add, remove, or change the commission-related data here. 

  

  

A new Order Grid column Internal Change is now available for making commission-related 

changes. When added to the Order Grid, an Internal Change button will appear on each row 

of a filled order. Selecting the button launches the Change Order window. In this window 

the following can be accomplished: 

  

 Add a commission to the order if one wasn't assigned 

 Remove an order's commission 

 Change the commission value 

 Change the commission designation (per share or flat fee) 

 Add/remove a note 

 

When all changes are satisfactory, press the Change button. Changes can be made more 

than once to any filled order. 

  

Add the Internal Change column to the Order Grid with the Field Chooser. 
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13.4.60.0 

October, 2013 

  

  

  

 Hedge Agent Improvement: Minimum Size Field Changed to Minimum Delta 

 Enable/Disable Eye Added to Managed Order Console 

 New Prompt for Password Reset 

 Tool Tips Added for Trading Status 

  

  

  

  

Hedge Agent Improvement: Minimum Size Field Changed to Minimum Delta 

  

 
  

The field "Min Size" has been replaced with "Min Delta" (minimum delta). The default Min 

Delta value is 100. 

  

Previously, Hedge Agent checked that the quantity sent had to be above a minimum value. 

Now Hedge Agent will attempt to hedge a portfolio above the value defined in the Min Delta 

field. 
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Enable/Disable Eye Added to Managed Order Console 

  

  

 
  

  

The ability to enable/disable the Eye feature in managed orders has been added to the 

Managed Order Console. 

  

The Eye feature can be checked or unchecked as long as the managed order is not running. 

  

  

  

  

New Prompt for Password Reset 

  

 
  

  

If a user cannot remember their password, selecting I forgot my password on the WTP 

Connection screen will launch the prompt above. 

  

Select Yes to have the system email the user with a temporary password. Select No to 

close the window.  

  

Note: The password will not be reset until the temporary password is actually used. 
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Tool Tips Added for Trading Status 

  

  

 
  

  

 
  

  

  

Trading status tool tips for a selected security are now displayed in the Order Ticket, 

Option Quote Cube, and Equity Quote Cube. 

  

View a tool tip by positioning the mouse pointer in the symbol (or security name) field.  

  

For Equity tickets, one of the following tool tips will display: 

  

 Trading Status: Normal 

 Trading Status: Short Sale Restricted 

 Trading Status: Halted 

 Trading Status: Volatility Pause (i.e., LULD Pause) 

 Stale Data: (unreliable data at the moment) 

  

For Option tickets, one of the following tool tips will display: 

  

 Underlier Trading Status: Normal 

 Underlier Trading Status: Short Sale Restricted 

 Underlier Trading Status: Halted 
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 Underlier Trading Status: Volatility Pause (i.e., LULD Pause) 

 Stale Data: (unreliable data at the moment) 
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13.4.59.0 

October, 2013 

  

  

 Short Sale Affirmation Message Improved 

 

 Support for new Friday Expirations 

  

  

Short Sale Affirmation Message Improved 

  

  

 
  

  

The affirmation message that appears when issuing a short sale has improved to include the 

order quantity and stock symbol. 

  

  

  

  

Support for new Friday Expirations 

  

Starting with the February 2015 expirations, the Options Clearing Corporation (OCC) is 

changing the default expiration to be the third Friday of each month. Previously, it was the 

Saturday after the third Friday. 

  

WTP now supports the new Friday expirations. In addition, WTP supports exceptions to the 

default expiration rule (for example, .mnx "mini index" options). 
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13.4.58.0 

October, 2013 

  

  

 New Managed Order Applet: Hedge Agent 

 New WTP Applet: Historical Trades Browser 

 Allocator Improvement: Allocate Legs in a Spread Order by Quantity 

 New Hammer Sweep-and-Cross Options Algorithm 

 Managed Order Improvement: Right-Click to Access "Other Actions" Menu 

  

  

  

New Managed Order Applet: Hedge Agent 

  

 
  

Hedge Agent offers the ability to delta hedge an entire portfolio of managed orders at 

market price, BASB (buy ask/sell bid), or BBSA (buy bid/sell ask). The hedging occurs on 

orders as they arrive and only for those orders sent by the user running the managed order. 

  

Learn more about Hedge Agent here. 
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New WTP Applet: Historical Trades Browser 

  

 
  

  

The Historical Trades Browser allows access to the WEX Client Portal wherein users with 

appropriate permission can: 

  

 Retrieve Orders, Executions, and Slippage Reports 

 Access WTP-related programs (WTP downloads, WTP Help, Real-time-data, 

VPN/Cisco connectivity) 

 Read WEX Specifications (WOTI & FIX) 

 Access Sentry, the Administration Tool for WTP 

 Add New Accounts 

 

Learn more about the Historical Trades Browser here. 

  

  

  

Allocator Improvement: Allocate Legs in a Spread Order by Quantity 

  



Release Notes  13.4.58.0  

   

477 © 2014 Wolverine Execution Services, LLC 

 
 

Allocate legs in a spread by quantity 

  

  

When allocating multiple positions of a filled spread order in Allocator, the amount 

allocated can now be defined by the quantity (number of shares). In the image above, 350 

shares of a 500 share total are being allocated from one account to another. 

  

If a filled spread order with differing quantities is to be allocated, the quantity to allocate is 

based on the percentage of the total number of shares. In the image below, the executed 

quantity totals 300 (100 short and 200 long). The allocated percentage is 65% (or 65 and 

130 shares respectively). 

  

  

 
  

Allocate legs in a spread by percentage 

  

  

  

New Hammer Sweep-and-Cross Options Algorithm 

  

A new WEX options algorithm designed to sweep the market up to a defined limit price and 

cross the remaining quantity in a crossing order has been named "the hammer."  

  

Learn more about the WEX Hammer Sweep and Cross here. 
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Managed Order Improvement: Right-Click to Access "Other Actions" Menu 

  

 
  

  

The Other Actions menu in all Managed Order applets can now be launched by right-

clicking directly on the managed order. 
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13.4.57.0 

September, 2013 

  

  

 Route Time Entry Field Available in Report Trade Ticket 

 Report Trade Spread Ticket Now a Standalone Applet 

 "Partial Fill" Order Status Now Available in Improved Order Status Filters 

 Montreal Spread Data Supported 

 Check Box Filter Added to Three WTP Applets 

  

  

Route Time Entry Field Available in Report Trade Ticket 

  

 
  

A new route time entry field (i.e., a start control) is now available for the Report Trade 

Ticket. 

  

By default, the start time will display the time at which the ticket was created. To have the 

start time reflect the current time, un-check the Start box and re-check it. Adjust the start 

time by entering the time in the appropriate fields or by selecting the up/down spinner 

arrows. 

  

Add the Start control to the Report Trade Ticket with the Ticket Editor. The control is found 

in the Advanced category. 

  

Save the Report Trade Ticket as a template to have the Start control appear each time the 

ticket is launched. 
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Report Trade Spread Ticket Now a Standalone Applet 

  

 
  

  

Previously, the Report Trade Spread Ticket was launched only from Spread Builder. Now 

the Report Trade Spread Ticket is a standalone applet and can be launched as follows: 

 

 From the WTP button in the WTP Toolbar, select Report Trade Spread Ticket. 

 From the WTP toolbar select Manage -->Report Trade Spread Ticket. 
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"Partial Fill" Order Status Now Available in Improved Order Status Filters 

  

  

 
  

  

The Order Grid filter selection has improved. Order State Filters have been replaced with 

Order Status Filters. 

  

Now, there are two order types in which to define order status filters: Live Orders and 

Pending Orders*. 

  

Among the various orders status filters is the new Partial Fill.  Orders with a partial fill 

status (i.e., not canceled, not filled) will be displayed when this is selected. 

  

  

*Live and Pending order status can also be selected from the Order Status drop-down list. 
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Montreal Spread Data Supported 

  

WTP now supports spread data from the Montreal (MX) Exchange. 

  

Contact WEX Support to configure WTP to receive spread data from the Montreal 

Exchange, and to receive information on related fees. 

  

  

  

Check Box Filter Added to Three WTP Applets 

  

  

 
Defined conditions are displayed in Quote Grid along with a Filters check box  

  

  

  

When display conditions are defined for Quote Grid, Symbol Browser, or Corporate 

Action Viewer, the filters will be listed in the applet along with a Filters check box.  

  

Un-check the Filters box to turn off grid filtering. 
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13.4.56.0 

September, 2013 

  

  

  

 Users Allowed To Reset Their Password 

 "I Forgot My Password" Feature 

 WTP Version Added to Title Bar 

 Security Drop-Down Filter Available in Order Grid 

  

Users Allowed To Reset Their Password 

  

 
  

When logged in to WTP, press the Change button to initiate a password change. 
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User must select Yes in order to disconnect and continue with the password change 

procedure. 

  

  

 
  

Enter current password, new password, and confirm new password. 

  

  

 
  

A security question displays after the password change. 

  

  

  

WTP users can now change their password. When a password is changed, a follow-up 

security question is issued, completing the process. 

  

  

Change Password Procedure 

  

1. While logged in to WTP, press the Connection button on the WTP toolbar to launch 

the Connection window. 
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2. Press the Change... button. A Disconnect to Change Password confirmation 

displays. To change a password it is required to disconnect from WTP. Select Yes to 

disconnect from WTP. 

3. The Change Password dialog window launches. Enter the current password and 

new password. Re-key the new password in the Confirm New Password field. 

Select Connect & Change. 

 

Note: A password must consist of the following: 

 

 Minimum of eight characters 

 At least one alphabet character (a-z) 

 At least one numeric (1-9), punctuation, or special character 

 

 

4. When a new password has been entered successfully, the Security Question 

window will launch. Enter the correct answer in the blank field and select OK. The 

login will commence and the new password will be in force. 

Note about the Security Question Window: If, during a normal login, a security 

question and answer had not been previously defined, the Security Question window will 

launch. Select a security question from the drop-down list and enter an answer to the 

question. The selected question will appear in Step #4 above when issuing a password 

change. 
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"I forgot my password..." Feature 

  

  

 
  

  

If a user forgets their WTP login password, selecting the "I forgot my password..." button 

in the Connection window causes a temporary password to be generated. Also, this 

informational message launches: 

  

  

 
  



Release Notes  13.4.56.0  

   

487 © 2014 Wolverine Execution Services, LLC 

 

WTP Version Added to Title Bar 

  

 
  

  

The version number of currently running WEX Trading Platform can now be seen in the WTP 

title bar. 

  

The version number can also be viewed by selecting About WTP in the Help menu. 

  

  

  

  

  

Security Drop-Down Filter Available in Order Grid 

  

 
  

In the Order Grid, the ability to view only desired securities has been made easier with the 

addition of the Security drop-down filter. 

  

1. Add the Security column to the Order Grid using the Field Chooser. The Security 

column is found under the Quote category. 

2. Press the down arrow at the top of the Security column to view a list of all securities 

currently displayed in the Order Grid. 

3. Check all securities that are to be displayed. Check <ALL> to display all listed 

securities. 
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13.4.55.0 

August, 2013 

  

  

 "Report Trade Allocator" Available in Order Grid 

 "Per Share" Changed to "Per Contract" on Report Trade Ticket (Option 

 Mode) 

 New Notifications Added for Staged Executions 

  

"Report Trade Allocator" Available in Order Grid 

  

 
  

After reporting a trade (with the Report Trade Ticket), select Allocate Report Trade to define 

allocations. 
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Two allocations have been created from the original quantity of 100 shares (20 and 80 

respectively). Note that different side types, CMTA, and Commission values have been 

defined. 

  

  

 
  

Confirmation window summarizes the report trade allocation. 

  

  

  

Filled orders that have been reported with the Report Trade Ticket can have their 

quantities and other related values allocated as desired. 

  

In the example above, a filled 100-share option order was reported. Selecting Allocate 

Report Trade launches the Report Trade Allocations window. In the first line, a quantity 

of 20 shares is defined with associated side type, price, CMTA value, and commission price. 

The second line (80) refers to the quantity available for allocation after the first line has 

been input. 

  

When satisfied with the allocations, the Allocate button is selected, and a confirmation 

window launches containing details of the allocations. 

  

Note 1: If there is difference in price from one allocation to another, WTP will flag the 

discrepancy. The allocation can still commence despite the price difference. 

  

Note 2: Multiple reported trades can be allocated in a single Report Trade Allocation window 

if the symbol, side type, route, and portfolio are identical for each order. For staged orders, 

 the staged order parent ID must be identical for each order. 

 

Note 3: Although a specific side type can be changed (for example, BYO to BYC), the side 

(Buy/Sell) cannot. 
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Note 4: The entire quantity of the reported trade must be accounted for in the sum of the 

allocations, otherwise the allocation cannot be completed. For example, a 100-share order 

cannot be allocated unless the total of all allocations equals 100. 

  

  

Step-by-step instructions on how to use Report Trade Allocation can be found here. 

  

  

  

  

"Per Share" Changed to "Per Contract" on Report Trade Ticket (Option Mode) 

  

 
  

In the Report Trade Ticket, Option mode, the selection formerly identified as "Per Share" 

has been renamed to Per Cont (Per Contract). This field is available for selection when a 

commission value is set. 

  

Only the label has been changed. The previous "Per Share" label calculated the commissions 

based on the number of contracts. 
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New Notifications Added for Staged Executions 

  

 
  

Two new staged order events are available for selection in Global Configuration, 

Notifications page: 

  

 Staged Order Event - Fill 

 

The notification triggers when there is an execution generated on a staged order. 

 Staged Order Event - Complete Fill 

 

The notification triggers when a staged order has been completely filled. 
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13.4.54.0 

August, 2013 

  

  

 New Account Type: "Proprietary Customer" 

 Background Color of Report Tickets Configurable 

 New Function Allows Entering Reject Reason for Staged Orders 

 Ability to Restore Deleted Managed Orders Now in WTP 

 Filter Status Bar Replaces Filter Check Boxes in Some WTP Applets  

  

  

  

New Account Type: "Proprietary Customer" 

  

 
  

  

  

  

A new account type Proprietary Customer (a customer of a broker/dealer trading for a 

proprietary account) is now available for selection (in the ticket advanced mode) for the 

following WTP applets: 

 

 Order Ticket (Option Mode) 

 Spread Ticket 

 Basket Trader  

 Option Quote Cube 
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Background Color of Report Tickets Configurable 

  

  

 
  

New color configuration button "Report Color" selects color for Report Trade Tickets 

  

  

 
  

Result of "Report Color" configuration 

  

  

A new color-definition button has been added to the Theme page of Global Configuration. 

  

The button, Report Color, is used to define the background color of the Report Trade 

Ticket. 

  

When Report Color is unchecked, the Report Trade Ticket will display in the system default 

color. 
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New Function Allows Entering Reject Reason for Staged Orders 

  

  

 
Stage:Reject column and button in Order Grid. The button appears only for staged orders 

that are pending (i.e., not auto accepted). 

  

  

 
  

When the Stage:Reject button is selected, a Reject Reason window launches. Enter a reject 

reason or just select OK. 

  

 
  

The Notifications window will (when configured) report rejected orders. If no reason was 

given for the reject, only the user id will be displayed, otherwise the reason will be 

displayed. 

  

  

In the Order Grid, pending stage orders (i.e., those orders that are not auto-accepted), 

can be rejected and an optional reject reason can be attached to the order. 
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The column Stage:Reject displays the Stage:Reject button for pending stage orders. 

  

When an order is rejected and the reason for the rejection is not supplied, the default 

reason will be "Rejected by [user id]" and it will be recorded and reported as such in the 

Notifications window. When a reject reason is supplied, the reject reason will be recorded 

and reported in the Notifications window (see the Notifications window above for both types 

of reject reason reporting). 

  

  

Note 1: Add the Auto Accept check box to the Staged Ticket with the Ticket Editor 

function. This box must be unchecked when sending a staged order for the Stage:Reject 

button to appear. 

  

Note 2: Add the Stage:Reject column to the Order Grid using the Field Chooser. 

  

Note 3: Add the notification event "Order Event - Reject Order/Change" to the 

Notifications window in Global Configuration to be notified when a reject order has been 

issued. 

  

  

  

Ability to Restore Deleted Managed Orders Now in WTP 

  

  

 
  

An order is selected and deleted from the Managed Order Console. 
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The deleted order is placed on the Deleted tab. Select the Restore button to restore the 

order to the Managed Order Console. A confirmation window will launch: 

  

  

 
  

Select Yes to restore the order. It will be removed from the "Deleted" tab and returned to 

the Managed Order Console. 

  

  

Any managed order that was deleted from the Managed Order Console can be restored. A 

new tab "Deleted" has been added for this purpose. 

  

When a managed order is deleted, it is placed in the Deleted grid. Select the Restore 

button and choose Yes from the confirmation window. The managed order will be returned 

to the Managed Order Console. 

  

Note: A deleted managed order must be from the current day to be restored.  

  

  

  

Filter Status Bar Replaces Filter Check Boxes in Some WTP Applets 

  

 
  

The Filter Check Box (above) has been replaced with a Filter Status Bar: 
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The Filter Status Bar replaces the Filter Check Box in the following WTP applets: 

  

 Equity Time and Sales 

 Option Time and Sales 

 Option Sector Viewer 

  

The Filter Status Bar is already functional in all other WTP grid-based applets. 
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13.4.53.0 

July, 2013 

  

  

 ISE Gemini Exchange supported in WTP 

 Notes can now be modified after an order has been filled 

 View Average Leg Price Across Multiple Spreads 

 Commission Field Available in select WTP apps  

 Managed Order Applets Percentage Order and Trade Ripper Retired 

 Chart Viewer renamed Tick Chart Viewer 

 

  

ISE Gemini Exchange supported in WTP 

  

 
  

  

In April, 2013, the International Securities Exchange (ISE) announced ISE Gemini as the 

brand name of its new options exchange. The exchange is set to launch in August, 2013, 

pending regulatory approval. 

  

The Gemini Exchange is available for selection in Option Quote Cube, Order Ticket, 

Crossing Ticket, Spread Book, Spread Builder, and Spread Ticket. 
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Notes can now be modified after an order has been filled 

  

  

 
A note is added to the Order Ticket 

  

  

  

  

  

 
  

To change an existing note in the Order Grid, right-click on a filled order and select Change 

Selected Orders --> Misc... 

  

  

 
  

The Change Orders window launches. Changes to the note are made here. 
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The updated note can now be seen in the Order Detail screen. 

  

  

The note field (found in the various order tickets of WTP) can be modified in the Order Grid 

after an order has been filled. No changes are allowed while an order is live. 

  

To modify a note field: 

 

1. Right-click on an order and select Change Selected Orders-->Misc... 

 

2. The Change Orders window launches. Enter changes to the note in the checked 

Note field. 

 

3. Select Change to update the note. 
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View Average Leg Price Across Multiple Spreads 

  

 
  

Three filled spreads selected in Order Grid.  

  

  

         

  

Order Summary for all selected orders. 

  

  

 
  

Drop-down list allows for the selection of individual legs.  
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The selected leg appears in 3 orders. The average price per leg is displayed. 

  

  

The average leg price across multiple spreads can now be viewed in the Order Summary 

window in the Order Grid. 

  

1. Select multiple orders and press the Order Summary icon  

2. From the Displaying drop-down list, select a specific leg. The summary will include 

the average price per leg. 

  

By default, the Order Summary will display <All Symbols> when selected. 
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Commission Field Available in select WTP apps  

  

 
  

  

A new column "Commission" is available in select WTP applets. Values in this column can 

be set directly in the grid in which it resides. 

  

For the Order Ticket, a Commission control can be added. Commission values can be set 

directly on the ticket. 

  

The Commission column can be added to the following basket-related applets: 

 

 Basket Trader 

 Crossing Basket Trader 

 Spread Basket Trader 

 Staged Basket Trader 

 

The following ticket applets also support the Commission field: 

  

 Order Ticket 

 Report Trade Ticket 

 Staged Ticket 

 Crossing Ticket 

 

Learn how to add a column with the Field Chooser. 

  

Learn how to add a control to an order ticket with the Ticket Editor. 
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Managed Order Applets Percentage Order and Trade Ripper Retired 

  

Both Percentage Order and Trade Ripper have been retired from WTP. They will no longer 

be accessible. 

  

Note: All Help page references to Percentage Order and Trade Ripper have been removed. 

  

  

  

Chart Viewer renamed Tick Chart Viewer 

  

The WTP applet formerly known as Chart Viewer has been renamed to Tick Chart Viewer. 

Functionality remains the same. 
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13.4.52.0 

June, 2013 

  

  

 Short Sale Restricted Status Now Supported in WTP 

 Activ and Solace Market Data Supported in this Release 

  

  

 

Short Sale Restricted Status Now Supported in WTP 

  

 
  

  

 
  

  

The symbol field in Order Tickets and Spread Ticket has been updated so that 'Short Sale 

Restricted' securities are flagged with a specific color: 

 

 Yellow (Spread Ticket)—The underlier security is short-sale restricted.  

 Red (Order Tickets, Equity Quote Cube)—The side type is SLA, SSE, SSH and the 

security is short-sale-restricted. 

  

The Trading Status column in Quote Grid will display "Short Sale Restricted" for 

applicable securities: 
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Activ and Solace Market Data Supported in this Release 

  

From WTP release version 13.4.52.0 going forward, both Activ and Solace market data are 

fully supported. 
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13.4.51.0 

June, 2013 

  

  

 New Global Managed Order Setting: Abort on Executions Outside the 

Expected Market 

 "Close On Execute" Function Added to Spread Ticket and Spread Builder 

 BOX Spreads Now Supported in WTP  

 Jumbo Options Now Supported in WTP 

 Force Connect Added to Global Configuration 

  

New Global Managed Order Setting: Abort on Executions Outside the Expected 

Market 

  

  

 
  

A new global managed order setting "Abort on executions that are _ _ _ increments 

outside the expected market has been added to the Managed Order Console 

configuration window. 
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When selected, a managed order will abort if the execution price is X increments outside the 

expected price (the market bid or ask price that WTP had at the time the order was sent). 

  

Note: Contact WEX Support to have this feature enabled. 

  

  

  

  

"Close On Execute" Function Added to Spread Ticket and Spread Builder 

  

 
  

Click "Auto Close on Execute" to enable the feature. 
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"Auto Close on Execute" enabled 

  

  

Spread Ticket and Spread Builder will close upon a successful buy or sell order if the 

Auto Close on Execute option is selected in the Configure Spread Ticket/Spread 

Builder window. The selected app's auto close button will be displayed in red. The feature 

can be disabled by pressing the auto execute button. 

  

If it is preferable to enable the auto close button each time Spread Ticket/Spread Builder 

launches, select Auto Close on Execute and save the Spread Ticket/Spread Builder as the 

default template. 

  

Note: Auto Close on Execute will be enabled automatically when a send to command is 

issued with Spread Ticket or Spread Builder as its destination. 
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BOX Spreads Now Supported in WTP 

  

 
  

  

BOX (Boston Options Exchange) has recently begun trading spreads.  

  

BOX is available for selection from the configuration screens for Spread Book, Spread 

Ticket, and Spread Builder. 

  

Note: Permission to trade BOX spreads is required. Contact WEX Support to have the 

feature enabled. 
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Jumbo Options Now Supported in WTP 

  

 
Large option contracts also known as Jumbo Options began trading on the BOX on May 

13, 2013. Traders can now execute these contracts on the SPDR S&P 500 ETF under the 

ticker symbol SPY. 

  

Support for these jumbo options has been enabled in Option Quote Cube and Spread 

Builder. 

  

   

  

  

Force Connect Added to Global Configuration 

  

 
  

A Force Connect button has been added to the Activ Connection portion of Global 

Configuration's Quote Connections window. 

  

If Activ has not been able to make a successful connection, selecting Force Connect will 

display any username or password issues that need to be fixed. 

  

Force Connect can also be used to manually disconnect from, and reconnect to, Activ. 
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Before selecting the Force Connect button, be sure to save configuration changes by hitting 

Apply. 

  

Note: This feature can be used to forcibly disconnect other WTP instances using the same 

username from Activ. Contact WEX Support to have the feature enabled. 
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13.4.50.0 

May, 2013 

  

  

 Buy/Sell Buttons Renamed to Execute/Reverse in Basket Trader and Stage 

Basket Trader 

 Basket Trader or Spread Basket Trader Launches When Multiple Staged 

Orders are Released 

 Order Grid Column: "Lmt Away Last" 

 Global Configuration Improvement: Notification Event Added for Change 

Orders 

 Spread Book Filter Improvements 

  

  

  

Buy/Sell Buttons Renamed to Execute/Reverse in Basket Trader and Stage Basket 

Trader 

  

  

 
  

The Buy and Sell buttons in Basket Trader and Stage Basket Trader have been 

renamed to Execute and Reverse. 

  

The unintuitive nature of an order with negative weight (e.g., a buy order is actually a sell 

order and vice versa) precipitated the change. 
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Basket Trader or Spread Basket Trader Launches When Multiple Staged Orders are 

Released 

  

 
  

Three staged orders selected in Order Grid. When "Stage: Release" is pressed, Basket 

Trader launches, populated with the selected orders. 

  

  

The following changes have been made in WTP when selecting two or more staged orders 

for release: 

 If none of the staged orders is a spread, Basket Trader launches. 

 If any of the staged orders is a spread, Spread Basket Trader launches. 

  

If only one staged order is selected for release: 

 If the order is not a spread, the regular Order Ticket launches. 

 If the order is a spread, the Spread Ticket launches. 

  

In all cases, when launched, the specific Basket Trader app will be populated with the 

selected staged orders and their staged order IDs. 

  

  

  

Order Grid Column: "Lmt Away Last" 
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Lmt Away Last (Limit Away Last) is a column available in the Order Grid. It provides 

traders with values that determine how close or far away the current price of a security is 

based on the current order price.   

  

The values in the column are derived as follows: 

  

Outright Orders 

 Buy Orders = Order Price - Ask Price 

 Sell Orders = Bid Price - Order Price 

Complex Orders 

  Order Price - Ask Price 

  

Note: As expected, whenever the price is changed, the Lmt Away Last value will change as 

well. 

  

The Lmt Away Last column is found under the Order category when using the Field 

Chooser. 

  

  

  

Global Configuration Improvement: Notification Event Added for Change Orders 

  

 
  

A new Global Configuration event notification "Order Event - Change" is now available. 

When selected, an optional sound or notification can be attached to the event whenever an 

unfilled order is changed. 

  

This event can have both a user and side type defined. 
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Spread Book Filter Improvements 

  

  

 
  

Filter description status bar now in Spread Book. 

  

  

  

The following improvements have been made to Spread Book: 

  

 The Filters check box has been removed. 

 A filter description status bar is now displayed whenever a filter is enabled. 

 Double-clicking the filter description status bar launches the Filters window where 

expressions, conditions, and target values are defined. 
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13.4.49.0 

May, 2013 

  

 Allocator Commission Check Box Warnings 

  

The Commission feature of Allocator has been improved by providing a warning message 

when a per-share or flat-fee commission value of zero (or blank) or a value greater than 

$0.05 is selected.  

  

Empty commission values are interpreted as "No commission on this allocation." 

  

When Commission is unchecked, the Commission column will not be displayed, resulting in 

the same interpretation as an empty commission value.  

  

Allocations can be successfully completed despite the warning messages. Click Yes on the 

warning message to allow the allocation to complete.  

  

  

  

 
  

Add Allocation window. First per-share commission field is blank, second is greater than 

$0.05. Either condition yields a warning message. 

  

  

 
  

Warning message when a per-share or flat-fee commission value is zero or blank.  
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Warning message when per-share or flat-fee commission value is great than $0.05 per 

share 

  

  

 
  

Warning message when two or more per-share or flat-fee commissions are either zero or 

greater than $0.05 per share 
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13.4.48.0 

April, 2013 

  

 New Layout for Global Configuration Quote Connections Page 

 Global Configuration Quote Connections Improvement 1: Use Daemon Field 

(for Activ Connection) 

 Global Configuration Quote Connections Improvement 2: New Spread 

Market Data Field 

 Options Column Button Added to Order Grid 

 Price Per Leg Added to Default Flex Ticket Template 

  

  

New Layout for Global Configuration Quote Connections Page 

  

 

The Quote Connections page of Global Configuration has been reformatted with these 

improvements:  

  

1. The Activ Connection section has been moved to the top of the window along with 

the Prefer Activ For News selection. 

2. The Mkt Data Cache and Spread Market Data (formerly Worms Quoter) fields 

have been moved to the middle of the screen and have been made more descriptive.  

3. The Reuters Sink Connection section has been moved to the bottom of the 

window. 
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Global Configuration Quote Connections Improvement 1: Use Daemon Field (for 

Activ Connection) 

  

  

 
  

In Global Configuration, on the Quotes Connections page, an Activ connection can now be 

defined by a primary route or by a daemon background process. 

  

This feature simplifies the way to configure the daemon. When Use Daemon is selected, a 

Port Number must be entered (e.g., 9003) instead of a full address (e.g., 

192.168.187.51:9002). After selecting Apply, a message will be displayed indicating 

whether or not a connection has made. If the message is "Not connected" it will also display 

the time (in seconds) in which a reconnection will be attempted. 

  

When Use Daemon is selected, both Primary and Backup selections are unavailable for 

editing.  

  

  

  

Global Configuration Quote Connections Improvement 2: Spread Market Data Field 

  

 
  

The host(s) from which spread market data can be derived are selected in the Spread 

Market Data section of Global Configuration (Quotes Connections page). This field was 

previously known as Worms Quoter. 

  

From the drop-down list in the Hosts field, check the box next to each desired host name. 

  

For both the Market Data Cache and Spread Market Data fields, the connection status is 

displayed (connected, disconnected, pending reconnect), 
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Options Column Button Added to Order Grid 

  

  

 
  

The Order Grid has been improved with easier access to options columns. 

  

To display options columns: 

  

 Select the Options Columns button 

 

Alternate Methods: 

 Right-click in the grid and select Show Options Columns 

 In the Configure Order Grid screen, check the box Show Options Columns 

  

  

Price Per Leg Added to Default Flex Ticket Template 

  

  

 
  

The Price column has been added to the system default template of the Flex Ticket. 

  

The column, already a default in the Spread Ticket, allows for the input of the price per leg 

for FLEX spreads. 
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13.4.47.0 

 

April, 2013 

  

 Default Portfolio/Route Configuration for Crossing and Staged Orders 

Implemented 

 New Spread Agent Safeguard: Enable Hedging with BASB Limit Orders 

 Persist Ticket Values for Security Tabs in Quote Cubes 

 Equity Quote Cube Improvement: An Easier Method of Displaying Exchange 

Quotes 

  

  

  

  

Default Portfolio/Route Configuration for Crossing and Staged Orders 

Implemented 

  

  

 
  

New portfolio configuration columns: Order Category and Complexity and their available 

selections 
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New route configuration columns and available selections. 

  

  

Crossing orders (both sides) and staged orders can now have their default portfolios and 

routes defined in Global Configuration under the Portfolios and Routes tabs 

respectively. 

  

For portfolios and routes, new columns Order Category and Complexity have been added. 

  

Order Categories Available For Portfolios: 

 <Any> 

 Basic 

 Crossing (Contra) 

 Crossing (Order) 

 Staged 

 

Order Categories Available for Routes: 

 <Any> 

 Basic 

 Crossing (Order) 

 Staged 

 

Note: There is no such thing as a route for Crossing <Contra> orders. 

  

  

Complexity Items for Portfolios and Routes 

 <Any> 

 Outright 

 Spread 

  

Changes to Previous WTP Versions 

  

Route configurations from previous WTP versions will be converted automatically to the new 

configuration as follows: 

 Rules that had an <Any> security type will be converted to a complexity type of 

<Any>. 
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 Rules formally containing a Spread security type have been converted to the 

complexity type Spread. 

 Rules formally containing other security types have been converted to a complexity 

of Outright. 

Note: Route configurations saved in WTP version 13.4.47.0 will not be available if a 

previous WTP version is loaded. 

  

  

  

  

New Spread Agent Safeguard: Enable Hedging with BASB Limit Orders 

  

 
  

  

Hedging for BASB orders (Buy at ask, Sell at bid) can now be accomplished with a new 

Spread Agent safeguard Force hedge with BASB limit orders. 

  

When checked, a BASB order will attempt to hedge at the market price. When disabled, 

Spread Agent will hedge at a price that will achieve the spread as long as the market has 

not moved beyond the configured Stop Loss value. 

  

Note: For new orders, this safeguard will be enabled by default. Any Spread Agents created 

before WTP version 13.4.47.0 will have this safeguard enabled. 

  

  

  

  

Persist Ticket Values for Security Tabs in Quote Cubes 

  

Multiple tabs can be created in the Option Quote Cube and Equity Quote Cube. Each tab 

represents a different security, and has its own order ticket. 

  

In this WTP release, the values defined in each order ticket will persist when moving from 

tab to tab. 

  

  

Note: If a tab has an order ticket in advanced mode, all order tickets in all tabs will be in 

advanced mode. 

  

  

  

  

  



Release Notes  13.4.47.0  

   

526 © 2014 Wolverine Execution Services, LLC 

Equity Quote Cube Improvement: An Easier Method of Displaying Exchange Quotes 

  

  

 
 New dynamic Quotes window displays the exchanges on which a selected symbol trades. 

  

  

Equity Quote Cube has been improved to dynamically provide all exchanges on which a 

selected symbol trades.*  

  

Previously, exchanges were manually selected in EQC's configuration window. 

  

To view the exchanges on which a selected symbol trades: 

 

 Select the Select Quote/Book Sources button  

 

Alternate Methods: 

 From the Config menu, select Filter Quotes... 

 Right-click in the EQC grid and select Filter Quotes... 

  

*The displayed exchanges are those in which the user has market data permissions. These 

are not necessarily inclusive of all exchanges on which the symbol trades. 
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13.4.46.0 

March, 2013 

  

  

 Limit Up/Limit Down (LULD) Now Supported in WTP 

  

  

  

Background 

  

On May 31, 2012, the SEC approved, on a pilot basis, a new "limit up-limit down" (LULD) 

rule to address extraordinary market volatility in U.S. equity markets. LULD is intended to 

prevent security trades from occurring outside of specified price bands. These price bands 

are set at a percentage level above and below the average reference price of a security over 

the immediately preceding five-minute period. 

  

Reference price is the average price of eligible reported transactions over the past five 

minutes. 

  

  

 

Upper and Lower Price Bands price calculation 

  

Price Band = (Reference Price) +/- ((Reference Price) x (Percentage Parameter)) 

  

  

  

Warning Messages 

  

          

  

Two different warning messages. Orange = product is halted, Yellow = warning that security 

price is outside price band. 

  

  

If a product being traded has been halted, or if the order price is outside the price band, a 

warning message will be issued. 

  

If options or spreads are being traded, warnings will be issued if the underlying security of 

the option or spread is halted. 

  

Ignore the warnings and send the order by checking the "Confirm this operation despite 

warnings" box, then OK. 
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Note: Managed Orders will abort when symbols or underliers are halted or paused. 

  

  

  

Security Drop-down Highlighting 

  

 
Red highlight in Symbol field indicates security is halted from trading 

  

  

Security drop-downs in the quote cubes and order tickets will be highlighted as follows: 

 RED if the underlying security is halted 

 YELLOW if the underlying security is paused 

  

  

  

Add LULD Columns to Apps Supporting Quote Fields 

  

 
  

Limit High and Limit Low quote columns can be added to WTP applets that support quote 

fields, such as Quote Grid or Equity Quote Cube.. 

  

Both columns are found under the Quote category in the Field Chooser. 
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13.4.45.0 

March, 2013 

  

  

 Lock Control Added for Locate ID Field 

 Search Function Enabled for Ticket Fields 

 Generic Ticket Controls Now Available 

  

  

Lock Control Added for Locate ID Field 

  

 
  

The contents of a Locate ID (Loc Id) field clear when changing symbols. 

  

A lock button has been added to the Locate ID field. Enable the lock to persist the Locate 

ID value when changing symbols. 

  

The lock button for the Locate ID field is found in advance mode for Order Ticket, Equity 

Quote Cube, and Option Quote Cube. 
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Search Function Enabled for Ticket Fields 

  

 
  

"Commission" is found under two control categories: "Report Trade" and "Advanced" 

  

  

A search field has been added to the Add Control window of the Ticket Editor.  

  

Search results are displayed on a character-by-character basis as each character is entered 

in the search field. Also, search results are displayed within the control category in which 

they reside. In the example above, the word "Commission" is found under two control 

categories, "Report Trade" and "Advanced". 

  

Learn more about the Ticket Editor here. 
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Generic Ticket Controls Now Available 

  

 
  

  

Generic controls (string, int (integer), double, price) are now available for selection in the 

Ticket Editor. 

 

 String—Uppercase/lowercase letters 

 Int—Whole numbers 

 Double—Non-whole numbers 

 Price—For Prices 

  

Each generic field is composed of three segments: 

 Enable (check box controlled) 

 

Note: If the Enable segment is not included with the Field and Label segments, the 

field will always be enabled. 

 

 Field (spinner controlled) 

 Label (generic identifier) 

 

Note: The Label segment is strictly optional when using an Enable segment, since 

Enable has its own label. 
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Each segment name can be customized. 

  

In the image below, Generic Price controls were added to the Order Ticket. 

  

 
  

  

Also, each generic field can be represented as a column in the Order Grid. 

  

Learn more about the Ticket Editor here. 

  

Learn how to add columns to grids using the Field Chooser here. 
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13.4.44.0 

February, 2013 

  

 New Order Ticket Control: "Done Away Commission" 

 Automatic Tab Adding in Equity/Option Quote Cubes 

  

  

  

New Order Ticket Control: "Done Away Commission" 

  

 
  

Order Ticket in Edit Mode. "Done Away Commission" controls found under Advanced. 
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Both controls added to the Order Ticket. 

  

  

Two new controls, Done Away Commission Enable and Done Away Commission Field 

can now be added to the Order Ticket in edit mode. 

  

Done Away Commissions allows a user to include additional commission information on 

any order without directly affecting WEX billing. 

  

The Done Away Commission Enable is check-box enabled. The Done Away 

Commission Field allows for alpha/numeric content. 

  

In addition to the controls on the Order Ticket, the Done Away Commission Field can be 

added as a column in the Order Grid: 

  

  

 
  

Done Away Commission column added to Order Grid. 
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Automatic Tab Adding Now in Equity/Option Quote Cubes 

  

 
  

Enable Automatic Tab Adding in the configuration window. 
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Automatic Tab Adding Enabled Automatic Tab Adding Disabled 

 

 

 

 

 

 

 

 

  

  

Automatic Tab Adding is a optional feature found in the Equity Quote Cube and Option 

Quote Cube. 

  

Automatic Tab adding will create a tab without any additional user interaction. Disabling 

Automatic Tab Adding will require pressing the Enter key after a symbol is entered to add a 

tab. 

  

With Automatic Tab Adding enabled (column 1 above): 
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 When a symbol is entered in the symbol field, a new tab is created soon after the 

final character is entered. 

 

For example, if the symbol MSFT is entered slowly, the Quote Cubes would respond 

by creating four new tabs as follows: 

 

M opens a new tab with the symbol M. 

 

S opens a new tab with the symbol MS. 

 

F opens a new tab with the symbol MSF. 

 

T opens a new tab with the symbol MSFT. 

With Automatic Tab Adding disabled (column 2 above): 

 The Quote Cubes will display the symbol name as each letter is entered. 

 

A single tab will be created and updated as additional letters are entered but 

additional tabs will not be created. 

 
To create additional tabs, press Enter after each symbol is entered. 

  

In the System Default Template for the Equity/Option Quote Cubes, Automatic Tab Adding 

is disabled. If it's preferred to always allow Automatic Tab Adding, either Quote Cube can be 

saved as a template. 

  

  

Hide Tabs 

  

If neither of the Automatic Tab Adding options is desired, tabs can be hidden. 
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13.4.43.0 

January, 2013 

  

  

 "Eye" Field Added to Spread Agent 

 Filters for Montage Grids Improved in Option Quote Cube 

 Drag and Drop Feature Improved in Ticket Editor 

 Save or Open Any Template From a Connected Applet 

  

  

"Eye" Field Added to Spread Agent 

  

 
  

  

The Eye field has been added to Spread Agent under Advanced Parameters. The Eye field 

is available for selection only when the work mode is "Work Bid or Offer." 

  

  

  

Filters for Montage Grids Improved in Option Quote Cube 

  

 
  

In Option Quote Cube, new selections have been added to the filter selection window.  

  

Contract Types: 

 Binary 

 Mini* 

 All Other** 
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*Mini contracts (control 10 shares of stock compared to the standard of 100 shares) begin 

trading on March 18, 2013. 

**All Other contract types include Cash-in-Lieu, and odd lots that are not Mini contracts. 

  

Expiration Type 

 Weekly 

 Quarterly 

 All Other* 

 

*All Other refers to non-standard expiration types. 

  

  

  

Drag and Drop Feature Improved  in Ticket Editor 

  

 
  

The Control name displays when dragging/dropping it from the Add Control window. 

  

  

The Ticket Editor drag/drop method has been improved to display the name of the control 

as it's being dragged. 
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Save or Open Any Template From a Connected Applet 

 

 
  

"Send to" command was used to send an Option Quote Cube symbol to Equity Time and 

Sales. Templates in receiving applets can now be saved or opened. 

  

  

  

Previously, when a Send to command was issued, the receiving WTP applet could not open 

or save a template. 

  

With release 13.4.43.0, the receiving applet can now save its displayed content as a 

template. Additionally, saved templates can be opened or reverted to the applet's system 

default. 

  

Learn more about templates here. 
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13.4.42.0 

January, 2013 

  

 New WTP Applet: "Most Active Symbols Viewer" 

 Eye Field Added to Managed Order Console 

 New Field in Flex Ticket: "Flex Type" 

 "Activ Symbol List" Column Added to Symbol Browser 

 New Field in Order Summary: "Net Traded" 

  

  

  

New WTP Applet: "Most Active Symbols Viewer" 

  

 
  

The Most Active Symbols Viewer is a reporting tool displaying the most active symbols 

by cumulative value, cumulative volume, percentage change of advancers and decliners. 
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The reporting exchange and security types (equity and call/put options) can be selected 

from a drop-down list. 

  

In addition, option fields can be added when viewing the most active symbols for Options 

data. 

  

Learn more about the Most Active Symbols Viewer here. 

  

  

  

Eye Field Added to Managed Order Console 

  

 
  

Managed Order Console with Eye field. The checked box indicates the Eye feature was 

selected in the Vol Trader order (below). 

  

  

 
  

Eye option selected in Vol Trader 

  

  

The Eye feature in Vol Trader enables the "Work Bid or Offer" option to place an IOC 

(Immediate or Cancel) order to buy at the ask or sell at the bid (which is the reverse 

strategy of the standard Work Bid or Offer mode). 

  

A new column in the Managed Order Console "Eye" displays a checked box if the Eye option 

is selected for a specific Vol Trader order. 

  

If the Vol Trader order does not have the Eye feature selected, the box will display in the 

Managed Order Console, but it will not be checked. 

  

Note that the Eye box cannot manually be checked/unchecked. 
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Add the Eye column to the Managed Order Console with the Field Chooser. 

  

  

New Field in Flex Ticket: "Flex Type" 

  

 
  

Flex Type is a new field for the Flex Ticket and is found in the system default template. 

  

The Flex Type defines whether the leg of a Flex order is traded American or European. The 

AM/PM designation refers to the time of the settlement. 

  

Also, in the Root field, a number is now added to the front of the root symbol. For Index 

options: 

  

1 = American exercise, AM settlement 

2 = European exercise, AM settlement 

3 = American exercise, PM settlement 

4 = European exercise, PM settlement 

  

All Equity options are PM settled. Their numbers refer to the following: 

  

1 = American exercise 

2 = European exercise 

  

The balance of a Flex option's symbol matches that of other standard options symbols 

(underlying, expiration date, option type (call/put) and strike price). 
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"Activ Symbol List" Column Added to Symbol Browser 

  

 
  

Activ Symbol List for the symbol RIM. Word spaces separate the various suffixes. 

  

  

 
  

Activ Symbol List for IBM 

  

  

The Activ Symbol List is an optional column for the Symbol Browser that displays the 

many suffixes associated with a symbol or security name. If the symbol match is a single 

name (as in the RIM example above), the Activ Symbol List displays all suffixes in a single 

row separated by word spaces. 

  

The Activ Symbol List replaces the Activ Symbol field. 

  

Add the Activ Symbol List column to the Symbol Browser with the Field Chooser. 
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New Field in Order Summary: "Net Traded" 

  

 
  

The Net Traded field has been added to the Order Summary window in the Order Grid. 

  

For spread orders, the net traded field reports on the executed quantity of each leg of the 

spread. 

  

In the Order Summary window below, a two-leg spread where one side is BYO and the other 

is SLO with the same ratio, the order yields a net traded value of zero: 

  

 
  

  

The value displayed in the Net Traded field is dependent on the order type and is calculated 

as follows: 

  

Order Type Net Traded Calculation 

Outright Equities/Options Order Quantity 

Spread with 2 option legs, 

same ratio, opposite sides 
0 

Spread with 2 option legs, 

different ratio, opposite 

sides 

Quantity of spread  x  difference of the ratios 

Spread with 2 option legs, 

opposite sides 
Quantity of spread  x  sum of the ratios 

Spread with 1 equity and 1 

option leg 
Quantity of spread  x  difference of the  ratios 
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13.4.41.0 

January, 2013 

  

  

 New WTP Applet: Corporate Action Viewer 

 New WTP Applet: Symbol Browser 

 Control Names for Quick Quantity Buttons Renamed for Clarity 

 Flex Ticket Improvements 

  

New WTP Applet: Corporate Action Viewer 

  

 
  

A new WTP applet Corporate Action Viewer displays corporate action for the past week 

including Corporate Events, Delisted Symbols, Dividends, IPOs, Splits, and Symbol Changes. 

  

Learn more about Corporate Action Viewer here. 

  

  

  

  

New WTP Applet: Symbol Browser 
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Search for securities by name or symbol in Symbol Browser. Symbols in the grid can be 

sent to populate other WTP applets (via the send to --> command).  

  

Note: An Activ Quote Connection is required in order for Symbol Browser to search for 

names and symbols. 

 

Learn more about Symbol Browser here. 
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Control Names for Quick Quantity Buttons Renamed for Clarity 

  

 
  

Control Names (in bold) available for selection when the Order Ticket is in Edit mode 

  

  

  

The control names for the Quick Quantity buttons have been renamed for clarity only. Their 

functionality has not changed. 

  

The increment value of each button is based on the Qty Inc. field defined in Global 

Configuration (under the Trade Defaults tab). 

  

The quick quantity buttons are available in the following increments (based on the defined 

Qty Inc value): 

 1 x 

 5 x 

 10 x 

 25 x 

 50 x 

 100 x 

In the example below, the Qty Inc. value for the symbol CSCO was defined as 7. The quick 

quantity buttons are multiples of that value. 
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Learn how to edit a ticket layout with the ticket editor here. 

  

  

  

  

Flex Ticket Improvements 

  

1. The new system default template for the Flex Ticket is Crossing Mode: 
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2. Side Controls (byc, bya, sel, slc, etc.) are no longer used and are not selectable. 

  

  

Note: The Flex Ticket is not available for selection unless crossing and flex permissions 

are enabled. Contact WEX support to enable these permissions. 
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13.4.40.0 

December, 2012 

  

  

 Confirmation Message Displays When Closing WTP 

  

 
  

  

When exiting from WTP a confirmation message appears asking "Are you sure you want to 

close WTP?". 

  

This message is displayed to prevent an accidental closing of WTP. 

  

If Yes is selected, WTP will close. Orders that remain unfilled will continue to run. Select No 

to keep WTP open. 

  

  

  

Exit WTP While Live Managed Orders Are Running 

  

If managed orders are running when attempting to exit from WTP, a managed order 

warning message will display. In the following example, a Time Slicer order is active and the 

command to exit WTP is issued: 

  

 
  

Select Yes to stop executing the managed order and exit WTP. 

  

Select No to not disconnect from WTP and keep the managed order active. 

  

Selecting Cancel acts the same as selecting No. 
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13.4.39.0 

November, 2012 

  

 Volatility Chart Viewer Now Its Own Applet 

 COMEX and NYMEX Books Added to Equity Quote Cube 

 Two New Safeguards in Vol Trader:  

 

Place Option Only After Quote Update 

 

Stop Loss with BASB Limit Orders 

  

   

Volatility Chart Viewer Now Its Own Applet 

  

 
  

The Volatility Chart Viewer is now its own applet. 
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Previously, the Volatility Chart Viewer was only available from the Option Quote Cube, 

Spread Trader, Equity Time and Sales and Vol Trader. The links to the Volatility Chart 

Viewer from these apps have not changed. 

  

Learn more about the Volatility Chart Viewer here. 

  

  

COMEX and NYMEX Books Added to Equity Quote Cube 

  

Comex (Commodity Exchange) and NYMEX (New York Mercantile Exchange) are now 

available for selection as book sources in the Equity Quote Cube.  

  

  

  

Two New Safeguards in Vol Trader: Place Option Only After Quote Update and Stop 

Loss with BASB Limit Orders 

 

 
  

Place option only after quote update—If checked, option orders will be placed only when 

the market has changed (e.g., if buying the option, its Ask Price or Ask Size changes) since 

the previous option execution. This is recommended so that the Vol Trader doesn't place 

option orders until the effect of its previous executions on the market have been reflected in 

its quotes. 

  

Stop loss with BASB limit orders—The Stop loss safeguard has been expanded to 

include BASB (Buys the Ask or Sells the Bid) limit orders. Once a loss is encountered that is 

greater than the entered value, Vol Trader cancels the offending hedge order and replaces it 

at the BASB price when this safeguard is enabled. 
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13.4.38.0 

November, 2012 

  

 New Setting in Global Configuration: Choose Workspace to Open on Initial 

Connection 

 ContRatio Field Added to Option Sector Viewer 

 VWAP Intensity Field Added to Quote Grid 

 Alphabetize Tabs In Equity and Option Quote Cubes 

 Portfolio Ordering Can Now Be Customized in Order Ticket 

 New in WTP Help: Option Exchange Codes and Condition Codes 

  

New Setting in Global Configuration: Choose Workspace to Open on Initial 

Connection 

  

 
  

The workspace that will load upon the initial connection to WTP can be set on the general 

page of Global Configuration.  

  

The initial connection is defined as the first connection to WTP following a complete exit. To 

log on after a log off (while WTP remains running) is not the same thing as an initial 

connection. 

  

Choose one of three settings: 

1. Show Blank Workspace—No workspace will load. 

2. Restore Last State—Load the workspace that was open at the time of the most 

recent close of WTP. 

3. Open Specific Workspace—Select the Browse button and choose an existing 

workspace (with a .wtp extension). This workspace will load upon an initial 

connection to WTP. 

  

  

ContRatio Field Added to Option Sector Viewer 

  

A new field ContRatio (Contract Ratio) has been added to the system default template of 

Option Sector Viewer. 

  

The quotient is defined as the Contract Total divided by the 20-Day Contract Total. 
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VWAP Intensity Field Added to Quote Grid 

  

A new column VWAP Intensity has been added to Quote Grid. 

  

The VWAP (Volume Weighted Average Price) Intensity displays the high (green) or low (red) 

movement of the VWAP relative to the day's highs and lows. 

  

VWAP Intensity is not in the system default template of Quote Grid. Add it using the Field 

Chooser. 

  

  

  

Alphabetize Tabs In Equity and Option Quote Cubes 

  

 
  

Tabs listed in random order 

  

 
  

New option "Keep Tabs Sorted" sorts tabs alphabetically 
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Tabs sorted alphabetically 

  

  

A new feature in Equity Quote Cube and Option Quote Cube allows for the display of 

tabs in alphabetical order. 

  

To place tabs in alphabetical order: 

1. Right-click on any tab and select Configuration. 

 

Alternate Method: 

 

From the Config menu select Configure Tabs. 

2. In the Configure Tabs window, select the Format tab. 

3. Check Keep Tabs Sorted. 

Every new tab that is added will be placed in the correct alphabetical order. 

  

Note: Tabs cannot be manually repositioned as long as Keep Tabs Sorted is in effect. To 

manually reposition tabs, uncheck Keep Tabs Sorted. 

  

  

Portfolio Ordering Can Now Be Customized in Order Ticket 
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The Order Ticket can now have the listing of portfolios customized into a preferable order. 

The configuration governs the display order in the Order Ticket's portfolio box. 

  

A single or multiple portfolios can be re-ordered at once. 

  

Note: The default ordering of portfolios is alphabetical. 

  

To customize the list of portfolios: 

1. On the Configure Order Ticket window, check Customize Ordering. 

2. Select one or more portfolios you wish to move 

3. Use one of four ordering buttons to move your selected portfolio(s): 

 

 Move the portfolio(s) to the top of the list 

 

 Move the portfolio(s) one position up 

 

 Move the portfolio(s) one position down 
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 Move the portfolio(s) to the bottom of the list 

4. Click OK to apply your changes.  

  

  

New in WTP Help: Option Exchange Codes and Condition Codes 

  

A table listing U.S. Option Exchange codes can be found here. 

  

Condition Codes displayed in the system default template of Option Time and Sales (in 

the Cond column) are defined here. 
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13.4.37.0 

October, 2012 

  

 New Vol Trader Safeguard: "Option Px Limit" 

 

 Conditional Row Filtering Added To Wave Grid 

 Spread Viewer Usability Improvements 

  

  

  

New Vol Trader Safeguard: "Option Px Limit" 

  

  

 
  

  

A new safeguard Option Px Limit has been added to Vol Trader.  

  

Vol Trader will not trade if its desired option price is greater than the value in the Option Px 

Limit field. 
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Conditional Row Filtering Added To Wave Grid 

  

 
  

1. Wave Grid showing 5 waves 

  

 
  

2. "Add Conditions" window where an expression is defined and the Filter box checked. 

In this expression, we want to display only Qty Executed orders greater than 1000. 
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3. Wave Grid displays the wave order that meets the defined conditions while filtering out 

those that don't. 

  

  

In the Wave Grid, data in the grid can be filtered with the use of the Filter check box in 

the Add Conditions window. 

  

Launch the Add Conditions window by right-clicking on any column head in the Wave Grid 

and select Add Conditions. 

  

  

Spread Viewer Usability Improvements 

  

 
  

The following usability improvements have been made In Spread Viewer: 

  

1. When the Add New Spread button is selected, two rows are now automatically added 

to the grid, identified as <Leg 1> and <Leg 2>. Additional legs will be identified in 

numerical order as they're added (<Leg 3>, <Leg 4>, etc.).  

2. The Add Leg button has been moved from above the grid to the row where the 

spread is identified. 

3. The Delete Leg(s) and Delete Spread(s) buttons have been removed from above 

the grid. Deleting spreads and legs is now accomplished by selecting the red Del 

button in the appropriate row of the grid. 
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13.3.36.0 

October, 2012 

  

 Peg Lmt Added to Change Order Window 

 New Look for Global Configuration 

 FAQ Help Page Updated 

  

  

  

Peg Lmt Added to Change Order Window 

  

 
  

Live, unfilled peg orders listed in the Order Grid can now have their Peg Limit value changed 

in the Change Order window. 

  

Learn how to change unfilled orders here. 
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New Look for Global Configuration 

  

  

 
  

  

  

In Global Configuration, the configuration tabs at the top of the window have been 

replaced by a vertical listing of each section. 

  

The Appearance screen was renamed Theme, and Qty/Price was renamed Qty/Price 

Increments. 

  

Other than cosmetic, there are no functional changes to Global Configuration. 

  

  

  

FAQ Help Page Updated 

  

The look of the FAQ page in Help has been changed to match the look of other WTP pages. 

Answers to questions are hidden until the question is clicked. 

  

The latest frequently asked question defines the various entries that can be found in a 

ticker's EXTRA column. Read it here.  
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13.3.35.0 

October, 2012 

  

  

 Dragged Tabs Create a New Window at the Drop Point 

 Time in Force (TIF) and Stop Price Settings Added to Change Order Window 

 Spreads Allowable in Time Slicer 

 New Help Page: Keyboard Shortcuts 

  

  

  

 Dragged Tabs Create a New Window at the Drop Point 

  

  

 
  

Select a tab and drag it to a preferred desktop location. A new window will display at the 

drop point. 
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Tabs in the Equity Quote Cube and Option Quote Cube can be dragged from their 

location onto another area of the desktop, creating a new window at the drop point. 

  

When a tab is dragged to a new location, it will be removed from the remaining tabs of the 

source applet. 

  

Learn more about tabs in grids here. 

  

  

  

Time in Force (TIF) and Stop Price Settings Added to Change Order Window 

  

 
  

Live, unfilled orders listed in the Order Grid can now have their Time In Force (TIF) value 

changed in the Change Order window. 

  

Also added to the Change Order window is the Stop field. Stop Lmt or Stop Mkt orders can 

have their values adjusted in this field. 

  

Learn how to change unfilled orders here. 
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Spreads Allowable in Time Slicer 

  

 
  

  

Time Slicer now has the ability to support spread orders. 

  

The send to feature can be used to send spread parameters from a WTP applet (such as 

Option Quote Cube or Spread Trader). Spread parameters can be manually entered as 

well by checking the Complex box and filling in values into the Symbol, Side Type, and 

Ratio edit boxes. 

  

  

   

New Help Page: Keyboard Shortcuts 

  

A new Help page listing all keyboard shortcuts in WTP is available here. 
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13.3.34.0 

September, 2012 

  

  

 Instant Messenger Layout Improvement 

 Export Grid Data/Quick Export Improvements 

  

  

  

Instant Messenger Layout Improvement 

  

  

 
  

  

The following layout improvements have been made to Instant Messenger: 

 The Clear and Refresh buttons have been removed. Both commands can be found 

by right-clicking anywhere in the top portion of the chat window. 

 The list of Members now extends to the bottom of the window. 
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Export Grid Data/Quick Export Improvements 

  

 
  

The Export Grid Data function has been improved with the addition of the Save Settings 

button. 

  

The Save Settings button allows for the saving of export parameters without the need to 

export the grid data. Previously, selecting the OK button would save the export parameters 

and export the grid data at the same time. 

  

The Quick Export feature will now issue a warning if either of these conditions exist: 

 

 The Export Grid Data settings have not been configured and saved 

 The exported grid data will overwrite an existing exported file 

  

It is recommended to save the WTP app containing the Export Grid Data settings as a 

template (either as the default template or a customized template) in order to retain the 

export settings when the app is re-launched. If the app is not saved as a template, the 

Export Grid Data settings will not be saved. 
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13.3.33.0 

August, 2012 

  

 Quick Export Added to Single-Grid Apps 

 Display all Expirations for a Single Product in Option Quote Cube and Spread 

Builder 

 Side Type as a Notification in Global Configuration 

  

  

Quick Export Added to Single-Grid Apps 

  

 
  

A new function called Quick Export has been added to the menu bar of the following apps: 

  

Order Grid 

Position Grid 

Wave Grid 

Option Quote Cube 

Option Time and Sales 

Spread Book 

Spread Builder 

Basket Trader 

Spread Basket Trader 

Stage Basket Trader 

Crossing Basket 

Allocator 

Equity Imbalance Viewer 

News Browser 

Option Sector Viewer 

Managed Order Console 
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Quote Grid 

  

Quick Export exports grid data (either selected range or entire grid) to a file, clipboard, or 

MS-Excel spreadsheet, based on the settings defined in the Export Grid Data window: 

  

  

 
  

In the Export Grid Data window are the customized export settings. When Quick Export is 

selected, it will use these parameters as it exports grid data. 

  

Things to note about Quick Export: 

 

 Quick Export will not be available for selection until Export Grid Data has been 

configured. The configuring of Export Grid Data will result in an exported file when 

OK is selected. 

 Each time Quick Export is selected it will overwrite a previously-created export file. 

 Quick Export will not issue a warning that a previously-created export file exists 

before overwriting it. Also, it will not confirm that an exported file was created. 

 When the Export Grid Data has been configured, a grid app can be saved as a default 

template. When launched, Quick Export will be available for selection without the 

need to reconfigure the Export Grid Data window. 

 A quick export can be issued by selecting the Quick Export icon in an grid app's 

toolbar.  

 

Alternate methods for selecting Quick Export: 

 From the Action menu 

 Right-clicking in the grid 

 Ctrl + Shift + E keyboard shortcut 

  

  

Display all Expirations for a Single Product in Option Quote Cube and Spread 

Builder 
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When a single product is selected in the Option Montage Grid of the Option Quote Cube or 

Spread Builder, issuing the View Expirations for Strike command (by right-clicking in 

the grid) will launch a new window in which data for all expiration dates is displayed. 

Multiple strike prices can be selected before or after issuing the command. 

  

If a different security is selected in the Option Quote Cube or Spread Builder, it will be 

reflected in the View Expirations for Strike window. 

  

The newly-launched window responds as other WTP grids in which the Order Ticket can be 

launched when selecting a bid or ask value. Also, the grid data can be exported and the 

send to command can be issued. 

  

Note: Only one option side can be shown at a time. If a call and a put are selected in the 

Option Quote Cube or Spread Builder, the View Expirations for Strike window will display the 

most recently selected option side. 
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Side Type as a Notification in Global Configuration 

  

 
  

A new notification can now be set based on the Side Type in Global Configuration under 

the Notifications tab. 

  

Side type notifications can be selected only for Order Events. The selection of side types 

(buy, byc, sel, slo, etc.) is made from the drop-down list in the Side Type column. Check All 

to select all available side types. 
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13.3.32.0 

August, 2012 

  

 Spread Agent Quick-Launch Button Added to the Option Quote Cube 

 Colors for the Strike Columns in the Option Quote Cube Are Configurable 

  

   

Spread Agent Quick-Launch Button Added to the Option Quote Cube 

  

 
  

The Spread Agent quick-launch button has been added to the Option Quote Cube. It 

replaces the Spread Trader quick-launch button.  
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Colors for the Strike Columns in the Option Quote Cube Are Configurable 

  

 
  

In the Option Quote Cube the colors displayed in the grid for standard expirations, non-

standard expirations, and unusual strikes can be configured. To define the colors for the 

strike types, open the Option Quote Cube configuration window, go to the Grid Colors tab, 

and select the strike type. A color palette will open allowing for the selection of basic colors 

or the defining of custom colors. 
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13.3.31.0 

July, 2012 

 Support for BX and MIAX Option Exchanges Added to WTP 

 Calculate Vol Trader Percentage from Reference Prices Using the Snap Vol 
Button 

  

Support for BX and MIAX Option Exchanges Added to WTP 

 

 
 

WTP now supports option quotes from the Nasdaq OMX BX Options Exchange (BX). 

Additionally, the Miami International Options Exchange (MIAX) is available for selection in 

anticipation of its launch scheduled for later this year. 

Select either exchange as an Option Quote Source route in Global Configuration under the 

Routes tab.  

  

Calculate Vol Trader Percentage from Reference Prices Using the Snap Vol Button 

 

 

  

 

Vol % is 0.00 for imported Vol Trader orders   Vol % is calculated when Snap Vol is selected 

 

Unless specifically defined in a Vol Trader import file, imported Vol Traders do not have an 

associated Vol % value. This is due to the fact that a Vol % value is dependent on a number 
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of factors including a security's reference price, an underlying security's reference price, and 

current market conditions. 

 

Consequently, the Managed Order Console will display the Vol % of imported Vol Traders as 

0.00 unless one of the following occurs: 

 The order is opened for viewing, at which point the Vol % will be calculated. 

 A new Vol Trader button Snap Vol is selected. The Vol % will be calculated and 

displayed without the need for opening the order. 
 

To add the Snap Vol column to the Managed Order Console, user the Field Chooser, 

select Vol Trader, and Snap Vol. 
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13.3.30.0 

July, 2012 

  

 Work Bid or Offer with Eye now in the Vol Trader 

 Increment Spinner Values by a Factor of 5 with the Shift Key 

 Flash On Notification Setting Added to Global Configuration 

  

  

  

Work Bid or Offer with Eye now in the Vol Trader 

  

 
  

  

The Vol Trader Eye feature provides a more aggressive approach to capturing marketable 

Vol % levels. 
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By default, the Work Bid or Offer mode (in the Advanced section) places option orders to 

buy at the bid or sell at the ask when market conditions are valid. The Eye feature enables 

this work mode to place an IOC (Immediate or Cancel) option order to buy at the ask or sell 

at the bid to try and capture marketable liquidity before falling back to its default behavior. 

  

To use this feature, the Vol Trader must be in Work Bid or Offer mode with Eye checked, 

and the configured option route must support a Time In Force of IOC.  

  

Since the order will only be routed to the exchange designated in the Rte (Route) field, it is 

highly recommended to use this feature with a WEX smart router such as Xenon for orders 

to capture liquidity more broadly. 

  

  

  

Increment Spinner Values by a Factor of 5 with the Shift Key 

  

  

 

 

 

    

Spinners change the Px field in $0.01 increments (as defined in Global Configuration)  

  

  
 

    

With the shift key pressed, spinners change the Px field in $0.05 increments (the defined 

increment value X 5)  

  

  

  

The default spin increment for price and quantity controls are set in the Qty/Price tab of 

Global Configuration. If a security has a price increment of $0.01, the price field will 

increase/decrease by $0.01 each time the spinner control (the up/down arrow) is used. 

  

A new Quick Shift feature allows the spinners to increment by a factor of five from the 

value defined in Global Configuration when the shift key is pressed while the spinner control 

is used. 

  

In the example above, the default increment value for the symbol DELL is $0.01. When the 

shift key is pressed, the price increment changes to $0.05, or five times the default 

increment value. 

  

The quick shift feature also works for other values within WTP order tickets that are 

controlled by the spinners (e.g., the Qty field). 
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Flash On Notification Setting Added to Global Configuration 

  

 
  

  

When the WTP toolbar is minimized to the taskbar, the WTP taskbar icon will flash if Flash 

On Notification is checked and the Notifications Window launches. 

  

The flashing of the taskbar icon stops when the Notifications Window is selected. 

  

If it is preferable to eliminate the taskbar flash when a notification is received, do not check 

Flash On Notification. 

  

Note: Auto Open Log Window for _____ Severity must be checked in order to access 

the Flash On Notification option. 
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13.3.29.0 

June, 2012 

  

 Activ Market Data and Activ for News Available in Global Configuration 

 Currency Support Added to Spread Agent 

 Spread Agent Now Available as a "Send To" Destination 

 Hot Key Command in Equity/Option Quote Cube Launches Crossing Ticket 

  

  

Activ Market Data and Activ for News Available in Global Configuration 

  

  

 
  

In Global Configuration under the Quote Connections tab, are the Activ Connection 

fields. 

  

If market data is to be received via an Activ data feed, select a Primary connection address 

from the drop-down list, or type one in the Primary field. Optionally, a backup connection 

can be defined by checking the Backup box and selecting the backup address (or entering 

an address in the Backup field). 

  

The primary/backup fields are formatted as Host Name: Port. 

  

Enter also a predefined Username and Password. 

  

Note: All fields relating to the Activ connection are normally set up during WTP installation. 
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Prefer Activ For News 

  

Check this box if its preferable to have headlines/news stories delivered via the Activ feed. 

  

If unchecked, headlines/news stories will be delivered via Reuters. 

  

   

  

Currency Support Added to Spread Agent 

  

 
  

By default, Spread Agent trades in U.S. dollars, but different currencies may be selected. 

  

Choose a different currency: 

1. Check the Use Currencies box. 

  

2. From the drop-down list, select a currency for each side. The State values in the 

Calculated fields will be adjusted for the selected currency.  

 

Note: The conversion rate is computed automatically. 

  

Show Native Currencies 

  

The "Show native currencies" check box is available when Use Currencies is checked. 

The State values (Bid/Ask) will display the security's selected currency value. 
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Spread Agent Now Available as a "Send To" Destination 

  

  

 
  

  

  

  

 
  

An Equity Quote Cube bid sent to Spread Agent using the "Send To" feature 

  

  

Selected grid data from WTP apps can now be sent to Spread Agent using the Send To 

command. Spread Agent will populate the Symbol fields with the same field as the 

forwarding app. 
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Hot Key Command in Equity/Option Quote Cube Launches Crossing Ticket 

  

In both the Equity Quote Cube and Option Quote Cube the Crossing Ticket can be 

launched with the following hot key command: 

  

Ctrl + Shift + X 

  

Note that the Crossing Ticket can also be launched from the Action menu in both apps. 
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13.3.28.0 

May, 2012 

  

 New Chart Viewer Feature Allows You to Save Chart as an Image File 

 Method for Importing a Basket Improved in Basket Trader 

 Enable Custom Vol Data Now Selectable in Global Configuration 

 Tip of the Week “Only Show Me New Tips” 

 

  

  

New Chart Viewer Feature Allows You to Save Chart as an Image File 

  

 
  

Chart Viewer with "Save Chart As..." command 
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Saved chart in jpg format 

  

  

A new feature in Chart Viewer allows you to save a chart as an image file in one of the 

following formats: 

 bmp 

 png 

 jpg 

 gif 

 

Save a Chart as an Image File: 

  

From the File column in Chart Viewer, select Save Chart As... 

  

Alternate Method: 

 

Right-click anywhere on the chart itself. Select File Commands-->Save Chart As... 

  

When the Save As window opens, select a file name, file type, and destination for the chart 

image. 
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Method for Importing a Basket Improved in Basket Trader 

  

 
  

Select Import Basket to load a previously-defined .csv file 
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After issuing the "Import Basket" command, a .csv file has been selected and the Import 

From File window launches.  

  

  

The method of importing a *.csv or text file into Basket Trader has been improved with the 

new Import Basket command. 

  

The command is found in the File menu, or by right-clicking anywhere in the basket grid 

and selecting File Commands-->Import Basket... 

  

Basically, once the Import Basket command has been issued, a .csv file is selected. The 

Import From File window launches, allowing you to assign column names, load a 

previously-defined template, and select the delimiters that exist in the .csv file. Once the 

import parameters have been defined, the .csv file is loaded into Basket Trader as its own 

basket. 

  

Detailed instructions for importing a file into Basket Trader can be found here. 
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Enable Custom Vol Data Now Selectable in Global Configuration 

  

 
  

In Global Configuration under the General tab, a check box now allows you to 

enable/disable Custom Vol Data. 

  

If checked, both a data file path and import file path must exist before saving the 

configuration. If unchecked, a data file path and/or import file path need not be defined. 

  

Learn the details of setting up custom vol data, data file paths, and creating an import file 

here. 

 

 

Tip of the Week “Only Show Me New Tips” 
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A new configuration check box "Only Show Me New Tips" has been added to the Splash 

Screen. 

  

When checked, the Splash Screen launches when logging in to WTP only when a new tip has 

been added (approximately once a week). 

  

If unchecked, the Splash Screen will launch upon logging in to WTP regardless if a new tip 

has been added. 

  

In either case, the Splash Screen can still be launched from the WTP toolbar under the Help 

menu. 
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13.3.27.0 

May, 2012 

  

 Locate ID Field Added to Managed Order Apps 

 Initial Spread Can Be Disabled in Spread Agent 

 Accurate/Delta Hedge Button Added to Spread Viewer 

  

  

  

  

Locate ID Field Added to Managed Order Apps 

  

 
  

Trade Ripper in Advanced mode 

  

  

The following managed order apps now contain the Locate ID field in advanced mode: 

 Time Slicer 

 Market Maker 

  

Note: Both numbers and letters can be used as a Locate ID, but there is a 16-character 

limit. 
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Initial Spread Can Be Disabled in Spread Agent 

  

 
  

Spread Agent with Initial and Reverse check boxes. The Initial spread can be disabled while 

the app is running by unchecking the box. 

  

  

 
  

The Managed Order Console lists the Spread Agent with both Initial and Reverse spreads. 

  

  

 
  

The Managed Order Console displays only the Reverse Spread when the Initial Spread is 

disabled. 
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In Spread Agent you can now disable the initial spread by unchecking the Initial check 

box. Spread Agent will respond by working only the reverse spread. 

  

The Initial check box can be unchecked while the Spread Agent is running. The order 

change will be reflected in the Managed Order Console in the Summary column. 

  

At any time while the Spread Agent is running, the initial spread can be worked again by 

checking the Initial check box.  

  

  

  

Accurate/Delta Hedge Button Added to Spread Viewer 

  

  

 
  

Two spreads defined in Spread Viewer. New Accurate Hedge button is at the top. 

  

 
  

First spread selected (containing one BYO, one SLO). Accurate Hedge pressed, equity leg 

added (SSH) bringing the total Delta to zero. 

  

  

 
  

Delta Hedge can be selected instead of Accurate Hedge in a single option leg configuration. 
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A new button Accurate Hedge has been added to Spread Viewer. 

  

The Accurate Hedge button inserts an Equity leg (or modifies one that already exists) to 

bring the total Delta for the order to zero.  If the Delta is positive then a Sell Equity Leg will 

be inserted.  Conversely, a Buy Leg will be added for negative deltas.  Equity legs are added 

in lots of 100, so the Equity will only be added if the offending Delta is more than 50 (or less 

than -50). 

  

In a single option leg configuration, Delta Hedge can be selected instead of Accurate 

Hedge by pressing the up arrow next to the button. When Delta Hedge is in force, the stock 

leg ratio is changed to 100 (or -100). 

  

  

Note: If the legs are close to zero already, selecting Accurate Hedge will have no effect. 
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13.3.26.0 

May, 2012 

 

 Improved Help Function Added to WTP 

 New Field for Equity Quote Cube: "Volume At" 

 "Send To" Feature Added to Order Ticket 

 "Enable Side Type Row Coloring" Now in Spread Builder and Spread Viewer 

  

  

Improved Help Function Added to WTP 

  

 
  

Additional granularity has been added to the Help pages. When the mouse pointer is 

hovered over an icon, press the F1 key to open an existing Help page that describes the 

icon and its function. 

  

Note: An icon's description may not necessarily be found on the app's main Help page. 

  

An app's main Help page will be displayed if: 

 The F1 key is selected without hovering over an icon. 

 Non-WTP-specific icons (cut, copy, paste, undo, etc.) are selected. 
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New Field for Equity Quote Cube: "Volume At" 

  

 
  

The volume traded at each price tier is now available for display in the Equity Quote Cube 

with the Vol At (Volume At) column. 

  

The Vol At column can be placed in both the Bid and Ask grids. 

  

To add the Vol At column: 

1. Right-click in the column head area of the grid. 

2. Select Field Chooser. 

3. Select Quote Cube Detail-->Vol At 
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"Send To" Feature Added to Order Ticket 

  

 
   
The ability to send field data from the Order Ticket to another 

WTP app has been enabled. These fields are supported:  

 Symbol/Security 

 Quantity 

 Price 

 Price Type 

 Route 

 Portfolio (Contra) 

 TIF 

 Side Type (Contra) 

 Staged Order ID 

 Give Up (Contra) 

 CMTA (Contra) 
 Account Type (Contra) 

The following order tickets have the "send to" feature enabled: 

 Equity/Option Outright 

 Equity/Option Crossing 
 Staged Order Ticket 
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"Enable Side Type Row Coloring" Now in Spread Builder and Spread Viewer 

  

 
  

Configure Spread Builder 

  

 
  

Leg display, side type row coloring disabled 
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Leg display, side type row coloring enabled.  Colors for Buy/Sell rows configured in Global 

Configuration-->Theme 

  

  

The option to display legs of a spread in custom colors has been added to Spread Builder 

and Spread Viewer. 

  

Enable Side Type Row Coloring is found under the Spread Builder tab in the Spread 

Builder configuration. 

  

When selected, Enable Side Type Row Coloring will display the Buy side in one color and 

the Sell side in another. 

  

The colors for Buy and Sell are configured in Global Configuration, under the Theme tab. 
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13.3.25.0 

May, 2012 

  

 New Splash Screen design features Tip of the Week 

 Total Cash Now Displayed in Order Summary Window 

 Custom Solace Values Can Now be Viewed in the Order Ticket 

 Spread Viewer: Drag and Drop to Reposition Spreads and Legs 

  

  

  

New Splash Screen design features Tip of the Week 

  

  

 
  

Splash Screen, former version 

  

  

 
  

New Splash Screen featuring Tip of the Week 
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A newly designed splash screen launches when logging into WTP. 

  

The contents of the splash screen: 

 

 Tip of the Week—A short informational message that changes on a weekly basis. 

Note that the tip may be describing functionality that doesn't apply to every user's 

trading situation (i.e., tips on trading options may not be useful to equity traders, 

and vice versa).  

 A link to www.tradewex.com (the WEX website). 

 What's new?—A link to the current WTP Release Notes (also selectable from the 

Help menu in the WTP Toolbar). 

 More Tips—A link to the Help page that lists all created tips to date. 

 Close—Click on "close" to close the splash screen.  

 

A closed splash screen can be relaunched by selecting Splash Screen from the Help menu 

in the WTP Toolbar. 

  

  

Total Cash Now Displayed in Order Summary Window 

  

 
  

A new field Total Cash has been added to the Order Summary window. 

  

Total Cash is defined as the sum of the executed values with respect to Buy and Sell. The 

sum can refer to a single order, or multiple-selected orders in the Order Grid. 

  

The formula for computing Total Cash is as follows: 

 

Total Cash = Price  x  Quantity  x  {-1 if BUY, +1 if SELL}  x  Lot Size 

  

To launch the Order Summary window, select one or more filled orders in the Order Grid. 

Right-click and select Show Order Summary (or select Show Order Summary from the 

Action menu). 

  

  

Custom Solace Values Can Now be Viewed in the Order Ticket 
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A quote grid that displays Solace and other data can be added to the Order Ticket (in 

Equity or Options mode) via the Ticket Layout command. The grid inherits its data from 

the standard Quote Grid as well as its functionality: 

 

 The symbol in the Order Ticket is reflected in the grid. 

 Double-clicking within the grid is reflected in the Order Ticket (for example, double-

clicking the Ask value populates the Order Ticket with the appropriate price). 

 

Once in place, the grid can have its rows and columns customized and formatted with 

regard to content, colors and styles. See Columns and Formatting for more details on 

customizing a grid display. 

  

The Quote Grid control is found in Edit Ticket Layout mode under Common-->Quote Grid. 

  

  

  

Spread Viewer: Drag and Drop to Reposition Spreads and Legs 

  

   

Original display of spreads  

  

  

   

Result after changing the row display in the 

Spread Viewer grid 
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Spread and Legs original display order 

  

  

Result after changing the leg order display 

  

  

Spreads and legs within a spread can be moved within the Spread Viewer grid. 

  

Change the display order of spreads: 

  

1. Select the row containing the spread to be moved.  

  

2. A thin red line will appear as the left mouse button is pressed. Drag the row to its desired 

location (taking notice of the red line) and release the mouse. 

  

  

Change the display order of legs within a spread: 

  

1. Select the leg row to be moved. 

  

2. Drag the leg to its desired location within the spread and release the mouse. Legs will be 

relocated to any row above the red line. 

Multiple legs can be selected within a spread and moved as a unit. Hold down the ctrl key 

to select multiple rows. 

  

Note: Spreads and the legs within spreads cannot be moved into other spreads. 
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13.3.24.0 

April, 2012 

  

 Show Live Orders for the Current User 

 Position Fields Added to Spread Agent 

 Locate ID Field Added to Spread Builder 

  

  

  

Show Live Orders for the Current User 

  

 
  

User's Orders Only is a new configuration option for displaying a user's live orders 

exclusively. When selected, all orders not generated by the current user will be hidden. 

  

This option is selected from the configuration screen in Option Quote Cube, Equity Quote 

Cube, Spread Book, and Spread Builder.  

  

  

  

Position Fields Added to Spread Agent 



Release Notes  13.3.24.0  

   

604 © 2014 Wolverine Execution Services, LLC 

  

 
  

Spread Agent can now display positions on both securities being worked.  

  

Position refers to the accumulated position by firm, account, or portfolio. The default 

position mode is set in Global Configuration. 

  

  

  

  

Locate ID Field Added to Spread Builder 

  

 
  

The Locate ID field (Loc Id) has been added to Spread Builder. Access this field by placing 

the Spread Builder ticket in advanced mode. 
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13.3.23.0 

April, 2012 

  

 An Improved Method for Inserting Columns Into Grids: Field Chooser 

 Position Now Displayed in Vol Trader 

 New Install Update Message 

  

  

  

An Improved Method for Inserting Columns Into Grids: Field Chooser 

  

 
Original method for inserting a single column at a time into grids 

  

  

  

 
  

Field Chooser, an improved method for inserting one or more columns into grids 
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With Field Chooser, single or multiple columns can be inserted in all WTP Grid apps (i.e., 

Quote Grid, Order Grid, etc.) in a manner that is relatively easy. 

  

The benefit of using Field Chooser is that multiple columns can be added in a single pass, 

whereas only a single column at a time could be added via the Insert Column-->Field 

Name-->Column name command. 

  

Launch Field Chooser 

  

In a WTP Grid app, right-click on any column head and select Field Chooser. The Field 

Chooser selection window opens. 

  

Select Columns with Field Chooser 

  

In the top portion of the Field Chooser window (white background) select the field type (for 

example, Alert, Launch Button, etc.) Note that field types are specific to each grid. 

  

Once a field type has been selected, the columns associated with that field type are 

displayed in the bottom portion of Field Chooser (the background color in Field Chooser 

reflects the background color of the grid). 

  

To place a single column to the left of the selected column, double-click on a column 

name. 

  

To place a single column anywhere in the grid, single-click a column name and drag 

the column to the desired location in the grid and release. 

  

To select and place multiple columns anywhere in the grid in a single pass, hold 

down the Ctrl key while selecting the columns. Drag the selected columns to the desired 

location in the grid and release. 

  

When a column is placed in a grid it is removed from selection in Field Chooser. When a 

column in a grid is removed, it is available for selection in Field Chooser. 
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Position Now Displayed in Vol Trader 

  

 
  

  

Each security's position is now displayed in Vol Trader. The value (in the Position field) 

refers to either the firm, account, or portfolio position based on the default position mode 

setting in Global Configuration. 

  

  

  

New Install Update Message 

  

 
  

A new Install Update message displays when the update icon button is selected. To 

complete the update, select Yes. 
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13.3.22.0 

March, 2012 

 

 New Managed Order: Spread Agent 

 Grid Improvement: Click Fade Control Fades All Rows when Column Selected 

  

  

New Managed Order: Spread Agent 

  

 
  

  

With Spread Agent a single spread and reverse spread can be traded simultaneously. The 

reverse spread is achieved by trading the same two securities as the initial spread but with 

opposing side types (for example BUY/SSH vs. SSH/BUY). 

  

Spread Agent also employs a feature known as a Slip Adjustment. A slip occurs in Spread 

Agent when it attempts to achieve a spread, yet fills a portion of the order at a worse than 

configured price. Spread Agent will attempt to rectify this situation by adding a calculated 

amount that's spread over the entire order (a "Slip Adjustment"), with the result of a 

completed order at the desired price. 

 

Learn all about Spread Agent here. 
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Grid Improvement: Click Fade Control Fades All Rows when Column Selected 

  

 

 
  

Fade Away column selected. 

  

  

Formerly, if a column containing either the Fade Away or Fade In buttons was selected, 

and a single button was pressed, a single live order would be affected. 

  

Now, if a column is selected containing a Fade Away or Fade In button and a single button 

is pressed, all live orders in that column will either fade away or fade in to the market 

(depending on the selection and whether the order is a buy or sell). 

 

These buttons can still be used on individual orders by not selecting the entire column. 
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13.3.21.0 

March, 2012 

  

 BYA/SLA Auto Split Orders Available in Vol Trader 

   

 New Display: Average Price Per Leg for Spreads 

   

 Trade Limit Warning Percentage in Global Configuration 

   

 GTC (Good Till Canceled) Time-In-Force Now Permission Based 

  

 

BYA/SLA Auto Split Orders Available in Vol Trader 
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Activity Log displays when BYA/SLA split occurred 

  

  

The Global Configuration optional order command Auto-Split Outright BYA/SLA Orders 

will now be applied to Vol Trader orders. 

  

If Auto-Split Outright BYA/SLA Orders is enabled, a Vol Trader order crossing a flat 

position will be split into two orders and a "BYA/SLA Split..." message will be displayed in 

the Vol Trader Activity Log. 

  

  

New Display: Average Price Per Leg for Spreads 

  

 
  

Original Order 

  

 
  

Average Price of Filled Order 

  

The Average Price Per Leg of filled multi-leg orders originally placed in Spread Ticket or 

Spread Builder is now available for display in the Order Grid. 

  

To add the Avg Px column right-click on any column head in the Order Grid and select 

Insert Column-->Order Fields-->Avg Px. 

  

The Avg Px  is also displayed on the Spread Order Leg Details table. To view this table, 

double-clock on a spread order in the Order Grid, then select Spread Order Detail: 
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The Order Detail Window. Press Spread Order Detail to view the Spread Order Leg 

Details: 

  

 
  

Spread Order Leg Details table now with Avg Px per leg 

  

  

Trade Limit Warning Percentage in Global Configuration 
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Value set in Global Configuration 

  

 
  

Sample of some Trade Limit warnings 

  

The percentage value set in the Trade Limit Warning Percentage field indicates the point 

at which a warning message will appear. This value can refer to a number of maximum 

limits including Max Total Share, Max Total Value, Max Position Shares, Max Position 

Value. The message informs you that you are approaching a defined limit. 

  

Example of when a warning will occur: You have the permission to trade a maximum of 

5000 shares per day. If you set the Trade Limit Warning Percentage to 80%, a warning 

message will appear once you've traded 4000 shares (80% of 5000 = 4000). 

  

  

  

GTC (Good Till Canceled) Time-In-Force Now Permission Based 

  

The time-in-force selection GTC (Good Till Canceled) is now available only by permission. 

Contact WEX Support to have this permission enabled. 
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13.3.20.0 

March, 2012 

  

 Auto-Accept Staged Orders Now Configurable 

  

 
  

  

In the past, the creation of a staged order was automatically accepted in WTP. If it is 

desirable, the automatic acceptance of a staged order can be configurable. 

  

The control Auto Accept Staged Enable adds a check box to the Staged Order Ticket. See 

the Ticket Editor Help page for instructions on adding a control. 

  

If the Auto Accept Staged Enable is unchecked when a staged order is created, the status 

of the staged order will display as Pending in the Order Grid.  

  

To change the status from Pending to Live the Stage: Accept column must exist in the 

Order Grid. In the row with the Pending order, click the Stage:Accept button and click OK 

in the confirmation window. 

  

Note: If the Auto Accept Staged Enable check box has not been placed on the Staged 

Order Ticket, all staged orders will be accepted automatically. 
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13.3.19.0 

February, 2012 

 

 "Attach to Stage" Command Allows Filled Orders to be Attached to Staged 

Orders 

  

A staged order is "a queued order representing an intention to trade shares, contracts, or 

spread by the end of the trading day." During the course of the day, shares may be 

purchased or sold (depending on the staged order) via the Stage: Release command in the 

Order Grid, reducing the quantity left in the staged order. 

  

For example: A staged order is created to buy 500 shares of AAPL. The staged order is seen 

in the Order Grid. During the day, Stage:Release is selected which opens an Order Ticket. 

An order is placed to buy 150 shares of AAPL. When the order is filled, the quantity 

remaining in the staged order will be reduced to 350 shares. 

  

What if, during that same day, an order is placed for 100 shares of AAPL using the standard 

Order Ticket and not the Stage:Release ticket? The remaining quantity of the original staged 

order will not be affected. If the intent of the order was to reduce the remaining quantity of 

the staged order, but the standard Order Ticket was inadvertently employed, the filled order 

can now be defined as being attached to the original staged order, reducing the staged 

order's quantity. 

  

A new command "Attach to Stage" has been created for this purpose. 

  

In the first image below, a Staged Order (purchase) is placed for 500 shares. Another order 

to purchase 150 shares is filled, but does not reduce the quantity of the Staged Order. In 

the second image, the filled order of 150 shares is attached to the Staged Order, reducing 

the Staged Order quantity to 350 shares. 

  

 
  

Staged Order shows a quantity of 500 shares left, 

disregarding the filled order below it. 
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Staged Order now shows a quantity of 350 shares left after attaching the filled order to it. 

  

  

To use the Attach to Stage command: 

  

1. An unfilled staged order must exist. 

2. A filled order with the same symbol AND same portfolio as the staged order must 

exist. 

3. In the Order Grid select the staged order row and the filled order row using the ctrl key. 

4. Right-click on the Order Grid (or click on the Action menu) and select Attach to Stage. 

  

Note 1: The quantity of the filled order cannot be greater than the remaining quantity of 

the staged order. 

  

Note 2: An unfilled order cannot be attached to a staged order. 
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13.3.18.0 

February, 2012 

  

 OCC Symbol Formatting Now Available in Grids 

  

  

 
  

Define the OCC format for the Symbol column 

  

  

 
  

OCC Formatting for Options order 

  

  

The OCC (Options Clearing Corp), the world's largest clearing organization, has defined a 

new method for displaying ticker symbols for option orders. 
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This new code is displayed in the order of four key components: 

 The Underlying Symbol 

 The Expiration Date 

 The Option Type (Put or Call) 

 The Strike Price 

  

In the example above, the security is AAPL, the expiration date is May (19) 2012, the 

option type is Call, and the strike price is $235.00. This translates to the OCC code as 

AAPL20120519C00235000. 

  

The OCC code always shows eight decimal values. Any price that doesn't use all eight 

decimal values will be padded with zeroes. For example: 

  

25.00 = 00025000 

  

 9.50 = 00009500 

  

12345.678 = 12345678 

  

  

  

The OCC code formatting is now available in all WTP grids. To set OCC formatting: 

  

1. Right-click on the Symbol column header in a grid and select Set Column Style. 

  

2. Move to the Format tab. 

  

3. In the Custom Format text input field enter occ.  

 

4. Click OK. 

  

  

If it is desirable to always use OCC formatting, you may save your grid as a default 

template. 
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13.3.17.0 

February, 2012 

  

 New Feature in Option Quote Cube: Scroll To ATM 

 Add Control Feature in Ticket Designer Updated 

  

  

New Feature in Option Quote Cube: Scroll To ATM 

  

 
  

  

When the price of an underlying security is equal to the strike price, the option is ATM (At 

The Money).  

  

Check the Show ATM box to have the Option Montage Grid to scroll to the ATM quote.  

  

  

  

Add Control Feature in Ticket Designer Updated 
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Previously, the Add Control feature in Ticket Editor listed the controls in alphabetical 

order. 

  

Now, The Add Control window lists controls by category. 

  

Double-click on a control category (or click on the + symbol) to display the controls for the 

category. 
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13.3.16.0 

January, 2012 

  

 Alert User if their Login is to Expire Soon 

 

 New Custom Vol Data Fields 

  

  

Alert User if their Login is to Expire Soon 

  

  

A new WTP message (to be displayed in the WEX connection window) has been created 

alerting a user that their account will expire soon  Typically, this message will appear five 

days prior to the expiration. 

  

The expiration feature is managed by the WEX Administrator. 

  

Note that no expiration date can be configured for WTP users if desired by the 

Administrator. 

  

  

  

New Custom Vol Data Fields 

  

 
  

Imported IVol (Implied Volatility) data can be displayed in the Option Quote Cube. 
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Three new columns are available for selection in the configuration screen under the Strike 

Detail Grid tab, Quote Fields: 

  

 Imported IVol  

 Imported IVol Diff (Difference between Imported and Yesterday's IVol) 

 Imported YDay Ivol (Yesterday's IVol) 

 

Note: The data will be displayed whenever valid data is supplied. Otherwise, the columns 

will not display. 
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13.3.15.0 

January, 2012 

  

 New Time-in-force selection: GTC 

 New Increment Values for Canadian Options 

 Solace Support Added to Global Configuration 

 "Order Grid" Quick-Start Video in Help 

  

  

  

New Time-in-force selection: GTC 

  

A new time-in-force selection GTC (Good Till Canceled) is now available on WTP order 

tickets. 

  

A GTC order is one to buy or sell that remains in effect until it is either executed or 

canceled, and is sometimes called an "open order." 

  

  

New Increment Values for Canadian Options 

  

New price increments for Canadian option orders has been developed. The increments are: 

 

 Less than $.10, one-cent increments 

 Equal or more than $.10. five-cent increments 
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Solace Support Added to Global Configuration 

  

 
  

Solace is a device used in distributing high-speed real-time market data (similar to 

Reuters). Support for Solace connections has been added to Global Configuration under 

the Quote Connections tab. 

  

The Solace Custom Data field is designed for users who wish to publish their data into 

Solace. The settings tell WTP where to find that custom data.  

  

All Solace values are set up by WEX support during WTP installation. 

  

  

"Order Grid" Quick-Start Video in Help 

  

A new quick-start video Order Grid has been added to the online version of WTP Help. 
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13.3.14.0 

December, 2011 

 

 No New WTP Features in this Release 

 

 

There are no new features in release 13.3.14.0. 

 



Release Notes  13.3.13.0  

   

626 © 2014 Wolverine Execution Services, LLC 

13.3.13.0 

December, 2011 

 

 No New WTP Features in this Release 

 

 

 

 

There are no new WTP features in release 13.3.13.0. 
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13.3.12.0 

December, 2011 

 

 Lock WTP After a Period of Inactivity 

 

 Changes to Online Help 

 

 

 

 

Lock WTP After a Period of Inactivity 

 

WTP has the ability to lock out a user after a defined period of inactivity. If the defined 

inactivity period is reached, the user will be required to log in with username and password. 

By default, Lock WTP is disabled. 

 

Note: Lock WTP is not a user-defined feature. Contact WEX Support to enable Lock 

WTP and define the inactivity period.  

 

 

 

Changes to Online Help 

  

The following changes have been implemented in Online Help: 

1. These links were removed from the Help landing page and replaced by quick launch 

buttons: 

 

About 

Contact 

New In This Release 

FAQ 

Release Notes Archive 

WTP Quick Start Videos 

PDF version 

Home Page 

 

2. The Introduction link in the Table of Contents now links to the page What is WTP. 

Formerly, it linked the user to the main Help page. The Home Page button has 

replaced this link. 

 

3. The font and background color of the Table of Contents pane has changed. 

 

4. The Search feature has improved. The results obtained from a search are now 

ranked in order based on the number of times the search term appears in a 

particular Help page. 

 

5. Global Change: Copyright notice changed to © 2012 Wolverine Execution 
Services, LLC. WTP Help logo also changed to "Wolverine Execution Services". 
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13.3.11.0 

November, 2011 

 

 No new features in this release of WTP 

  

 Quick Start Videos Added to Help 

 

 

 

Quick Start Videos Added to Help 

 

An ongoing project, Quick Start Videos, is now available in WTP Help. 

 

As of release 13.3.11.0 there are two videos: Order Ticket and Basket Trader, and new 

videos will be added at a rate of approximately two per month. 

 

The goal of these one-to-three-minute narrated videos is to introduce the new WTP user to 

the basics of a particular applet without delving into advanced details or complicated topics. 

 

The videos were designed to run directly in the same browser window without the need to 

open a third party application. 

 

For more advanced topics, the user is still directed to these Help pages. 

 

Note: Quick Start Videos are available only in the online version of Help, not in this PDF 

version. 
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13.3.10.0 

November, 2011 

 

 No new features in this release of WTP 

  

 New question added to the FAQ page 

 

 

 

New question added to the FAQ page 

 

The following Basket Trader question was added to the FAQ page: 

 

Can I have Buy and Sell Orders in the Same Basket? 
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13.3.9.0 

November, 2011 

 

 No new features in this release of WTP 

  

 Help pages improvements 

 

 

 

Help pages improvements 

 

The following improvements were made to WTP Help: 

 

 New Help Page: Volatility Chart. 

  

 Help pages for all WTP applets are now available for selection on the main Help page. 

  

 Two Help pages renamed to match their WTP names: 

 

Sector Viewer is now Option Sector Viewer.  

 

Imbalance Viewer is now Equity Imbalance Viewer. 

  

 Release Notes main page renamed to Release Notes Archive.  

 

All release notes dating back to WTP version 13.2.80.0 are now available. 

 

Note: This change is for the online version of WTP Help, not this PDF version. 
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13.3.8.0 

November, 2011 

 

 Allow Market Price Type now a Configuration Option in Basket Trader and Spread 

Basket 

  

 Release Notes Main Page added to WTP Help 

  

 WTP Applet Definitions Linked to WTP Applets in Help Table of Contents 

 

 

 

 

Allow Market Price Type now a Configuration Option in Basket Trader and Spread 

Basket 

 

 
 

In the past, some users have used the override sell type "Market" for basket orders in 

Basket Trader and Spread Basket, only to realize that not all the orders in the basket 

should have been filled at market. 

 

A new configuration option Allow Market price type must be checked if the Market sell 

type override is to be available in Basket Trader and Spread Basket. 

 

If Allow Market price type is unchecked, the Market sell type will be unavailable for 

selection. 

 

 



Release Notes  13.3.8.0  

   

632 © 2014 Wolverine Execution Services, LLC 

 

Release Notes Main Page added to WTP Help 

 

Note: This feature is only for on-line WTP Help, not the PDF version. 

 

 

A new Release Notes main page has been added to WTP Help. 

 

Release notes from WTP version 13.2.80.0 will be available for selection on this page. WTP 

releases in which there were no new features will not be available from the Release Notes 

page. 

 

A link to the Release Notes main page has been added to the WTP Help main page. 

 

The links to Release Notes that resided on all Help pages have been removed. 

 

 

 

WTP Applet Definitions Linked to WTP Applets in Help Table of Contents 

 

Note: This feature is only for on-line WTP Help, not the PDF version. 

 

When selecting WTP Applets from the Help pages table of contents (in the left pane), the 

WTP Applet Definitions page will be displayed. 
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13.3.7.0 

October, 2011 

 

 New WTP Feature: Ticket Editor 

  

 New Help Pages: Icons in WTP, WTP Applet Definitions 

 

 

New WTP Feature: Ticket Editor 

 

 
 

 

The Ticket Editor is a new function in which all WTP order tickets can be customized. With 

the Ticket Editor you can: 

 

 Add or delete fields 

  

 Rename and resize fields 

  

 Move and align fields 

  

 Save a ticket layouts as a default 

 

 

New Help Pages: Icons in WTP, WTP Applet Definitions 
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Two tables that were originally in the FAQ page have been moved to Basic Concepts: 

 

Icons in WTP 

 

WTP Applet Definitions 
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13.3.6.0 

October, 2011 

 

 No New WTP Features in this Release 

  

 WTP Icon Table Added to FAQ 

 

 

 

There are no new features in WTP version 13.3.6.0. 

 

 

 

 

WTP Icon Table Added to FAQ 

 

 

A table listing all WTP icons with links to their usage has been added to the FAQ. 
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13.3.5.0 

October, 2011 

 

 Algo Fields Now Available in Order Tickets 

 

 

Specialized algo fields are now available for the following WTP applets: 

 

Order Ticket 

Spread Tickets 

Spread Basket Trader 

 

Route permissions are required in order to access specific algo fields. Also, a number of 

exchanges do not support them. 

 

Contact WEX Support for information on how to configure algo fields. 
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13.3.4.0 

October, 2011 

 

 Price-Per-Leg Now Configurable in Spread Ticket 

  

 New Account Type: Non-TPH Affiliate 

 

 

Price-Per-Leg Now Configurable in Spread Ticket 

 

 
 

A new column "Price" has been added to the Spread Ticket standalone app and the Spread 

Ticket in Spread Builder.  

 

The price-per-leg can now be individually adjusted (its default value will be the mid value). 

The changing value in the Price column will be reflected in the Px field of the ticket. 

 

Note: This column is displayed by default (there is no option to add it or remove it). If the 

Price column cannot be seen, its column width may have been reduced to the point that the 

column is hidden. In the System Default template for the ticket, the Price column is 

adjacent to the required Opt column. 
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New Account Type: Non-TPH Affiliate 

 

 

 
 

 

A new account type Non-TPH Affiliate (Non-Trading Permit Holder Affiliate) is now 

available for selection in the advanced mode of the Order Ticket. 

 

A Non-Trading Permit Holder Affiliate of the Chicago Board Options Exchange is a 

100% wholly-owned affiliate or subsidiary of a Clearing Trading Permit Holder that 

is a) registered as a United States or foreign broker-dealer and b) is not itself 

a CBOE Trading Permit Holder. 
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13.3.3.0 

September, 2011 

 

 Locate ID or Clearing Firm Information Added to Short Sale Affirmation 

Message 

 

 

 

When issuing a short sale, an updated affirmation message will appear prior to a final 

confirmation message. 

 

 

If a locate ID is present in the Order Ticket (or any of the tickets in the applets listed at the 

bottom), a message featuring the security name and locate id displays: 

 

 

 
 
Affirmation message with locate ID information 

 

 

 

If a locate ID is not present in the Order Ticket (or any of the tickets in the applets listed at 

the bottom), a message featuring the security name and clearing firm name 

displays: 

 

 
 
Affirmation message with clearing firm information 

 

 

The applets which are affected by this improvement are: 

 

 

Order Ticket 

 

Equity Crossing Ticket 

 

Spread Ticket 
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Quick Ticket (in Global Configuration/Orders/Configure Quick Trades) 

 

Equity Quote Cube  

 

Basket Trader 

 

Spread Basket Trader 

 

All Managed Orders 
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13.3.2.0 

September, 2011 

 

 

 No New WTP Features in this Release 

  

 FAQ expanded 

  

 

 

No New WTP Features in this Release 

 

 

 

FAQ expanded 

 

The FAQ on the Help Pages has been expanded to include more questions/answers and an 

improved table of contents. 
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13.3.1.0 

September, 2011 

 

 

  

There are no new WTP features in Release 13.3.1.0. 
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13.3.0.0 

August, 2011 

 

 Note Field Added to All Four Basket Traders 

  

 BYA/SLA Order Splitting for Complex Orders 

 

 

   
Note Field Added to All Four Basket Traders 

 

 
Note field in standard Basket Trader 

 

 

The Note field has been added to all four Basket Traders. It is found in the Override 

Advanced Order Parameters section of the standard Basket Trader and Spread Basket 

Trader. 

 

In the Crossing Basket Trader and Stage Basket Trader the Note field is found in the 

Override Order Parameters section. 

 

 

 

BYA/SLA Order Splitting for Complex Orders 

 

When a complex order (whose legs are the automatic side types "BYA" or "SLA") crosses 

over a flat position, the order can be configured to automatically split into multiple orders. 

 

In Global Configuration  the option "Auto-split outright BYA/SLA orders based on 

the default position mode (account)" must be checked in order to enable this feature. 

 

The formula for determining the maximum number of orders that can be auto-split is: 

 

Number of legs in a complex order  +   1 

 

A new split order will be created only if the split can maintain the initial ratio for all legs. If a 

split is required but cannot satisfy this requirement, the leg will not be split. Instead, it will 

trade according to standard (i.e., non auto split) rules. 
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13.2.103.0 

August, 2011 

 

 

There are no new features in WTP version 13.2.103.0. 
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13.2.102.0 

August, 2011 

 

 Executed Volatility Level Field Added to Managed Order Console 

  

 Release Notes Button Now Available On All Help Releases 

 

 

 

Executed Volatility Level Field Added to Managed Order Console 

 

 
 

 

 

A new Vol Trader column VT: Exec Vol Level is now available for the Managed Order 

Console. 

 

When added to the Managed Order Console, the column displays the volatility percentage 

when a Vol Trader order is executed. 

 

 

 

Release Notes Button Now Available On All Help Releases 

 

Beginning with this release, a link to all WTP Help page release notes going back to 

13.2.80.0 will be placed at the bottom of the page. WTP releases with no new features will 

not be in the list of release notes. 

 

The release notes button is only available for the online Help pages. It will not be on the 

PDF version of Help. 



Release Notes  13.2.101.0  

   

646 © 2014 Wolverine Execution Services, LLC 

13.2.101.0 

August, 2011 

 

 

 

 

There are no new features in WTP version 13.2.101.0. 
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13.2.100.0 

July, 2011 

 

 Level 2 Data Available in Managed Order Console 

  

 Help Button Added to Managed Orders 

 

 

Level 2 Data Available in Managed Order Console 

 

 
 

A new menu option View Level 2 Data has been added to the Managed Order Console. When 

activated, select any managed order. The Equity Quote Cube and/or Option Quote Cube 

(depending on the managed order) will launch with the symbol(s) associated with that 

order. If View Level 2 Data is turned off while the quote cubes are displayed, the quote 

cubes will close. 

 

To activate View Level 2 Data, select it from the Action menu or right-click anywhere in the 

Managed Order Console grid and select View Level 2 Data. 
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Help Button Added to Managed Orders 

 

 
 

The link to help that was formerly available in the Managed Order Console is now available 

for all managed order types. The exception is Market Maker which does not have its own 

help page. Selecting Market Maker's Help icon will open the Managed Order Console page. 
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13.2.99.0 

July, 2011 

 

 User Column Added to Notifications 

 

 
 

The column "User" has been added to Global Configuration under the Notifications tab. 

 

Now, a notification can be sent if a user (or users) match a specific event, security, and 

type. With the User column displayed, select user(s) by clicking in the column and checking 

the required names for notification. 

 

The User column is visible only when the Show Notifications For Other Users box is not 

selected. 
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13.2.98.0 

July, 2011 

 

 Order Summary Window Added to Allocator 

  

 EDGA and EDGX Added as Book Sources 

 

 

Order Summary Window Added to Allocator 

 

 
 

A new Order Summary window in Allocator displays: 

 

 The number of orders for the number of selected symbols 

 Total quantity 

 Total traded 

 Remaining quantity 

 Average price 

 Total cost 

 Total value 

 

To launch the Order Summary window, highlight one or more orders in the Orders portion of 

the Allocator window. Right-click and select Show Order Summary. 
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The Order Summary window is also available in the Order Grid and is accessible by right-

clicking on selected orders or via the Action menu. 

 

 

 

EDGA and EDGX Added as Book Sources 

 

 
 

 

EDGA and EDGX (permission-based dual equity trading platforms owned by Direct Edge 

ECN, LLC) are available for selection as book sources. 

 

Either one can be added as a quote source for the Equity Quote Cube (on the 

configuration page, General tab) and in Global Configuration (under the Quote Data 

tab).  
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13.2.97.0 

June, 2011 

 

New WTP Applet: Flex Ticket 

 

 
 

 

FLexible EXchange (FLEX) options are customized equity or index option contracts that 

provide investors with the ability to customize key contract terms including strike prices, 

exercise styles and expiration dates of up to ten years from the trade date; with the 

transparency, administrative ease and clearing guarantees of standard listed options. 

 

A new WTP applet Flex Ticket has been created that allows traders the ability to customize 

key terms (i.e., exercise price, expiration date) for equity or index option contracts. 

 

There are two execute-style buttons in the Flex Ticket: Request For Quote and Execute: 

 

 Request For Quote—Quotes for Flex options are generated only in response to a 

Request For Quote (RFQ), since no Flex option series are continuously quoted. A 
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quote will be supplied if there is not another live RFQ with the same trading strategy. 

RFQs do not acknowledge prices and quantities, so those values will be ignored when 

issuing the command. 

  

 Execute—Select this button to send the flex order. 

 

 
 

The CFLEX Spread Book Exchange (a connection requirement for Flex orders) is available for 

selection in the configuration windows of the Flex Ticket and Spread Ticket. 
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13.2.96.0 

June, 2011 

 

 Two Overrides Now Available in Stage Basket Trader 

  

 Bulk Ownership Changes Can Be Made in the Managed Order Console 

 

 

Two Overrides Now Available in Stage Basket Trader 

 

 
 

Two overrides Buy Type and Sell Type are now available in the Stage Basket Trader. 

 

The only selection available for each order type is Market. All limit orders can be changed to 

market orders with this feature. 

 

 

 

Bulk Ownership Changes Can Be Made in the Managed Order Console 

 

Users with the client permission Managed Order Admin can assign ownership of managed 

orders to another person.  

 

In addition, a user with the Managed Order Admin permission can delete managed orders 

owned by someone else. 

 

Contact technical support if the Managed Order Admin permission is required. 
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13.2.95.0 

June, 2011 

 

 Warning Message Displayed for Spread Orders Without Delta 

  

 Locate ID and Note fields Available in Basket Trader 

  

 Additional Slip Fields Available in Order Grid 

 

 

 

 

Warning Message Displayed for Spread Orders Without Delta 

 

If there is no market data for the Delta value in a spread order, a warning message will 

display. This message is a guard against sending a possibly mis-hedged order. 

 

 

 

Locate ID and Note fields Available in Basket Trader 

 

 
 

Two new grid columns Locate ID and Note are now available for Basket Trader. Content is 

added directly to either column by clicking directly in the appropriate field. 

 

Add either column by right-clicking on a column head and selecting Insert Column--

>Basket Fields-->. 
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Additional Slip Fields Available in Order Grid 

 

 
 

 

New order fields available in Order Grid: 

 

 SlipLast 

 SlipLast Avg 

 SlipMid 

 SlipMid Avg 

 

SlipLast Avg is calculated from the last price and SlipMid Avg from the mid price. 

 

Add the columns by right-clicking on a column head and selecting Insert Column-->Order 

Fields-->. 
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13.2.94.0 

June, 2011 

 

 No New WTP Features in this Release 

  

 FAQ Added to Help 

 

 

 

FAQ Added to Help 

 

 
 

Questions received by the WEX Help desk revolving around a similar theme or product have 

been included in this FAQ. The questions are divided by product type except for WTP Misc. 

which encompasses general questions about WTP.  

 

A link to the FAQ is on the main page and the contents pane of Help. 

 

If there's a question you'd like to see added to the FAQ, send an email to the WEX Help 

desk. 

mailto:support@tradewex.com
mailto:support@tradewex.com
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13.2.93.0 

 

May, 2011 

 

 Notification Created for "Idle Waiting" Instant Messenger Users 

  

 Instant Messenger—Unseen Message Navigation from WTP Toolbar 

  

 

 

Notification Created for "Idle Waiting" Instant Messenger Users 

 

 
 

"IM (Idle Waiting User)" is a new notification event in Global Configuration. Once the event 

has been created, a Notification will be sent to the recipient of an Instant Message if the 

recipient has not responded to the message after a defined time period. The notification will 

repeat until the recipient responds: 
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The system default value is two minutes (120 seconds) wait time before a notification is 

issued. The system default value is five minutes (300 seconds) before WTP assumes a 

new conversation has begun. 

 

Idle notification values (in seconds) are stored in the UserConfig.WTP.ini file as follows: 

 

IdleWaitingUserNotificationTime=120 

 

UserIdleNotificationTime=300  

 

To adjust the time before a notification is issued, change the value of 

IdleWaitingUserNotificationTime.  

 

Remember to set the IM (Idle Waiting User) event in Global Configuration. It is preferable 

to set the log severity and Auto Open Log Window to High.  

 

Note: Idle User Notification does not apply for Chats in Instant Messenger. 

 

 

 

Instant Messenger—Unseen Message Navigation from WTP Toolbar 

 

 
 

 

The Instant Messenger applet has always allowed users to view the most recently received 

instant message by clicking on New Messages in the WTP toolbar. 

 

Now, a user can view messages older to newer or vice versa by selecting New Messages. 

 View Older to Most Recent Unseen Message In the Appropriate Channel—Right 

double-click on New Messages 

  

View Most Recent to Older Unseen Messages in the Appropriate Channel—Left double-click 

on New Messages. 
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13.2.92.0 

May, 2011 

 

 Locate ID Field Added to Select WTP Applets 

 

 

 
 

Loc(ate) ID in Advanced Order Ticket 

 

 
   
Locate ID column in Order Grid 

 

 



Release Notes  13.2.92.0  

   

661 © 2014 Wolverine Execution Services, LLC 

 
 

Locate ID in Order Detail window 

 

 
 

Locate ID in Vol Trader 
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Spread Trader with Locate ID fields for both sides 

 

 

SEC regulation SHO includes a new uniform requirement for broker-dealers to locate 

securities available for borrowing prior to effecting a short sale. Regardless of whether the 

seller’s short position may be closed out by purchasing securities the same day, firms will 

need to document that (a) they have borrowed or arranged to borrow the stock, or (b) they 

have reasonable grounds to believe they can borrow the stock and deliver on delivery date. 

 

Consequently, a new field Locate ID has been created and is now available in: 

 Equity Order Tickets (advanced mode) 

 Equity Report Trade ticket 

 Select managed orders (Vol Trader, Spread Trader) 

 Order Grid (Locate ID column) 

Both numbers and letters can be used in a Locate ID, but there is a 16-character limit. 
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13.2.91.0 

May, 2011 

 

 New Account Type: Broker Dealer (Customer) 

  

 Spread Basket Trader Now a Standalone Applet 

  

 

New Account Type: Broker Dealer (Customer) 

 

 
 

A new account type, Broker Dealer (Customer) is now available for Options trading in select 

WTP applet order tickets (in advanced mode).  

 

The basic difference between trading as a Broker Dealer and a Broker Dealer (Customer) is 

the method of clearing orders at the OCC (Options Clearing Corp.). Both account types pay 

the same fees and are given the same priority on the book. 
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Spread Basket Trader Now a Standalone Applet 

 

 
 

In previous releases, the Spread Basket Trader was not a standalone applet. It was 

launched when it received Spread Viewer orders via the send to--> command. 

 

Now, the Spread Basket Trader is a standalone applet launched from the WTP menu or via 

Trade-->Spread Basket Trader. 
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13.2.90.0 

April, 2011 

 

 Progress Bars Added to Order Grid 

  

 Vol Trader Hedge Delta Warning 

 

Progress Bars Added to Order Grid 

 

 
 

A progress bar that displays the amount traded, the remaining order quantity (Qty. Left), 

and % complete has been added to the Order Grid. 

 

The progress bars will not display if: 

 

 the order has no filled quantity 

 the order has completely filled 

 

To display the progress bar, check the option Show Progress Bar in the column's 

style/format window: 
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Vol Trader Hedge Delta Warning 

 

 
 

 
 

A warning message now displays in Vol Trader when a Hedge Delta value (for an 

underlying security) is applied. The message states that a defined underlying quantity will 

not change with the market.  
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13.2.89.0 

April, 2011 

 

 New WTP Applet: Stage Basket Trader 

 

 

 
 

 

A new stage-order type Stage Basket Trader is now available in WTP. Operating in 

the same fashion as the standard Basket Trader, orders sent via the Stage Basket 

Trader are different because they represent an intention to trade waves of single 

orders. 

 

New orders for a particular security can be attached to the same security in the 

basket, reducing the staged order's amount. Viewable in the Order Grid, Stage Basket 

Trader orders can be changed or released. 

 

Stage Basket Trader is opened via the WTP menu or from Trade-->Stage Basket Trader. 
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13.2.88.0 

April, 2011 

 

 "Spread" Now a Security Rule Type 

  

 Help Pages Update 

 

 

"Spread" Now a Security Rule Type 

 

 
 

Spread as a security rule type is now available in Global Configuration (in the Qty/Price 

tab). 

 

For futures orders, Spread cannot be selected. 
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Help Pages Update 

 

 
 

Information on Stop Limit and Stop Market orders in advanced mode has been added to the 

Order Ticket help page. 

 

A link to this feature on the Order Ticket page was added to the Equity Quote Cube page 

(whose ticket also allows Stop Limit/Stop Market order types). 
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13.2.87.0 

April, 2011 

 

 

 No new WTP features in this release 

  

 Help Pages changes 

 

 

 

No new WTP features in this release 

 

 

 

 

Help Pages changes 

 

1. Main page link to HELP PDF file 

 

A link to the WEX Client Portal login is now available on the main Help page. 

 

2. On the Columns and Formatting page new content was added for the following 

features: 

 

Custom Quote Fields 

 

User Defined Fields 
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13.2.86.0 

March, 2011 

 

 New Feature for Tabs in Grids "Close All But This" 

  

 Portfolio-Specific Routes Added to Global Configuration 

  

 Open New Window for Tabs 

  

 Conversion Columns Available In Option Quote Cube and Spread Builder 

  

 Left/Right Navigation Arrows Now Functional 

 

New Feature for Tabs in Grids "Close All But This" 

 

 
 

A new tab control command "Close All But This" has been added to all WTP apps that 

feature grids. 

 

Right-click on a tab to display the tab menu. When "Close All But This" is selected, all 

existing tabs will close except for the one that was right-clicked. 

 

 

Portfolio-Specific Routes Added to Global Configuration 
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In the Portfolios section of Global Configuration, a security can be linked to a portfolio via 

a route when <From Route> is selected. 

 

Now, in the Routes section (under Portfolio-Specific Routes), a portfolio/route link can be 

established. When a portfolio is selected, its associated route will also be selected. 

 

In the example above, selecting the portfolio TEST will automatically use the NYSE-TEST 

route. 

 

 

Open New Window for Tabs 

 

 
 

A new tab option Open in a New Window opens a new window with the selected security in 

place. 

 

Right-click on a tab name to view the tab menu. Select Open in a New Window to open a 

new instance of the current applet. 
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This feature works with all WTP grid applets. 

 

 

Conversion Columns Available In Option Quote Cube and Spread Builder 

 

 
 

Option Quote Cube, Conversion Ask Price = $0.22 

 

 
 

Spread Ticket, Conversion Ask Price in the Px field 

 

 



Release Notes  13.2.86.0  

   

674 © 2014 Wolverine Execution Services, LLC 

In the Option Quote Cube and Spread Builder configurations, under "Option Montage 

Grid/Option Montage Fields", three new columns are available for both calls and puts: 

Conversion Ask, Conversion Bid, and Conversion Mid. In these columns are either 

conversion or reversal values that act as follows: 

 

 Conversion = sell call, buy put, buy stock 

  

 Reversal = buy call, sell put, sell stock 

 

The midpoint conversion/reversal for all strikes is useful to see as high delta options can 

have wider bid/ask spreads. 

 

Clicking on a conversion field for a particular strike price opens the Spread Ticket with 

spread data in place. The selected conversion value will appear in the Px field of the ticket 

(all negative values are converted to positive, i.e., -0.04 become 0.04). Generally speaking, 

positive conversion amounts yield a debit value, while negative conversion amounts yield a 

credit value. 

 

 

Left/Right Navigation Arrows Now Functional 

 

 
 

Left and Right page navigation arrows are now functional in online Help. 

 

The keyboard equivalents (alt + left arrow, alt + right arrow) remain enabled. 
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13.2.85.0 

 
March, 2011 

 

 WTP Option to "Display Prices In Basis Points" Moved to Configuration Page 

  

 PDF Version of the Help Documentation Now Available 
 

 
 
 

WTP Option to "Display Prices In Basis Points" Moved to Configuration Page 

 

The option to "Display Prices In Basis Points" has been moved from the "show montage 

filters" drop-down list to the configuration page of Option Quote Cube and Spread 

Builder. 

 

 

PDF Version of the Help Documentation Now Available 
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A PDF version of all the Help pages (including Release Notes) has been created. The home 

page has been replaced with a table of contents, and all pages feature chapter identifiers 

and page folios. 

 

The PDF is available from the tradewex site. 

 
 

 

http://www.tradewex.com/
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13.2.83.0 

 
February, 2011 

 

 IVol Change Column Available in Option Quote Cube and Spread Builder 

 

 
 

 

A new implied volatility quote field column IVol Change is now available in Option Quote 

Cube and Spread Builder. 

 

The data displayed in the IVol Change column reflects the change from previous day's IVol 

value to the current IVol value. 
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13.2.82.0 

 
February, 2011 

 

 User Provided Hedge Delta for Vol Trader 

  

 New PNL-Based Columns Available in Position, Order, and Wave Grids 

 

User Provided Hedge Delta for Vol Trader 

  

 
 

 

Hedge Delta is a new advanced option in Vol Trader, allowing a user to specify a delta 

value which, in turn, will be used in computing the Est. Qty of an underlying symbol. 

 

The Est. Qty is computed as follows: Hedge Delta x  Qty = Est. Qty.  In the image above, 

the Hedge Delta is 80 x 50 (Qty) with a product of 4,000 (Est. Qty). 

 

If Hedge Delta is not selected, the market delta will be used when calculating the Est. Qty 

value. 

 

 

New PNL-Based Columns Available in Position, Order, and Wave Grids 
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The following realized/unrealized PNL account position columns are now available in 

Position Grid, Order Grid and Wave Grid: 

 

 PNL real (order is filled with a realized PNL) 

  

 PNL real adj (adjusted) 

  

 PNL unreal (live order but unfilled with a theoretical PNL) 

  

 PNL unreal adj (adjusted) 
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13.2.81.0 

February, 2011 

 

 Click Enabled Feature Added to Ticket Controls 

  

 Smart Ticket 

  

 Order Ticket Offers Multiple Ticket Selections 

 

 

Click Enabled Feature Added to Ticket Controls 

 

 
 

Px Field Greyed When Order Type = Market 

 

 

 
 

After Clicking in Greyed Area, Order Type = Limit 

 

 

In all WTP Order Tickets, a Market Order can be instantly changed to a Limit Order by 

clicking on the grayed out Px field.  

 

Similar functionality can be found in the following fields that only require a click in the field 

to enable it: 

 Show Quantity 

 Discretion 

 Aggression 

 Peg Limit 

 Percent Volume 
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 Start Time 

 Stop Time 

 

For Crossing Ticket: 

 Contra Price 

 

For Report Trade Ticket: 

 Liquidity Type 

 Commission Price (and per-share/flat-fee buttons) 

 

For Staged Order Ticket: 

 Price 

 Route 

 

Smart Ticket 

 

 

   
 

A new send to--> selection Smart Ticket has been added to WTP. The Smart Ticket opens 

the appropriate ticket (i.e., regular order ticket, spread ticket, crossing ticket, or staged 

ticket) based on the data sent to it. 

 

For example, selecting a single row in Option Quote Cube and sending it to the Smart Ticket 

opens a standard Order Ticket in Option mode. Selecting multiple rows in Option Quote cube 

opens a Spread Ticket when sending the rows to the Smart Ticket. The selected rows are 

the legs of the Spread Ticket. 
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Once an order is sent to the Smart Ticket, all other ticket selections will be unavailable in 

the send to--> menu. Conversely, if an order is sent to a non-smart ticket, the Smart 

Ticket will be unavailable in the send to--> menu. 

 

You can, however, change a created Smart Ticket from the ticket's menu bar. For example, 

if a Smart Ticket creates an Order Ticket in option mode, the ticket can be changed to a 

Staged Ticket or Crossing Ticket, but cannot be changed to an equity Order Ticket. 

 

 

Order Ticket Offers Multiple Ticket Selections 

 

 
 

In addition to offering the ability to change an Equity Ticket to an Option Ticket (and vice 

versa), a Staged Ticket and Crossing Ticket can now be selected. 

 

A Staged Ticket can be changed to an Option Staged Ticket, Crossing Ticket, or 

standard Order Ticket. 

 

A Crossing Ticket can be changed to an Option Crossing Ticket, Staged Ticket, or 

standard Order Ticket. 
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13.2.80.0 

February, 2011 

 

 Fade In/Fade Away Buttons Added to Order Grid 

 

 
 

Two new buttons Fade In and Fade Away allow a user to adjust prices in defined 

increments on live orders. Both columns/buttons and are now available in the Order Grid. 

 

The columns are found under Order Fields in either the configuration window of Order Grid 

or by right-clicking on any column head and selecting Insert Column-->Order Fields--

>Fade In (or Fade Away). 

 

The Fade In/Fade Away buttons work in a similar fashion to the +/- buttons with a 

couple of exceptions: 

 

 Fade In/Fade Away can be used for multiple live orders. 

  

 With "+" the buy/sell prices move higher. With "-" the buy/sell prices move lower.  

 

The actions of Fade In/Fade Away are described below: 

 

COMMAND LIVE ORDER 

(BUY) 

LIVE ORDER 

(SELL) 

RESULT 

Fade In 

Increases price 1 

increment at a 

time 

Decreases price 1 

increment at a 

time 

The buy price 

moves higher, 

the sell price 

moves lower 

(everything 

becomes more 

marketable). 

Fade Away 

Decreases price 1 

increment at a 

time 

Increases price 1 

increment at a 

time 

The buy price 

moves lower, 

the sell price 

moves higher 

(everything 

becomes less 

marketable). 
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Note: The price increment is normally $0.01 but can be any value when defined in Global 

Configuration. 
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13.2.79.0 

January, 2011 

 

 User Custom IVol Values Can Be Added To Various Grids 

 

 

 

 

Source data file lists symbols, strike price, expiration date, custom IVol values: 

 

 
 

 

Data file is imported along with an import file: 
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An "import from file" window displays the imported data (Strike, Expiration, and 

IVOL values are in place): 

 

 
 

 

 

A new column, Custom IVol, is now available for various grids (in this example, 

the Option montage grid of Option Quote Cube): 
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A notification can be defined to alert the user when the source comma-delimited 

file has been changed: 

 

 
 

 

 

After the change, a confirmation window asking if the source file should be 

reloaded is displayed: 
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A notification window is available to view when the custom IVol values have been 

changed and re-imported: 

 

 
 

 

Custom IVol values that are stored in a comma-delimited source file can be imported into 

one of the various WTP grids where Options data is reported. 

 

As seen in the workflow above, the source file is imported along with an import file 

(containing the relevant column headings). If no import file exists, it must be created and 

have its column heading defined. 

 

Once imported, a new column Custom IVol must be manually added to the grid. The 

custom IVol values (multiplied by a factor of 100) are added to the Custom IVol column, 

matching the strike price and expiration date that is listed in the source file. 

 

If a change is made to the source file after importing, a confirmation window will display 

asking if the source file is to be reloaded (i.e., re-imported). 

 

A notification can be setup whereby a notification window announces any custom IVol 

import changes (along with a sound, if defined). 
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13.2.78.0 

January, 2011 

 

 Bypass Confirmations for Staged Orders 

  

 Alternating Expiration Colors in Option Quote Cube Montage Grid 

 

 

Bypass Confirmations for Staged Orders 

 

 
 

 

In the Orders tab of Global Configuration staged equity shares, staged option contracts, 

and staged futures contracts can now have their confirmation messages disabled. If 

selected, no confirmation message will display for orders less than the amount entered. 

 

A warning message will be issued if any order type is selected to bypass a confirmation 

dialog: 
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Alternating Expiration Colors in Option Quote Cube Montage Grid 

 

 
 

Originally, alternating colors in the montage grid of Option Quote Cube referred to 

individual rows. Now, alternating colors can be configured by expiration dates. 

 

Configuring alternating rows has not changed. See Columns and Formatting for more 

details. 
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13.2.77.0 

January, 2011 

 

In this release: 

 

 Sweep and Book Only Added to Option Ticket 

  

 Volatility Chart Button Added to Spread Trader 

  

 Spread Ticket Launch Button Added to Spread Trader 

 

 

Sweep and Book Only Added to Option Ticket 

 

 
 

When the Options Order Ticket is in Advanced Mode, Sweep or Book Only can be 

selected: 

 

 Sweep—When Sweep is checked, an exchange is instructed to route an order only 

to fast exchanges.  

  

 Book Only—A limit order to buy or sell is executed in whole or in part. The portion 

not executed is posted in the Book without routing any portion of the order to 

another market center. When checking Book Only an exchange is ordered to not 

route an order out. Either the order will fill something currently on the exchange's 

book or it will remain on the exchange's book. 

 

Note: Both client and route permissions are required to access the Sweep feature. The 

route permission alone is required for Book Only. 

 

 

Volatility Chart Button Added to Spread Trader 
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Buttons have been added to Spread Trader that will launch the volatility chart when 

selected. 

 

 

Spread Ticket Launch Button Added to Spread Trader 

 

 
 

A launch Spread Ticket button has been added to Spread Trader. 

 

In order for the button to be activated, the securities must be the same and, at least, one of 

the two has to be an option order. 

 

In the above example, a symbol and expiration date were selected in Option Quote Cube 

and sent to the Spread Trader where the Spread Ticket button became available. 
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13.2.76.0 

December, 2010 

 

In this release: 

 

 Reverse Button Added to Spread Builder 

 

Reverse Button Added to Spread Builder 
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After selecting Reverse 

 

A Reverse button has been added to Spread Builder. Press the Reverse button to 

reverse the side types of the legs (i.e., SLO becomes BYO and vice versa).  

 
Greeks will adjust accordingly when selecting Reverse. 
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13.2.75.0 

December, 2010 

 

In this release: 

 

 IOC Routes Added For Spreads 

  

 Buy/Sell Sides Added To Global Configuration 

  

 Staged Order Notifications 

  

 

IOC Routes Added For Spreads 
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Spread IOC routes can now be configured under the Routes tab in Global Configuration.  

 

After they're defined, IOC routes can be selected with the Spread Ticket (either standalone 

ticket, or the Spread Ticket in Spread Builder) in advanced mode. 

 

When a spread order is sent with IOC routes, the IOC Tracker will open. 

 

 

Buy/Sell Sides Added To Global Configuration 
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You can now specify buy/sell types for securities in the QTY/Price tab of Global 

Configuration.  

 

Once set, the default side types will apply to orders placed in Order Tickets, Basket Trader, 

Spread Builder, Spread Viewer, and Vol Trader. 

 

 

Staged Order Notifications 
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New event notifications Staged Orders-Canceled and Staged Order-Received have been 

added to Global Configuration under the Notifications tab. 
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13.2.74.0 

November, 2010 

 

In this release: 

 

 Canadian Quote/Book Sources Added to Equity Quote Cube 

  

 Spread Basket Trader Now Available 

  

 Multiple Option Tick Service In Global Config 

  

 Column Filter Added to Position Grid 

 

 

Canadian Quote/Book Sources Added to Equity Quote Cube 

 

 
 

The Equity Quote Cube now supports Canadian book and quote sources such as the TSX 

Venture Exchange and the Toronto Stock Exchange. 

 

The configuration page has been improved to allow the selection of quote/book/futures 

quotes from USA, Canada, Europe, Futures, and Other sources. Any or all may be 

selected. 

 

 

Spread Basket Trader Now Available 
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Spread Viewer sends its spreads to the Spread Basket Trader: 

 

 
 

A new Basket Trader app called Spread Basket Trader is available via the send to--> 

menu function. Two new fields Quantity and Price have been added to Spread Viewer to 

facilitate the basket trade. This allows users to save their spreads with quantity and price 

data and have that information carried over into the basket. 

 

Note: Spread Basket Trader is not a standalone WTP app. It is launched only with the send 

to--> command. 

 

 

Multiple Option Tick Service In Global Config 
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WTP can now receive ticks from multiple worldwide exchanges. In Global Configuration 

under the Quote Connection tab is a new two-column grid titled Options Tick Service. 

 

The first column Ric Regex (Reuters Instrument Code, Regular Expression) is where an 

expression is entered. This will be either <Default> or a security's ticker symbol and its 

exchange. 

 

For example: MSFT.N refers to Microsoft on the New York Stock Exchange. The same 

security on the London Stock Exchange is written MSFT.L. Wildcard characters may also be 

used in defining an expression (example: .*\L). 

 

Once a RIC Regex expression is defined, select a tick service from the drop-down menu. 

 

 

Column Filters Added to Position Grid 
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Column filters have been added to the following columns in Position Grid: 

 Account 

 Firm 

 Portfolio 

 Security 

 Security Type 

 Staged Order 

 Wave 

 

For each filtered column, check the data to be displayed in the column head's drop-down 

list. 
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Contact Information 

 
 

 
 

Wolverine Execution Services is headquartered in Chicago, IL. 

 

 

Trading Desk   312.884.3717 

 

 

Technical Support    888.313.0664  support@tradewex.com 

 

 

Institutional Sales   877.310.8155  sales@tradewex.com 

 

 

 

Chicago 

 

175 W. Jackson Blvd. 

2nd Floor 

Chicago, IL 60604 

New York 

 

111 Broadway 

15th Floor 

New York, NY 10006 
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